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Safety

Your press and the recommended supplies have been designed and tested to meet strict safety requirements. 
Attention to the following information ensures the continued safe operation of your Xerox® Press.

PRODUCT SYMBOLS

This product uses a variety of symbols; refer to the following table for a list of these symbols and their definitions.

SYMBOL NAME AND DEFINITION (IF REQUIRED) 

CCaauuttiioonn 

This symbol indicates a mandatory action to take in order to avoid damage to these 
areas.

WWaarrnniinngg 

This symbol alerts users to areas where there is the possibility of personal injury.

HHoott WWaarrnniinngg 

This symbol alerts users to areas where there are heated surfaces which should not be 
touched.

LLaasseerr WWaarrnniinngg 

This symbol indicates a laser is being used and alerts the user to refer to the 
appropriate safety information.

PPiinncchh HHaazzaarrdd 

This warning symbol alerts users to areas where there is the possibility of personal 
injury.

LLoocckk 

UUnnlloocckk 

DDoo NNoott TToouucchh 

DDoo NNoott TToouucchh tthhee DDrruumm CCaarrttrriiddggee 

To avoid damage, do not touch the surface of the Drum Cartridge.
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SYMBOL NAME AND DEFINITION (IF REQUIRED) 

DDoo NNoott DDiissppoossee iinnttoo aann OOppeenn FFllaammee oorr IInncciinneerraattee 

DDoo NNoott IInncciinneerraattee tthhee TToonneerr CCaarrttrriiddggee 

Always refer to the recycling instructions for your region or marketplace for correct 
disposal information and procedures.

DDoo NNoott IInncciinneerraattee tthhee TToonneerr WWaassttee BBoottttllee 

Always refer to the recycling instructions for your region or marketplace for correct 
disposal information and procedures. 

DDoo NNoott IInncciinneerraattee tthhee DDrruumm CCaarrttrriiddggee 

Always refer to the recycling instructions for your region or marketplace for correct 
disposal information and procedures. 

DDoo NNoott IInncciinneerraattee tthhee SSeeccoonndd BBiiaass TTrraannssffeerr RRoollll  

Always refer to the recycling instructions for your region or marketplace for correct 
disposal information and procedures. 

FFlliicckkeerr LLaabbeell wwiitthh 110000 AAmmpp CCuurrrreenntt 

This symbol indicates usage only in premises that have a service current capacity 
equal to or greater than 100 Amps per phase.

GGrroouunndd,, CCoommmmoonn,, oorr EEaarrtthh TTeerrmmiinnaall 

LLAANN 

Local Area Network

UUSSBB 

Universal Serial Bus

KKeeeepp AArreeaa CClleeaarr 

Do not store any objects in this location.

KKeeeepp AArreeaa CClleeaarr 

Do not store any objects in this location. 
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SYMBOL NAME AND DEFINITION (IF REQUIRED) 

KKeeeepp AArreeaa CClleeaarr 

Do not store any objects in this location. 

DDoo NNoott UUssee TTrraannssppaarreenncciieess wwiitthh aa WWhhiittee SSttrriipp oorr OOvveerrhheeaadd PPrroojjeeccttoorr SShheeeettss 
wwiitthh aa WWhhiittee SSttrriipp 

DDoo NNoott UUssee OOppeenn EEnnvveellooppeess 

DDoo NNoott UUssee FFoollddeedd,, CCrreeaasseedd,, CCuurrlleedd,, oorr WWrriinnkklleedd PPaappeerr 

DDoo NNoott UUssee IInnkk JJeett PPaappeerr 

TTrraayy GGuuiiddeess MMuusstt TToouucchh MMeeddiiaa 

LLooaadd PPoossttccaarrddss iinn tthhee IInnddiiccaatteedd DDiirreeccttiioonn 

LLooaadd HHoollee--ppuunncchheedd PPaappeerr aass IInnddiiccaatteedd 

OOnn 

This symbol indicates the main power switch is in the OONN position.

OOffff 

This symbol indicates the main power switch is in the OOFFFF position.
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SYMBOL NAME AND DEFINITION (IF REQUIRED) 

SSttaannddbbyy 

This symbol indicates the secondary power switch is in the SSttaannddbbyy position.

DDoo NNoott DDiissppoossee iinn NNoorrmmaall HHoouusseehhoolldd WWaassttee SSttrreeaamm 
• Application of this symbol is confirmation that you should not dispose of items, 

such as Customer Replaceable Units (CRUs), in the normal household waste 
stream. You must dispose of these items in compliance with agreed national 
procedures. 

• This symbol often accompanies batteries and indicates that used electrical and 
electronic products and batteries should not be mixed with general household 
waste. 

• For more information about collection and recycling, please contact your local 
municipality, your waste disposal service, or the point of sale where you purchased 
the items. 

NOTICES AND SAFETY

Carefully read the following instructions before operating your press. Refer to these instructions to ensure the 
continued safe operation of your press.

Your Xerox® press and supplies are designed and tested to meet strict safety requirements. Safety requirements 
include safety agency evaluation and certification, and compliance with electromagnetic regulations and 
established environmental standards.

The safety and environment testing and performance of this product have been verified using Xerox® materials 
only.

Unauthorized alterations, which can include the addition of new functions or connection of external devices, can 
affect the product certification. For more information, contact your Xerox representative.

ELECTRICAL SAFETY

General Guidelines

Warning: Read the following warnings.

• Do not push objects into slots or openings on the press. Touching a voltage point or shorting out a part could 
result in fire or electric shock.

• Do not remove the covers or guards that are fastened with screws unless you are installing optional equipment 
and are instructed to do so. Switch off the press when performing these installations. Disconnect the power cord 
when removing covers and guards for installing optional equipment. Except for user-installable options, there 
are no parts that you can maintain or service behind these covers.
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Emergency Power Off

The following are hazards to your safety: 

• The power cord is damaged or frayed.

• Liquid is spilled into the press.

• The press is exposed to water.

• The press emits smoke, or the surface is unusually hot.

• The press emits unusual noise or odors.

• The press causes a circuit breaker, fuse, or other safety device to activate.

If any of these conditions occur, do the following: 

1. Turn off the printer immediately.

2. Disconnect the power cord from the electrical outlet.

3. Call an authorized service representative.

Power Cable and Electrical Supply

• Use the power cords that are supplied with your press.

• Do not remove or modify the power cord.

• The electrical outlet must be near the printer and must be easily accessible.

• Plug the power cable directly into a properly grounded electrical outlet. Ensure that each end of the cable is 
connected securely. If you do not know if an outlet is grounded, ask an electrician to check the outlet. 

Warning: To avoid risk of fire or electrical shock, do not use extension cords, power strips, or power 
plugs. Always adhere to national and local building, fire, and electrical codes regarding length of cord, 
conductor size, grounding, and protection.

• Do not use a ground adapter plug to connect the press to an electrical outlet that does not have a ground 
connection terminal.

• The electrical supply for the press must meet the requirements stated on the data plate located on the rear of 
the press. If necessary, consult your local electricity provider or a licensed electrician.

• Do not place the press in an area where people can step on the power cable.

• Do not place objects on the power cable.

• Do not plug or unplug the power cable while the power switch is in the On position.

• If the power cable becomes frayed or worn, replace it.

• To avoid electrical shock and damage to the cable, grasp the plug when unplugging the power cable.

Disconnect Device

The power cable is the disconnect device for this equipment. To remove all electrical power from the machine, 
disconnect the power cable from the electrical outlet.
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LASER SAFETY

North America Laser Safety

This product complies with safety standards and is certified as a Class 1 Laser product under the Center for Devices 
and Radiological Health (CDRH) of the United States Food and Drug Administration (FDA) implemented regulations 
for laser products. This product complies with FDA performance standards for Laser products except for deviations 
pursuant to Laser Notice No. 50 dated June 24, 2007. These regulations apply to laser products marketed in the 
United States. The label on the Production Press indicates compliance with CDRH regulations and must be attached 
to laser products marketed in the United States. This product does not emit hazardous laser radiation.

Laser Warning: Use of controls or adjustments or performance of procedures other than those specified 
herein may result in hazardous exposure of laser light.

Since radiation emitted inside this product is completely confined within the protective housing and external covers, 
the laser beam cannot escape from the Production Press during any phase of the user operation.

This product contains laser warning labels. These labels are intended for use by the Xerox Service Representative 
and are placed on or near panels or shields that require special tools for removal. Do not remove any of the panels. 
There are no operator serviceable areas in these covers. 

European Union (EU) Laser Safety

This product complies with IEC safety standard EN 60825-1: 2014.

The equipment complies with laser product performance standards set by governmental, national, and international 
agencies as a Class 1 Laser Product. It does not emit hazardous radiation as the beam is totally enclosed during all 
phases of customer operation and maintenance.

Warning: Use of controls or adjustments or performance of procedures other than those specified herein 
may result in hazardous radiation exposure.

If you need additional safety information about the product or Xerox supplied materials, you can email request to 
EHS-Europe@xerox.com.

OPERATIONAL SAFETY

Your Xerox equipment and supplies were designed and tested to meet strict safety requirements. These include 
safety agency examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines will help ensure the continued safe operation of your Press:

• Do not remove any trays when the Press is printing.

• Do not open the doors when the Press is printing.

• Keep hands, hair, neckties, and so on, away from the exit and feed rollers.

• Covers, which require tools for removal, protect the hazard areas within the Press. Do not remove the protective 
covers.

• Do not attempt to remove paper that is jammed deeply inside the Press. Switch off the Press promptly and 
contact your local Xerox representative.
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• To avoid a tip hazard, do not push or move the device with all of the paper trays extended. 

• Do not place the Press in locations susceptible to vibrations.

• For optimum performance, use the Press at the Altitude specified in Environmental Specifications section of the 
User Documentation.

• Use the materials and supplies specifically designed for your Press. The use of unsuitable materials may result in 
poor performance of the Press and possibly a hazardous situation.

• Follow all warnings and instructions that are marked on or supplied with the Press.

• Place the Press in a room that provides adequate space for ventilation and servicing.

• Place the Press on a level, solid surface, not on a thick pile carpet, that has adequate strength to support the 
weight of the Press.

• Do not attempt to move the Press. A leveling device that was lowered when your Press was installed may 
damage the carpet or floor.

• Do not set up the Press near a heat source.

• Do not set up the Press in direct sunlight.

• Do not store or operate the Press in an extremely hot, cold, or humid environment.

• Do not set up the Press in line with the cold air flow from an air conditioning system.

• Do not place containers of coffee or other liquid on the Press.

• Do not block or cover the slots and openings on the Press.

• Do not attempt to override any electrical or mechanical interlock devices.

WARNING—HOT SURFACE: Be careful when working in areas identified with this warning symbol. 
These areas may be very hot and should not be touched.

If you need any additional safety information concerning the Press or materials, contact your Xerox representative.

Ozone Information

This product produces ozone during normal operation. The ozone is heavier than air, and the quantity is dependent 
on print volume. Install the system in a well-ventilated room.

For more information, refer to Facts about ozone and Fact about ventilation at www.xerox.com/EHS or www.xerox. 
com/EHS-eu.

MAINTENANCE INFORMATION

Do not carry out any maintenance on this product which is not described in the customer documentation.

Warning: Do not use aerosol cleaners. Aerosol cleaners can be explosive or flammable when used on 
electromechanical equipment.

Use supplies and cleaning materials only as directed.

Do not remove the covers or guards that are fastened with screws. Customer service items are not located behind 
these covers.
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Note: Your Xerox Production Press is equipped with an power saving device to conserve power when the 
Production Press is not in use. The Production Press can be left on continuously.

WARNING—HOT SURFACE: The metallic surfaces in the fuser area are hot. Use caution when you 
remove paper jams from this area and avoid touching any metallic surfaces.

Vacuum Cleaner Use for Dry Ink/Toner Spills

Use a broom or a wet cloth to wipe off spilled dry ink/toner. Sweep slowly to minimize generation of dust during 
clean up. Avoid using a vacuum. If a vacuum must be used, the unit should be designed for combustible dusts (for 
example, explosion rated motor and non-conductive hose).

CONSUMABLE INFORMATION

Warning: When handling cartridges such as ink or fuser, avoid skin or eye contact. Eye contact can cause 
irritation and inflammation. Do not attempt to disassemble the cartridge. This can increase the risk of skin 
or eye contact.

Caution: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, and 
Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused 
by use of non-Xerox supplies, or the use of Xerox supplies not specified for this Production Press. The Total 
Satisfaction Guarantee is available in the United States and Canada. Coverage can vary outside these 
areas. For more details, contact your Xerox representative.

Store all consumables in accordance with the instructions given on the package or container.

Keep all consumables away from the reach of children.

Never throw dry ink/toner, print cartridges, or dry ink/toner containers into an open flame.

For information on Xerox® supplies recycling programs, go to:

• For the United States or Canada: www.xerox.com/recycling

• For Europe and other markets: www.xerox.com/recycling-eu

BATTERY SAFETY

One or more circuit boards in this printer contain a lithium battery.

Do not attempt to repair or replace the lithium battery. If there is a problem with the battery, contact an 
authorized service representative to correct the problem.

The lithium battery in this printer contains Perchlorate material. For information about the special handling 
procedures associated with Perchlorate material, refer to www.dtsc.ca.gov/hazardouswaste/perchlorate.

Warning: If the battery on a circuit board is installed incorrectly, there is a risk of explosion.
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ENVIRONMENTAL,  HEALTH,  AND SAFETY CONTACT INFORMATION

For more information on Environment, Health, and Safety in relation to this Xerox® product and supplies, contact 
the following:

• United States and Canada: 1-800-ASK-XEROX (1-800-275-9376)

• Email request to Europe: EHS-Europe@xerox.com.

• Web address: www.xerox.com/environment or www.xerox.com/environment_europe.
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Press Overview

The Xerox® Versant® 4100 Press is a full color or black and white, auto-duplex press that operates at a speed of 100 
prints per minute, when printing on 8.5 x 11 inch or A4 paper.

The system configuration consists of the Advanced Oversized High Capacity Feeder (Trays 6 and 7), the print 
engine with internal feeding trays (Trays 1-3), and an embedded Control Panel and touch screen (the user 
interface). A print server is also part of the configuration, which includes the PredictPrint Media Manager 
application used for stock and tray setup, and print job submission. An Offset Catch Tray can be connected to the 
press or other optional inline finishing devices are available. 

Note: With the exception of the Offset Catch Tray, all other finishing devices require the Interface Decurler 
Module.

The press includes the 4 dry ink/toner and drum cartridges, transfer belt and fuser or ROS system, Full Width Array 
calibration feature, decurler, registration and paper path, and paper inverter.

PRESS COMPONENTS

1. Advanced Oversized High Capacity Feeder (Trays 6 and 7), with Tray 5 (Bypass)

2. Dry Ink/Toner Cover

3. Control Panel and Touch Screen

4. Power Button

5. Offset Catch Tray (OCT)

6. Right Front Door

7. Center Front Door

8. Left Front Door

9. Paper Trays 1, 2, and 3
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Internal Components

1. Dry Ink/Toner Cartridges

2. Main Power Switch

3. Circuit Breaker Switch (on rear of press)

4. Paper Cooling Module

5. Dry Ink/Toner Waste Bottle

6. Fuser Module

7. Transfer Module

Locating the Press Serial Number

The press serial number can be accessed from the User Interface (UI) or by locating the serial number plate on the 
inside frame of the first feeder tray (Tray 1).

1. Press the Machine Status button on the UI.

2. From the Machine Status screen, ensure that the Machine Information tab is displayed. 

The press serial number is displayed under General Information.

3. If there is a loss of power and it is not possible to access the Machine Status screen, the press serial number 
can also be found on the inside frame of the press near paper Tray 1:  

a. At the press, fully open paper Tray 1.
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b. At the left of the feeder tray, on the press frame, locate the plate with the serial number (SSEERR##). 

Advanced Oversized High Capacity Feeder (Trays 6 and 7)

Tip: The Advanced Oversized High Capacity Feeder is part of the standard press configuration.

The Advanced Oversized High Capacity Feeder contains Trays 6 and 7. These trays feed a variety of stock sizes, 
including standard, heavyweight, and large-sized stocks up to 330 x 488 mm (13 x 19.2 in.) in size and weighing 
between 52 g/m2 and 400 g/m2. Each tray holds 2,000 sheets of coated and uncoated stock.

Note: For Versant® 4100 Press, the Advanced Oversized High Capacity Feeder (Trays 6 and 7) includes the 
Tray 5 (Bypass). It is a part of the standard press configuration.

The following illustration show the Trays 6 and 7 with the Tray 5 (Bypass).

Trays 6 and 7 with Tray 5 
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Trays 6 and 7 Components

1. Paper Jam and Error Indicator Panel

2. Paper Level Indicators

3. Feeder Front Cover

4. Tray 6

5. Tray 7

6. Circuit Breaker Switch

Control Panel

The embedded Control Panel on the press includes an LCD touch screen, keypad and feature buttons. The touch 
screen displays instructions, faults, and informational messages. Select the Control Panel buttons to log in, perform 
job setup functions, and view job, press, and supply statuses.
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ITEM NUMBER NAME DESCRIPTION 

1 Home button Displays the main menu. Provides access to 
view the supplies and trays available on the 
press and the status of consumables. 

2 Tools button Displays the Tools mode screen. For the 
operator, select the Tools icon to view billing 
information and to perform press calibration 
such as Full Width Array color uniformity 
adjustments.  

3 Job Status button Use to check the progress of active jobs and 
detailed information about completed jobs or 
pending jobs. This area also allows you to 
delete a job (cancel printing) and to pause 
jobs. 

4 Machine Status button Use to check the press configuration, the 
software version, the press billing meter and 
counter information, and to access and print 
job history or error reports. 

5 Touch Screen Directly touch the screen to select and set 
features. Displays instructional and 
informational messages, fault clearance 
procedures and general press information. 

6 Log In / Out button Use to log in and out of Administrator mode or 
Authentication mode with user ID and 
password. 

7 Language button Use to select a different language for the 
touch screen options. 

8 Power Saver button Use this button if the press has been inactive 
and the touch screen is dark (system is in 
Power Saver mode). This button manually exits 
the system from Power Saver mode; it does not 
place the press in Energy Save mode. 

9 Numeric Keypad Use to enter alphanumeric characters. The ‘C’ 
Cancel Entry cancels the previous entry made 
on the numeric keypad.  

10 Cancel Entry button Use this button to cancel the previous entry 
made on the numeric keypad. 

11 Clear All button Use this button to return all selections to the 
same state as when the press was powered on. 
Press once to clear a current entry. Press twice 
to return to default settings. 
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ITEM NUMBER NAME DESCRIPTION 

12 Stop button Press to stop and pause the print job in 
progress. 

13 Start button Press to start and print a selected report. Also 
used by the Customer Service Engineer during 
diagnostic routine procedures. 

14 Press Status Lights The three indicator lights that identify: data 
transmission in progress, the press is 
experiencing an error, and main power is on. 

Status Lights

There are three status lights on the press directly below the Control Panel. From right to left, they are:

ITEM 
NUMBER NAME DESCRIPTION 

1 Main Power Status LED This is a steady green light indicating 
the main power to the system is on. 

2 Error Status LED This is a steady orange light indicating 
the press is experiencing faults and 
errors. 

3 Data Transmission Status LED This is a flashing green light indicating 
that the transmission of an incoming 
print job is in process. 
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Login

There are two login levels:

• Guest or Operator: This is the default login user. You are automatically logged in as Guest.

• Administrator: This login level is required to customize the system and network defaults for your press and to 
customize particular print jobs by setting or changing parameters for certain features. Press the Guest button or 
the Log in button on the Control Panel to access the Login screen.

Note: Refer to the System Administrator Guide for more information on the Administrator features.

Language

Note: The number of languages available on your system depends on what was installed during the initial 
installation process.

Selecting a particular Language button immediately changes the language. No confirmation is required.

CChhaannggiinngg tthhee LLaanngguuaaggee

1. Press the Language button on the press Control Panel. 

The Language window displays on the touch screen.

2. Select the desired language from the list and select Save.  

The language on the screen changes to the new language and closes the Language window.

3. Select the Cancel button to return to the main screen.

Full System Configuration

Note: Full system configurations will vary depending on which optional devices are attached to the press. For 
detailed information about an optional device, refer to the appropriate device chapter in this guide.

The following illustration shows an example of a full system configuration with optional devices attached. This is 
only one example. 
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1. Dual Advanced Oversized High-Capacity Feeder (Trays 8 and 9)*

2. Advanced Oversized High-Capacity Feeder (Trays 6 and 7), with Tray 5 (Bypass)

3. Press

4. Interface Decurler Module (IDM)*

5. Inserter*

6. High-Capacity Stacker*

7. Crease and Two-sided Trimmer*

8. C/Z Folder*

9. Production Ready (PR) Booklet Maker Finisher*

10. SquareFold® Trimmer*

* Numbers 1 and 4–10 indicate optional devices.

PPrreessss CCoonnffiigguurraattiioonn wwiitthh OOtthheerr OOppttiioonnaall DDeevviicceess AAttttaacchheedd

This is another example of a full system configuration with optional devices attached, such as Dual High-Capacity 
XLS Vacuum Feeder and Plockmatic MPS XL.

1. Dual High-Capacity XLS Vacuum Feeder (Trays 8 and 9) (Optional)

2. High-Capacity Vacuum Feeder (Trays 6 and 7) (Optional)

3. Press

4. Interface Decurler Module (IDM) (Optional)

5. Inserter Module (Optional)

6. High-Capacity Stacker (Optional)

7. Two-sided Trimmer (Optional)
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8. C/Z Folder (Optional)

9. Production Ready (PR) Finisher Plus (Optional)

10. Plockmatic MPS XL (Multi-Purpose Stacker) (Optional)
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PredictPrint Media Manager Overview

PredictPrint Media Manager is a hardware and software solution for Xerox® Production Presses that provides simple, 
step-by-step guidance through setup routines for printing optimization. With the Stock Wizard feature of 
PredictPrint Media Manager, and with the use of a handheld barcode scanner, you can do the following:

• Program the paper trays with specific stock properties for a job

• Perform print engine adjustments to optimize print performance for the stock

• Complete Calibration and Profiling for the stock to maximize image quality and color output

For Versant Presses, the PredictPrint Media Manager application is on the EX or EX-P Print Server, powered by Fiery®. 
With the help of PredictPrint Cloud Server, the PredictPrint Media Manager application manages the stocks that the 
press uses. The PredictPrint Media Manager application connects to the PredictPrint Cloud server when a barcode is 
scanned, and retrieves all of the stock properties and recommended setup routines.

1. Main Menu

2. Login (for Administrator access)

3. Trays

4. Profiles

5. Stock Library

6. Stock Wizard

7. Display screen

For more information on PredictPrint Media Manager, refer to PredictPrint Media Manager.
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Print Server Overview

The Production Press is configured with a digital print server, the Xerox® EX or EX-P Print Server, Powered by Fiery®.

One of the following print servers can be used with your press:

• Xerox® EX 4100 Print Server, Powered by Fiery®

• Xerox® EX-P 4100 Print Server, Powered by Fiery®

Fiery® Print Server version 2.0 include Fiery System version FS600 and have unique features that are not available 
on older Fiery® Print Servers. To find your print server version or Fiery System version, on the Command WorkStation 
window, go to Server > Device Center > GENERAL > General Info, then refer to Fiery Server or Fiery System. 
This information is accessible also on the Fiery configuration page, printed through Fiery® Print Server.

The print server accepts, processes, and manages document files for job submission to the press.

The PredictPrint Media Manager application is installed on the print server. For information on setting up stocks and 
custom profiles, and paper trays that the press uses, refer to PredictPrint Media Manager.

Note: For detailed information on your specific print server, refer to the customer documentation that was 
delivered with it.

Documentation can also be downloaded from www.xerox.com by searching for the press and selecting the Support 
link or go to Fiery - Xerox Versant 4100 Press.
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Specifications

FEATURE DESCRIPTION 

Rated Speed 100 pages per minute of Letter (8.5 x 11 in.) or A4 paper size (full 
color or black only) 

Print Modes Two print modes are supported and are specified at the print server: 
• 4 Color Mode: Cyan, Magenta, Yellow, Black (CMYK) 
• Black and White Mode (Grayscale) 

Maximum Printable Area • Default Border: 4 mm on the leading edge and 2 mm on the 
remaining sides 

• Print Image Quality Assurance Area: 317 mm x 482 mm (12.48 x 
18.98 in.) 

• For Trays 1, 2 or 3: 323 x 482 mm (12.72 x 18.98 in.) 
• Tray 5 (Bypass): 326 x 482 mm (12.83 x 18.98 in.) 
• Advanced High Capacity Feeder (Trays 6 and 7): 326 x 482 mm 

(12.83 x 18.98 in.) 

Printing Resolution • Print Engine Imaging Resolution: 2400 x 2400 dots-per-inch (dpi)  
• Print Server Raster-Image-Processing (RIP) Resolution (print server 

to print engine): 1200 x 1200 dpi 

Paper Size Ranges For information, refer to Paper Size Ranges. 

Paper Tray Information For information, refer to Paper Tray Information. 

Productivity Information For information, refer to Press Productivity Information. 

PERFORMANCE SPECIFICATIONS

FEATURE DESCRIPTION 

Press Warmup Time The press warmup times vary depending on the current state or mode of the 
press. Warmup times are listed as follows: 
• From a cold start (power on or power saver mode), less than 5 minutes 
• From Sleep Mode or Power Saver, less than 5 minutes 
• From Standby Mode, less than 1 minute 
• When switching print modes (such as from black only to full color), 

approximately 2 minutes 

Time of First Print Out of Press This is the minimum time from when the press receives a job from the print 
server to the time when the trail edge of the first print passes through the 
press exit sensor.  
• From a cold start (power on or power saver), the system takes less than 5 

minutes to start printing 
• From standby mode, the system usually takes less than 1 minute to the 

start printing 
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ENVIRONMENTAL SPECIFICATIONS

The press enters the Power Saver mode after 15 minutes of inactivity. The factory default time of 15 minutes can 
be changed when you are logged in as the administrator. For more information, refer to the System Administrator 
Guide.

For the press system to operate, the temperature and relative humidity of the room where the press is located 
needs to be within the minimum and maximum allowable temperature and relative humidity limits.

OPERATING ENVIRONMENT  VERSANT 4100 PRESS 

Required Temperature Range 10–32° C (50–90° F) 

Ambient temperature for optimal image quality and 
paper handling performance 

20–24° C (68–76° F) 

Required Relative Humidity Range 15%–85% Relative Humidity (RH) 

Relative humidity for optimal image quality and paper 
handling performance 

45% RH 

Altitude (above sea level) 0–2500 meters (0–8200 feet) 

Sound Pressure Levels • Running: 65 dBA 
• Standby: 40.8 dBA 

Note: The press can operate outside of this range, but the performance cannot be guaranteed.
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Getting Help

HELP ON THE XEROX WEBSITE

For technical support, Xerox supplies, customer documentation, and answers to frequently-asked questions, go to 
www.xerox.com. Find the latest documentation and online support under Customer Support > All Support and 
Drivers. Use the Contact Us link for specific contact information and telephone numbers in your area.

Note: Periodically check the website for the latest information on your press.

It is helpful to know your press serial number before calling for support. The press serial number is shown on the 
Machine Information tab: Machine Status > Machine Information.

PRINT SERVER DOCUMENTATION

The EX or EX-P Print Server Help menu on the Command WorkStation window is designed to provide information on 
specific workflows when using the Command WorkStation. Additional user documentation supplied by Fiery is 
available from www.xerox.com under the Customer Support > Support and Drivers link for your press.

XXeerrooxx EEaassyy VViittaallss

Fiery® Print Servers version 2.0, FS600, introduces a new feature called Easy Vitals. It is a dashboard available in 
the printer server, showing graphical and numeric indicators of key elements of the digital press. The dashboard 
also shows warning messages associated with the press. The key elements in the Easy Vitals dashboard include: 

• Temperature and Humidity

• Toner levels

• Waste toner bottle status

• High Frequency Service Items (HFSI) status

You can access Easy Vitals dashboard from Fiery Command WorkStation. From the print server menu, click Easy 
Vitals. Data on the Easy Vitals dashboard is updated shortly after the print engine has cycled down. Temperature 
and Humidity data are from sensors inside the print engine and can vary from the operating environment of the 
press.

For more information, refer to Fiery - Xerox Versant 4100 Press.

XXeerrooxx®® FFrreeeeFFllooww®® VViissiioonn CCoonnnneecctt

Xerox® FreeFlow® Vision Connect is a Web-based software solution that offers real-time, at-a-glance visibility and 
control of production operations. The dashboard screen monitors, tracks, and benchmarks performance across 
printers and sites. To access FreeFlow® Vision Connect web application, install the Vision Connect Printer Agent on 
your Fiery Print Server. For more information, refer to Xerox® FreeFlow® Vision Connect Web Application User Guide 
available at Workplace and Digital Printing Solutions | Xerox. 

MORE INFORMATION

Refer to the following sources for more information about your press and its capabilities.
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RESOURCE LOCATION 

Other documentation for your printer Print Server Documentation: For more information, refer to the 
documentation that shipped with the print server. After 
installation is complete, it is recommended that you or your 
System Administrator get additional print server documentation 
for later reference from www.xerox.com/VERSANT_4100docs or 
Fiery - Xerox Versant 4100 Press. 

PredictPrint Media Manager Cloud Server Go to PredictPrint Media Manager Software - Xerox. 

Recommended Media List United States: www.xerox.com/rmlna

Europe: www.xerox.com/rmleu

Technical support information for your 
printer; including online technical support, 
Online Support Assistant, and print driver 
downloads. 

Go to www.xerox.com/VERSANT_4100support. 

Information Pages To print from the control panel, press the Machine Status button, 
then touch Machine Information. 

To print from the CentreWare® Internet Services, click Support, 
then on the Online Support, click Connect.

Order supplies for your printer Go to www.xerox.com/office/VERSANT_4100supplies. 

Local sales and Technical Customer Support Go to www.xerox.com/office/worldcontacts. 

Printer registration Go to www.xerox.com/register. 

It is recommended that you print all customer documentation and keep it close to the machine.

Note: For the latest documentation updates for your Xerox Digital Press, go to www.xerox.com/VERSANT_ 
4100docs or www.xerox.com/VERSANT_4100support.

Before you contact Xerox for support, ensure that you have the serial number of your Xerox press. To locate the 
press serial number, refer to Locating the Press Serial Number.
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Regulatory Information

BASIC REGULATIONS

Xerox® has tested this printer to electromagnetic emission and immunity standards. These standards are designed 
to mitigate interference caused or received by this printer in a typical office environment.

Changes or modifications to this device not specifically approved by the Xerox® Corporation may void the user's 
authority to operate this equipment.

FCC Regulations in the USA

This product has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of 
the Federal Communications Commission (FCC) Rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user will be required to correct the 
interference at his or her own expense.

Changes or modifications to this equipment not specifically approved by the Xerox® Corporation may void the 
user’s authority to operate this equipment.

To maintain compliance with FCC regulations, shielded cables must be used with this equipment. Operation with 
non-approved equipment or unshielded cables is likely to result in interference to radio and TV reception. 

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 

1. This device may not cause harmful interference, and

2. This device must accept any interference received, including interference that may cause undesired operation.

Responsible Party: Xerox® Corporation

Address: 800 Phillips Road, Webster, NY 14580

Web address: www.xerox.com/environment

Canada

This Class A digital apparatus complies with Canadian ICES-003 and ICES-001.

Cet appareil numérique de la classe A est conforme à la norme NMB-003 et NMB-001 du Canada.

This device complies with Industry Canada’s license-exempt RSSs. Operation is the subject to the following two 
conditions: 

1. This device may not cause interference, and

2. This device must accept any interference, including interference that may cause undesired operation of the 
device.

Le présent appareil est conforme aux CNR d’Industrie Canada applicables aux appareils radio exempts de licence. 
L’exploitation est autorisée aux deux conditions suivantes: 
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1. l’appareil ne doit pas produire de brouillage, et

2. l’utilisateur de l’appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible 
d’en compromettre le fonctionnement.

European Union and European Economic Area Compliance

The CE mark applied to this product indicates compliance to applicable EU Directives. You 
can find the full text of the EU Declaration of Conformity in www.xerox.com/environment_ 
europe.

European Union Lot 4 Imaging Equipment Agreement

Xerox® has agreed to design criteria for energy efficiency and environmental performance of our products that are 
in scope of the European Union (EU) Energy Related Products Directive, specifically the Lot 4 - Imaging Equipment.

In scope products include Household and Office equipment that meet the following criteria: 

• Standard monochrome format products with a maximum speed less than 66 A4 images per minute.

• Standard color format products with a maximum speed less than 51 A4 images per minute.

TO LEARN MORE ABOUT GO TO 

• Power Consumption and Activation Times 
• Default Power Saver Settings 

User Documentation or Systems Administrators Guide 

www.xerox.com/VERSANT_4100docs

• Benefits of purchasing ENERGY STAR® 

qualified products 
www.energystar.gov

• Environmental Benefits of Duplex Printing 
• Benefits of using lighter paper weights (60 

g/m2) and Recyclability 
• Cartridge disposal and treatment 
• Xerox participation in sustainability 

initiatives 

www.xerox.com/environment or www.xerox.com/environment_ 
europe

European Union Lot 19 Ecodesign Directive

Per European Commission Ecodesign Directive, the light source contained within this product or its components is 
intended to be used for Image Capture or Image Projection only, and is not intended for use in other applications.

Environmental Benefits of Duplex Printing

Most Xerox® products have duplex printing, also known as 2-sided printing, capability. This enables you to print on 
both sides of the paper automatically, and therefore helps to reduce the use of valuable resources by reducing your 
paper consumption. The Lot 4 Imaging Equipment agreement requires that on models greater than or equal to 40 
ppm color or greater than or equal to 45 ppm monochrome the duplex function has been auto-enabled, during the 
setup and driver installation. Some Xerox models below these speed bands may also be enabled with 2-sided 
printing settings defaulted on at the time of install. Use of the duplex function will reduce the environmental impact 
of your work. However, you must require simplex or 1-sided printing, you can change the print settings in the print 
driver.
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Paper Types

You can use this product to print on both recycled and virgin paper, approved to an environmental stewardship 
scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper (60 g/m2), which contains 
less raw material and thus saves resources per print, can be used in certain applications. We recommend you to 
check if this is suitable for your printing needs.

ENERGY STAR

The ENERGY STAR program is a voluntary scheme to promote the development and purchase of 
energy-efficient models, which help to reduce environmental impact. Details on the ENERGY STAR 
program and models qualified to ENERGY STAR can be found at the following website: www. 
energystar.gov.

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks.

The ENERGY STAR Imaging Equipment Program is a team effort between United States, European 
Union, Japanese governments, and the office equipment industry to promote energy-efficient 
copiers, printers, fax, multifunction printers, personal computers, and monitors. Reducing product 
energy consumption helps combat smog, acid rain, and long-term changes to the climate by 
decreasing the emissions that result from generating electricity.

For more information on energy or other related topics, go to:

• www.xerox.com/environment or

• www.xerox.com/environment_europe

Power Consumption and Activation Time

The amount of electricity that a device consumes depends on the way the device is used. This device is designed 
and configured to enable you to reduce your electricity usage.

Power Saver modes are enabled on your device to reduce energy consumption. After the last print, the device goes 
to Ready mode. In this mode, the device can print again immediately. If the device is not used for a specified 
period, the device goes to Low Power mode, then to Sleep mode. In these modes, to enable reduced-power 
consumption, only essential functions remain active. The device takes longer to produce the first print after it exits 
the Power Saver modes than it takes to print in Ready mode. This delay is the result of the system waking up and is 
typical of most imaging devices on the market.

To save power, you can enable Auto Power Off mode on your device. If Auto Power Off mode is enabled, you can 
configure the mode as follows:

• AAllwwaayyss AAlllloowweedd: The device powers off automatically after the specified time, and the cumulative Low Power 
mode and Sleep mode time outs have elapsed.

• AAlllloowweedd OONNLLYY WWhheenn tthhee CCoonnddiittiioonnss aarree MMeett: The device automatically powers off only after time outs have 
elapsed. The device also powers off if USB Drive, and Wired and Non-Wired Network are not activated.

To change the Power Saver settings, refer to the User Documentation at www.xerox.com/VERSANT_4100docs. For 
more details, contact your System Administrator or refer to the System Administrator Guide.

To enable Auto Power Off mode, contact your System Administrator. For details, refer to the System Administrator 
Guide at www.xerox.com/VERSANT_4100docs.
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To learn more about Xerox participation in sustainability initiatives, go to:

• www.xerox.com/environment or

• www.xerox.com/environment_europe

Default Power Saver Settings

This device is ENERGY STAR® qualified under the ENERGY STAR Program Requirements for Imaging Equipment. The 
Low-Power mode time can be configured up to 30 minutes. The default value is 15 minutes. The Sleep mode time 
can be configured up to 30 minutes. The default value is 30 minutes. Sleep mode begins after the configured time 
of inactivity rather than time after Low-Power mode.

To change the Default Power Saver settings, contact your System Administrator, or refer to the System 
Administrator Guide at www.xerox.com/VERSANT_4100docs.

Note: Changing the default Power Saver activation times can result in an overall higher energy consumption 
of the device. Before you turn off Power Saver modes or set a long activation time, consider the increase in 
device power consumption.

Eurasian Economic Union Compliance

The EAC mark applied to this product indicates certification for use on the markets of the Member 
States of the Customs Union.

Turkey RoHS Regulation

In compliance with Article 7(d), we hereby certify “it is in compliance with the EEE regulation EEE yönetmeliğine 
uygundur.” (Compliant with EEE Regulations).

Ukraine RoHS Compliance

Обладнання відповідаєвимогам Технічного регламенту щодо обмеження

використання деяких небезпечних речовин в електричному та електронному

обладнані, затвердженого постановою Кабінету Міністрів України від 3 грудня 2008 № 1057

(The equipment complies with requirements of the Technical Regulation, approved by the Resolution of Cabinet of 
Ministry of Ukraine as of December 3, 2008, in terms of restrictions for the use of certain dangerous substances in 
electrical and electronic equipment.)

COPY REGULATIONS

United States

Congress, by statute, has forbidden the reproduction of the following subjects under certain circumstances. Penalties 
of fine or imprisonment can be imposed on those guilty of making such reproductions.

1. Obligations or Securities of the United States Government, such as: 
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• Certificates of Indebtedness

• National Bank Currency

• Coupons from Bonds

• Federal Reserve Bank Notes

• Silver Certificates

• Gold Certificates

• United States Bonds

• Treasury Notes

• Federal Reserve Notes

• Fractional Notes

• Certificates of Deposit

• Paper Money

• Bonds and Obligations of certain agencies of the government, such as FHA and so on

• Bonds. United States Savings Bonds can be photographed only for publicity purposes for the campaign of 
the sale of such bonds

• Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a canceled 
revenue stamp, this can be done provided the reproduction of the document is performed for lawful 
purposes

• Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps can be photographed, 
provided the reproduction is in black and white and is less than 75% or more than 150% of the linear 
dimensions of the original document

• Postal Money Orders

• Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States

• Stamps and other representatives of value, of whatever denomination, which have been or can be issued 
under any Act of Congress

• Adjusted Compensation Certificates for Veterans of the World Wars

2. Obligations or Securities of any Foreign Government, Bank, or Corporation

3. Copyrighted materials, unless permission of the copyright owner has been obtained or the reproduction falls 
within the fair use or library reproduction rights provisions of the copyright law. Further information of these 
provisions can be obtained from the Copyright Office, Library of Congress, Washington, D.C. 20559. Ask for 
Circular R21.

4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates can be photographed.

5. Passports. Foreign Passports can be photographed.

6. Immigration papers

7. Draft Registration Cards

8. Selective Service Induction papers that bear any of the following Registrant information: 
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• Earnings or Income

• Court Record

• Physical or mental condition

• Dependency status

• Previous military service

• Exception: United States military discharge certificates can be photographed

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the various 
Federal Departments, such as FBI, Treasury, and so on, unless the head of such department or bureau orders a 
photograph.

Reproducing the following items is prohibited in certain states: 

• Automobile Licenses

• Driver Licenses

• Automobile Certificates of Title

The above list is not all-inclusive, and no liability is assumed for its completeness or accuracy. If there is doubt, 
consult your attorney.

For more information about these provisions, contact the Copyright Office, Library of Congress, Washington, D.C. 
20559. Ask for Circular R21.

Canada

Parliament, by statute, has forbidden the reproduction of the following subjects under certain circumstances. 
Penalties of fine or imprisonment may be imposed on those guilty of making such reproductions: 

• Current bank notes or current paper money

• Obligations or securities of a government or bank

• Exchequer bill paper or revenue paper

• The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of a court of 
law

• Proclamations, orders, regulations or appointments, or notices thereof (with intent to falsely cause same to 
purport to have been printed by the Queen’s Printer for Canada, or the equivalent printer for a province)

• Marks, brands, seals, wrappers or designs used by or on behalf of the Government of Canada or of a province, 
the government of a state other than Canada or a department, board, Commission or agency established by 
the Government of Canada or of a province or of a government of a state other than Canada

• Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of a province 
or by the government of a state other than Canada

• Documents, registers or records kept by public officials charged with the duty of making or issuing certified 
copies thereof, where the reproduction falsely purports to be a certified copy thereof

• Copyrighted material or trademarks of any manner or kind without the consent of the copyright or trademark 
owner

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is assumed for its 
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completeness or accuracy. In case of doubt, consult your solicitor.

Other Countries

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be imposed on 
those found guilty of making such reproductions.

• Currency notes

• Bank notes and checks

• Bank and government bonds and securities

• Passports and identification cards

• Copyright material or trademarks without the consent of the owner

• Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of doubt, contact 
your legal counsel.

SAFETY CERTIFICATION

This device is compliant with IEC and EN product safety standards certified by a National Regulatory Test 
Laboratory (NRTL).

SAFETY DATA SHEETS

For Material Safety Data information regarding your printer, go to: 

• Web address: www.xerox.com/sds or www.xerox.co.uk/sds_eu

• United States and Canada: 1-800-ASK-XEROX (1-800-275-9376)

• For other markets, send email request to: EHS-Europe@xerox.com

38 Xerox® Versant® 4100 Press User Documentation

Learning About

https://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=msdsna
https://www.xerox.co.uk/sds_eu
mailto:EHS-Europe@xerox.com


Recycling and Disposal

ALL COUNTRIES

If you dispose your Xerox product, note that the printer may contain lead, mercury, perchlorate, and other materials 
whose disposal may be regulated due to environmental considerations. The presence of these materials is fully 
consistent with global regulations applicable at the time that the product was placed on the market. For recycling 
and disposal information, contact your local authorities.

Perchlorate Material: This product may contain one or more perchlorate-containing devices, such as batteries. 
Special handling may apply. For more information, go to www.dtsc.ca.gov/hazardouswaste/perchlorate.

Battery Removal

Only a manufacturer approved service facility can replace the batteries.

NORTH AMERICA

Xerox operates an equipment take-back and reuse or recycle program. Contact your Xerox representative (1-800- 
ASK-XEROX) to ensure that this Xerox product is part of the program. For more information about Xerox 
environmental programs, go to www.xerox.com/environment.

For recycling and disposal information, contact your local authorities.

Xerox® Versant® 4100 Press User Documentation 39

Learning About

http://www.dtsc.ca.gov/hazardouswaste/perchlorate
https://www.office.xerox.com/cgi-bin/printer.pl?APP=udpdfs&Page=color&PgName=environmentna


EUROPEAN UNION

These symbols indicate that this product is not to be disposed of with your household waste, 
according to the Waste Electrical and Electronic Equipment (WEEE) Directive (2012/19/EU), 
the Battery Directive (2006/66/EC) and national legislation implementing those Directives.

If a chemical symbol is printed beneath the symbol shown above, in accordance with the 
Battery Directive, this indicates that a heavy metal (Hg = Mercury, Cd = Cadmium, Pb = Lead) 
is present in this battery or accumulator at a concentration above an applicable threshold 
specified in the Battery Directive.

Some equipment can be used in both a domestic or household and a professional or 
business application. Private households within European Union can return used electrical 
and electronic equipment to designated collection facilities free of charge. For more 
information about collection and recycling of old products and batteries, contact your local 
municipality, your waste disposal service or the point of sale where you purchased the items. 
In some member states, when you purchase new equipment, your local retailer may be 
required to take back your old equipment free of charge. For more information, contact your 
retailer.

Business Users in the European Union, in accordance with European legislation, end of life 
electrical and electronic equipment subject to disposal must be managed within agreed 
procedures. If you discard electrical and electronic equipment, contact your dealer or 
supplier, local reseller or Xerox representative for end of life take-back information prior to 
disposal.

Improper handling of this type of waste can have a possible impact on the environment and 
human health due to potentially hazardous substances that are generally associated with 
EEE. Your cooperation in the correct disposal of this product will contribute to the effective 
usage of natural resources.

Disposal Outside of the European Union

These symbols are only valid in the European Union. If you want to discard these items, contact your local 
authorities or dealer and ask for the correct method of disposal

OTHER COUNTRIES

Contact your local waste management authority to request a disposal guidance.
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Power On or Off

POWER SWITCHES

There are three power switches involved with the press:

• Circuit Breaker Switch

• Main Power Switch 

• Power Button

Important: To power off, always press the power button first. Wait until the lights on the user interface stop 
blinking, to allow the fuser to finish cooling. Move the main power switch to the off position.

Circuit Breaker Switch

The Circuit Breaker Switch located at the rear of the press. Initially check to make sure this switch is set to On when 
the press is shipped.

Main Power Switch

The Main Power Switch located inside the Center Front Door. 

Note: Switching off the Main Power also shuts off the Main Power Status LED.
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Tip: Before switching off the press, ensure that it is not in Power Saver Mode.

This switch is used mainly by the Xerox Service Representative when servicing the press. In rare troubleshooting 
situations, you may be directed to power off the press with this switch. 

Power Button

The power button is located on the right side of the Control Panel. Use this button to power ON or OFF the press.

POWER ON OR OFF THE PRESS

1. To switch on the press, check that the Main Power switch behind the Center Front Door is On. 

Xerox® Versant® 4100 Press User Documentation 43

Working With



2. Press the Power button on top of the press to the ON position.  
The Ready Indicator light displays green.

A screen message advises of a short wait while the fuser warms up and the press runs a system check. You can 
set features for a job during this time and the printing process will start automatically when the press is ready.

3. To switch off, press the Power button to the Off position. 

Note: Allow the press to remain off for a minimum of 10 seconds before switching on the power again.

POWER SAVER MODE

The Power Saver feature allows the press to enter a reduced power consumption mode when all print jobs have 
completed and there are no jobs currently processing. There are two power saving modes: Low Power and Sleep.

• Low Power: After remaining inactive for a preset time period, the press enters the Low Power mode.

• Sleep: After entering Low Power mode and remaining inactive for another preset time period, the press enters 
the Sleep mode.

By default, the press automatically enters the Low Power mode after 15 minutes of inactivity. After 30 minutes of 
inactivity, the press then enters Sleep mode. These time intervals for both modes can be changed by the system 
administrator.

Refer to the following example:

• Low Power Mode is set to 1 minute. 

• Sleep Mode is set to 10 minutes.

• Sleep Mode activates after 10 minutes of total inactivity, and not 10 minutes after the Low Power Mode begins.

Low Power Mode

In this mode, the power to the Control Panel and fuser unit is lowered to save power. The display goes out and the 
Power Saver button on the Control Panel lights. 

To exit the Low Power Mode, press the Power Saver button. The Power Saver button is no longer lit, indicating that 
the Power Saver feature is canceled.

Sleep Mode

In this mode, the power is lowered more than in the Low Power mode. The display goes out and the Power Saver 
button on the Control Panel lights. 

To exit the Sleep Mode, press the Power Saver button. The Power Saver button is no longer lit, indicating that the 
Power Saver feature is canceled.

Exiting Power Saver Mode

The press exits Power Saver mode by pressing the Power Saver button on the Control Panel or when receiving print 
data from an incoming job.
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Job and Machine Status

JOB STATUS

The Job Status feature allows the user to check active, pending, and completed jobs. The ability to cancel printing 
or pause jobs is also available from Job Status.

Job Status Area

The Job Status button on the press control panel displays the progress and status of any currently printing jobs and 
lists all completed jobs.

1. Select the Active Jobs tab to view the status of currently pending or in-progress print jobs on the system.

2. Select the Completed Jobs tab to view a list of all jobs that have printed successfully.

3. Select the Group Parent Jobs checkbox to list and display the jobs according to a parent and child relationship 
hierarchy.

Active Jobs Tab

1. Press the Job Status button on the control panel.

2. Select the Active Jobs tab.

3. From the displayed list, select the applicable job to view. 
Use the up or down buttons to navigate the list.

4. If required, select Display Time to show the time required to process the job.

5. To delete a job or change the execution order, select a job from the list.

6. From the pop-up menu, you can select one of the following option: 

• Delete: This option cancels the current or pending job.

• Job Progress: This option shows the progress of the job that is currently printing or copying.

• Details: This option shows the details of the selected document.

• Close Menu: This option closes the pop-up menu.
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Completed Jobs Tab

1. Press the Job Status button on the Control Panel.

2. Select the Completed Jobs tab. 

A list of the completed or deleted jobs appear. Use the scroll bar to navigate the list. 

3. To verify the details of a job, select the job from the displayed list.

4. From this Status window, select one of the following to print a history of this job. 

a. To print the job details, select Print this Job Report button.

b. To print the history of parent and child jobs, select Print this Job History Report button.

5. After verifying the job details, select Close.

MACHINE STATUS

Press the Machine Status button on the Control Panel to access the Machine Status information, including press 
configuration, faults, billing information, maintenance, and reporting features.

Machine Information Tab

This tab provides general information about the press such as the currently installed software version and the press 
serial number. This area also allows you to print reports and view details that apply to billing impressions.

1. General Information

2. Xerox Website

3. Model

4. Machine Serial Number

5. Current System Software

6. IP Address

7. Host Name
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8. Machine Configuration

9. Software Version

10. Print Reports

11. Maintenance Assistant

Machine Serial Number

The Machine Serial Number is displayed in the General Information area on the Machine Information tab. Use this 
number when calling Xerox for technical information or assistance.

Current System Software

The version of the system software that is currently installed on the press is displayed under the Current System 
Software title.

IP Address and Host Name

This is the unique Internet Protocol (IP) address and host name that identifies the press to the specific network to 
which it is connected.

Machine Configuration

Select the Machine Configuration tab to display a list of the various hardware components and options that are 
available on the press as well as their status. Hardware components and options include any optional feeding and 
finishing devices attached to the press.

Software Version

Select the Software Version tab to display a list of the software versions for the various system components, 
including any optional feeding and finishing devices.

Maintenance Assistant

Select the Maintenance Assistant tab to send the Xerox Remote Print Services diagnostic information or SMart 
eSolutions Data on the press to Xerox Support. Also, when logged in as an Administrator, Communication Test 
under Maintenance Assistant helps the press to upgrade software and NVM values through Xerox Remote Services. 
For more information, refer to System Administrator Guide.

Print Reports

This Print Reports button is enabled by the system administrator. From the various reports available, select a report 
on the touch screen and then select the Start button to print. Some reports are only available in the system 
administrator mode. From the Print Reports screen, select the desired report to print.

Job Status

From the Job Status screen, select the desired history report to print.

• Job History Report: This report lists the status, attributes, input source and output destination of every print job 
completed, deleted or shutdown.

• Error History Report: This report lists the most recent errors and faults that occurred on the press.
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Printer Reports

From the Printer Reports screen, select Configuration Report. The Configuration Report lists the hardware 
configuration, devices and software installed, and the network settings on the system such as port and proxy 
settings. Print and place this report near the press for easy access to information such as the press serial number.

NNeettwwoorrkk CCoonnttrroolllleerr JJoobbss RReeppoorrtt

Network Controller Jobs Report includes the following reports:

• Job History Report

• Error History Report

• Font List

• Configuration Report

Job Counter Report

The Job Counter Report is available only when from the system administrator mode. This report identifies the total 
number of minutes the press has been in various operating modes, the billing counters for various size impressions 
printed from each tray, and a summary of the number of jobs printed with various page counts.

Auditron Report/Meter Report

The Auditron Report/Meter Report is available only when from the system administrator mode. 

Note: This Auditron Report/Meter Report is not applicable to a print-only system.

Faults Tab

The Faults tab provides a list of faults that occurred on the press. Access this tab by pressing the Machine Status 
button on the control panel and then selecting the Faults tab.

The Faults tab displays the following information about faults that occurred on the press:

1. FFaauulltt CCooddee: This column identifies the code number assigned to the fault message.

2. DDaattee aanndd TTiimmee: These columns indicate the day and time the fault occurred.

3. IImmaaggee CCoouunntt: This column indicates the total number of printed impressions.
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Billing Information Tab

Accessing Billing Information

To view billing impressions and counters (or meters) information recorded by the press, access the Machine Status 
area of the press Control Panel.

1. Press the Machine Status button on the Control Panel.

2. Select the Billing Information tab.  

The Billing Information screen displays.

3. To view the Billing Impression Mode, press the Tools button on the Control Panel, select the Tools icon, and 
select Setup > Billing Impression Mode.

Billing Impressions Information

The Billing Information screen allows you to view the total number of impressions (prints) recorded by the press, 
including a category of the number of color prints only, black prints only and large media prints. It also displays 
specific usage counter information. The counters display the impression amount for all printed jobs.

All meters that may be used for billing purposes are displayed on the Billing Information screen:

• CCoolloorr IImmpprreessssiioonnss: This value (number) represents the total number of color impressions that have been 
printed.

• BBllaacckk IImmpprreessssiioonnss: This value (number) represents the total number of black-only impressions that have been 
printed.

• TToottaall IImmpprreessssiioonnss: This value (number) represents the total number of ALL impressions. It is the sum of the 
Color Impressions and the Black Impressions.

• CCoolloorr LLaarrggee IImmpprreessssiioonnss: This value (number) represents the total number of large color impressions. These 
impressions are one side of one sheet of large media (for example 11 x17 in., A3). Large Impressions are any 
prints that are larger than 145 sq. in., 935 sq. cm. 

Note: This meter is NOT added to the Total Impressions meter since it is already added to the Color 
Impressions meter.

• EExxttrraa LLoonngg IImmpprreessssiioonnss: For this impression type, the meter increases for any media with a length between 
491 mm (19.33 in.) and 661 mm (26 in.).

Billing Impression Mode

The Billing Impression Mode defines how the press tracks and records impressions made on large-size paper such as 
A3 or tabloid. The type of Billing Impression Mode used by your press is set during system installation. A Xerox Sales 
Representative can confirm the Billing Impression Mode applicable for your press. 

There are two types of Impression Modes:

• AA33 IImmpprreessssiioonn MMooddee - For all media sizes (including large-sized), counts all impressions equally. 

• AA44 IImmpprreessssiioonn MMooddee - Counts large impressions on media such as A3 and 11 x 17 inches (media that is larger 
than 8.5 x 14 inches), as their A4 equivalent.

To view the current Billing Impression Mode in effect on the press:

• Press the Tools button on the Control Panel, select the Tools icon, and select Setup > Billing Impression Mode.
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Usage Counters

Select the Usage Counters button to view even more detail on billing and counts being tracked on the press such 
as the number of 1-sided vs 2-sided print jobs.

From the Counters drop-down list you can select the desired counter to view:

• Impression Counters

• Sheet Counters

• All Usage Counters

IImmpprreessssiioonn CCoouunntteerrss

This view displays the total impression amount. In other words, impression is the image on one side of one 
sheet of media. This counter shows the total impression amount for color and black-only impressions. 

• Total Impressions: This number represents the total number of impressions for all color and black-only print 
jobs.

• Black Impressions: This number represents the total number of impressions for all black and white print jobs.

• Black Large Impressions: These impressions are one side of one sheet of a large black-only document (such 
as 11 x17 in., A3). Large Impressions are any prints that are larger than 8.5 x14 in., B4.

• Color Impressions: This number represents the total number of impressions for all color print jobs.

• Color Large Impressions: These impressions are one side of one sheet of a large color document (such as 11 
x17 in., A3). Large Impressions are any prints that are larger than 8.5 x14 in., B4.

SShheeeett CCoouunntteerrss

This counter provides information on the total number of sheets the press feeds to the output area. Each sheet 
counts as one click on the counter (regardless of size or whether it is a one-sided or two-sided print job).

AAllll UUssaaggee CCoouunntteerrss

This view provides a complete total of all the counters, including the totals from the Impression Counters and 
Sheet Counters.

UUppddaattee BBuuttttoonn

Select this button to refresh and update the counts.
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Paper and Media

PAPER AND MEDIA OVERVIEW

Before loading paper, consider the following:

• To define attributes for a stock, to add a new stock to the Stock Library, or to assign a stock to a paper tray for 
the print job, access the Stock Wizard in the PredictPrint Media Manager application on the print server. If you 
have restricted access, contact your System Administrator. 

Note: The PredictPrint Media Manager is an application that is loaded onto the print server and is used 
to manage the stocks and paper trays for your press. 

– By default, the Stock Library feature is available to both the operator and system administrator modes.  

– Your System Administrator may restrict user access to change or add stocks.  

– When you are loading paper, the Stock Wizard opens in the PredictPrint Media Manager application. The 
Stock Wizard guides you through the steps to set up the stock assigned to that tray. 

Note: If the Administrator has disabled the Stock Wizard, then the Tray Properties window for the tray 
appears.

• The press supports the ability to pull different stock sizes and paper types from various trays and assemble them 
as part of a single job. To select multiple paper trays and insert different papers within one job, program this 
custom job at the print server using features such as special pages.

• The press supports Automatic Tray Switching, which allows a job to switch automatically from an empty tray to 
a full tray containing the same size paper, orientation, and stock type. For details on how to enable this feature 
and prioritize the order of trays to search on and use, refer to the System Administrator Guide.

General Paper Loading Guidelines

• Fan paper before loading it in the paper tray.

• Do not overfill the paper trays. Do not load paper above the indicated maximum fill line in the tray.

• Adjust the paper guides to fit the paper size.

• If excessive jams occur, use paper or other approved media from a new package.

• Do not print on label media after a label has been removed from a sheet.

Unsupported Media

Some paper and other media types can cause poor output quality, increased paper jams, or damage the press. Do 
not use the following:

• Rough or porous paper

• Inkjet paper

• Paper that is business-card size

• Paper that is folded or wrinkled

• Paper that is curled more than 0.47 in., 12 mm
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• Paper with cutouts or perforations

• Stapled paper

• Damp paper 

• Thermal or heat-transfer paper

• Envelopes with windows, metal clasps, side seams, or adhesives with release strips

• Padded envelopes

• Envelopes 

Note: For envelopes, use Trays 5, 6, or 7.

Note: In addition to the above list, there may be other media that is not recommended or supported. For 
details, please contact your local Xerox representative.

Paper and Media Storage Guidelines

Storing paper and other media properly contributes to optimum print quality.

• Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from ultraviolet and 
visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly damaging to paper.

• Reduce the exposure of paper to strong lights for long periods of time.

• Maintain constant temperatures and relative humidity.

• Avoid storing paper in locations that are damp or collect moisture.

• Store paper flat on pallets, cartons, shelves, or in cabinets.

• Avoid food or drinks in the area where paper is stored or handled.

• Do not open sealed packages of paper until you are ready to load the paper into the trays. Leave stored paper 
in the original packaging. The paper wrapper protects the paper from moisture loss or gain.

• Some special media is packaged inside resealable plastic bags. Store the media inside the bag until you are 
ready to use it. Keep unused media in the bag and reseal it for protection.

SUPPORTED PAPER

Paper Size Ranges

TRAY MINIMUM SIZE MAXIMUM SIZE 

Trays 1, 2, and 3 140 x 182 mm (5.51 x 7.17 in.) 330.2 x 488 mm (13 x 19.2 in.) 

Tray 5 (Bypass) 98 x 146 mm (3.86 x 5.75 in.) 330.2 x 488 mm (13 x 19.2 in.) 

Extra Long Sheets (XLS):

1–Sided 330.2 x 660.4 mm (13 x 26 in.)

Trays 6 and 7, or Trays 8 
and 9 

98 x 146 mm (3.86 x 5.75 in.) 330.2 x 488 mm (13 x 19.2 in.) 
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Paper Specifications for All Trays

Note: Always refer to the Recommended Media List (RML) or Tested Substrate List (TSL) for a comprehensive 
list of supported media. You can access the latest RML or TSL version from www.xerox.com and https://www. 
xerox.com/predictprintmedia.

PAPER TYPE PAPER SIZE 
FEED DIRECTION 
(LEF AND SEF*) TRAYS WEIGHT (G/M2) 

Plain paper 
(coated and 
uncoated) 

• B5  
• A4  
• A4 Cover  
• B4  
• A3  
• SRA3  
• 7.25 x 10.5 in.  
• 8 x 10 in.  
• 8.46 x 12.4 in.  
• 8.5 x 11 in.  
• 8.5 x 13 in.  
• 8.5 x 14 in.  
• 9 x 11 in.  
• 11 x 15 in.  
• 11 x 17 in.  
• 12 x 18 in.  
• 12.6 x 19.2 in.  
• 13 x 18 in.  
• 16-kai (TFX)  
• 16-kai (GCO)  
• Pa-kai (TFX)  
• Pa-kai (GCO)  

• SEF and LEF 
• SEF and LEF 
• SEF and LEF 
• SEF 
• SEF 
• SEF 
• SEF and LEF 
• SEF and LEF 
• SEF 
• SEF and LEF 
• SEF and LEF 
• SEF 
• SEF and LEF 
• SEF 
• SEF 
• SEF 
• SEF 
• SEF 
• SEF and LEF 
• SEF and LEF 
• SEF 
• SEF 

All Trays • Trays 1, 2, and 3: 52– 
256 

• Trays 5, 6, and 7: 52– 
400 Hole-punched 

paper (coated and 
uncoated) 

Recycled paper 
(coated and 
uncoated) 

All Trays 64–105 

Embossed (coated 
and uncoated) 

All Trays • Trays 1, 2, and 3: 106– 
256 

• Trays 5, 6, and 7: 106– 
400 

Transparency 8.5 x 11 in. (A4) LEF All Trays — 

Postcard (coated 
and uncoated) 

4 x 6 in., A6 SEF Trays 5 
(Bypass), 
6, and 7 

106–400 

Government-Legal 215.9 x 330.2 mm 
(8.5 x 13 in.) 

SEF and LEF All Trays — 

Double-Thick (DT) 
Special A4  

226.0 x 310.0 mm 
(8.90 x 12.20 in) 

SEF and LEF All Trays — 

Double-Thick (DT) 
Special A3 

310.0 x 432.0 mm 
(12.20 x 17.00 in) 

SEF All Trays — 

Envelopes For supported 
envelope sizes, refer to 

— Trays 5 
(Bypass), 

— 
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PAPER TYPE PAPER SIZE 
FEED DIRECTION 
(LEF AND SEF*) TRAYS WEIGHT (G/M2) 

the Customer 
Expectation and 
Installation Guide. 

6, and 7 

Labels (coated 
and uncoated) 

8.5 x 11 in., A4  LEF All Trays • Trays 1, 2, and 3: 106– 
256 

• Trays 5, 6, and 7: 106– 
400 

Tabs and Dividers 9 x 11 in.  LEF All Trays 163 

LEF = Long Edge Feed; SEF = Short Edge Feed 

Paper Tray Information

Paper Tray Information for Trays 1, 2, and 3

Trays 1, 2, and 3 are identical. When the press is first installed, the tray size setting for Trays 1 and 3 are set at 8.5 x 
11 in. or A4 (LEF). The tray size setting for Tray 2 is set at 11 x 17 in. or A3 (SEF). 

Note: Each feeder tray has a stock loading label. When loading media into the tray, refer to the labels on the 
inside panel of the feeder tray for the correct orientation of that stock type.

When the PredictPrint Media Manager application is installed on the print server, the default for all trays is Letter 
(8.5 x 11 in.). At the PredictPrint Media Manager, the operator can change those default tray sizes different stock 
size settings. 

Note: The sizes selected from the PredictPrint Media Manager application for all trays must match the 
paper sizes that are loaded in the trays.

Note: Fiery® Print Server version 2.0 include Fiery System version FS600 and have unique features that are 
not available on older Fiery® Print Servers. On Fiery® Print Server version 2.0, FS600 or newer version, if the 
stock loaded in the tray is registered with PredictPrint Stock Wizard, then you can right-click on the tray to 
Run Image Quality System Check. To enable this option, refer to Accessing the Stock Wizard or Settings 
Tab.

The specifications for each tray are:

• Maximum of 550 sheets of 24 lb. (90 g/m2) uncoated paper; 28-80 lb. cover (105-120 g/m2) coated stock

• Paper weight range of 18 lb. Bond to 95 lb. Cover (64 g/m2 to 256 g/m2)

• Paper sizes starting at 140 x 182 mm (5.51 x 7.17 in.) to a maximum of 330.2 x 488 mm (13 x 19.2 in.)

• Stock types include transparencies, heavyweight, coated and uncoated, hole-punched, and tabs 

• Loading paper Long Edge Feed (LEF) or portrait or Short Edge Feed (SEF) or landscape dependent on the actual 
paper size

• Auto size detection capability

• Automatically adjusts the tray position in the front and back based on the paper size; this is done once the tray 
is closed
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Paper Tray Information for Trays 6 and 7

Note: Each feeder tray has a stock loading label. When loading media into the tray, refer to the labels on the 
inside panel of the feeder tray for the correct orientation of that stock type.

The specifications for each tray are:

• Maximum of 2,000 sheets of 24 lb. (90 g/m2) uncoated paper; 2,100 sheets of 82 g/m2 and 2,300 sheets of 64 
g/m2

• Paper weight range of 52 to 400 g/m2

• Stock types include transparencies, heavyweight, coated and uncoated, hole-punched, and tabs  

Tip: Transparencies perform best when printed from Trays 6 and 7.

• It is recommended that you use Tray 5 (Bypass) to feed envelopes. However, Trays 6 and 7 may also be used for 
feeding envelopes. 

– If you use Trays 6 or 7, envelopes must be fed with the Postcard Bracket or with the installed optional 
Envelope Support Kit. 

– If the Postcard Bracket is used, the stack height is limited to 200 envelopes. 

PPoossttccaarrdd BBrraacckkeett

The postcard bracket is delivered with Trays 6 and 7 from manufacturing. The postcard bracket allows you to print 
on smaller size media without requiring post-processing cutting or sorting. The postcard bracket accommodates 
101.6 x 152.4 mm (4 x 6 in.) SEF media and smaller. For more information, refer to Paper Size Ranges.

Note: For more information, refer to Postcards.

OOppttiioonnaall EEnnvveellooppee SSuuppppoorrtt KKiitt

The Envelope Support Kit enables a greater quantity of envelopes to be loaded and printed from Trays 6 or 7. This 
optional kit consists of two plastic pieces that fit into the bottom of the tray and a postcard bracket that attaches 
to the side of the tray. The plastic pieces lift one side of the stack of envelopes to offset the extra thickness of the 
flaps. This keeps the stack level for feeding and enables more envelopes to be fed from the tray.

Note: For more information, refer to Envelopes.

Paper Tray Information for Tray 5 (Bypass)

Note: Depending on system configuration, optional Tray 5 (Bypass) is located on the top of Trays 6/7 or 
optional Trays 8/9).

This tray is used primarily when using a small quantity and special media (such as envelopes). When you use the 
Tray 5 (Bypass), refer to the following information:

• Maximum of 250 sheets of 24 lb. (90 g/m2) uncoated paper; 28 lb. to 110 lb. cover (106-300 g/m2) coated 
stock 

• Paper weight range of 52 g/m2 (uncoated) to 300 g/m2 (coated)

• Stock types include transparencies, heavyweight, coated and uncoated, hole-punched, and tabs

• Program the stock job properties using the Stock Wizard.
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• Do not load mixed-size paper into the bypass tray.

• Do not load materials above the MMAAXX line as indicated on the tray.

• It is recommended that you use Tray 5 (Bypass) to feed envelopes.

Press Productivity Information

The following tables show the maximum print speed of the press across the full range of paper sizes that the press 
supports. Unless otherwise noted, the print speed is identical for full-color or black-and-white-only prints. 

Process and print speed is based on 1-Sided or 2-Sided mode, paper type, paper weight, paper size, and feeding 
tray. 

Note: The references to Bond and Cover weight ranges are approximations based on conversion to the 
nearest standard paper weight and type.

Productivity Information for Trays 1–3, 6, 7, 8, and 9

The Postcard size is supported only with optional Trays 6 and 7, Trays 8 and 9, and Tray 5 (Bypass). To support 
Postcard size, Trays 6 and 7, and Trays 8 and 9, require a postcard bracket. Trays 1, 2, and 3 support only 52–256 g/ 
m2 paper.

Note: The ideal room temperature is 16° C (60.8° F) or higher.

Important: Media heavier than 256 g/m2 (90 lb. Cover) cannot be fed from Trays 1–3.

PAPER SIZE 
PAPER FEED 
DIRECTION PAPER TYPE PAPER WEIGHT 

PRINTS PER MINUTE (PPM) 

1–SIDED 2–SIDED 

Postcard SEF Uncoated, 
Coated, and 
Matte Coated 

52–300 g/m2 

301–400 g/m2

100 ppm 

80 ppm

50 ppm 

40 ppm

8.5 x 11 in., A4  LEF Uncoated, 
Coated, and 
Matte Coated 

52–300 g/m2 

301–400 g/m2

100 ppm 

80 ppm

50 ppm 

40 ppm

8.5 x 11 in. SEF Uncoated, 
Coated, and 
Matte Coated 

52–300 g/m2 

301–400 g/m2

80 ppm 

64 ppm

50 ppm 

40 ppm

8.5 x 14 in., A4, 
B4 

SEF Uncoated, 
Coated, and 
Matte Coated 

52–300 g/m2 

301–400 g/m2

60 ppm 

51 ppm

30 ppm 

25.5 ppm

11 x 17 in., A3 SEF Uncoated, 
Coated, and 
Matte Coated 

52–300 g/m2 

301–400 g/m2

52 ppm 

44 ppm

30 ppm 

22 ppm

12 x 18 in., 
SRA3 

SEF Uncoated, 
Coated, and 
Matte Coated 

52–300 g/m2 

301–400 g/m2

47 ppm 

39 ppm

23.5 ppm 

19.5 ppm

330.2 x 488 SEF Uncoated, 52–300 g/m2 47 ppm 23.5 ppm 
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PAPER SIZE 
PAPER FEED 
DIRECTION 

PAPER TYPE PAPER WEIGHT 
PRINTS PER MINUTE (PPM) 

1–SIDED 2–SIDED 

mm (13 x 19.2 
in.) 

Coated, and 
Matte Coated 301–400 g/m2 39 ppm 19.5 ppm

8.5 x 11 in., A4  LEF Labels, Cast 
Coated, 
Embossed/ 
Textured, Film 

52–400 g/m2 40 ppm — 

8.5 x 11 in. SEF Labels, Cast 
Coated, 
Embossed/ 
Textured, Film 

52–400 g/m2 32 ppm — 

8.5 x 14 in., A4, 
B4 

SEF Labels, Cast 
Coated, 
Embossed/ 
Textured, Film 

52–400 g/m2 25 ppm — 

11 x 17 in., A3 SEF Labels, Cast 
Coated, 
Embossed/ 
Textured, Film 

52–400 g/m2 22 ppm — 

12 x 18 in., 
SRA3 

SEF Labels, Cast 
Coated, 
Embossed/ 
Textured, Film 

52–400 g/m2 20 ppm — 

330.2 x 488 
mm (13 x 19.2 
in.) 

SEF Labels, Cast 
Coated, 
Embossed/ 
Textured, Film 

52–400 g/m2 19 ppm — 

Productivity Information for Tray 5 (Bypass)

PAPER SIZE 
PAPER FEED 
DIRECTION 

PAPER TYPE PAPER WEIGHT 
PRINTS PER MINUTE (PPM) 

1–SIDED 2–SIDED 

Postcard SEF Uncoated, 
Coated, and 
Matte Coated 

52–300 g/m2 

301–350 g/m2

70 ppm 

70 ppm

35 ppm 

35 ppm

8.5 x 11 in., 
A4  

LEF Uncoated, 
Coated, and 
Matte Coated 

52–300 g/m2 

301–400 g/m2

59 ppm 

57 ppm

35 ppm 

35 ppm

8.5 x 11 in. SEF Uncoated, 
Coated, and 
Matte Coated 

52–300 g/m2 

301–400 g/m2

59 ppm 

57 ppm

29.5 ppm 

28.5 ppm
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PAPER SIZE 
PAPER FEED 
DIRECTION 

PAPER TYPE PAPER WEIGHT 
PRINTS PER MINUTE (PPM) 

1–SIDED 2–SIDED 

8.5 x 14 in., 
A4, B4 

SEF Uncoated, 
Coated, and 
Matte Coated 

52–300 g/m2 

301–400 g/m2

50 ppm 

47 ppm

26 ppm 

23.5 ppm

11 x 17 in., 
A3 

SEF Uncoated, 
Coated, and 
Matte Coated 

52–300 g/m2 

301–400 g/m2

44 ppm 

40 ppm

22 ppm 

20 ppm

12 x 18 in., 
SRA3 

SEF Uncoated, 
Coated, and 
Matte Coated 

52–300 g/m2 

301–350 g/m2

41 ppm 

37 ppm

20.5 ppm 

18.5 ppm

330.2 x 488 
mm (13 x 
19.2 in.) 

SEF Uncoated, 
Coated, and 
Matte Coated 

52–220 g/m2 

221–350 g/m2

40 ppm 

36 ppm

20 ppm 

18 ppm

8.5 x 11 in., 
A4  

LEF Labels, Cast 
Coated, 
Embossed/ 
Textured, Film 

52–300 g/m2 40 ppm — 

8.5 x 11 in. SEF Labels, Cast 
Coated, 
Embossed/ 
Textured, Film 

52–300 g/m2 32 ppm — 

8.5 x 14 in., 
A4, B4 

SEF Labels, Cast 
Coated, 
Embossed/ 
Textured, Film 

52–300 g/m2 25 ppm — 

11 x 17 in., 
A3 

SEF Labels, Cast 
Coated, 
Embossed/ 
Textured, Film 

52–300 g/m2 22 ppm — 

12 x 18 in., 
SRA3 

SEF Labels, Cast 
Coated, 
Embossed/ 
Textured, Film 

52–300 g/m2 20 ppm — 

330.2 x 488 
mm (13 x 
19.2 in.) 

SEF Labels, Cast 
Coated, 
Embossed/ 
Textured, Film 

52–300 g/m2 19 ppm — 
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LOADING PAPER

Loading Paper in Trays 1, 2, and 3

Note: A paper jam may occur if a tray is opened while it is being used to feed stock.

1. Select the appropriate paper stock for your print job.

2. Pull out the tray slowly until it stops.

3. Open the ream of paper with the seam side facing up.

4. Fan the sheets before loading them into the tray.

5. Extend the paper guides outward until they stop. 

6. Load and align the edge of the paper against the left edge of the tray. 

Paper can be loaded in the LEF or portrait, or SEF or landscape direction.
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7. Adjust the paper guides by pressing in the guide releases and carefully moving the guides until they lightly 
touch the edges of the material in the tray. 

Note: Do not load materials above the MMAAXX line located on the guides.

8. Gently push in the tray until it comes to a stop. 

The Stock Wizard opens on the print server.

9. Scan the barcode on the stock, then to set up the stock, follow the steps in the Stock Wizard. 

Note: For details on setting up the stock in the Stock Wizard, refer to Scanning a Media Barcode.

Loading Paper in Trays 6 and 7

1. Select the appropriate paper stock for your print job.

2. Pull out the tray slowly until it stops. 

3. Open the ream of paper with the seam side facing up.

4. Fan the sheets before loading them into the tray.

5. Extend the paper guides outward until they stop. 
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6. Load and align the edge of the paper against the right edge of the tray. 

Paper can be loaded in the LEF or portrait, or SEF or landscape direction.

7. Adjust the paper guides by pressing in the guide releases and carefully moving the guides until they lightly 
touch the edges of the material in the tray. 

Note: Do not load materials above the MMAAXX line located on the guides.

8. Gently push in the tray until it comes to a stop. 

The Stock Wizard opens on the print server.

9. Scan the barcode on the stock, then to set up the stock, follow the steps in the Stock Wizard. 

Note: For details on setting up the stock in the Stock Wizard, refer to Scanning a Media Barcode.

Loading Paper in Tray 5 (Bypass)

1. Slide the paper guides outward to the desired paper size. 

2. Select the appropriate paper stock for your print job.

3. Open the ream of paper with the seam side facing up.

4. Fan the sheets before loading them into the tray.
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5. Insert the paper or media into the tray until it stops. 

The Stock Wizard opens on the print server.

6. Adjust the paper guides so that they touch the edges of the stack. 

Note: Do not load materials above the MMAAXX line located on the guides.

7. Scan the barcode on the stock, then to set up the stock, follow the steps in the Stock Wizard. 

Note: For details on setting up the stock in the Stock Wizard, refer to Scanning a Media Barcode.

MATCHING THE TRAY AND STOCK INFORMATION

Important: To ensure maximum productivity and successful job completion, always verify that the Tray 
Properties information on the PredictPrint Media Manager application on the print server matches the actual 
stock or media that is loaded in the tray being used for the print job.

Before running a print job, check for any of the following conditions:

• Modifications were made to the Stock Library, such as: 

– Adding a stock 

– Copying a stock 

– Creating a new stock 

– Editing an existing stock 

• Stock or media was loaded into the selected tray for the print job

• The tray selected for the print job was opened or closed

Note: If any of these conditions apply, verify that the Tray Properties information matches the actual tray 
contents.

If the stock loaded in the tray does not match the information on the Tray Properties window, then a message may 
appear on one or more of the following screens: 

• The press User Interface

• The PredictPrint Media Manager application

• The print server

Tip: Stock or tray mismatch information and how it is displayed is dependent on the individual print server. If stock 
is changed in a tray, a message may not be displayed. Therefore it is important to perform the following steps 
always before running a print job.
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1. Check for a tray mismatch message on the press User Interface. If a mismatch message is displayed, select it. 

A new message displays and explains what media is required and the tray location.

2. Go the print server and check the main or home window for a similar message: 

• If a message exists, follow the information provided on the print server to correct the stock mismatch issue, 
then continue to the next step.

• If a message does not exist, continue to the next step.

3. Load the stock in the tray. 
If the User Interface on the press displays a mismatch message, to correct the mismatch, use the Stock Wizard.

4. Close the tray. 

The Stock Wizard opens.

5. To change the Tray Properties to match the contents of the tray, follow the stock setup steps in the Stock 
Wizard.

6. Resolve all tray and stock mismatch messages.

7. Start your print job.

PAPER FEED PERFORMANCE IN TRAYS 6  AND 7

If misregistration or skew occurs on printed output that was fed from Trays 6 or 7, manual adjustment of the paper- 
feed levers may improve and correct the printed output.

Important: For most print jobs, these levers should remain in their default position. The position of these 
levers should be changed only if there is a skew problem when running a specific print job or media type. 
Changing the levers can cause more skew problems when running certain media types such as coated, label, 
tab stock, hole-punched paper, transparency, film, postcards, and envelopes.

The paper-feed adjustment levers are found in Trays 6 and 7. These levers are used to improve paper feed accuracy 
and to reduce paper skew problems.

1. Rear Paper-feed Adjustment Lever

2. Right-side Paper-feed Adjustment Lever

Xerox® Versant® 4100 Press User Documentation 63

Working With



Improving Paper Feed Performance in Trays 6 and 7

1. Open the tray by pulling it out slowly until it stops. 

2. Ensure that the desired paper is loaded into the tray.

3. Go to the PredictPrint Media Manager application on the print server. On the Tray Properties window, verify the 
correct paper information, such as size, type, weight, and paper curl or alignment option for the tray.

4. On the tray, slide the rear paper-feed adjustment lever to the right. 

5. Close the tray by slowly pushing it in until it comes to a stop.

6. Run your print job.

7. After the print job finishes, open the tray and return the rear paper-feed adjustment lever to its default position 
by sliding it to the left. 

Leave the tray open and continue to the next step.
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8. Retrieve and evaluate the printed output; choose one of the following: 

• The paper is fed accurately without skew and the printed output is satisfactory. Close the tray and your task 
is completed.

• The paper is skewed and the printed output is unsatisfactory; proceed to the next step.

9. Adjust the right-side paper-feed lever: 

a. On the tray, slide the right-side paper-feed adjustment lever toward the rear of the tray. 

b. Close the tray and verify the tray settings from the PredictPrint Media Manager application on the print 
server.

c. Run your print job.

10. Retrieve and evaluate the printed output; choose one of the following actions: 

• If the paper is fed accurately without skew and the printed output is satisfactory, perform the following: 

1. Open the tray.

2. Return the right-side paper-feed adjustment lever to its default position by sliding it toward the front of 
the tray. 

3. To complete the task, close the tray.

• If the paper is skewed and the printed output is unsatisfactory, proceed to the next step.

11. Adjust both levers: 
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a. Open the tray and slide the rear paper-feed adjustment lever to the right. 

b. Ensure that the right-side paper-feed adjustment lever still is in the rear position. 

c. Close the tray and verify the tray settings from the PredictPrint Media Manager application on the print 
server.

d. Run your print job.

12. After the print job finishes, open the tray and return both levers to their default positions: 

a. Return the rear paper-feed adjustment lever to its default position by sliding it to the left. 
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b. Return the right-side paper-feed adjustment lever to its default position by sliding it toward the front of the 
tray. 

c. Close the tray and continue to the next step.

13. Retrieve and evaluate the printed output; choose one of the following: 

• The paper is fed accurately without skew and the printed output is satisfactory; your task is completed.

• The paper is skewed and the printed output is unsatisfactory; continue to the next step.

14. If you are still having skew adjustment problems, refer to the Advanced Stock Setup information on the 
PredictPrint Media Manager on the print server. If necessary, to resolve the problem, perform one of the 
following: 

• Create or use an Alignment Profile

• Adjust the Aligner Roll Pressure

• Adjust the Regi-Loop
If the problem continues, contact the Customer Support Center. 

Important: If using an Advanced Stock Setup feature, always return the feature to its default setting 
before using the press.

PRINTING ON SPECIAL MEDIA

Transparencies

Guidelines for Printing on Transparencies

Always refer to the following guidelines before using transparencies:

• For optimum system performance and image projection, use Xerox removable stripe transparency materials. 
These premium transparencies are specifically designed to provide optimum print quality.

• Use of other transparencies may cause press damage and result in excessive service calls.

• Transparencies can be printed from all trays.

• Use only transparency stock listed in the Tested Substrate List (TSL). 

• Do not intermix paper with individual transparencies in a tray. Jams can occur.
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• Do not load more than 100 transparencies in a paper tray at one time.

• Load 8.5 x 11 in., A4 transparencies long edge feed only (portrait).

• Fan the transparencies to stop them from sticking together before loading.

• Load transparencies on top of a small stack of same-size paper.

• At the PredictPrint Media Manager, ensure that you select Transparency as the Paper or Media Type and 
select the tray that contains the transparencies as the Paper Source.

• The maximum output stack height should not exceed 100 transparencies.

Loading Transparencies in Trays 1, 2, and 3

Load the transparencies in the LEF (portrait) direction and align the edge of the transparencies against the left 
edge of the tray, with the side to be printed on facing up.

Loading Transparencies in Trays 6 and 7

Load the transparencies in the LEF (portrait) direction and align the edge of the transparencies against the right 
edge of the tray, with the side to be printed on facing up.

Loading Transparencies in Tray 5 (Bypass)

Load the transparencies in the LEF (portrait) direction and align the edge of the transparencies against the right 
edge of the tray, with the side to be printed on facing up.
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Hole-punched Paper

Guidelines for Printing on Hole-punched Paper

Hole-punched paper is defined as having two or more holes along one edge for use in ring binders and notebooks. 

Always refer to the following guidelines before using hole-punched paper:

• Paper with punched holes can be printed from all trays.

• Hole-punched paper can be loaded in the LEF or portrait or SEF or landscape direction.

• Position the holes along the feed edge, as shown on the image on the front of the tray. 

• Load hole-punched paper with the side to be printed on facing up. 

• To prevent jams or damage, ensure that no plugs (pieces cut out of the paper to create the holes) remain in the 
stack.

Loading Hole-punched Paper in Trays 1, 2, and 3

Load and align the edge of the hole-punched paper with the holes against the left edge of the tray.
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Loading Hole-punched Paper in Trays 6 and 7

LLoonngg--eeddggee ((LLEEFF)) FFeeeedd DDiirreeccttiioonn

Load and align the paper against the right side of the tray for LEF direction.

SShhoorrtt--eeddggee ((SSEEFF)) FFeeeedd DDiirreeccttiioonn

Load and align the paper against the right side of the tray for SEF direction.

Loading Hole-punched Paper in Tray 5 (Bypass)

Load and align the edge of the hole-punched paper with the holes against the right edge of the tray.
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Tab Stock

Guidelines for Printing on Tab Stock

Always refer to the following guidelines before using tab stock:

• Tab Stock can be printed from all trays.

• Tabs are loaded in the tray only in the long-edge feed (LEF) direction.

• Tab stock is loaded so the straight edge of the stock is in the feed direction.

• You can load single straight collated or single reverse collated tab stock.

• Refer to the print server documentation for more detailed information on how to set up a tab job at your print 
server.

• If a jam occurs while running tabbed sets, cancel the job and start again.

Loading Tab Stock in Trays 1, 2, and 3

Load the tab stock LEF (portrait) and align the straight edge of the tab stock against the left edge of the tray and 
with the side to be printed on facing down. 

LLooaaddiinngg SSttrraaiigghhtt CCoollllaatteedd TTaabbss

Load straight collated tabs with the first blank tab cutout toward the rear of the tray.
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LLooaaddiinngg RReevveerrssee CCoollllaatteedd TTaabbss

Load reverse collated tabs with the first blank tab cutout toward the front of the tray.

Loading Tab Stock in Trays 6 and 7

Load the tab stock LEF, with the side to be printed on facing down; align the straight edge of the tab stock against 
the right edge of the tray and the tabs to the left. 

LLooaaddiinngg SSttrraaiigghhtt CCoollllaatteedd TTaabbss

Load straight collated tabs with the first blank tab cutout toward the front of the tray.
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LLooaaddiinngg RReevveerrssee CCoollllaatteedd TTaabbss

Load reverse collated tabs with the first blank tab cutout toward the rear of the tray.

Loading Tab Stock in Tray 5 (Bypass)

Load the tab stock LEF, with the side to be printed on facing up; align the straight edge of the tab stock against the 
right edge of the tray and the tabs to the left. 

LLooaaddiinngg SSttrraaiigghhtt CCoollllaatteedd TTaabbss

Load straight collated tabs with the first blank tab cutout toward the front of the tray.
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LLooaaddiinngg RReevveerrssee CCoollllaatteedd TTaabbss

Load reverse collated tabs with the first blank tab cutout toward the rear of the tray.

Labels

Guidelines for Printing on Labels

Always refer to the following guidelines before using labels:

• Labels can be printed from all trays.

• When you submit your print file, select Labels as the Paper Type, then select the tray containing the labels as 
the Paper Source.

• Use labels designed for laser printing.

• Follow these weight guidelines:  

– Trays 1, 2, and 3 can hold a maximum of 256 g/m2 

– Tray 5 (Bypass) can hold a maximum of 300 g/m2 

– Trays 6 and 7 can hold a maximum of 400 g/m2 

• Do not use vinyl labels or dry gum labels.

• Only print on one side of the sheet of labels.

• Do not use any sheet where labels are missing as it may damage the press. 

• Store unused labels flat in their original packaging. 

• Leave the label sheets inside the original packaging until ready to use. 
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• Return any unused sheets of labels to their original packaging and reseal. 

• Do not store labels in extremely dry, humid, hot, or cold conditions. 

• Rotate stock frequently. 

• Long periods of storage in extreme conditions can cause labels to curl and jam in the press. 

Loading Labels in All Trays

Refer to the following when loading labels in the paper trays.

• Load labels in Trays 1, 2 and 3 with the labels face down.

• Load labels in Trays 5 (Bypass), 6 and 7 with the labels face up. 

Glossy Paper

Guidelines for Printing on Glossy Paper

Glossy Paper is a type of coated paper that can be printed from all trays.

Always refer to the following guidelines before using glossy paper:

• Select Coated as the Paper Type, then select the tray containing the glossy paper as the Paper Source. 

• Select the correct Paper Weight and Size.

• Do not open sealed packages of glossy paper until you are ready to load them into the press.

• Store glossy paper flat in the original packaging.

• Remove all other paper from the tray before loading glossy paper.

• Load only the amount of glossy paper you plan to use. Remove the unused portion from the tray when you have 
finished printing.

• Replace the unused portion in the original wrapper and seal for later use.

• Rotate stock frequently.

• Long periods of storage in extreme conditions can cause glossy paper to curl and jam in the press 

Postcards

Guidelines for Printing on Postcards

Always refer to the following guidelines before using postcard stock:

Tip: When printing postcards in Trays 6 or 7, the Postcard Bracket is required. Always install the postcard bracket 
before loading and printing postcards from these trays.

• Postcards can be printed from Trays 5, 6, and 7.

• Do not open sealed packages of postcard stock until you are ready to load them into the press. 

• Store postcard stock flat in the original packaging. 

• Remove all other paper from the tray before loading postcard stock. 
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• Load only the amount of postcard stock you plan to use. Remove the unused portion from the tray when you 
are finished printing. 

• Replace the unused portion in the original wrapper and seal for later use. 

• If using Trays 6 or 7, always remove and store the Postcard Bracket when you are finished printing.

• Rotate the postcard stock frequently. 

• Long periods of storage in extreme conditions can cause postcard stock to jam in the press. 

Supported Postcard Sizes

POSTCARD SIZE FEED DIRECTION 

101.6 x 152.4 mm (4 x 6 in.) Short Edge Feed (SEF) 

A6, 148 x 105 mm (5.8 x 4.1 in.) Short Edge Feed (SEF) 

Loading Postcards in Trays 6 and 7

Note: Install the postcard bracket before printing postcards.

1. Slowly open one of the paper trays until it stops and remove the paper. 

2. Move the paper guides out to their largest position. 
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3. To remove the postcard bracket, loosen the screw on the left side of the tray (1) and remove the bracket (2). 

4. Install the postcard bracket:  

a. Sit the bracket on the locating pins on the upper frame and in the grooves on the bottom of the tray.

b. Tighten the thumb screw so it locks the postcard bracket in place.

5. Load the postcard stock SEF and against the right side of the tray.  
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6. Adjust the paper guides against the stock. 

7. Close the paper tray and confirm the new settings at the print server.

8. Run your print job.

9. Upon completion of your print job, remove the postcard stock and the postcard bracket from the tray.

10. Store the postcard bracket by inserting it into the storage area on the left side of the tray (1) and tightening 
the screw (2). 

Loading Postcards in Tray 5 (Bypass)

Load postcards SEF, with the side to be printed on facing up. 

Envelopes

Guidelines for Printing on Envelopes

For envelope guidelines and limitation information, refer to the Customer Expectation and Installation Guide.

Supported Envelope Sizes

For supported envelope sizes, refer to the Customer Expectation and Installation Guide.
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Loading Envelopes in Trays 6 and 7 with the Postcard Bracket

Note: Install the postcard bracket before printing envelopes.

1. Slowly open one of the paper trays until it stops and remove the paper. 

2. Move the paper guides out to their largest position. 

3. To remove the postcard bracket, loosen the screw on the left side of the tray (1) and remove the bracket (2). 

4. Install the postcard bracket:  

a. Sit the bracket on the locating pins on the upper frame and in the grooves on the bottom of the tray.

b. Tighten the thumb screw so it locks the postcard bracket in place.
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5. Load the envelope in the short-edge-feed (SEF) or long-edge-feed (LEF) direction:  

• When loading envelopes SEF, ensure the flaps are closed and face down and position the flaps along the 
front of the tray. 

• When loading envelopes LEF, ensure the flaps are closed and face down and position the flaps along the 
right of the tray. 

6. Adjust the paper guides against the stock. 

7. Close the paper tray and confirm the new settings at the print server.

8. Run your print job.

9. Upon completion of your print job, remove the remaining envelopes and the postcard bracket from the tray.

10. Store the postcard bracket by inserting it into the storage area on the left side of the tray (1) and tightening 
the screw (2). 
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11. Store the remaining envelopes in their original packaging.

Loading Envelopes in Trays 6 and 7 with the Optional Envelope Support Kit

Note: If available, use the optional Envelope Support Kit to feed and print envelopes from Trays 6 or 7. 

The Envelope Support Kit enables a greater quantity of envelopes to be loaded and printed from the tray.

1. Slowly open one of the paper trays until it stops and remove the paper. 

2. Move the paper guides out to their largest position. 

3. Locate the Envelope Support Kit.

4. Install the L-shape envelope bracket:  

a. Sit the bracket on the locating pins on the upper frame and in the grooves on the bottom of the tray.

b. Tighten the thumb screw so it locks the L-shape envelope bracket in place.
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5. Locate the larger of the plastic pieces and place it in the bottom of the tray so that it fits around the ends of 
the inboard paper guide.  

6. Locate the shorter plastic piece and install it in the tray:  

a. Place the shorter plastic piece in the bottom of the tray so that it fits along the right side of the tray and 
into the corner, to the right of the envelope bracket that you installed. 

b. Place the magnet at the end of the piece into the corner of the tray and facing down.  
The raised portion of the piece at the other end should be facing up and on top of the cork pad on the tray 
bottom.
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7. Load the envelopes SEF on top of the plastic inserts, with the flaps closed and facing down.  

Note: The flaps should always be down and positioned along the front of the tray.

8. Adjust the paper guides against the stock. 

9. Close the paper tray and confirm the new settings at the print server.

10. Run your print job.

11. Upon completion of your print job, remove the envelope stock and the envelope supply kit components from 
the tray.

12. Place the envelope supply kit components into storage.

13. Store the remaining envelopes in their original packaging.

Loading Envelopes in Tray 5 (Bypass)

Load envelopes in Tray 5 in the short edge feed (SEF) or long edge feed (LEF) direction.

LLooaaddiinngg EEnnvveellooppeess iinn TTrraayy 55 iinn tthhee SSEEFF DDiirreeccttiioonn

When you load envelopes in the SEF direction, ensure that the flaps are closed and face down and position the 
flaps along the front of the tray.
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LLooaaddiinngg EEnnvveellooppeess iinn TTrraayy 55 iinn tthhee LLEEFF DDiirreeccttiioonn

When you load the envelopes in the LEF direction, ensure that the flaps are closed and face down, and position the 
flaps along the right of the tray.

LOADING MEDIA IN OPTIONAL DEVICES

Loading Media in the Optional Dual Advanced High Capacity Feeder (Trays 8 and 9)

For information, refer to Dual Advanced Oversized High Capacity Feeder (Trays 8 and 9).

Loading Post-Process Media in the Optional Inserter

For information, refer to Inserter Device.

Loading Post-Process Media in Optional GBC® AdvancedPunch™ Pro

For loading tabs into the GBC® AdvancedPunch™ Pro, refer to the User Documentation, or go to www.xerox.com/ 
gbc-advancedpunch-pro.
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PredictPrint Media Manager

Important: Access the PredictPrint Media Manager application on the Fiery EX or EX-P Print Server. It cannot 
be accessed from the press.

Note: Information shown on the PredictPrint Media Manager main window varies depending on system 
configuration.

Use the PredictPrint Media Manager application to do the following:

• Use the Stock Wizard feature to get automated media management for the press.

• Log in as Administrator.

• Choose specific System and Stock Wizard setting options associated with stocks and feeder trays. The System 
and Stock Wizard setting features are available when you are logged in as Administrator.

• Change the language that is displayed in the PredictPrint Media Manager application.

• Manage profiles that are associated with stocks, including creating, editing, and deleting profiles. Profiles include 
alignment, folder adjustment (optional), and third-party finishing devices (optional).

• Manage stocks that the press uses, including assigning specific stocks to feeder trays, and adding, copying, 
editing, creating, and deleting stocks from the Stock Library.

• View Tray Properties, assign a specific stock to a tray, and set various parameters for that assigned stock.

Note: The administrator specifies whether the Stock Library feature appears on the main window of the 
PreditPrint Media Manager application. The administrator sets this feature in Administration > System. If 
the Stock Library feature is not displayed on the PredictPrint Media Manager main screen, the administrator 
has restricted access to the feature to administrators only. In this case, contact your administrator for more 
information.

DESKTOP SHORTCUTS

Two desktop shortcut icons are provided on the print server for easy and quick access to the PredictPrint Media 
Manager application and to the customized Stock Library list. During the installation of the PredictPrint Media 
Manager application, two icons are created on the desktop of Fiery print server. These icons are shortcuts to the 
following items:

• PredictPrint Media Manager application: This shortcut icon allows the user to open quickly and easily start the 
application.

• PredictPrint Media Manager Profiles folder: This shortcut icon displays as a folder on the print server desktop. 
The shortcut allows the user to access the customized Stock Library files.

To use the desktop shortcuts, perform the following steps:

1. Access the desktop of the print server.

2. Locate the two icons:. 

• PredictPrint Media Manager

• PredictPrint Media Manager Profiles
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3. To open and access either the PredictPrint Media Manager application or the PredictPrint Media Manager 
Profiles folder, double click the appropriate icon. 

Depending on which icon is selected, either the PredictPrint Media Manager application opens or the folder 
that contains the Stock Library files opens.

PREDICTPRINT CLOUD SERVER

PredictPrint Cloud Server Overview

The PredictPrint Cloud Server stores the stock attributes including recommended setup routines. The PredictPrint 
Media Manager application connects to the PredictPrint Cloud server when a barcode is scanned, and retrieves all 
of the stock properties and recommended set points and setup routines.

Downloading a Stock List from PredictPrint Cloud Server

If your press is connected to the Internet, the stock information is updated on your system automatically, each time 
you scan the barcode. If the press is not connected to the Internet, you can download the stock lists from the 
PredictPrint Cloud Server.

1. Open a Web browser, then go to https://www.xerox.com/predictprintmedia.

2. Click Download Stock List. 

A webpage appears with download options for different types of stock lists.

3. Select an option: 

• To download the entire stock and media list (SML), click Download Full Stock & Media List.

• To download the Recommended Media List (RML), click Download Recommended Media List.

• To download the Tested Substrate List (TSL), click Download Tested Media List.

The Download Media List page appears, where you can select the printer family.

4. Select Xerox VERSANT 4100 Press, then click OK.

5. In the Save As window, select a location for the stock list file, then click Save. 

The stock list file downloads to your computer.

6. Extract the .xml file from the .zip file.

7. Insert a USB storage device into a USB port on the computer, then copy the .xml file to the USB storage device.

8. Insert the USB storage device into a USB port on the Fiery Print Server.

9. From the USB storage device, upload the file with the stock list information for the PredictPrint Media Manager 
application. 

After uploading the media list, the stock information appears automatically in the stock list when the barcode 
is scanned.
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BACKING UP AND TRANSFERRING THE STOCK LIBRARY

Stocks that are created, copied, and stored in the Stock Library list can be backed up and transferred to another 
PredictPrint Media Manager application. This is accomplished by using an external USB flash drive.

The backup or transfer of Stock Library information is important only for systems that are not connected to the 
Internet. When connected to the Internet, there is no need for a local backup. When a stock barcode is scanned, the 
PredictPrint Cloud Server downloads all stock data to the PredictPrint Media Manager application, including 
recommended setup routines.

Important: The PredictPrint Media Manager application resides on the print server that is connected to the 
press. The application can be accessed only from the print server and cannot be accessed from the press.

1. Insert the USB flash drive into a USB port on the print server.

2. From the print server desktop, open the PredictPrint Media Manager Profiles folder, which is the shortcut 
icon on the desktop.

3. Browse to the stock directory. 

The .stock extension distinguishes the stocks that were created, copied, and stored in the library.

4. Select all the files in the stock directory with the .stock extension.

5. Select either Edit > Copy or Ctrl > C.

6. Open the directory of the USB flash drive.

7. Select either Edit > Paste or Ctrl > V. 

The files are copied to the USB flash drive.

8. Close both directories.

9. Remove the USB flash drive from the print server. 

The .stock files can remain on the USB flash drive as a backup copy. 

10. Choose one of the following: 

• Store the USB flash drive in a safe, secure location.

• Copy the files onto a different PredictPrint Media Manager application of the print server, then go to the 
next step.

11. Copy the files onto a different PredictPrint Media Manager application of the print server. Perform the following 
steps: 

a. Insert the USB flash drive into a USB port on the second print server.

b. Open the directory of the USB flash drive, and browse to the folder that contains the backed-up files.

c. Select all the files with the .stock extension.

d. Select either Edit > Copy or Ctrl > C.

e. From the second print server desktop, open the PredictPrint Media Manager Profiles folder.

f. Select either Edit > Paste or Ctrl > V. 

The files are copied to the PredictPrint Media Manager Profiles folder.

g. Close both directories.
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h. Remove the USB flash drive from the print server.

12. Store the USB flash drive in a safe, secure location.

Downloading Current Media Information

For current stock and paper guidelines, go to https://www.xerox.com/predictprintmedia and download the 
appropriate list for your press.

STOCK WIZARD

When you open a paper tray or scan a barcode, the PredictPrint Stock Wizard opens. The Stock Wizard instantly 
loads stock properties to a tray and provides a simple, step-by-step guidance through setup routines for printing 
optimization. The setup routines are automatic, semi-automatic, or manual, and are provided by the PredictPrint 
Media Manager application.

Stock Wizard Overview

The Stock Wizard is a feature that automates media management for the digital presses. You can scan the media 
barcode using the barcode scanner, then load the paper in the tray, or you can load the paper, then scan the 
barcode. When you scan the barcode, the PredictPrint Media Manager application connects to the PredictPrint 
Cloud server and retrieves all the stock properties and recommended setup routines for the stock.

The Stock Wizard performs all the advanced settings recommended to optimize print performance for each stock. 
When a stock is loaded for the first time, to maximize image quality and color output, the Stock Wizard runs a fully 
automated calibration and profiling process.

The Stock Wizard uses the following processes:

SSccaann

On the Scan screen, you scan the barcode of a specific media with a barcode scanner. When you scan the 
barcode, the Stock Wizard connects to the PredictPrint Cloud Server and downloads all the stock attributes, set 
points, and recommended setup routines for the stock.  

DDeeffiinnee

If you have an unknown barcode or are creating a custom barcode, the Define screen opens. When you create a 
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custom barcode or scan a barcode that is not known by the cloud server, you need to define the media 
attributes manually. 

Note: The stock only needs to be defined once. After you set up the stock for the first time, the data is stored 
in the PredictPrint Cloud Server. You can scan the associated barcode to obtain the stock information 
automatically.

LLooaadd

On the Load screen, you can specify the trays where you have loaded the stock. The paper tray options are Trays 
1–3, 6–9, Tray 5 (Bypass), or Inserter Tray T1. You can load the media before or after you scan a barcode or 
define the stock properties. For multiple tray loading, you can load all trays or scan the barcodes in any order. 
You can load all trays or scan the barcodes in any order, as follows: 

• If you scan the barcodes first: Scan all barcodes. To load the media in the correct trays, follow the Stock 
Wizard.

• If you load the trays first: Load all stocks in the appropriate trays. To verify the barcodes for the loaded 
stocks, follow the Stock Wizard screens.

SSeettuupp

On the Setup screen, you can verify that the stock properties are correct. You can select the orientation of the 
paper that feeds into the press: Long Edge Feed or Short Edge Feed. On the Setup screen, the Stock Wizard 
performs automatic setup routines that are recommended for the stock. The automatic setup routines include:  

• Tray Programming

• Alignment Setup

• Secondary Transfer Voltage Adjustment

• Calibration and Profiling

AAddvvaanncceedd

On the Advanced screen, the Stock Wizard performs semi-automatic setup routines that are recommended for 
the stock. The advanced setup routines include: 

• Advanced Alignment for Multiple Profiles

• Trail Edge Transfer Output Adjustment

• Aligner Roll Pressure Adjustment

• Paper Speed Transfer Adjustment

• Fuser Temperature Adjustment

• Regi-Loop Adjustment

• Pre Gate Roll Control

• Tray Air Assist Adjustment

• Tray Heater Adjustment

Note: If there are no semi-automatic setup routines to perform, the Calibration and Profiling process is done 
on the Setup screen.

DDoonnee

When the semi-automatic and automatic advanced setup routines are complete, the Done screen shows a list 

Xerox® Versant® 4100 Press User Documentation 89

Working With



of the manual setup routines that are recommended after you exit the Stock Wizard. You can complete the 
manual setup routines in the Stock Library. Manual setup routines include: 

• Fusing Speed Adjustment

• Multifeed Detection

For more information, refer to Advanced Stock Setup Options.

An example of a Stock Wizard workflow using these processes, when the press is connected to the Internet, is:

Scan/Define > Load > Setup > Advanced > Done.

Scanning a Media Barcode

A barcode scanner is provided with your press.

1. When you power on the Fiery Print Server, the PredictPrint Media Manager application starts automatically. If 
the PredictPrint Media Manager application is not already open, to open the application, on your Fiery Print 
Server screen, click PredictPrint Media Manager.

2. To launch the Stock Wizard, you can scan the media barcode using the barcode scanner, or on the PredictPrint 
Media Manager screen, click Stock Wizard. 

When you log in for the first time, a Welcome screen appears.

3. You can also load the media first, then scan the barcode. 

If the barcode is registered already in the PredictPrint Cloud server, after you scan the barcode, the Stock 
Wizard displays the stock properties and the press automatically receives the settings for the best printing 
values for the job.

4. If you did not load the media before you scanned the barcode, to load the media into one or more paper trays, 
click Next.

Defining or Creating a Custom Barcode in the Stock Wizard

When you power on the Fiery Print Server, the PredictPrint Media Manager application starts automatically. If the 
PredictPrint Media Manager application is not already open, to open the application, click PredictPrint Media 
Manager on your Fiery Print Server screen.

When the stock does not have a barcode, you specify the stock attributes and create a custom barcode using the 
Define screen:
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1. On the PredictPrint Media Manager screen, click Stock Wizard. 

When you log in for the first time, a Welcome screen appears.

2. On the Stock Wizard screen, click Define New Stock and Create Barcode. 

The Define screen appears.

3. On the Define screen, describe the following items for your stock: 

• Name

• Manufacturer

• Size

• Type

• Modulus (if needed)

• Preprinted Stock (required for the stocks printing from T1)

• Color

• Coating

• Grain

• Weight

• Hole Punched

For more information, refer to Stock Attributes.

4. To save the changes and go to the next step, click Next. 

Note: If you want to print the custom barcode, load Letter or A4 size paper in any tray other than the one 
you are currently programming with the stock. If no Letter or A4 size paper is loaded in the press, you 
cannot print the barcode during the setup process in the wizard. You can also print your custom barcodes 
from the PredictPrint Stock Library at any time.

Loading Media with the Stock Wizard

To load your media in the paper tray, perform the following:

1. Open a paper tray. Based on your media, select from Trays 1–3, 6–9, Tray 5 (Bypass), or Inserter Tray T1.

2. Load the media, then close the paper tray.

3. On the Stock Wizard Load screen, select from the following options: 

• Trays 1–3 or 6–9

• Tray 5 (MSI)

• Tray T1

Note: The available tray options are dependent on the configuration of your system. The options appear in 
accordance with the feeders and finishing devices that are attached to your press.

4. To complete the setup, on the Stock Wizard screen, click Next. 

The Setup screen appears. Follow the steps in the Stock Wizard to complete the setup.
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5. At any time during the process, to change the information on the previous screen, click Go Back.

Setting Up Media in the Stock Wizard

You can set up the media or stock in the Stock Wizard with or without a barcode. Refer to:

• Setting Up Media with a Barcode in the Stock Wizard

• Setting Up Media without a Barcode in the Stock Wizard

• Setting Up Media with a Custom Barcode in Offline Mode

Setting Up Media with a Barcode in the Stock Wizard

1. On the Stock Wizard Setup screen, select the paper orientation: 

• Long Edge Feed

• Short Edge Feed

2. Click Next.

3. The Stock Wizard performs the recommended automatic setup routines. After each setup, click Accept and 
Next. The automatic setup routines include: 

• Tray Programming

• Basic Alignment Setup

• Secondary Transfer Voltage Adjustment

• Calibration and Profiling: This automatic setup is performed after the semi-automatic adjustments, and 
before any manual adjustments. For more information, refer to Calibration and Profiling.

Note: It is important to remember that these setup routines and all of the other print engine adjustments 
are performed only if needed. If the PredictPrint Cloud Server Intelligence determines that they are not 
needed, the PredictPrint Stock Wizard skips them.

4. At any time during the process, to change the information on the previous screen, click Go Back.

5. At any time during the process, to cancel the stock setup routines, click Cancel Setup. 

Note: The Cancel Setup option stops any additional setup routines from running in the wizard, at that time. 
Cancelling setup routines does not cancel the assignment of the stock to the tray.

6. To go to the next setup routine, click Accept and Next.

Setting Up Media without a Barcode in the Stock Wizard

To get a barcode for the media, ensure that the tray is loaded with the stock for which you need a barcode.

1. On the Stock Wizard Setup screen, select the paper orientation: 

• Long Edge Feed

• Short Edge Feed

2. Click Next. 

A barcode appears on the next screen.
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3. To print the barcode, click Print Barcode. 

Note: If you want to print the custom barcode, load Letter or A4 size paper in any tray other than the one 
you are currently programming with the stock. If no Letter or A4 size paper is loaded in the press, you 
cannot print the barcode during the setup process in the wizard. You can also print your custom barcodes 
from the PredictPrint Stock Library at any time.

4. To scan the barcode as needed in the future, keep the printed barcode for reference.

5. Click Accept and Next. 

The Stock Wizard starts a series of automatic setup routines.

6. The Stock Wizard performs the recommended automatic setup routines. After each setup routine, click Accept 
and Next. The automatic setup routines include the following: 

• Tray Programming

• Basic Alignment Setup

• Secondary Transfer Voltage Adjustment

• Calibration and Profiling: This automatic setup is performed after the semi-automatic adjustments, and 
before any manual adjustments.

Note: It is important to remember that these setup routines and all of the other print engine adjustments 
are performed only if needed. If the PredictPrint Cloud Server Intelligence determines that they are not 
needed, the PredictPrint Stock Wizard skips them.

7. At any time during the process, to change the information on the previous screen, click Go Back.

8. At any time during the process, to cancel the stock setup routines, click Cancel Setup. 

Note: The Cancel Setup option stops any additional setup routines from running in the wizard, at that time. 
Cancelling setup routines does not cancel the assignment of the stock to the tray.

9. To go to the next setup routine, click Accept and Next.

Setting Up Media with a Custom Barcode in Offline Mode

When the stock does not have a barcode and the press is not connected to the Internet, the Stock Wizard cannot 
communicate with the PredictPrint Cloud Server to generate a barcode. Before you generate a custom barcode, 
ensure that you have a portable USB storage device.

Note: If the press is not connected to the Internet, you can download the Stock Lists from the PredictPrint 
Cloud Server. To download the Stock Lists from the PredictPrint Cloud Server, refer to Downloading a Stock 
List from PredictPrint Cloud Server.

1. On the Stock Wizard Setup screen, select a Paper Edge Feed option: 

• Long Edge Feed

• Short Edge Feed

2. Click Next.

3. To get a barcode and complete the stock setup, insert a USB storage device into the Fiery Print Server. Click 
Copy Stock File.

4. Save the stock file on the USB storage device.
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5. From a browser on an Internet-connected device, go to https://www.xerox.com/predictprintmedia. The 
PredictPrint Media Manager opens. Click Get New Barcode.

6. Upload the stock file from the USB storage device to the PredictPrint Cloud Server. The PredictPrint Cloud Server 
generates a new barcode with stock setup routines. Save the setup and barcode information to the USB 
storage device.

7. Ensure that the tray is loaded with the stock for which you need a barcode.

8. Insert the USB storage device into a USB port on the Fiery Print Server. On the Stock Wizard Setup screen, click 
Load Barcode File.

9. From the USB storage device, copy the file with stock setups and the barcode information to the PredictPrint 
Media Manager application. Click Next. 

A barcode appears on the next screen.

10. To print the barcode, click Print Barcode.

11. To scan the barcode as needed in the future, keep the printed barcode for reference.

12. Click Accept and Next. 

The Stock Wizard starts the series of automatic setup routines.

Advanced Stock Setup in the Stock Wizard

On the Advanced screen, the PredictPrint Stock Wizard guides you through a series of advanced settings that 
include semi-automatic and automatic setup routines. 

For any semi-automatic setup routine, you can print a sample, inspect the sample, and make adjustments, if 
needed. The semi-automatic setup routines include:

• Advanced Alignment for Multiple Profiles

• Trail Edge Transfer Output Adjustment

• Aligner Roll Pressure Adjustment

• Paper Speed Transfer Adjustment

• Fuser Temperature Adjustment

• Regi-Loop Adjustment

• Pre Gate Roll Control

• Tray Air Assist Adjustment

• Tray Heater Adjustment

The automatic setup includes Calibration and Profiling. If there are no semi-automatic setup routines to run, the 
Calibration and Profiling process is done on the Setup screen. If there are semi-automatic setup routines 
recommended for the stock, the Calibration and Profiling process is done on the Advanced screen. For more 
information, refer to Calibration and Profiling.

1. To view the instructions about adjusting a specific semi-automatic setup routine, click Get Instructions. For 
more information, refer to Advanced Stock Setup Options.

2. To verify the printed output, click Print Sample. Make adjustments to the setup routine, as needed.
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3. After each semi-automatic setup routine, to perform the next setup routine, click Accept and Next. 

Note: It is important to remember that these setup routines and all of the other print engine adjustments 
are performed only if needed. If the PredictPrint Cloud Server Intelligence determines that they are not 
needed, the PredictPrint Stock Wizard skips them.

4. At any time during the process, to cancel the stock setup routines, click Cancel Setup.

5. To go to the previous setup, click Go Back.

Calibration and Profiling

Color Calibration and Profiling is a fully automated process within the PredictPrint Stock Wizard. The Stock Wizard 
hands off the stock information to the Fiery Print Server to initiate the process. Calibration and Profiling is 
performed after all other adjustments are completed. 

The need for Calibration and Profiling is first determined by the PredictPrint Cloud Server based on the stock 
properties, then performed and managed by the Fiery Print Server. The Calibration and Profiling process uses the 
Full Width Array. Each individual stock is first calibrated and then profiled. Profiling each stock is performed once. 
Recalibration is performed after the set time limit has expired for the stock-barcode, and it is scanned again to load 
the stock into a tray. The calibration process takes about 60 sheets for the first time the stock is added, then about 
18 sheets for each recalibration.

With the Fiery® Print Server version 2.0, FS600, the Calibration and Profiling process is streamlined and enhanced 
further, as follows:

1. By using the Group Adjustments By feature, the print server can group stocks with common Coating or Media 
Name when the stock passes a new Color Check routine. The first passing stock only requires 7 sheets to be 
calibrated, followed by 3 sheets for the Color Check routine. Any additional stock added for calibration requires 
only 3 sheets, if successful.

2. If you decide to maintain Individual Stock as the method for Calibration and Profiling, then the process 
requires about 30 sheets the first time the stock is added, then 7 sheets for each recalibration.

3. A Color Check routine is performed prior to recalibration, when needed. If the stock passes the routine, no 
further sheet printing is required, and the calibration expiration time limit is extended.

Note: The Calibration and Profiling process is enhanced on Fiery® Print Server version 2.0, FS600 or newer 
software version. To find your print server version or Fiery System version, on the Fiery Command 
WorkStation window, go to Server > Device Center > GENERAL > General Info, then refer to Fiery Server 
or Fiery System. This information is accessible also on the Fiery configuration page, printed through Fiery® 

Print Server.

The default time limit for recalibration is 7 days. From the print server, you can change the default 7-day time 
setting for calibration. On the Fiery Print Server Device Center, click General > Tools > Calibrator, then click the 
small gear icon at the bottom of the page.

Calibration and Profiling proceeds as follows:
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1. On the Advanced screen, after the semi-automatic setup routines are complete, the Stock Wizard starts the 
Calibration and Profiling process automatically. 

Note: If there are no semi-automatic setup routines to perform, the Calibration and Profiling process is 
done on the Setup screen.

2. The PredictPrint Stock Wizard coordinates with the Fiery Print Server. The Color Profiling and Calibration Check is 
done automatically, and the progress appears on the Fiery Color Xpress window.

3. To cancel the Calibration and Profiling process, on the Fiery Color Xpress window, click Cancel.

4. When the Calibration and Profiling process is complete, a Success message appears and the Fiery Color 
Xpress window closes automatically.

5. After the Calibration and Profiling process completes, the Done and Close screen appears.

If needed, you can perform other Calibration and Profiling procedures outside of the PredictPrint Stock Wizard using 
the Fiery Calibrator on the Fiery Print Server. For more information, refer to the Fiery Print Server documentation at 
Fiery - Xerox Versant 4100 Press.

Exiting the Stock Wizard

After the advanced semi-automatic and automatic setup routines are complete, the Stock Wizard displays the list 
of manual setup routines that are required. To make manual adjustments, exit the Stock Wizard, then go to 
Advanced Setup for the stock in the Stock Library.

Manual setup routines are performed last. Manual setup routines include:

• Fusing Speed Adjustment

• Multifeed Detection

1. After the Calibration and Profiling process is complete, on the Stock Wizard Advanced screen, click Accept and 
Next. 

The Done screen appears.

2. The Done screen displays the list of manual setup routines that are required. To perform the manual setup 
routines, exit the Stock Wizard. Click Done and Close.

To perform the manual setup routines, refer to Manual Stock Setup.

Manual Stock Setup

To view the list and perform the required manual setup routines, in the PredictPrint Media Manager application, do 
the following:

1. Click Trays. 

The Trays screen appears. A yellow triangle icon appears on the tray that is loaded with the stock you are 
setting up.

2. Hover the cursor over the yellow triangle icon. 

The list of required manual setup routines appears.
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3. To perform the manual setup routines, go to the Stock Library. In the Stock Library list, select the stock that 
requires the manual setup routines. To access the stock properties, on the Stock Library menu bar, click the 
pencil icon for Edit. To access the manual adjustments, click Advanced Setup. 

Note: For details on how to perform the manual step routines, refer to Advanced Stock Setup Options.

ADMINISTRATION

The PredictPrint Media Manager Administrator mode allows you to set the default settings for your Production Press 
to fit your individual requirements. You can change the settings for various features, such as the Language, Date 
and Time, the Administrator password, creating custom paper and alignment profiles, and more.

The Administrator mode includes:

• Stock Wizard tab or Settings tab

• System tab

On Fiery® Print Server version 2.0, FS600, the Stock Wizard tab is changed to Settings tab. To find your print server 
version or Fiery System version, on the Fiery Command WorkStation window, go to Server > Device Center > 
GENERAL > General Info, then refer to Fiery Server or Fiery System. This information is accessible also on the 
Fiery configuration page, printed through Fiery® Print Server.

Logging In as Administrator

1. On the PredictPrint Media Manager screen, click Login.

2. From the Login screen, select Administrator.

3. Type the Administrator password. The default administrator password is five ones, 11111.

4. Click OK. 

Important: To prevent unauthorized access to the Administrator mode, after installing the Production 
Press, change the Administrator password as soon as possible. For more information, refer to Changing 
the Administrator Password.

5. To exit the Administrator mode, click User: Administrator, then click Log Out.

Stock Wizard or Settings Tab

Important: On Fiery® Print Server version 2.0, FS600, the Stock Wizard tab is changed to Settings tab. To 
find your print server version or Fiery System version, on the Fiery Command WorkStation window, go to 
Server > Device Center > GENERAL > General Info, then refer to Fiery Server or Fiery System. This 
information is accessible also on the Fiery configuration page, printed through Fiery® Print Server.

As an Administrator, the Stock Wizard or Settings tab allows you to make changes to the following features:

• Stock Wizard

• Guided Stock Setup 

– Paper Calibration and Profiling 

– Group Adjustments By (available only on Fiery® Print Server version 2.0, FS600 or newer version) 
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– Alignment Profile Setup 

– Secondary Transfer Voltage Setup 

– Other Routines 

• Custom Stock Name

• Private Stock Sharing

• Stock Wizard Timeout

• PredictPrint Database

• Load Database from Device

• Automatic Image Quality System Check (available only on Fiery® Print Server version 2.0, FS600 or newer 
version) 

– Auto Alignment + 2nd Bias Transfer Roll 

– Auto Color Check 

Accessing the Stock Wizard or Settings Tab

1. From the main window of the PredictPrint Media Manager application, log in as administrator. Refer to Logging 
In as Administrator.

2. Click Administration.

3. From the Administration screen, select the Stock Wizard or Settings tab. 

Important: On Fiery® Print Server version 2.0, FS600, the Stock Wizard tab is changed to Settings tab. 
To find your print server version or Fiery System version, on the Fiery Command WorkStation window, go 
to Server > Device Center > GENERAL > General Info, then refer to Fiery Server or Fiery System. 
This information is accessible also on the Fiery configuration page, printed through Fiery® Print Server.
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4. To make changes to the following features, click the On/Off toggle buttons for each feature. The toggle button 
changes color, and a label indicates whether the feature is On or Off. 

• Stock Wizard: When this feature is disabled, the Stock Wizard does not appear on the main window of the 
PredictPrint Media Manager application. For more information, refer to Managing Access to the Stock 
Wizard from Administration.

• Guided Stock Setup: By default, when you scan and load a stock, the PredictPrint Cloud Server guides you 
through recommended setup routines for the stock. You can choose to disable guided stock setup 
completely, or you can choose to disable the following elements of guided stock setup: 

• Paper Calibration and Profiling: To enable or disable the Calibration and Profiling setup routines, for 
Paper Calibration and Profiling, select the On/Off toggle button. 

Group Adjustments By: This feature under Paper Calibration and Profiling is available only for the 
Fiery® Print Server version 2.0, FS600. Stocks with certain parameters are grouped together to use a 
single profile. Stock grouping saves the paper used in Calibration and Profiling routines. Following 
options are available for stock grouping:

– Media Name: Select this option to share profile for the stocks with same media name. Media 
name of the stock is pre-defined, user cannot change it. 

– Coating: Select this option to share the profile for stocks with same coating type. This is the default 
option. 

– Individual Stocks: Select this option to create dedicated profile for each stock. 

• Alignment Profile Setup: Basic Alignment Setup and Advanced Alignment Setup are automatic setup 
routines, but their parameters are set in Administration. An Administrator can select the following 
options: 

– Off: To disable automatic alignment profile setup, select Off. 

– Basic (set up once): To enable the basic Alignment Profile setup routine, select Basic (set up 
once). Basic Alignment runs only when the stock is set up for the first time. This setting is managed 
on the PredictPrint Cloud Server. 

– Advanced (multiple profile): To enable the advanced Alignment Profile setup routine, select 
Advanced (multiple profile). Advanced Alignment runs every time you scan the barcode for the 
stock. You can select the Print Density and Alignment Profile. 

• Secondary Transfer Voltage Setup: To enable or disable the automatic setup for secondary transfer 
voltage, for Secondary Transfer Voltage Setup, select the On/Off toggle button
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• Other Routines: To enable or disable the automatic setup for other routines, for Other Routines, select 
the On/Off toggle button.

• Custom Stock Name: To restrict the operator from adding a custom name for a scanned stock, for Custom 
Stock Name, select the On/Off toggle button.

• Private Stock Sharing: You can create a unique, minimum 4-digit code that all locations in your company 
can use to share custom stocks and their barcodes. To enable or disable private stock sharing, for Private 
Stock Sharing, select the On/Off toggle button. If you enabled private stock sharing, type a sharing code 
that has at least four digits.

• Stock Wizard Timeout: To modify or change Stock Wizard Timeout, refer to Stock Wizard Timeout.

• PredictPrint Database: To load PredictPrint Database from other devices, refer to Load PredictPrint 
Database from Device.

• Automatic Image Quality System Check: This feature is available only with Fiery® Print Server version 
2.0, FS600. You can set the following Image Quality checks through PredictPrint Media Manager: 

• Auto Alignment + 2nd Bias Transfer Roll: To enable or disable Image Quality check for Auto 
Alignment + 2nd Bias Transfer Roll, select the On/Off toggle button.

• Auto Color Check: In Auto Color Check, the print server evaluates if the prior calibration and profiling 
associated with the PredictPrint stock remains within tolerance level. If the Calibration is out of 
tolerance level, the stock or group will be recalibrated when the stock or any stock linked to the same 
group is reloaded the next time. To enable or disable Auto Color Check, select the On/Off toggle button.

Important: When the above image quality checks are enabled in the Administration tab, you can 
access this feature from the Trays tab on the main Menu. To perform Run Image Quality System 
Check, right-click on a tray loaded with a stock registered with PredictPrint Stock Wizard. For more 
information, refer to Tray Properties.

Note: The Image Quality System Check can be scheduled through the Zero Touch Recalibration workflow of 
Fiery. For more information, refer to Fiery® Print Server User Guide.

5. To exit the Stock Wizard or Settings tab and return to the PredictPrint Media Manager main window, select 
either Apply or Cancel.

6. To exit the administrator mode, click User: Administrator, then click Log Out.

Managing Access to the Stock Wizard from Administration

The administrator can manage whether the Stock Wizard icon appears on the PredictPrint Media Manager main 
screen. By default, the Stock Wizard icon always appears on the main screen. The administrator can choose to 
restrict access to the Stock Wizard. When access is restricted, the Stock Wizard does not appear on the PredictPrint 
Media Manager main screen.

1. From the PredictPrint Media Manager screen, click Login, then log in as the Administrator.

2. Click Administration.

3. From the Administration screen, select the Stock Wizard or Settings tab. 

Important: On Fiery® Print Server version 2.0, FS600, the Stock Wizard tab is changed to Settings tab. 
To find your print server version or Fiery System version, on the Fiery Command WorkStation window, go 
to Server > Device Center > GENERAL > General Info, then refer to Fiery Server or Fiery System. 
This information is accessible also on the Fiery configuration page, printed through Fiery® Print Server.
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4. To show or hide the Stock Wizard icon on the PredictPrint Media Manager main screen, for the Stock Wizard 
option, click the On/Off toggle button. 

The toggle button changes color, and a label indicates whether the Stock Wizard is On or Off.

5. Click Apply.

6. To exit the Administrator mode, click User: Administrator, then click Log Out.

Stock Wizard Timeout

After you open the PredictPrint Stock Wizard or open a tray, if you do not scan a stock, after a set time period, the 
Stock Wizard closes. The default time period is 1 minute. The Administrator can change the amount of time that 
the Stock Wizard appears on the screen before it closes.

1. From the PredictPrint Media Manager screen, click Login, then log in as the Administrator.

2. Click Administration.

3. From the Administration screen, select the Stock Wizard or Settings tab. 

Important: On Fiery® Print Server version 2.0, FS600, the Stock Wizard tab is changed to Settings tab. 
To find your print server version or Fiery System version, on the Fiery Command WorkStation window, go 
to Server > Device Center > GENERAL > General Info, then refer to Fiery Server or Fiery System. 
This information is accessible also on the Fiery configuration page, printed through Fiery® Print Server.

4. For Stock Wizard Timeout, select a timeout option: 

• 10 seconds

• 20 seconds

• 30 seconds

• 1 minute

• 2 minutes

• 5 minutes

5. To save your changes, click Apply.

6. To exit the Administrator mode, click User: Administrator, then click Log Out.

Load PredictPrint Database from Device

This procedure requires that you have copied the database from the PredictPrint Cloud Server onto a USB flash 
drive. For details, refer to Downloading a Stock List from PredictPrint Cloud Server.

1. Insert the USB flash drive that contains one or more downloaded stock lists into a USB port on the Fiery Print 
Server.

2. From the PredictPrint Media Manager screen, click Login, then log in as the Administrator.

3. Click Administration.

4. From the Administration screen, select the Stock Wizard or Settings tab. 

Important: On Fiery® Print Server version 2.0, FS600, the Stock Wizard tab is changed to Settings tab. 
To find your print server version or Fiery System version, on the Fiery Command WorkStation window, go 
to Server > Device Center > GENERAL > General Info, then refer to Fiery Server or Fiery System. 
This information is accessible also on the Fiery configuration page, printed through Fiery® Print Server.
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5. Click Load database from device.

6. In the Open window, locate and select the stock list .xml file to be loaded to the Stock Library.

7. Click Open. 

The stock list file name appears on the Stock Wizard or Settings tab in the PredictPrint database area.

8. Click OK. If you are prompted to overwrite the existing database, click Yes. To cancel loading the database file, 
click No.

9. To exit the Administrator mode, click User: Administrator, then click Log Out.

System Tab

Important: Do not make changes to the print server information. Changes to these settings causes the 
PredictPrint Media Manager to stop communicating with the press.

To access the System settings, log in as an administrator. From the System tab, the user can do the following:

• View specific print server information including: 

– IP Address/Host Name 

– Community Name 

– Port Number 

• Make changes to the following settings: 

– AAuuttoommaattiicc AAddmmiinniissttrraattoorr LLooggooffff: When this feature is enabled, after a set period of inactivity, the system 
logs the user out of Administrator mode automatically. When the user is logged out of Administrator mode, 
the PredictPrint Media Manager returns to Operator mode. 

– TTrraayy SSttoocckk PPrrooppeerrttiieess WWiinnddooww TTiimmeeoouutt: Use this setting to specify whether the tray properties window 
closes automatically if no changes are made to it. 

– RReessttrriicctt OOppeerraattoorr SSttoocckk LLiibbrraarryy AAcccceessss: By default, the Stock Library feature is displayed on the 
PredictPrint Media Manager main screen. With this setting, the Administrator can restrict the Operator from 
accessing the Stock Library feature. If the Stock Library feature is restricted, it is available to the 
Administrator only. 

– CChhaannggee PPaasssswwoorrdd: Use this setting to change the administrator password. 

– DDeeffaauulltt LLaanngguuaaggee: Use this setting to view and change the default language. 

– DDaattee FFoorrmmaatt: Use this setting to view and change the date format. 

– TTiimmee FFoorrmmaatt: Use this setting to view and change the time format. 

Accessing the System Tab

1. From the main window of the PredictPrint Media Manager application, log in as administrator. Refer to Logging 
In as Administrator.

2. Select Administration > System. 

The System screen appears.

3. To exit System settings and return to the PredictPrint Media Manager main window, select either Apply or 
Cancel.
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4. To exit the administrator mode, click User: Administrator, then click Log Out.

Enabling Automatic Administrator Logoff

1. From the PredictPrint Media Manager screen, click Login, then log in as the Administrator.

2. Click Administration.

3. From the Administration screen, select the System tab.

4. To enable Automatic Administrator Logoff, click the On/Off toggle button. 

The toggle button changes color, and a label indicates whether the Automatic Administrator Logoff feature is 
On or Off.

5. To change the time, use the + and – buttons. 
The available time range is 1–60 minutes.

6. To save changes, select Apply.

7. Close the System tab, then return to the PredictPrint Media Manager main window.

8. To exit the administrator mode, click User: Administrator, then click Log Out.

Tray Stock Properties Window Timeout

From the System tab, the Administrator can enable or disable the Tray Stock Properties Window Timeout option. 
Use the Tray Stock Properties Window Timeout to specify whether the tray properties window closes 
automatically if no changes were made to it.

1. From the PredictPrint Media Manager screen, click Login, then log in as the Administrator.

2. Click Administration.

3. From the Administration screen, select the System tab.

4. To enable or disable Tray Stock Properties Window Timeout, click the On/Off toggle button. 

The toggle button changes color, and a label indicates whether the Tray Stock Properties Window Timeout is 
On or Off.

5. Select the needed Tray Stock Properties window timeout period. To change the time, use the + and – buttons. 
The available time range is 1–240 minutes. When a timeout period from 1–240 minutes is set, you do not 
need to close the window manually. When the preset time is reached, the window closes automatically.

6. To save changes, select Apply.

7. Close the System tab, then return to the PredictPrint Media Manager main window.

8. To exit the administrator mode, click User: Administrator, then click Log Out.

Restrict Operator Stock Library Access

Specify how the Stock Library feature is displayed on the PredictPrint Media Manager main window:

Note: By default, the Stock Library feature is displayed on the PredictPrint Media Manager screen. If the 
Stock Library feature is always displayed, both the Operator and the Administrator can access the Stock 
Library at all times.

• The administrator can restrict the Operator from accessing the Stock Library feature.

• If the Stock Library feature is restricted, it is available to the Administrator only.
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1. From the PredictPrint Media Manager screen, click Login, then log in as the Administrator.

2. Click Administration.

3. From the Administration screen, select the System tab.

4. To enable or disable Restrict Operator Stock Library Access, click the On/Off toggle button. 

The toggle button changes color, and a label indicates whether the Restrict Operator Stock Library Access 
feature is On or Off.

5. To save changes, click Apply.

6. Close the System tab, then return to the PredictPrint Media Manager main window.

7. To exit the administrator mode, click User: Administrator, then click Log Out.

Changing the Administrator Password

1. From the PredictPrint Media Manager screen, click Login, then log in as the Administrator.

2. Click Administration.

3. From the Administration screen, select the System tab.

4. From the System tab, click Change Password. 

The Change Password window opens. 

Note: Use only numbers for your new password. Alpha characters, letters, and symbols are not allowed.

5. From the Change Password window, perform the following: 

a. For Old Password, type the old password.

b. For New Password, type a new password. Choose a password of 4–12 numbers. Use only numbers for your 
new password. Alpha characters, letters, and symbols are not allowed.

c. For Confirm New Password, type the new password again.

d. Click OK. 

Note: For security reasons, only asterisks are displayed on the window.

6. To save the change, click Apply.

7. Close the System window, then return to the PredictPrint Media Manager main window.

8. To exit the administrator mode, click User: Administrator, then click Log Out.

Setting the Default Language

Use the Language feature to switch from the currently displayed language to a different language. The language 
selected here affects only the PredictPrint Media Manager application. It does not affect any other applications on 
the print server. 

Note: The number of languages available on your system depends on what was installed during the initial 
installation process.

1. From the PredictPrint Media Manager screen, click Login, then log in as the Administrator.

2. Click Administration.
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3. From the Administration screen, select the System tab.

4. To change the default language, from the menu, for Default Language, select a language option. 

Important: If a language is selected, the PredictPrint Media Manager displays the new language. The 
Language window closes. No further confirmation is required. The new language remains in effect until 
a different language is selected or the PredictPrint Media Manager application is closed and restarted.

5. To save changes, click Apply.

6. Close the System tab, then return to the PredictPrint Media Manager main window.

7. To exit the administrator mode, click User: Administrator, then click Log Out.

Setting the Date and Time

Use this feature to set the date and time for the PredictPrint Media Manager application.

1. From the PredictPrint Media Manager screen, click Login, then log in as the Administrator.

2. Click Administration.

3. From the Administration screen, select the System tab.

4. From the System tab, select Date Format.

5. For Date Format, select an option: 

• MM/DD/YYYY: Month/Day/Year

• DD/MM/YYYY: Day/Month/Year

• YYYY/MM/DD: Year/Month/Day

6. From the System tab, select Time Format.

7. For Time Format, select an option: 

• 12-Hour Display

• 24-Hour Display

8. To save changes, click Apply.

9. Close the System tab, then return to the PredictPrint Media Manager main window.

10. To exit the administrator mode, click User: Administrator, then click Log Out.

STOCK MANAGEMENT

Important: Access the PredictPrint Media Manager application on the Fiery EX or EX-P Print Server. It cannot 
be accessed from the press.

Note: The administrator specifies whether the Stock Library feature appears on the main window of the 
PreditPrint Media Manager application. The administrator sets this feature in Administration > System. If 
the Stock Library feature is not displayed on the PredictPrint Media Manager main window, the 
administrator has restricted access to the feature to administrators only. In this case, for more information, 
contact your administrator.

Use the Stock Library feature to manage stocks for the press. The Stock Library feature allows the user to do the 
following:
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• Assign specific stocks to feeder trays

• Add new stocks to the customized Stock Library list from the All Media list

• Copy stocks from the All Media list and customize the stock properties as required

• Copy an existing stock and customize the stock properties as required

• Edit the attributes of existing stocks

• Create and save new stocks

• Change the order in which stocks are shown by moving a stock up or down in the Stock Library list

• Remove and delete a stock entry

After a stock type is defined, named, and saved, it can be referenced easily from the Stock Library list. A saved stock 
can be selected quickly and used for a required paper tray or print job.

Accessing the Stock Library Feature

Note: The administrator specifies whether the Stock Library feature appears on the main window of the 
PreditPrint Media Manager application. The administrator sets this feature in Administration > System. If 
the Stock Library feature is not displayed on the PredictPrint Media Manager main window, the 
administrator has restricted access to the feature to administrators only. In this case, for more information, 
contact your administrator.

Choose one of the following:

1. From the PredictPrint Media Manager main window, select the Stock Library.

2. If the Stock Library feature is not displayed, perform the following: 

a. Log in as Administrator.

b. Click Administration > System.

c. To enable access to the Stock Library, for Restrict Operator Stock Library Access, click the On/Off toggle 
button.  

The toggle button changes color, and a label indicates whether the Restrict Operator Stock Library Access is 
On or Off.

d. To save changes, click Apply.

e. Select Close to return to the PredictPrint Media Manager main window.

f. To exit the administrator mode, click User: Administrator, then click Log Out.

For more information, refer to Restrict Operator Stock Library Access.

Stock Library Feature

The Stock Library feature includes the following options:

AAllll MMeeddiiaa LLiisstt OOppttiioonnss

Refer to All Media List Options.

106 Xerox® Versant® 4100 Press User Documentation

Working With



SSttoocckk LLiibbrraarryy LLiisstt OOppttiioonnss

Refer to Stock Library List Options.

All Media List Options

AAllll MMeeddiiaa LLiisstt MMeennuu

Select the appropriate list from the Filter by menu: 

• TSL for Tested Substrate List: Non-Xerox branded stocks that are tested and validated, but may not give the 
optimum performance

• RML for Recommended Media List: Xerox branded stocks that are fully tested and validated, ideal stock list 
to get optimum performance from the press

• ALL for All Media list, includes Tested Substrate List (TSL) and Recommended Media List (RML)

AAllll MMeeddiiaa LLiisstt VViieeww

This area displays a list of stocks that are created manually, without using the Stock Wizard. The columns of the 
All Media list can be resized and rearranged to the preference of the user. For example, to move the Weight 
column to the left or right of the Type column, highlight it and drag it with the mouse.
Columns include the following stock information:  

• Media Name

• Name

• MFR or Manufacturer

• Size

• Type

• Weight

• Coated

• Color

• Modulus

• Hole Punched

• Smart Stock

• Global Ratings

• Comment

For more information, refer to Stock Attributes.

AAllll MMeeddiiaa LLiisstt AAccttiioonnss

From the All Media list area, you can perform the following actions: 

• Search: Allows the user to search for a stock

• Reset to System Default icon: Select this option to return the Media List view to its original layout.

• View icon: Select this option to view properties of a stock. Select the stock, then click the View icon.

• New icon: Select this option to add or create a new stock. Select the stock, then click the New icon.
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• Copy icon: This option allows the user to copy an existing stock from the All Media list, edit the stock 
properties, then save it to the Stock Library list as a new stock.

• Delete icon: Select this option to delete a stock from the Stock Library. Select the stock, then click the 
Delete icon.

• Add to Stock Library icon: This option allows the user to add a stock from the All Media list to the Stock 
Library list. Select the stock, then click the Add to Stock Library icon.

Stock Library List Options

SSttoocckk LLiibbrraarryy LLiisstt VViieeww

This area of the Stock Library feature displays a list of all the stocks that are scanned using the Stock Wizard, or 
created by the user by copying from the Stock Library list or from the All Media list. The Stock Library list displays 
stocks that are specific to your press. Columns can be resized and rearranged to the preference of the user.
Columns include the following stock information:  

• Name

• MFR or Manufacturer

• Size

• Type

• Weight

• Coated

• Color

• Modulus

• Hole Punched

• Smart Stock

• My Ratings

• Global Ratings

• Last Updated

• Comment

Note: The Last Updated column reflects the most recent date and time when a stock was edited or 
changed.

For more information, refer to Stock Attributes.

SSttoocckk LLiibbrraarryy SSoorrttiinngg SSeelleeccttiioonnss

Select either By Columns or Manual. 

• By Columns: Select this option to sort the stocks alphabetically by the Name column automatically.

• Manual: Select this option to move items around manually within any column. This option is used with the 
following clickable icons: 

– Move to Top 

– Move Up 
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– Move Down 

– Move to Bottom 

Tip: Regardless of the sorting selection, you can move and arrange columns in any order that you need, for 
example, move the Weight column to the right of the Coating column.

SSttoocckk LLiibbrraarryy LLiisstt AAccttiioonnss

From the Stock Library list area, you can perform the following actions: 

• Search: Allows the user to search for a stock

• Reset to System Default icon: Select this option to return the Stock Library List view to its original layout.

• Create New icon: Select this option to create and save a new stock to the Stock Library list. Select the stock, 
then click the Create New icon.

• Edit icon: This option allows the user to edit an existing stock from the Stock Library list, edit the stock 
properties, then save the stock to the Stock Library list.

• Copy icon: This option allows the user to copy an existing stock from the Stock Library list, edit the stock 
properties, then save it to the Stock Library list as a new stock.

• Delete icon: Select this option to delete a stock from the Stock Library list. Select the stock, then click the 
Delete icon.

• Print Barcode icon: This option allows the user to print the barcode of any stock that has a custom barcode, 
created using the Stock Wizard. Select the stock, then click the Print Barcode icon. Before you print a 
barcode, ensure that you load Letter or A4 size paper in any tray other than the one you are programming 
with the stock.

Stock Attributes

For each stock, you can set the following attributes:

NNaammee

Enter a name for the stock. Alphanumeric characters can be used, and symbols, with the exception of a slash.

MMFFRR

Enter the name of the Manufacturer.

SSiizzee

Select the appropriate stock size from the menu. If Custom is selected, enter the customer stock size 
information (width, height, and inches or millimeters), then select OK.

TTyyppee

Select the stock type from the menu. If Custom is selected, enter the custom type information, select Add 
Type, then select Close.

WWeeiigghhtt ((gg//mm22))

Select the weight of the stock by using the scroll up and down arrows or by clicking inside the field and typing 
the weight.
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CCooaatteedd

Select the desired coating from the menu.

CCoolloorr

Select the desired color for the stock from the menu. If Custom is selected, enter the custom color information, 
select Add Color and Close.

GGrraaiinn:: LLoonngg EEddggee FFeeeedd aanndd SShhoorrtt EEddggee FFeeeedd ((LLEEFF aanndd SSEEFF))

Indicates the orientation of the stock in the tray.

MMoodduulluuss

Select None or from 2–255 tabs. 

Note: When printing tabs, you must set the Modulus option to Precut Tabs.

HHoollee PPuunncchheedd

If available, select the desired number of holes from the menu. The number of holes is dependent on the hole- 
punched stock being used.

MMyy RRaattiinnggss

You can set your own valuation for stocks. The My Ratings values are retained locally on the press. To set the 
rating for a stock, in the My Ratings column, click one of the 5 stars.

LLaasstt UUppddaatteedd

The Last Updated column displays the most recent date and time when a stock was edited or changed.

CCoommmmeenntt

This section allows the user to enter information about the paper, such as a brand name or job-specific 
information. A maximum of 256 characters is allowed.

In addition to the stock attributes, to ensure print engine adjustments to optimize print performance for the stock, 
use the following features:

AAddvvaanncceedd SSeettuupp

Select this option to open and access the Advanced Stock Setup options and for more information, refer to 
Advanced Stock Setup.

TTeesstt PPrriinntt

Select this option to run test prints. For more information and instructions, refer to Test Print.

Accessing the Stock Library from Tray Properties

The Stock Library list contains the names of all the stocks that are specific to your press.

The Stock Library list is available either from PredictPrint Media Manager > Stock Library, or through the Tray 
Stock Properties window.

From the Tray Stock Properties window, you can select to load a stock from the following options:
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• Stock Library

• Media List

Accessing the Stock Library List from Tray Properties

1. Select a tray from the PredictPrint Media Manager Trays tab. 

The Tray Stock Properties window appears.

2. Click Stock Library. 

The Stock Library list appears.

3. To close the Stock Library list, select Cancel or the x in the upper-right corner of the window.

4. From Tray Stock Properties, select either OK or Cancel. 

The Tray Stock Properties window closes and the PredictPrint Media Manager main window appears.

Accessing the Media List from Tray Properties

1. From the PredictPrint Media Manager Trays tab, select a tray. 

The Tray Stock Properties window appears.

2. Click Media List. 

The Media List window appears.

3. From the menu, select the necessary list to display.

4. To close and save, select Cancel or click the x in the upper right corner of the window.

5. From Tray Stock Properties, select either OK or Cancel. 

The Tray Stock Properties window closes and the PredictPrint Media Manager main window appears.

Using the Stock Library Feature

Use the Stock Library feature to do the following:

• Add new stocks to the customized Stock Library list from the All Media list

• Copy an existing stock and customize the stock properties as required

• Create and save new stocks

• Edit the attributes of existing stocks

• Remove and delete a stock entry

Note: The option to create and save a new stock using the Stock Library is needed only when you have 
disabled the Stock Wizard.

Adding a Stock Entry from the All Media List

1. From the PredictPrint Media Manager main window, click Stock Library. 

The Stock Library window appears.

2. Select the required stock from the All Media list.
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3. Click the Add to Stock Library icon. 
The stock is added to the bottom of the Stock Library list.

4. To move the stock within the Stock Library list, click the Move Up and Move Down icons.

Copying a Stock Entry

1. From the PredictPrint Media Manager main window, click Stock Library. 

The Stock Library window appears.

2. Select the required stock from the All Media list or the Stock Library list.

3. Click the Copy icon. 

The Stock Properties window appears.

4. Type a new stock name and modify the attributes as required.

5. Click Advanced Setup. 

a. Select the various Advanced Stock Setup options as required. Refer to Advanced Stock Setup Options.

b. To save the changes, click OK, then close the Advanced Stock Setup window.

6. To save and close the Stock Properties window, click OK. 
The stock is added to the bottom of the Stock Library List.

7. To move the stock within the Stock Library list, click the Move Up and Move Down icons.

Creating a New Stock from the Stock Library Feature

Note: The option to create and save a new stock using the Stock Library is needed only when you have 
disabled the Stock Wizard.

1. From the PredictPrint Media Manager main window, click Stock Library. 

The Stock Library window appears.

2. Click Create New. 

The New Stock Setup window appears.

3. Type a new stock name and modify the attributes as required.

4. Click Advanced Setup. The Advanced Stock Setup window appears. 

a. Select the various Advanced Stock Setup options as required. Refer to Advanced Stock Setup Options.

b. To save the changes, click OK, then close the Advanced Stock Setup window.

5. To save and close the New Stock Setup window, click OK. 
The stock is added to the bottom of the Stock Library List.

6. To move the stock within the Stock Library list, click the Move Up and Move Down icons.

Creating a New Stock from Tray Properties

Note: The option to create and save a new stock using the Stock Library is needed only when you have 
disabled the Stock Wizard.
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1. From the PredictPrint Media Manager on the print server, select the tray where the new stock is loaded. 

The Tray Stock Properties window for that tray appears.

2. Click Create New Stock. 

The New Stock Setup window appears.

3. Type a new stock name and modify the attributes as required.

4. Click Advanced Setup. The Advanced Stock Setup window appears. 

a. Select the various Advanced Stock Setup options as required. Refer to Advanced Stock Setup Options.

b. To save the changes, click OK, then close the Advanced Stock Setup window.

5. The stock is either a temporary stock or a permanent stock in the Stock Library: 

• To make the stock a temporary stock, ensure that the Save In Stock Library check box is not selected.

• To permanently save the stock to the Stock Library, ensure that the Save In Stock Library check box is 
selected.

6. To save and close the New Stock Setup window, click OK.

7. To close the Tray Stock Properties window, click OK again. 
The new stock is displayed in the Stock Library list of PredictPrint Media Manager. 

Note: Before you run the job, ensure that the tray is loaded with the same stock as programmed for that 
tray in the Stock Library.

Editing an Existing Stock in the Stock Library

1. From the PredictPrint Media Manager main window, click Stock Library. 

The Stock Library window appears.

2. Select the required stock from the Stock Library list.

3. Click the Edit icon. 

The Stock Properties window appears.

4. Modify the stock attributes as required.

5. Click Advanced Setup. 

a. Select the various Advanced Stock Setup options as required. Refer to Advanced Stock Setup Options.

b. To save the changes, click OK, then close the Advanced Stock Setup window.

6. To save and close the Stock Properties window, click OK. 
The Last Updated column in the Stock Library list displays a new date and time, which indicates when the 
changes were made.

Removing a Stock from the Stock Library

1. From the PredictPrint Media Manager main window, click Stock Library. 

The Stock Library window appears.

2. Click the Remove icon. 

A prompt appears with the message Are you sure you want to Delete this stock?
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3. To delete the stock from the Stock Library list, click Yes.

TRAY PROPERTIES

From the Tray Properties window, the user views and sets various stock parameters for the feeder trays. You can 
access the Tray Properties window from PredictPrint Media Manager > Trays, then select any tray.

Note: Fiery® Print Server version 2.0 include Fiery System version FS600 and have unique features that are 
not available on older Fiery® Print Servers. On Fiery® Print Server version 2.0, FS600 or newer version, if the 
stock loaded in the tray is registered with PredictPrint Stock Wizard, then you can right-click on the tray to 
Run Image Quality System Check. To enable this option, refer to Accessing the Stock Wizard or Settings 
Tab.

From the Tray Stock Properties window, you can view the stock details, and load new stocks from the Stock Library 
or the Media List:

SSttoocckk DDeettaaiillss

This area displays the current tray information, including the paper size, type, weight, coating, and color, the 
orientation of the paper (LEF or SEF), hole punching, and grain.

LLooaadd aa nneeww ssttoocckk ffrroomm::

You can select to load a new stock from the following options: 

• Stock Library

• Media List

The Stock Library list displays stocks that are specific to the press. The user selects a stock from the list, and that 
stock is assigned to the tray. For more information, refer to Accessing the Stock Library from Tray Properties.

The Tray Stock Properties window includes the following settings:

EEnnaabbllee TTrraayy

Permits the selected tray to be used.

DDiissaabbllee TTrraayy

Prohibits the selected tray from being used.

LLoonngg EEddggee FFeeeedd

Indicates that the paper in the tray is loaded in the Long Edge Feed (LEF) direction.

SShhoorrtt EEddggee FFeeeedd

Indicates that the paper in the tray is loaded in the Short Edge Feed (SEF) direction.

AAlliiggnnmmeenntt PPrrooffiillee

Allows the user to select the system default profile or a specific profile that was created and saved from the 
Profiles feature. Select one of the following: 

• Apply to stock: This option uses a specific alignment profile for the stock. This option does not apply the 
profile to the tray. 
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Note: This is the system default option.

• Apply to tray: This option uses a specific alignment profile for the tray only and not the stock loaded in it. 
The Apply to tray field shows either Default Profile or a selected profile.

• Select Profile: Select this option to open the Select Alignment Profile window and choose a previously saved 
profile that can be applied to the selected tray. 

For detailed information and instructions, refer to Alignment Profiles.

OOvveerrrriiddee

• If the Override checkbox is cleared, when the current media loaded in the tray does not match the media 
information on the Tray Stock Properties window, a message appears.. Load the tray with the same media 
that is indicated on the Tray Stock Properties window.

• If the check box is selected, when there is a media mismatch between the actual tray contents and the 
information shown on the Tray Stock Properties window for that tray, a message never appears.

CCaanncceell

Select this option to close the Tray Stock Properties window without making any changes.

OOKK

Select this option to save any changes made and close the Tray Stock Properties window.

Accessing Tray Properties

1. Select a tray from the PredictPrint Media Manager main window. 

The Tray Stock Properties window opens.

2. To close the Tray Stock Properties window, select either OK or Cancel. 

The PredictPrint Media Manager main window appears.

Note: Fiery® Print Server version 2.0 include Fiery System version FS600 and have unique features that are 
not available on older Fiery® Print Servers. On Fiery® Print Server version 2.0, FS600 or newer version, if the 
stock loaded in the tray is registered with PredictPrint Stock Wizard, then you can right-click on the tray to 
Run Image Quality System Check. To enable this option, refer to Accessing the Stock Wizard or Settings 
Tab.

Alignment Profile Library

The Alignment Profile Library is populated with all the saved alignment profiles for the system. A user can select a 
desired profile to use at point of need.

The Alignment Profile Library can be accessed from Tray Properties and from Advanced Stock Setup.

Note: Alignment profiles cannot be created or edited from the library. To create or edit profiles, from the 
PredictPrint Media Manager main window, select Profiles > Alignment Profile.
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Matching the Tray and Stock Information

Important: To ensure maximum productivity and successful job completion, always verify that the Tray 
Properties information on the PredictPrint Media Manager application on the print server matches the actual 
stock or media that is loaded in the tray being used for the print job.

Before running a print job, check for any of the following conditions:

• Modifications were made to the Stock Library, such as: 

– Adding a stock 

– Copying a stock 

– Creating a new stock 

– Editing an existing stock 

• Stock or media was loaded into the selected tray for the print job

• The tray selected for the print job was opened or closed

Note: If any of these conditions apply, verify that the Tray Properties information matches the actual tray 
contents.

If the stock loaded in the tray does not match the information on the Tray Properties window, then a message may 
appear on one or more of the following screens: 

• The press User Interface

• The PredictPrint Media Manager application

• The print server

Tip: Stock or tray mismatch information and how it is displayed is dependent on the individual print server. If stock 
is changed in a tray, a message may not be displayed. Therefore it is important to perform the following steps 
always before running a print job.

1. Check for a tray mismatch message on the press User Interface. If a mismatch message is displayed, select it. 

A new message displays and explains what media is required and the tray location.

2. Go the print server and check the main or home window for a similar message: 

• If a message exists, follow the information provided on the print server to correct the stock mismatch issue, 
then continue to the next step.

• If a message does not exist, continue to the next step.

3. Load the stock in the tray. 
If the User Interface on the press displays a mismatch message, to correct the mismatch, use the Stock Wizard.

4. Close the tray. 

The Stock Wizard opens.

5. To change the Tray Properties to match the contents of the tray, follow the stock setup steps in the Stock 
Wizard.

6. Resolve all tray and stock mismatch messages.

7. Start your print job.
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TEST PRINT

The Test Print option runs sample prints of the specific stock loaded in a tray. Use these sample prints to assess 
whether the loaded stock prints correctly with the selected stock properties, including any selected Advanced Stock 
Setup options. The test pattern that is used for the sample prints can vary depending on which Test Print option is 
selected and used.

The Test Print option is available with the following features or options:

• Stock Properties

• Advanced Stock Setup

Tips for Using the Test Print Option

Before you use the Test Print option, review the following information.

• If multiple Stock Properties attributes or Advanced Stock Setup options are changed, then do the following: 

1. Change only one attribute or option

2. Run test prints

3. Evaluate the sample output

4. If the sample output is acceptable, then change a different attribute or option

5. Repeat the previous steps for evaluating the next attribute or option

• If the sample output is unacceptable after running test prints, do one of the following: 

– Make further adjustments to the attribute or option and run more test prints, or 

– Return the attribute or option to its default value and continue to the next attribute or option 

• It is important to remember that any settings used today for a particular attribute or option cannot achieve the 
same desired output when used on different day. This is especially relevant if the room in which the press is 
located experiences changes in temperature and humidity

• Repeat the procedures continually and test prints for any attribute or option until you achieve acceptable 
output prints

• If the printed output still is not acceptable after repeating procedures and test prints multiple times, call your 
Customer Support Center for assistance

Using the Test Print Option from Stock Properties

1. Perform one of the following: 

• Copy an existing stock entry. Refer to Copying a Stock Entry

• Modify or edit an existing stock entry. Refer to Editing an Existing Stock in the Stock Library

2. From the Stock Properties window, modify the stock attributes as required, including entering a revised stock 
name, if applicable, selecting a stock size, color, and other attributes.

3. Select the Test Print button. 

The test print window opens.
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4. Select the desired Test Print options, including: 

• Tray:

• Quantity: It is recommended that you select a quantity of 10 test prints in order to best evaluate the 
printed output.

• Sides Imaged: 

• 1 Sided-Face Up

• 1 Sided-Face Down

• 2 Sided

• Long Edge Feed or Short Edge Feed:

• Color Mode: 

• Black: Select this for black and white only output

• CMYK: Select this for color output

5. Select Start. 
An Information window displays stating Test Print in Progress.

Upon completion of the test prints, the Information window closes.

6. Retrieve the test prints from the output area of the printer.

7. Review the output. 

• If the sample output is acceptable, go the next step.

• If the sample output is not acceptable, repeat the previous steps until acceptable output is accomplished. If 
the output remains unacceptable after multiple trials, contact your Customer Support Center for further 
assistance.

8. Select OK to save and close the Stock Properties window.

9. Select Close to exit the Stock Library feature or Tray Properties.

Using the Test Print Option from Advanced Stock Setup

1. Perform one of the following: 

• Copy an existing stock entry. Refer to Copying a Stock Entry.

• Modify or edit an existing stock entry. Refer to Editing an Existing Stock in the Stock Library.

2. From the Stock Properties window, select and modify the stock attributes as required, including entering a new 
or revised stock name, selecting a stock size, color, and other attributes.

3. Select the Advanced Setup button. 

The Advanced Stock Setup window opens.

4. Select the Test Print button. 

The test print window opens.

118 Xerox® Versant® 4100 Press User Documentation

Working With



5. Select the desired Test Print options, including: 

• Tray:

• Quantity: It is recommended that you select a quantity of 10 test prints in order to best evaluate the 
printed output.

• Sides Imaged: 

• 1 Sided-Face Up

• 1 Sided-Face Down

• 2 Sided

• Long Edge Feed or Short Edge Feed:

• Color Mode: 

• Black: Select this for black and white only output

• CMYK: Select this for color output

6. Select Start. 
An Information window displays stating Test Print in Progress.

Upon completion of the test prints, the Information window closes.

7. Retrieve the test prints from the output area of the press.

8. Evaluate the printed output. 

• If the test prints are acceptable, continue to the next step.

• If the test prints are not acceptable, repeat the previous steps and run more test prints until the desired 
printed output is achieved. If the output continues to be unacceptable after multiple sets of test prints, 
contact your Customer Support Center for further assistance.

It may take multiple adjustments to the Advanced Stock Setup options and running test prints before the 
printed output meets customer satisfaction.

9. To save selections and close the Advanced Stock Setup window, select OK.

10. To save and close either the New Stock Setup window or the Stock Properties window, select OK.

11. To exit the Stock Library or Tray Properties, select Close.

12. To exit the Administrator mode, select Logoff.

ADVANCED STOCK SETUP

The Advanced Stock Setup feature allows the user to customize the stocks further beyond the typical size, weight, 
type, and other characteristics.

Tip: The Advanced Stock Setup feature is accessed from either the Stock Properties window or the New Stock 
Setup window.

Different media, including paper type, weight, type, and paper curl, requires specific or special handling by the press 
as it moves through the paper path. For example, some media types may skew or curl as they progress through the 
printing path of the press. This can occur on frequently-run jobs or on jobs with a high volume output.

The Advanced Stock Setup feature allows you set specific custom parameters for different types of media and 
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jobs, such as outlined in the above paragraph. These custom stocks can be used at point of need to ensure 
optimum output quality of your print jobs. The stocks can be either a temporary stock for a specific, one-time job, or 
they can be a permanent stock added to the Stock Library list.

By setting custom stocks for specific media types, you can avoid output prints that are skewed, curled, have too 
much dry ink/toner or not enough dry ink/toner in areas, or images that are not registered properly on the output 
print, such as 1 Side 1 and Side 2 images that are misregistered.

Note: Once a custom stock is created, either temporarily or permanently, this information is sent to the print 
server and to the press. The print server in turn reflects this information in the print options for the print jobs.

Tips for Using the Advanced Stock Setup Feature

Before using the Advanced Stock Setup feature, review the following information:

• Choose only one Advanced Stock Setup option at a time. This helps you determine if the option is providing the 
desired printed output. 

Important: Always run test prints after selecting each option. This allows you to evaluate the printed 
output and determine whether or not it is acceptable. If it is acceptable, no further adjustments are 
required.

• If the output is unacceptable, do one of the following:  

– Make further adjustments to the value for the selected option (if applicable) or 

– Return the option to its default value and continue to the next option. 

• If the output still is unacceptable after repeatedly adjusting an option and running test prints, call your 
Customer Support Center for assistance.

• The output of a print job, which uses a specific Advanced Stock Setup option, varies from day to day. Settings 
that are used today cannot achieve the same desired output when used on different day for that same print 
job. This is especially relevant if the room in which the press is located experiences changes in temperature and 
humidity.

Advanced Stock Setup Options

For the Advanced Stock Setup feature, the following options are available:

• OK button: Select this button to save any changes made and close the Advanced Stock Setup window.

• Cancel button: Select this to close the Advanced Stock Setup window without making any changes.

• Stock by Name Only: Refer to Stock By Name Only.

• Multifeed Detection: Refer to Multifeed Detection.

• Tray Air Assist: Refer to Tray Air Assist.

• Enable Tray Heater: Refer to Enable Tray Heater.

• Aligner Roll Pressure: Refer to Aligner Roll Pressure.

• Regi-Loop: Refer to Regi-Loop.

• Pre Gate Roll Adjustment: Refer to Pre Gate Roll Adjustment.

• Test Print: Refer to Test Print.
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• Primary Transfer Current Adjustment: Refer to Primary Transfer Current Adjustment.

• Secondary Transfer Voltage Adjustment: Refer to Secondary Transfer Voltage Adjustment.

• Transfer output adjustment for trail edge: Refer to Transfer Output Adjustment for Trail Edge.

• Adjustment of Paper Speed at Transfer: Refer to Adjustment of Paper Speed at Transfer.

• Fuser Temperature Adjustment: Refer to Fuser Temperature Adjustment.

• Fuser Speed Adjustment: Refer to Fuser Speed Adjustment.

• Alignment Profile: Refer to Alignment Profile.

• Fold Adjustment Profile: Refer to Fold Adjustment Profile.

• Paper Curl Correction: Refer to Paper Curl Correction.

Stock By Name Only

When this option is selected (yes or true), stock can be selected from the print server or from the print driver of the 
client only by explicitly selecting its specific stock name (as shown in the Stock Library) and not by matching various 
parameters (such as weight, type, and coating). Selecting this option (by placing a check mark in the box) can 
prevent the inadvertent use of expensive or specialty stocks for slip-sheets, automatic paper selection, or generic 
paper requests by the user.

Tip: The behavior of this option is dependent on print server implementation; therefore, the functionality of this 
option may vary from one print server to another. Furthermore, because the option is dependent on print server 
implementation, this option may not function as detailed here.

When this option is unchecked (no or false), stocks can be selected from the print server or from the print driver of 
the client by matching the same attributes (such as weight, type, and coating) as those listed for stocks in the Stock 
Library. Stock names also are examined, but are not used exclusively.

Multifeed Detection

Note: This option is available only with the Trays 6, 7, 8, and 9. It does not function with Trays 1-3.

When this option is selected (yes or true), the press detects and prevents multiple sheets from being pulled 
simultaneously from the tray.

When this option is unchecked (no or false), the press ignores any multiple sheets that may feed through the paper 
path. Uncheck this option only as a temporary measure which allows the user to continue their workflow until the 
service representative resolves the problem.

Tray Air Assist

This option allows you to optimize and control the environmental conditions in your paper trays, which in turn 
ensures optimum print capability. Use Tray Air Assist option to switch on or off fans in a paper tray to eliminate 
misfeeds, multifeeds, paper jams, or other possible tray feeding problems. These fans blow air to the paper stack 
during the feeding operation and separate sheets of paper thereby providing a stable feed of paper.

Select one of the following options from the drop-down menu:
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• System Default: As its name states, this is the default selection. With this selection, the paper tray blowers 
automatically adjust by using system settings that are optimized for Xerox papers.

• Multifeed Support Table: Select this option when you have a multifeed condition. This changes the air assist 
function to lower the air volume so it does not fluff or pick up as many sheets of paper. This is a preset lower 
volume that is stored already in the machine NVM (NonVolatile Memory).

• Mis-Feed Support Table: Select this option when you have a misfeed condition. This changes the air assist 
function to lower the air volume so that it may reduce paper jams. This is also a preset lower air volume that is 
stored in the machine NVM.

• Forced Off: Select this option when neither of the above options produce a change in the output. This option 
switches off all air assist functions.

• Custom 1-8: By default, these are blank NVM storage settings. While these custom settings are selectable, they 
not available for use with the press nor are they operational now.

Enable Tray Heater

This option works in conjunction with the Tray Air Assist option. Checking this box, enables the tray heater. The 
heater maintains the appropriate internal temperature of the paper tray. Depending on the external temperature 
and humidity, the heater sends information to the tray blowers. The paper tray blowers then switch on and provide 
the required air to the paper stack, thereby preventing multifeeds or misfeeds from occurring.

Aligner Roll Pressure

Use this option with special paper types that slip or skew thereby causing image misregistration on the printed 
output. This feature is also used with some light-weight or heavy-weight paper stocks that require less or more roll 
pressure in order to avoid edge damage to the printed output. 

Note: The Aligner Roll Pressure option is used in conjunction with the Pre Gate Roll Adjustment option. 
Before using Aligner Roll Pressure, you must first switch on the Pre Gate Roll Adjustment. For more 
information, refer to Pre Gate Roll Adjustment.

Refer to the following two examples:

Example 1
Some coated, heavier paper types slip and skew, thereby misregistering the image on the output prints. In this 
case, you may want to increase the roll pressure in order to compensate for the slippage and skewing.
Example 2
Some light-weight papers may have too much roll pressure applied to them, thereby causing edge damage to the 
output prints. In this case, you may want to decrease the roll pressure.

Increasing the roll pressure for some faults may allow you to postpone a service call. However, you may want to call 
your service representative as soon as possible in order to restore the machine to its full feeding capabilities.

The default setting is 0 (zero). It is recommended that you leave this option at its default setting until you run test 
prints and evaluate the output of the prints.

Note: Changing the default setting should be considered a temporary solution because environmental 
conditions vary from day to day. It is recommended that upon completion of the print job, you return the 
option to its default setting.
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Regi-Loop

Use this option to adjust and correct skew that may be occurring in the lead direction of the sheet as it is being fed 
through the paper path. Adjusting the loop varies the amount of paper buckle that occurs against the registration 
gate, and thereby optimizes the correction of lead skew.

Tip: Regi-Loop is used in conjunction with Alignment Profile. Before using the Regi-Loop option, first use the 
Alignment feature; if adjusting the alignment is unsuccessful; then adjust the Regi-Loop option. For information 
and instructions, refer to Alignment Profiles.

The following illustration shows the sheet as it is being fed through the paper path and the area where the loop 
amount occurs.

• Adjustment ranges from -3.0 mm (-0.118 in.) to +3.0 mm (+0.118 in.), and the amounts may be set to as low as 
0.3 mm (0.0118 in.).

• If the variation of lead skew is large, then increase the loop amount in the plus (+) direction. Depending on the 
paper type or weight (g/m2) and if f the loop is too large, then damage may occur on the lead edge of the 
paper.

• If buckling occurs with thin paper in environments such as high temperature and high humidity, then reduce the 
amount of loop in the minus (-) direction.

Pre Gate Roll Adjustment

This will adjust the pregate roll nip pressure. Choose one of three options:

• System Default: This is an automatic setting which uses a preset system Look-Up Table (LUT) that assigns nip 
settings for each g/m2 (weight) stock type.

• On: This option enables custom settings when the Aligner Roll Pressure option is used. Before using Aligner 
Roll Pressure, you must first switch On this setting.

• Off: No nip setting is used.

Test Print

After making adjustments to any of the Advanced Stock Setup options, always run test prints before running a job. 
Running test prints will ensure whether or not the printed output is acceptable and if more changes should be made 
before running a job. For more information and instructions, refer to Test Print.

Primary Transfer Current Adjustment

The purpose of this adjustment is to correct black (K) line smears at lead edge area of the print output. The smears 
occur at approximately 10 mm from the lead edge. Black (K) line smears can be corrected by increasing the primary 
(first) transfer current.
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This smear occurs primarily with black (K); however, if other image quality problems occur, such as ghosting, the 
other colors, Cyan (C), Magenta (M), and Yellow (Y), may also be adjusted to correct these problems.

Secondary Transfer Voltage Adjustment

The purpose of this adjustment is to correct for mottle (uneven toner coverage) and color shift (inconsistent color). 
These image quality issues can occur on heavy-weight stocks. This adjustment creates and saves an image transfer 
adjustment to the Bias Transfer Roll in the press. The Bias Transfer Roll is where the image is transferred from the 
belt to the paper. Once created for a stock, the adjustment is saved and can be selected for that stock for any tray.

The adjustment can be performed by selecting either the Auto or Manual buttons.

• Auto button: The adjustment is done automatically by the press and eliminates the need for you to interpret 
printed targets and manually enter adjustment values. This saves time and avoids errors. Usually Auto fixes 
most image quality issues and should be used before performing a manual adjustment.

• Manual button: The user must manually perform the adjustment and step-by-step instructions for printing test 
patterns, interpreting the printed targets on those patterns, and then manually entering the adjustment values. 
Use the Manual adjustment option only when the Auto adjustment does not provide the desired output.

For more information, refer to Secondary Transfer Voltage Adjustment. Also refer to these procedures: Using the 
Auto Adjustment Option for Secondary Transfer Voltage Adjustment and Using the Manual Adjustment Option for 
Secondary Transfer Voltage Adjustment.

Transfer Output Adjustment for Trail Edge

This option raises or lowers the transfer voltage timing to the 2nd Bias Transfer Roll, which in turn reduces trail edge 
deletions on the output. Select between 0-100%. The default setting is 100%.

Note: This adjustment should not be used for trail edge flip problems which are caused by heavyweight 
stock.

Adjustment of Paper Speed at Transfer

Note: This option is used very infrequently.

In the press, the distance between the Second Transfer and Fuser is very small. When feeding large paper sizes, the 
paper is nipped (gripped) simultaneously by both the Second Transfer and Fuser. Occasionally, the paper is pulled 
between the Second Transfer and Fuser, which can cause paper damage or image defect on the output. When this 
happens, this option allows you to make very small adjustments in order to successfully feed paper through the 
Second Transfer and Fuser areas without damage or defects. 

The adjustment amounts range from -0.50% to a maximum of 0.50%. The default is 0 (zero).

Fuser Temperature Adjustment

This option allows the user to adjust the fuser temperature for specific media types. Under most conditions, the 
press adjusts the fuser temperature automatically at point of need. However, on infrequent occasions the user can 
minimally adjust the fuser temperature for specific stock weights or a specific job flow.

For Example
The printed output shows signs of offset or flaking dry ink/toner. This can be caused by specific media or stock 
(such as coated or silk media), and the fuser temperature can be too low or too high.
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• The temperature of the fuser can be adjusted within a range of -10° to +10° Celsius (14° - 50° Fahrenheit).

• The default setting is 0 (zero). It is recommended that you leave this option at its default setting until you run 
test prints and evaluate the output of the prints.

• Changing the default setting is considered as a temporary solution because environmental conditions vary from 
day to day. It is recommended that upon completion of the print job, you return the option to its default 
setting.

Fuser Speed Adjustment

This option allows the user to adjust the fuser speed for when there is a smear on the output print at 208 mm from 
the lead edge. This smear is caused by a speed mismatch between the paper lead edge in the fuser nip and the 
middle of the paper in the Second Transfer nip.

If this smear occurs on the output print (at 208 mm from lead edge), the fuser speed can be increased (up to +2 or 
3%). This helps to correct this defect.

Alignment Profile

Selecting the Alignment Profile button opens the Alignment Profile Library. This library is populated with all the 
saved alignment profiles for the system. A user can select a desired profile, as required. The selected profile then 
appears in the Alignment Profile field which is above the button.

All fold adjustment profiles are created and maintained from the Profiles feature on the PredictPrint Media 
Manager on the print server.

For detailed information and instructions, refer to Profiles feature and Alignment Profiles option.

AAlliiggnnmmeenntt PPrrooffiillee LLiibbrraarryy

The Alignment Profile Library is populated with all the saved alignment profiles for the system. A user can select a 
desired profile to use at point of need.

The Alignment Profile Library can be accessed from Tray Properties and from Advanced Stock Setup.

Note: Alignment profiles cannot be created or edited from the library. To create or edit profiles, from the 
PredictPrint Media Manager main window, select Profiles > Alignment Profile.

Fold Adjustment Profile

Note: The Fold Adjustment feature is available when the press is connected to an optional booklet maker 
finisher (for Bi-Fold or Single Fold), or when the press is connected to both an optional finisher and the C/Z 
Folder device.

Selecting the Fold Adjustment Profile button opens the Fold Adjustment Profile Library. This library is populated 
with all the saved fold profiles for the system. A user can select a desired profile, as required. The selected profile 
then appears in the Fold Adjustment Profile field which is above the button.

All fold adjustment profiles are created and maintained from the Profiles feature on the PredictPrint Media 
Manager on the print server.

For detailed information and instructions, refer to Profiles feature and Fold Adjustments option.
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FFoolldd AAddjjuussttmmeenntt PPrrooffiillee LLiibbrraarryy

The Fold Adjustment Profile Library contains all the saved fold profiles for the system. A user can select a desired 
profile to use at point of need.

From Advanced Stock Setup, access the Fold Adjustment Profile Library.

Note: Fold Adjustment profiles cannot be created or edited from the library. To create or edit profiles, select 
Profiles > Fold Adjustment from the main PredictPrint Media Manager window.

Paper Curl Correction

This option allows you to select the desired paper curl setting in order to prevent your output from curling. For more 
information, refer to the Paper Curl Correction feature.

Creating or Modifying Advanced Stock Setup Options

1. Perform one of the following: 

• Copy an existing stock entry. Refer to Copying a Stock Entry.

• Modify or edit an existing stock entry. Refer to Editing an Existing Stock in the Stock Library.

2. From the Stock Properties window, select and modify the stock attributes as required, including entering a new 
or revised stock name, selecting a stock size, color, and other attributes.

3. Select the Advanced Setup button. 

The Advanced Stock Setup window opens.
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4. From the Advanced Stock Setup window, select the various options as required.  
For information, refer to Advanced Stock Setup Options. 

Advanced Stock Setup options include the following:

• Stock By Name Only

• Multifeed Detection

• Tray Air Assist

• Enable Tray Heater

• Aligner Roll Pressure

• Regi-Loop

• Pre Gate Roll Adjustment

• Primary Transfer Current Adjustment

• Secondary Transfer Voltage Adjustment  

For more information, refer to Secondary Transfer Voltage Adjustment.

• Transfer output adjustment for trail edge

• Adjustment of Paper Speed at Transfer

• Fuser Temperature Adjustment

• Fuser Speed Adjustment

• Alignment Profile 

For detailed information and instructions, refer to Alignment Profiles.

• Fold Adjustment Profile  

For detailed information and instructions, refer to Fold Adjustments.

• Paper Curl Correction 

For detailed information and instructions, refer to Correcting the Paper Curl.

5. Run test prints to ensure that the selected options provide the desired output. 
For information, refer to Using the Test Print Option from Advanced Stock Setup.

• If the test prints are acceptable, continue to the next step.

• If the test prints are not acceptable, repeat the previous steps and run more test prints until the desired 
printed output is achieved. If the output continues to be unacceptable after multiple sets of test prints, 
contact your Customer Support Center for further assistance.

6. To save selections and close the Advanced Stock Setup window, select OK.

7. To save and close the Stock Properties window, select OK.

Secondary Transfer Voltage Adjustment

Use the Secondary Transfer Voltage Adjustment option to correct for mottle (uneven toner coverage) and color 
shift (inconsistent color). These image quality issues can occur on heavy-weight stocks. The Secondary Transfer 
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Voltage Adjustment option creates and saves an image transfer adjustment to the Bias Transfer Roll in the press. 
The Bias Transfer Roll is where the image is transferred from the belt to the paper.

Once created for a stock, the adjustment is saved and can be selected for that stock for any tray.

The adjustment can be performed by selecting one these buttons: Auto or Manual.

• Auto: The adjustment is done automatically by the press and eliminates the need for you to interpret printed 
targets and manually enter adjustment values. This saves time and avoids errors. Usually Auto fixes most image 
quality issues. 

Note: Always perform the Auto adjustment first before performing a manual adjustment.

• Manual: The user performs the adjustment manually, including printing test patterns, interpreting the printed 
targets on those patterns, and then manually entering the adjustment values. Use the Manual adjustment 
option only when the Auto adjustment does not provide the desired output.

Test Print Information for the Secondary Transfer Voltage Adjustment Option

When using the Test Print option for Secondary Transfer Voltage Adjustment option, two test print windows display. 
For more information, refer to the following procedures:

• Test Print Window 1 for Secondary Transfer Voltage Adjustment

• Test Print Window 2 for Secondary Transfer Voltage Adjustment

TTeesstt PPrriinntt WWiinnddooww 11 ffoorr SSeeccoonnddaarryy TTrraannssffeerr VVoollttaaggee AAddjjuussttmmeenntt

After selecting either Auto or Manual, the first Test Print (Auto or Manual) window opens. From this window, you 
may select the desired options, such as paper tray, sides imaged, and color mode.

For step-by-step instructions on using the Auto and Manual adjustment options, refer to the following procedures:

• Auto: Using the Auto Adjustment Option for Secondary Transfer Voltage Adjustment

• Manual: Using the Manual Adjustment Option for Secondary Transfer Voltage Adjustment

TTeesstt PPrriinntt WWiinnddooww 22 ffoorr SSeeccoonnddaarryy TTrraannssffeerr VVoollttaaggee AAddjjuussttmmeenntt

After the press runs a test print, a second Test Print window displays.

For information on which option to use for either the Auto or Manual adjustment options, refer to the following 
procedures:

• Auto: Using the Auto Adjustment Option for Secondary Transfer Voltage Adjustment

• Manual: Using the Manual Adjustment Option for Secondary Transfer Voltage Adjustment

Using the Auto Adjustment Option for Secondary Transfer Voltage Adjustment

1. Perform one of the following: 

• Copy an existing stock entry. Refer to Copying a Stock Entry.

• Modify or edit an existing stock entry. Refer to Editing an Existing Stock in the Stock Library.
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2. From the Stock Properties window, select and modify the stock attributes as required, including entering a new 
or revised stock name, selecting a stock size, color, and other attributes. 
If using the Secondary Transfer Voltage Adjustment option, customize the stock name or include information in 
the Comment section to identify the usage of this option. For example name the stock Custom STVAdj_ 
Auto or add a comment stating This custom stock is using Secondary Transfer Voltage 
Auto Adjustment.

3. Select Advanced Setup. 

The Advanced Stock Setup window opens.

4. For Secondary Transfer Voltage Adjustment, select the Auto option. 

The Test Print - Secondary Transfer Voltage Auto Adjustment window opens.

5. Select the following settings: 

a. Paper tray

b. Sides Imaged: Side 1 or Sides 1 and 2

c. Color Mode

d. Do not enter a Change Percentage value for either Side 1 or Side 2

6. Select Start. 
The press generates 16 patches on a single test print: 

• Patches 1–10 have more bias applied to them (more transfer voltage)

• Patches -1 through -5 have less bias applied to them (less transfer voltage)

• Patch 0 is the median range; this is the default value

7. Retrieve the test print from the output area of the press. Continue to the next step.

8. On the Test Print - Secondary Transfer Voltage Auto Adjustment second window, select Bias Acceptable. 

The window closes and displays Advanced Stock Setup.

9. To save and close the Advanced Stock Setup window, select OK.

10. To save and close the Stock Properties window, select OK.

Using the Manual Adjustment Option for Secondary Transfer Voltage Adjustment

1. Perform one of the following: 

• Copy an existing stock entry. Refer to Copying a Stock Entry.

• Modify or edit an existing stock entry. Refer to Editing an Existing Stock in the Stock Library.

2. From the Stock Properties window, select and modify the stock attributes as required, including entering a new 
or revised stock name, selecting a stock size, color, and other attributes. 
If using the Secondary Transfer Voltage Adjustment option, customize the stock name or include information in 
the Comment section to identify the usage of this option. For example name the stock Custom STVAdj_ 
Manual or add a comment stating This custom stock is using Secondary Transfer Voltage 
Manual Adjustment.

3. Select Advanced Setup. 

The Advanced Stock Setup window opens.
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4. For Secondary Transfer Voltage Adjustment, select Manual. 

The Test Print - Secondary Transfer Voltage Manual Adjustment window opens.

5. Select the following settings: 

a. Paper tray

b. Sides Imaged: Side 1 or Sides 1 and 2

c. Color Mode

d. When running a test print for the first time, there is no need to enter a Change Percentage value for either 
Side 1 or Side 2

6. Select Start. 
The press generates 16 patches on a single test print: 

• Patches 1–10 have more bias applied to them (more transfer voltage)

• Patches -1 through -5 have less bias applied to them (less transfer voltage)

• Patch 0 is the median range; this is the default value

7. Retrieve the test print from the output area of the press. 

The PredictPrint Media Manager displays a message to select either Bias Acceptable or Adjust Test Prints. 
Continue to the next step.

8. Evaluate the printed output for the patch with the best image quality. For example, the best image quality is on 
Patch# 2.

9. In the Patch number field for Side 1 and Side 2, enter the correct number of the patch with the best image 
quality.

10. Select Bias Acceptable. 

• The current window closes and displays Advanced Stock Setup.

• A new value is displayed in the Side 1 field or Side 1 and Side 2 fields, depending on which Sides Imaged 
option was selected earlier in this procedure.

11. To save and close the Advanced Stock Setup window, select OK.

12. To save and close the Stock Properties window, select OK.

13. Run a few prints from a job that uses the Stock Properties with the new Secondary Transfer Voltage Manual 
Adjustment setting. 
This verifies whether or not the changes made to the Secondary Transfer Voltage Adjustment option are 
providing the desired printed output.

14. Retrieve and review the printed output for image quality. Choose one of the following: 

• The printed output is acceptable: continue with normal workflow processes.

• The printed output is unacceptable: Repeat the steps of this procedure and if the output continues to be 
unacceptable, contact the Customer Support Center for further assistance.
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PAPER CURL CORRECTION

When paper is exposed to heat, the paper loses moisture and curls toward the heat source. High dry ink/toner 
coverage jobs tend to curl more due to the dry ink/toner plastification effect on the paper surface. 

Many variables can cause Paper curl, which includes:

• The weight of the paper and whether it is coated or uncoated

• The amount of dry ink/toner and the area that is covered on a sheet: the heavier the coverage, the greater the 
tendency to curl

• How the paper is loaded in the tray, load the paper as instructed on the ream wrapper

• The atmospheric conditions of the room where the paper is stored, especially those related to humidity and 
temperature

• The heat generated during the fusing processes

Tip: Successful paper curl correction varies from day to day. A successful setting used on one day cannot be 
successful on another day. This is especially relevant if the room in which press is located experiences changes in 
temperature and humidity.

Automatic Paper Curl Correction

The press is designed with an automated setting to control the curl. This automated setting does not require the 
user to make any Paper Curl Correction selections. The press automatically sends paper through the proper 
decurler, and automatically determines the amount of pressure needed at the different decurlers to reduce the 
output curl of the paper.

However, with some print jobs, the output prints can be curled more than you desire even with the automated 
control setting of the press. There can be other ways to correct the curl before you use the Paper Curl Correction 
option; this depends on your press and any optional devices attached to it, such as the Interface Decurler Module.

TThhee IInntteerrffaaccee DDeeccuurrlleerr MMoodduullee aanndd PPaappeerr CCuurrll

If the press is equipped with the optional Interface Decurler Module, then this is another way to correct paper curl. 
The Interface Decurler Module is designed with several automated presettings for controlling paper curl. The 
module decurler sets the amount of curl correction automatically.

If the automated curl correction Interface Decurler Module does not fix the paper curl, you can select the curl 
correction manually from the Interface Decurler Module control panel.

Tip: Using the buttons on the Interface Decurler Module is a quick and easy way to correct curl without using the 
Paper Curl Correction option from the Advanced Stock Setup feature. Another advantage to using the Interface 
Decurler Module is that paper curl can be adjusted while the job is printing by simply pressing one of the buttons 
on the Interface Decurler Module control panel.

From the Interface Decurler Module, the amount of curl correction is changed by selecting a related button on the 
control panel. The LEDs display the current selected amount of curl correction.

The Interface Decurler Module has the following curl correction options on its control panel:

• Auto Curl button: This button selects the Auto Decurl function.

• Manual Curl Up button: This button selects the three values of manual up curl.
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• Manual Curl Down button: This button selects the three values of manual down curl.

• Curl Up and Down indicators: These indicate the amount of manual curl (up or down) that is selected.

• Auto Curl indicator: This indicates that the Auto Curl Mode is selected.

CCoorrrreeccttiinngg PPaappeerr CCuurrll ffrroomm AAddvvaanncceedd SSttoocckk SSeettuupp

If not the press or the Interface Decurler Module corrects the paper curl, then use the Paper Curl Correction option 
to compensate for paper curl. Paper Curl Correction options are based on the job type and image density ratio.

Paper Curl Correction from Advanced Stock Setup

Tip: Changing the default setting can be considered a temporary solution because environmental conditions vary 
from day to day. It is recommended that upon completion of the print job, you return the option to its default 
setting.

Important: Always run several test prints, evaluate the output, and if necessary, readjust the values before 
running your print job. This ensures that the desired output is achieved.

The Paper Curl Correction options include:

11 SSiiddeedd--FFaaccee UUpp

Use this option to select the desired paper curl settings for one-sided print jobs that exit the machine in the 
face-up position.

11 SSiiddeedd--FFaaccee DDoowwnn

Use this option to select the desired paper curl settings for 1-sided print jobs that exit the machine in the face 
down position.

22 SSiiddeedd

Use this option to select the desired paper curl settings for 2-sided print jobs.

Edit Settings

Additional settings are available for each of the three Paper Curl Correction options by selecting Edit Settings. 
These additional settings include both the preset and custom settings, and use lookup tables for curl control that 
are based on the percentage of toner area coverage of the job and the humidity values in the room where the 
press sits.
If you select the Edit Settings button, it opens the Paper Curl Correction Test Print window which displays 
additional settings that include preset and custom selections.

Paper Curl Correction Test Print

The Paper Curl Correction Test Print includes the following options and settings:

• Default: This is the system preset value. The press uses this setting to determine the amount of pressure 
needed automatically at the different decurlers to reduce the output curl of the paper. Always use this setting 
first before using other custom settings.

• Types A, B, and C

• Custom Curl Correction
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• Test Print Button for Paper Curl Correction

Refer to the latest stock and paper guidelines for the press for the recommended paper types and weights. For more 
information, refer to Downloading Current Media Information.

Important: Always run several test prints, evaluate the output, and if necessary, readjust the values before 
you run the entire print job. This ensures that the desired output is achieved.

Types A, B, and C

Types A, B, and C are system default settings; the following list defines each type:

• Type A uses a preset system Look-Up Table (LUT) to evaluate and correct media which has a SSeevveerree ((LLaarrggee)) 
UUppwwaarrdd curl.

• Type B uses a preset system Look-Up Table (LUT) to evaluate and correct media which has an intermediate curl, 
MMooddeerraattee ((SSmmaallll)), or MMeeddiiuumm, UUppwwaarrdd, or DDoowwnnwwaarrdd curl.

• Type C uses a preset system Look-Up Table (LUT) to evaluate and correct media which has a SSeevveerree ((LLaarrggee)) 
DDoowwnnwwaarrdd curl.

These preset options offer an alternative to creating and using a customized setting. Using one of the preset Types 
A, B, or C settings usually eliminate the problem.

Always use these settings first before you use a customized setting. However, due to the broad range of paper 
variables, image coverage, and environmental factors, these default settings do not result in satisfactory 
performance. If the output is still curling more than desired, use one of the Custom Curl Correction settings.

Custom Curl Correction

There are nine customized settings, including the default No Curl. These settings are saved to the press memory 
and can be recalled and used at point of need. The nine settings include the following:

• Severe (Large) Upward

• Medium Upward

• Moderate (Small) Upward

• Slight (Very Small) Upward

• No Curl

• Slight (Very Small) Downward

• Moderate (Small) Downward

• Medium Downward

• Severe (Large) Downward

Use the custom selections if the Default and Types A, B, and C did not succeed in reducing or eliminating the paper 
curl.

• The selection is based on the printed output. For example, if the printed output is curled upwards, always select 
an upward correction.

• Select a value that is one higher or lower than the current output or value. For example with an upward curling 
output, select the next value of Medium Upward.
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• Selecting a value that is two or more higher or lower can apply too much correction, and therefore, can cause 
paper jams and wrinkled output.

Test Print Button for Paper Curl Correction

Selecting the Test Print button displays a window with secondary test print options:

TTrraayy sseelleeccttiioonn

Choose a tray from the drop-down list.

QQuuaannttiittyy

Select from 1–99.

LLoonngg EEddggee FFeeeedd oorr SShhoorrtt EEddggee FFeeeedd

Select the feed direction of the media loaded in the selected tray.

FFrroonntt PPrriinntt DDeennssiittyy LLeevveell

This option is available for 1 Sided-Face Up, 1 Sided-Face Down, and 2 Sided. 

• Enter the desired print (dry ink/toner) density amount as required.

• Density amount should match approximately with the image density on the target prints.

• Density amounts range from 0–70%.

• If your output is a high dry ink/toner coverage area on the output, you may want to enter a higher print 
density amount.

• The system default value is 10%.

BBaacckk PPrriinntt DDeennssiittyy LLeevveell

This option is available only for 2 Sided prints. 

• Enter the desired print (dry ink/toner) density amount as required.

• Density amount should match approximately with the image density on the target prints.

• Density amounts range from 0–70%.

• If your output is a high dry ink/toner coverage area on the output, you may want to enter a higher print 
density amount.

• The system default value is 10%.

Recommended Order for Using Paper Curl Correction Test Print Options

Important: Paper jams and wrinkled output occurs if the options are not used in the recommended order. 
For example, use Default and then skip to Type C).

The recommended, sequential order for selecting and using the various test print settings for paper curl correction is 
:

1. Default

2. Type A

3. Type B

4. Type C
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5. Custom Curl Correction: Slight (Very Small) Upward or Slight (Very Small) Downward

6. Custom Curl Correction: Moderate (Small) Upward or Moderate (Small) Downward

7. Custom Curl Correction: Medium Upward or Medium Downward

8. Custom Curl Correction: Severe (Large) Upward or Severe (Large) Downward

9. If paper curl still persists after trying several or all of these settings, try decreasing the image density on the 
print job or use a different type of paper. 

If paper curl is still a problem, contact the Customer Support Center for further assistance.

Correcting the Paper Curl

1. Perform one of the following: 

• Copy an existing stock entry. Refer to Copying a Stock Entry.

• Modify or edit an existing stock entry. Refer to Editing an Existing Stock in the Stock Library.

2. From the Stock Properties window, select and modify the stock attributes as required, including entering a new 
or revised stock name, selecting a stock size, color, and other attributes.

3. Select the Advanced Setup button. 

The Advanced Stock Setup window opens.

4. Select Edit Settings for the desired Paper Curl Correction option for 1 Sided-Face Up, 1 Sided-Face Down, 
or2 Sided as required. 

The Tray [1-3, 5, 6-7, 8-9] Paper Curl Correction Test Print window opens for the selected 1-sided or 2-sided 
option.

5. Select the desired curl correction setting: 

• Default

• Type A

• Type B

• Type C

• Custom Curl Correction: 

• Severe (Large) Upward

• Medium Upward

• Moderate (Small) Upward

• Slight (Very Small) Upward

• No Curl

• Slight (Very Small) Downward

• Moderate (Small) Downward

• Medium Downward
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• Severe (Large) Downward

Important: If selecting one curl correction setting does not correct the paper curl, then select another 
setting. It may take several attempts to correct the paper curl. Therefore, it is recommended that you 
use the curl correction settings in the sequential order listed in Recommended Order for Using Paper Curl 
Correction Test Print Options.

6. Select Test Print. 

The Test Print - Paper curl correction Tray [1-3, 5, 6-7, 8-9] window opens with secondary test print options.

7. Select the following: 

• The paper tray (if applicable)

• The desired test print quantity

• The desired Front Print Density setting

• The desired Back Print Density setting (if the 2 Sided option was selected)

• Long Edge Feed or Short Edge Feed

8. Select Start. 
An Information window displays stating Test Print in Progress.

Upon completion of the test prints, the Tray [1-3, 5, 6-7, 8-9] Paper Curl Correction Test Print window reopens.

9. Retrieve the test prints from the output area of the press.

10. Review the output and choose one of the following: 

• If paper curl still exists on the output: 

1. Select another curl correction setting (Step 5).

2. Repeat Step 6 through Step 9.

3. Review the output and if paper curl still exists, repeat these steps again.

4. If the output still contains too much paper curl, change the print density or type of paper used. If the 
results are still unsatisfactory, contact your Customer Support Center for further assistance.

• If the output is acceptable, perform the following: 

1. To save the selections or settings and close the Paper Curl Correction Test Print window, select OK.

2. To save the selections or settings and close windows until only the Stock Library screen or the Trays 
screen remains open, continue to select OK.

PROFILES

The Profiles feature allows you to create and customize various profiles.

AAlliiggnnmmeenntt PPrrooffiilleess

Alignment Profiles allow you to position the output image to accommodate for misalignment or skew. The 
profiles are used at the point of need for specialized print jobs.

FFoolldd AAddjjuussttmmeenntt PPrrooffiilleess

The Fold Adjustment feature allows you to adjust the fold position for various paper types, and set adjustment 
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values to various default types. 

The Fold Adjustment feature is available when the press is connected to one of the following:

• For Bi-Fold or Single Fold options, an optional booklet maker finisher

• For C and Z Fold options, an optional finisher and the C/Z Folder device

CCrreeaassee AAddjjuussttmmeenntt PPrrooffiilleess

The Crease Adjustment feature allows you to adjust the crease position for various paper types, and set 
adjustment values to various default types. 

Use of the Crease Adjustment feature requires an optional Crease and Two-Sided Trimmer module.

TThhiirrdd--ppaarrttyy FFiinniisshhiinngg DDeevviicceess

For systems which have a third-party, Digital Finishing Architecture (DFA) device attached, a Finisher Profile is 
available. 

Access the Finisher Profile from the press control panel when logged in as Administrator by selecting Tools > 
Maintenance > Finisher Adjustment > DFA Finisher Profiles.

Note: For more information, refer to the System Administrator Guide.

Entering and Exiting Profiles

1. From the PredictPrint Media Manager main window, select Profiles. 

The Profiles window appears.

2. Select the desired Profiles option: 

• Alignment: By default this option displays when Profiles opens. Use this option to create and store specific 
alignment adjustment profiles. For more information, refer to Alignment Profiles.

• Fold Adjustment: The Fold Adjustment feature is available when the press is connected to an optional 
finisher with a booklet maker (for Bi-Fold and Single Fold), an optional finisher with a C/Z Folder device. Use 
this option to adjust the fold position for various paper types, as well as set adjustment values to various 
default types. For more information, refer to Fold Adjustments.

• Crease Adjustment: The Crease Adjustment feature is available when the press is connected to an 
optional Crease and Two-Sided Trimmer module. Use this option to adjust the crease position for various 
paper types, as well as set trim values. For more information, refer to Crease Adjustments.

ALIGNMENT PROFILES

The Alignment feature allows you to create and store specific alignment adjustment profiles. These profiles allow 
you to accommodate different media types and how the image is registered, aligned, or magnified for side 1 and 
side 2 output. These profiles can be used to ensure optimum output quality of your prints.

Alignment adjustments can be made when the position of the output image is misaligned or skewed. This results in 
expansion or contraction of paper, cutting inaccuracy, or paper storage conditions.

Tip: Alignment can be done automatically or manually. Before doing any manual alignment, always perform an 
Auto Alignment.
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Note: It is recommended that you read through the entire Alignment section before creating, editing, or 
performing any actual alignment adjustments.

Alignment Information

When printing 2–Sided jobs and using different media types which includes paper type, weight, and type, the 
output requires specific handling by the machine as it is moving through the paper path. With certain media types 
and 2–Sided jobs, the images on side 1 or side 2 can be misregistered, skewed, perpendicularly misaligned, or 
stretched; this is where alignment profiles can be used to eliminate these types of issues.

Alignment adjustment profiles allow you to: 

• Adjustment the image based on the alignment output of a document. Various adjustments can be modified 
such as registration, perpendicularity, skew, and magnification.

• Make adjustments when the position of the output image is misaligned or skewed. This results in expansion or 
contraction of paper, cutting inaccuracy, or paper storage conditions. To compensate for this scenario, the 
Alignment profiles feature can be used to adjust the image alignment.

Alignment Tips

Tip: Before doing any manual alignment, always perform an Auto Alignment. For more information, refer to 
Automatic Alignment Information.

When selecting or editing the various Alignment options, consider these tips:

• The arrows above the paper illustration indicate the feed direction.

• Use the up and down arrow buttons to make the desired selections.

• As you click the arrow buttons, the illustration moves indicating the direction that the image moves or increases 
or decreases on the paper.

Note: The factory default setting for all the Alignment options is zero (0).

Before you create a new or using an existing Alignment profile, review the following important information:

• Side 1 or Side 2 images misregisteres because the paper is not the exact same size. It varies slightly, with 
differences of ±1 mm, causing the image to be misregistered. To reduce the possibility of size differences, it is 
recommended that you use paper from the same lot when running 2–Sided jobs.

• During the fusing process, the heat and pressure applied to the paper causes the paper to stretch. If the images 
on sides 1 and 2 are the same size, the stretching of the paper causes the image on side 1 to be slightly larger 
than the image on side 2.

• Creating an Alignment profile for these types of jobs allows you to reduce or eliminate the images that are 
larger on side1 than on side 2 prints.

• It is recommended that you choose only one Alignment profile option, such as skew, and then run a set of test 
prints to evaluate the skew on that output. If you want to adjust multipleAlignment profile options, individually 
select each option, run some test prints for that feature, and evaluate the output. After you determine that the 
output for the selected feature is acceptable, then you can select another Alignment profile option to adjust.

• When you adjust the multiple items, adjust the image in the following order: Perpendicularly adjustment, 
thenSkew adjustment, then Magnification adjustment, and finally Registration adjustment.
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• When an Alignment profile is set and in use, your print server does not reflect that profile in the print options for 
print jobs.

Alignment Options

The Alignment Profiles feature includes the following options:

• Registration

• Perpendicularity

• Skew

• Magnification

• Front and Back Print Density Levels

Registration

Registration includes the following:

• Lead Registration: Use this option to adjust the lead edge of the image for side 1 and side 2 registration.

• Side Registration: Use this option to adjust the side edge of the image for side 1 and side 2 registration.

Perpendicularity

Use this when the image is straight on the page, but the corners are slanted, not at right (90 degree) angles to 
each other. This option adjusts the image digitally on the drum so that it aligns with the paper for both side 1 and 
side 2.

Skew
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Use this when the entire image on the page is slanted and not straight. This option adjusts the paper so that the 
image for side 1 and side 2 are not skewed but aligned with each other.

Magnification

Use this option to correct for image stretch from side 1 to side 2. The image can be enlarged or reduced as 
necessary.

Front and Back Print Density Levels

Tip: The Front Print Density Level and Back Print Density Level options are available with the Alignment feature only 
when the Grid 90 - Front & Back Test Print is selected and used.

FFrroonntt PPrriinntt DDeennssiittyy LLeevveell

This option is available for 1 Sided-Face Up, 1 Sided-Face Down, and 2 Sided.

BBaacckk PPrriinntt DDeennssiittyy LLeevveell

This option is available only for 2 Sided prints.

Before you use either print density level options, refer to the following information:

• Enter the desired print (dry ink/toner) density amount as required. Density amount matches approximately with 
the image density on the target prints.

• Density amounts range from 0–10%.

• If your output is a high dry ink/toner coverage area on the output, enter a higher print density amount.

• The system default value is 4%.

Automatic Alignment Information

Important: Before creating or using an alignment profile, always perform the Pre-alignment Procedure and 
then perform the Auto Alignment Procedure.

The press includes an internal color calibration function referred to as Full Width Array. The Full Width Array feature 
uses xerographic parameters and diagnostics to scan the finished image and correct errors in registration, density, 
and color. This is the process of calibrating the print server with the press.

The Full Width Array includes the Auto Alignment option which automatically adjusts the output image quickly 
and easily for different media types without having to progress through any alignment profile steps manually. This 
allows you to adjust the output print at point of need quickly and easily without losing the productivity time and 
simultaneously providing the best possible output quality for your prints.
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Alignment Procedures

The following Alignment procedures are available:

• Pre-alignment Procedure

• Auto Alignment Procedure

• Using Manual Test Print for an Alignment

• Creating or Editing an Alignment Procedure

Pre-alignment Procedure

Before you create a new or using an existing alignment profile, perform the following procedure:

1. Load the appropriate stock into the desired tray.

2. Print a sample output and verify for any misalignment of the output image.

3. If the output image is misaligned, perform the Auto Alignment Procedure.

Auto Alignment Procedure

The Auto Alignment option automatically performs corrective registration, perpendicularity, skew, and 
magnification adjustments.

Before you perform the following steps, perform the Pre-alignment Procedure

1. From the PredictPrint Media Manager main window, select Profiles. 

The Profiles window appears.

2. Ensure that the Alignment tab is displayed. 
Alignment should be the first tab displayed after selecting Profiles from the PredictPrint Media Manager main 
window.

3. Select New or Edit to create an alignment profile or to edit an existing alignment profile. 

Either the New Profile Properties or the Edit Profile Properties window opens.

4. If needed, enter a new name or modify the existing name.

5. Select the Auto Alignment button. 

The Test Print window for Auto Alignment opens.

6. Select the appropriate tray and profile name.

7. Select the desired Front and Back Print Density Levels. 
The Front and Back Print Density Levels are available only with the Grid 90 - Front & Back Test Print. This is the 
default test print that the Alignment feature uses.

8. Select the Start button. 

• The press runs a test print and performs the automatic adjustments.

• When the press completes the test print, the following message appears: Examine the test print. 
If the print alignment is an improvement, click "OK" to accept the new settings. 
If the alignment isn't an improvement, click "Cancel" to revert to the original 
settings.

Xerox® Versant® 4100 Press User Documentation 141

Working With



• Before you select either OK or Cancel, continue to the next step.

9. Review the test print output and choose one of the following: 

• The test print output is an improvement and is acceptable, perform the following: 

1. Select OK to close the Auto Alignment - Confirmation window.

2. Select OK to save and close the New Profile Properties or the Edit Profile Properties window.

3. Select Close to exit Profiles and return to the PredictPrint Media Manager main window.

• The test print output is not an improvement and is not acceptable. Select Cancel to close the Auto 
Alignment - Confirmation window and perform the procedure entitled Using Manual Test Print for an 
Alignment Profile.

Using Manual Test Print for an Alignment Profile

Before you perform the following steps, perform the Pre-alignment Procedure

1. From the PredictPrint Media Manager main window, select Profiles. 

The Profiles window appears.

2. Ensure that the Alignment tab appears. 
Alignment is the first tab displayed after selecting Profiles from the PredictPrint Media Manager main window.

3. Select New or Edit to create a new alignment profile or to edit an existing alignment profile. 
Either the New Profile Properties or the Edit Profile Properties window opens.

4. If desired, enter a new name or modify the existing name.

5. Test Print. 

The Test Print window opens.

6. Select the appropriate tray and profile name.

7. Select the desired Front and Back Print Density Levels. 
The Front and Back Print Density Levels are available only with the Grid 90 - Front & Back Test Print. This is the 
default test print that the Alignment feature uses.

8. Select the Start button. 

• The press runs a test print.

• Once the press completes the test print, the following message displays: Examine the test print. If 
the print alignment is an improvement, click "OK" to accept the new settings. If 
the alignment isn't an improvement, click "Cancel" to revert to the original 
settings.

• Before selecting either OK or Cancel, continue to the next step.
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9. Review the test print output and choose one of the following: 

• The test print output is an improvement and is acceptable, perform the following: 

1. Select OK to close the window.

2. Select OK to save and close the New or Edit Profile Properties window.

3. Select Close to exit Profiles and return to the PredictPrint Media Manager main window.

• The test print output is not an improvement and is not acceptable. Select Cancel and continue to the next 
step.

10. From the New or Edit Profile Properties window, perform the following: 

a. Select an alignment profile option Registration, Perpendicularity, Skew, or Magnification.

b. Make the desired selections for that option. 

Tip: When adjusting multiple items, adjust the image in the following order: Registration, Perpendicularity, 
Skew, and finally Magnification.

11. Select the Test Print button. 

The Test Print window opens.

12. Select the desired Test Print options, including: 

a. The desired paper tray

b. Print quantity 
It is recommended that you select a quantity of 10 test prints in order to best evaluate the printed output.

c. Choose the desired test print; options include: Grid 90 - Front & Back, Grid 90 - 204, and PH-REGI 

d. Long Edge Feed or Short Edge Feed

13. If using the Grid 90 - Front & Back Test Print, select the desired Front and Back Print Density Levels. 
The Front and Back Print Density Levels are available only with the Grid 90 - Front & Back Test Print. This is the 
default test print that the Alignment feature uses.

14. Select Start. 

A message displays stating that the test print is in progress.

15. Retrieve your printed output. 
Discard the first few prints as inconsistency tends to be greater with these first images.
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16. Evaluate the test prints by holding the output at eye level near a light source. This allows you to see the 
registration marks for side 1, and side 2 (if 2 sided output was selected). Choose one of the following: 

• If the alignment on the output is acceptable, continue to the next step.

• If the alignment between side 1 and side 2 is unacceptable and needs further adjusting, perform the 
following: 

Note: It takes multiple adjustments to the Alignment options and running test prints before the printed 
output meets customer satisfaction.

1. From the New or Edit Profile Properties window, select an alignment profile option (Registration, 
Perpendicularity, Skew, or Magnification).

2. Make the desired selections for that option.

3. Select the Test Print button.

4. Select the desired Test Print options, including: 

• The desired paper tray

• Print quantity (minimum of 10 is suggested)

• The desired test pattern, if necessary

• Long Edge Feed or Short Edge Feed

5. Select Start to run the test prints.

6. Retrieve your printed output, and discard the first few prints as inconsistency tends to be greater with 
these first images.

7. Evaluate the test prints by holding the output at eye level near a light source. This allows you to see the 
registration marks for side 1, and side 2 (if 2 sided output was selected). Choose one of the following: 

• If the alignment on the output is acceptable, continue to the next step.

• If the alignment between side 1 and side 2 continues to be unacceptable, contact the Customer 
Support Center for further assistance.

17. Select OK to save and close the alignment Profile Properties window. 
The new or edited profile procedure (for example, AlignmentProfile2) is displayed on the Alignment window 
and can be selected at any point of need in the future.

Creating or Editing an Alignment Profile

Use the following procedure to create a new or edit an existing alignment profile for adjusting Side 1 and Side 2 
image output.

Use the following procedure to create a new or edit an existing alignment profile for adjusting Side 1 and Side 2 
image output.

1. From the PredictPrint Media Manager main window, select Profiles. 

The Profiles window appears.

2. Ensure that the Alignment tab is displayed. 
Alignment should be the first tab displayed after selecting Profiles from the PredictPrint Media Manager main 
window.
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3. Select New or Edit to create a new alignment profile or to edit an existing alignment profile. 
Either the New Profile Properties or the Edit Profile Properties window opens.

4. If desired, enter a new name or modify the existing name.

5. Select and edit an alignment profile option (Registration, Perpendicularity, Skew, or Magnification), and 
make the desired selections for that option. 

Tip: When adjusting multiple items, adjust the image in the following order: Registration, Perpendicularity, 
Skew, and finally Magnification.

6. Select the Test Print button. 

The Test Print window appears.

7. Select the desired Test Print options, including: 

a. For the Test Pattern, select PH-Regi

b. The desired paper tray

c. Print quantity 
It is recommended that you select a quantity of 10 test prints in order to best evaluate the printed output.

d. Long Edge Feed or Short Edge Feed

8. Select Start. 

A message displays stating that the test print is in progress.

9. Retrieve your printed output. 
Discard the first few prints as inconsistency tends to be greater with these first images.

10. Evaluate the test prints by holding the output at eye level near a light source. This allows you to see the 
registration marks for side 1, and side 2 (if 2 sided output was selected). 

a. If you determine that the alignment between side 1 and side 2 is unacceptable and needs adjusting, 
repeat this procedure. 
It takes multiple adjustments to the Alignment options and running test prints before the printed output 
meets customer satisfaction.

b. Once the printed output is acceptable, continue to the next step.

11. If desired, select the another desired Alignment option and make the desired changes. 

a. Run some test prints.

b. Evaluate the output.

c. Repeat the previous two substeps for any additional Alignment options that require adjusting.

When the output meets customer satisfaction, continue to the next step.

12. Select OK to save and close the alignment Profile Properties window. 
The new or edited profile procedure (for example, AlignmentProfile2) is displayed on the Alignment window 
and can be selected at any point of need in the future.

FOLD ADJUSTMENTS

The Fold Adjustment feature allows you to adjust the fold position for various paper types, and set adjustment 
values to various default types. You can assign a set type to each tray.
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The Fold Adjustment feature is available when the press is connected to one of the following: 

• For Bi-Fold or Single Fold options, an optional Production Ready (PR) Booklet Maker Finisher or Crease and Two- 
Sided Trimmer device

• For C and Z Fold options, an optional finisher and the C/Z Folder device or Crease and Two-Sided Trimmer device

If the press is equipped with the optional Crease and Two-Sided Trimmer device, extra fold and crease types are 
available. For information, refer to Crease Types.

Fold Types

Tip: The Bi-Fold feature is available when the press is connected to an optional Production Ready Booklet Maker 
Finisher. The C-Fold and Z-fold features are available when the press is connected to an optional finisher and the 
optional C/Z Folder device.

Fold positions can be adjusted for the following fold types:

BBii--FFoolldd SSiinnggllee SShheeeett 

A Bi-Fold has one fold which creates two panels to the output. Bi-Fold (Single Sheet) output is delivered to the 
Booklet Output Tray.

BBii--FFoolldd MMuullttiippllee SShheeeettss aanndd BBii--FFoolldd MMuullttiippllee SShheeeettss SSttaapplleedd 

Multiple sheets or multiple sheets with staples can also be added to a Bi-Fold adjustment.

CC--FFoolldd 

A C-Fold has two folds which creates a three-panel output. C-Fold output is delivered to the C/Z Folder Output 
Tray.

ZZ--FFoolldd 
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A Z-Fold has two folds that are folded in opposite directions, resulting in a type of fan fold. Z-Fold output is 
delivered to the C/Z Folder Output Tray.

ZZ--FFoolldd HHaallff SShheeeett 

As with a regular Z-Fold, the Z-Fold Half Sheet has two folds that are folded in the opposite directions. The 
difference between a regular Z-Fold and a Z-Fold Half Sheet is that the half sheet is not folded in two equal 
folds. The two folds are unequal which allows one edge of the Z-Fold Half Sheet to have a longer edge. The 
longer edge allows for stapling or hole punching. Z-Fold Half Sheet output is delivered to the C/Z Folder Output 
Tray. 

Note: Each Z-Fold Half Sheet added to a stapled set counts as 10 sheets. It reduces the total number of 
sheets for any given specified weight range.

If the press is equipped with the optional Crease and Two-Sided Trimmer device, extra fold and crease types are 
available. For information, refer to Crease Types.

Optional Trimming with Fold and Crease Adjustment Profiles

The Trim and Crease selections are available only when the press is connected to the following optional devices:

• Production Ready Booklet Maker Finisher

• Crease and Two-Sided Trimmer

Tip: For the Crease and Two-Sided Trimmer device, the trim selection is different from the trimming that occurs with 
the SquareFold® Trimmer module. For more information, refer to the Crease and Two-Sided Trimmer.

CCrreeaassee aanndd TTrriimm OOppttiioonnss

The Crease and Trim options are only available with the following Fold options:

• Bi-Fold Single Sheet

• Bi-Fold Multiple Sheet

• Bi-Fold Multiple Sheets Stapled

TTrriimm SSeelleeccttiioonn

The optional Trim selection cuts the top and bottom of the media as it passes through the optional trimmer 
module. The trimmed media is sent to the optional Production Ready Booklet Maker Finisher for bi-folding.
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Feed direction from 
press

Red dotted lines represent trimming of the media.

Output to optional booklet 
maker finisher

CCrreeaassee SSeelleeccttiioonn

The optional Crease selection applies the Crease-Bi-Fold Single Sheet to the corresponding Bi-Fold Full Adjust test 
print.

Fold Adjustment Procedures

Fold Adjustment procedures:

• Bi-Fold Single Sheet Adjustment Procedure

• Bi-Fold Multiple Sheets Adjustment Procedure

• Bi-Fold Multiple Sheets Stapled Adjustment Procedure

• C-Fold Adjustment Procedure

• Z-Fold Adjustment Procedure

• Z-Fold Half-Sheet Adjustment Procedure

Bi-Fold Single Sheet Adjustment Procedure

Note: The Bi-Fold Multiple Sheets Adjustment feature is available with an optional Production Ready Booklet 
Maker Finisher.

1. From the PredictPrint Media Manager main window, select Profiles. 

The Profiles window appears.

2. Select the Fold Adjustment tab. 

The Fold Adjustment option appears.

3. Select either the New or Edit button. 
If you edit an existing fold adjustment, select the desired profile from the list and then select the Edit button.

The [New or Existing] Profile Properties window opens.

4. Type in a new name, or if needed, edit the existing name. 
It is recommend that you use a name such as Single Fold Plain or something that indicates the fold 
type.

5. From the drop-down menu, select the Bi-Fold Single Sheet Fold Type.

6. Select desired settings such as Size, Coating, and Weight.
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7. Select the Test Print button. 

The Fold Adjustment - Test Print window appears.

8. For the Trim option, ensure that Off is selected. 

Note: The Trim selection is available only when the press is connected to an optional booklet maker finisher 
and an optional trimmer device.

9. Select the desired tray, and then select the Start button. 

After the test prints complete, the [New or Existing] Profile Properties window reopens.

10. Obtain the printed samples from the output area of the press.

11. Measure the sample output and record the bi-fold position on a sheet of paper.

12. Select the correct the bi-fold position for the single sheet option: 

• Left Side of Fold is Longer: Use the Up and Down Arrow buttons and enter the measurement value that 
you obtain during the previous step in the A Length window. The left side of the fold is the side with the 
printed arrow on it. 

• Right Side of Fold is Longer: Use the Up and Down Arrow buttons and enter the measurement value 
that you obtain during the previous step in the A Length window.

• Left and Right Sides are Equal: When you use the Up and Down Arrow buttons to adjust the fold 
position, the fold image changes to show the new fold position. 

13. Use the Up and Down Arrow buttons and select the desired settings by first selecting Adjust Position, then 
entering the correct fold positions. 

Note: The Trim selection is available only when the press is connected to an optional booklet maker finisher 
and an optional trimmer device.

14. Run more test prints to ensure that the fold position is now correct. 

a. Select the Test Print button.

b. Select the desired tray.

c. If you use the Trim settings, ensure that On is selected for the Test Print Trim option.

d. Select the Start button.

e. Obtain the printed samples from the output area of the press.

f. Measure the sample output and record the bi-fold position on a sheet of paper.

g. Select the correct the bi-fold position for the single sheet option.

h. Repeat the previous steps until the desired output is achieved.
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15. When desired output is achieved, select OK to save and close the Fold Adjustment Profile. 

Note: After multiple attempts, if acceptable output cannot be achieved, select OK to save and close the 
profile. For further assistance, contact the Customer Support Center.

Bi-Fold Multiple Sheets Adjustment Procedure

Note: The Bi-Fold Multiple Sheets Adjustment feature is available with an optional Production Ready Booklet 
Maker Finisher.

1. From the PredictPrint Media Manager main window, select Profiles. 

The Profiles window appears.

2. Select the Fold Adjustment tab. 

The Fold Adjustment option appears.

3. Select either the New or Edit button. 
If you edit an existing fold adjustment, select the desired profile from the list and then select the Edit button.

The [New or Existing] Profile Properties window opens.

4. Type a new name, or if desired, edit the existing name. 
It is recommend that you use a name such as Single Fold Plain or something that indicates the fold 
type.

5. From the drop-down menu, select the Bi-Fold Multiple Sheets Fold Type.

6. Select desired settings such as Size, Coating, and Weight.

7. Select the Test Print button. 

The Fold Adjustment - Test Print window appears.

8. For the Trim option, ensure that Off is selected. 

Note: The Trim selection is available only when the press is connected to an optional Production Ready 
Booklet Maker Finisher and an optional trimmer device.

9. Select the desired tray, and then select the Start button. 
After the test prints complete, the [New or Existing] Profile Properties window reopens. 

Note: This screen varies depending on the selected Fold Type.

10. Obtain the printed samples from the output area of the press.

11. Measure the sample output and record the bi-fold position on a sheet of paper.
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12. Select the correct the bi-fold position for the multiple sheets option: 

• Left Side of Fold is Longer: Use the Up and Down Arrow buttons and enter the measurement value that 
you obtain during the previous step in the A Length window. The left side of the fold is the one with the 
printed arrow on it. 

• Right Side of Fold is Longer: Use the Up and Down Arrow buttons and enter the measurement value 
that you obtain during the previous step in the A Length window.

• Left and Right Sides are Equal
When you use the Up and Down Arrow buttons to adjust the fold position, the fold image changes to show 
the new fold position. 

13. To select the desired settings, use the Up and Down Arrow buttons and first select Adjust Position, then 
enter the correct fold positions. 

Note: The Trim selection is available only when the press is connected to an optional Production Ready 
Booklet Maker Finisher and an optional trimmer device.

14. Run more test prints to ensure that the fold position is now correct. 

a. Select the Test Print button.

b. Select the desired tray.

c. If you use the Trim settings, ensure that On is selected for the Test Print Trim option.

d. Select the Start button.

e. Obtain the printed samples from the output area of the press.

f. Measure the sample output and record the bi-fold position on a sheet of paper.

g. Select the correct the bi-fold position for the multiple sheets option.

h. Repeat the previous steps until the desired output is achieved.

15. When desired output is achieved, select OK to save and close the Fold Adjustment Profile. 

Note: After multiple attempts, if acceptable output cannot be achieved, select OK to save and close the 
profile. For further assistance, contact the Customer Support Center.

Bi-Fold Multiple Sheets Stapled Adjustment Procedure

Note: The Bi-Fold Multiple Sheets Stapled Adjustment feature is available with an optional finisher with a 
booklet maker.

1. From the PredictPrint Media Manager main window, select Profiles. 

The Profiles window appears.
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2. Select the Fold Adjustment tab. 

The Fold Adjustment option appears.

3. Select either the New or Edit button. 
If you are editing an existing fold adjustment, select the desired profile from the list and then select the Edit 
button.

The [New or Existing] Profile Properties window opens.

4. Type in a new name, or if desired, edit the existing name. 
It is recommend that you use a name such as Single Fold Plain or something that indicates the fold 
type.

5. From the drop-down menu, select the Bi-Fold Multiple Sheets Stapled Fold Type.

6. Select desired settings such as Size, Coating, and Weight.

7. Select the Test Print button. 

The Fold Adjustment - Test Print window displays.

8. For the Trim option, ensure that Off is selected. 

Note: The Trim selection is available only when the press is connected to an optional booklet maker finisher 
and an optional trimmer device.

9. Select the desired tray, and then select the Start button. 
When the test prints complete, the [New or Existing] Profile Properties window reopens. 

Note: This screen varies depending on the selected Fold Type.

10. Obtain the printed samples from the output area of the press.

11. Measure the sample output and record the bi-fold position on a sheet of paper.

12. Select the correct the bi-fold position for the multiple stapled sheets option: 

• Left Side of Fold is Longer: Use the Up and Down Arrow buttons and enter the measurement value that 
you obtain during the previous step in the A Length window. The left side of the fold is the one with the 
printed arrow on it. 

• Right Side of Fold is Longer: Use the Up and Down Arrow buttons and enter the measurement value 
that you obtain during the previous step in the A Length window.

• Left and Right Sides are Equal

13. Select the desired staple position option: 

• Left of Fold

• Right of Fold

• On the Fold

14. Use the Up and Down Arrow buttons and enter the measurement value that you obtain during the previous 
step in the A Length window the B Length window.
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15. Use Up and Down Arrow buttons and select the desired Trim and Skew Correction settings. 

Note: The Trim selection is available only when the press is connected to an optional booklet maker finisher 
and an optional trimmer device.

16. Run more test prints to ensure that the fold and staple positions are now correct. 

a. Select the Test Print button.

b. Select the desired tray.

c. If you use the Trim or Skew Correction settings, ensure that On is selected for the Test Print Trim option.

d. Select the Start button.

e. Obtain the printed samples from the output area of the press.

f. Measure the sample output and record both bi-fold positions on a sheet of paper.

g. Select the correct the bi-fold position for the multiple sheets option.

h. Select the desired staple position option.

i. Repeat the previous steps until the desired output is achieved.

17. When the desired output is achieved, select OK to save and close the Fold Adjustment Profile. 

Note: After multiple attempts, if acceptable output cannot be achieved, select OK to save and close the 
profile. For further assistance, contact the Customer Support Center.

C-Fold Adjustment Procedure

Note: The C and Z Fold Adjustments are available with a C/Z Folder device.

1. From the PredictPrint Media Manager main window, select Profiles. 

The Profiles window appears.

2. Select the Fold Adjustment tab. 

The Fold Adjustment option appears.

3. Select either the New or Edit button. 
If you edit an existing fold adjustment, select the desired profile from the list and then select the Edit button.

The [New or Existing] Profile Properties window opens.

4. Type in a new name, or if needed, edit the existing name. 
It is recommend that you use a name such as C Fold Plain or something that indicates the fold type.

5. From the drop-down menu, select the C-Fold for the Fold Type.

6. Select desired settings such as Size and Weight.

7. Select the Test Print button. 

The Fold Adjustment - Test Print window appears.

8. Select the desired tray, and then select the Start button. 
After the test prints complete, the [New or Existing] Profile Properties window reopens. 

Note: This screen varies depending on the selected Fold Type.
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9. Obtain the printed samples from the output area of the press.

10. Measure the sample output and record both C-Fold positions on a sheet of paper.

11. Use the Up and Down Arrow buttons and enter the measurement value that you obtain during the previous 
step in the A Length window and the B Length window. 

12. To ensure that the fold positions are now correct, run more test prints. 

a. Select the Test Print button.

b. Select the desired tray.

c. Select the Start button.

d. Obtain the printed samples from the output area of the press.

e. Measure the sample output and record both fold positions on a sheet of paper.

f. Enter the measurement A Length and B Length values.

g. Repeat the previous steps until the desired output is achieved.

13. When desired output is achieved, select OK to save and close the Fold Adjustment Profile. 

Note: After multiple attempts, if acceptable output cannot be achieved, select OK to save and close the 
profile. For further assistance, contact the Customer Support Center.

Z-Fold Adjustment Procedure

Note: The C and Z Fold Adjustments are available with a C/Z Folder device.

1. From the PredictPrint Media Manager main window, select Profiles. 

The Profiles window appears.

2. Select the Fold Adjustment tab. 

The Fold Adjustment option appears.

3. Select either the New or Edit button. 
If you edit an existing fold adjustment, select the desired profile from the list and then select the Edit button.

The [New or Existing] Profile Properties window opens.

4. Type in a new name, or if desired, edit the existing name. 
It is recommend that you use a name such as Z Fold Plain or something that indicates the fold type.

5. From the drop-down menu, select the Z-Fold for the Fold Type.

6. Select desired settings such as Size and Weight.

7. Select the Test Print button. 

The Fold Adjustment - Test Print window displays.
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8. Select the desired tray, and then select the Start button. 
Upon completion of the test prints, the [New or Existing] Profile Properties window reopens. 

Note: This screen varies depending on the selected Fold Type.

9. Obtain the printed samples from the output area of the press.

10. Measure the sample output and record both Z-Fold positions on a sheet of paper.

11. Use the Up and Down Arrow buttons and enter the measurement values that you obtained during the 
previous step in the A Length window and the B Length window. 

12. Run more test prints to ensure that the fold positions are now correct.  

a. Select the Test Print button.

b. Select the desired tray.

c. Select the Start button.

d. Obtain the printed samples from the output area of the press.

e. Measure the sample output and record both fold positions on a sheet of paper.

f. Enter the measurement A Length and B Length values.

g. Repeat the previous steps until the desired output is achieved.

13. When desired output is achieved, select OK to save and close the Fold Adjustment Profile. 

Note: After multiple attempts, if acceptable output cannot be achieved, select OK to save and close the 
profile. For further assistance, contact the Customer Support Center.

Z-Fold Half-Sheet Adjustment Procedure

Note: The C and Z Fold Adjustments are available with a C/Z Folder device.

1. From the PredictPrint Media Manager main window, select Profiles. 

The Profiles window appears.

2. Select the Fold Adjustment tab. 

The Fold Adjustment option appears.

3. Select either the New or Edit button. 
If you are editing an existing fold adjustment, select the desired profile from the list and then select the Edit 
button.

The [New or Existing] Profile Properties window opens.

4. Type in a new name, or if desired, edit the existing name. 
It is recommend that you use a name such as Z-Fold_Half-Sheet or something that indicates the fold type.

5. From the drop-down menu, select the Z-Fold Half Sheet for the Fold Type.
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6. Select desired settings such as Size and Weight.

7. Select the Test Print button. 

The Fold Adjustment - Test Print window displays.

8. Select the desired tray, and then select the Start button. 
Upon completion of the test prints, the [New or Existing] Profile Properties window reopens. 

Note: This screen varies depending on the selected Fold Type.

9. Obtain the printed samples from the output area of the press.

10. Measure the sample output and record both Z-Fold, Half-Sheet positions on a sheet of paper.

11. Use the Up and Down Arrow buttons and enter the measurement values that you obtained during the 
previous step in the A Length window and the B Length window. 

12. Run more test prints to ensure that the fold positions are now correct. 

a. Select the Test Print button.

b. Select the desired tray.

c. Select the Start button.

d. Obtain the printed samples from the output area of the press.

e. Measure the sample output and record both fold positions on a sheet of paper.

f. Enter the measurement A Length and B Length values.

g. Repeat the previous steps until the desired output is achieved.

13. When desired output is achieved, select OK to save and close the Fold Adjustment Profile. 

Note: After multiple attempts, if acceptable output cannot be achieved, select OK to save and close the 
profile. For further assistance, contact the Customer Support Center.

Crease Adjustments

Tip: The Crease Adjustment feature is available only when the press is connected to a Crease and Two-Sided 
Trimmer device.

The Fold Adjustment feature allows you to adjust the crease position for various paper types. The Crease 
Adjustment feature also helps minimize dry ink/toner peel and provides a smoother fold edge.

Note: Access the Crease Adjustment feature from the Fold Adjustment tab of the Profiles window.

Crease Types

Crease Types and Adjustments: The following types of creasing are available with the optional Crease and Two- 
Sided Trimmer module installed. 
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Note: The A, B, and C designations on the images indicate the corresponding crease position length 
adjustments that you can make.

CCrreeaassee -- BBii--FFoolldd SSiinnggllee SShheeeett 

A Bi-Fold has one crease which creates two panels to the output.

CCrreeaassee -- CC--FFoolldd 

A C-Fold has two creases which creates a three-panel output.

CCrreeaassee -- ZZ--FFoolldd 
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A Z-Fold has two creases that are folded in opposite directions, resulting in a type of fan fold. In the Z-Fold, the 
paper is creases in equal thirds.

ZZ--FFoolldd HHaallff SShheeeett 

As with a regular Z-Fold, the Z-Fold Half Sheet has two creases that are folded in the opposite directions. The 
difference between a regular Z-Fold and a Z-Fold Half Sheet is that the half sheet is not creased in two equal 
lengths. The two creases are unequal which allows one edge of the Z-Fold Half Sheet to have a longer edge. The 
longer edge allows for stapling or hole punching. 

Note: Each Z-Fold Half Sheet added to a stapled set counts as 10 sheets. It reduces the total number of 
sheets for any given specified weight range.

DDoouubbllee GGaattee FFoolldd 

In Double Gate Folds, the paper is creased in half and then creased in half again with a fold parallel to the first 
fold. One-half of the sheet of paper is nested inside the other half.

CCrreeaassee -- DDoouubbllee PPaarraalllleell FFoolldd 
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In Double Parallel Folds, the paper is creased with the two outside fold panels each folding toward the middle. 
One-half of the sheet of paper is nested inside the other half.

AAccccoorrddiioonn 33 FFoolldd 

An Accordion 3 Fold is similar to a Z-Fold; however, the paper is creased in thirds accordion style.

CCrreeaassee -- AAccccoorrddiioonn 44 FFoolldd 

In an Accordion 4 Fold, the paper is creased in quarters accordion style.

CCrreeaassee -- AAccccoorrddiioonn 55 FFoolldd 
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In an Accordion 5 Fold, the paper is creased in fifths accordion style.

Crease Adjustment Procedure

Use the following procedure to create any type of crease: 

Note: To make a Bi-Fold Single Sheet fold, the press is connected to a Production Ready Booklet Maker 
Finisher.

Note: To make fold types other than a Bi-Fold Single Sheet, the press is connected to either a C/Z Folder 
device or to a Crease and Two-Sided Trimmer device.

1. From the PredictPrint Media Manager main window, select Profiles. 

The Profiles window appears.

2. Select the Fold Adjustment tab. 

The Fold Adjustment option appears.

3. Select either the New or Edit button. 
If you edit an existing crease adjustment, select the desired profile from the list and then select the Edit 
button.

The [New or Existing] Profile Properties window opens.

4. Type in a new name, or if needed, edit the existing name. 
It is recommend that you use a name that indicates the crease type.

5. From the drop-down menu, select the desired Fold Type.

6. Select desired settings such as Size, Coating, and Weight.

7. Make any desired changes to the following fields: 

a. Crease Position: Enter a length between -20.0–20.0 mm.

b. Adjust Position: Enter a value between -20.0–20.0 mm.

c. Crease Pressure: For best results, enter a value between 2–5.

8. Select the Test Print button. 

When the Fold Adjustment - Test Print window appears, select the desired tray.

9. If necessary, ensure that Off is selected for the Trim option. 

Note: The Trim selection is available only when the press is connected to an optional Production Ready 
Booklet Maker Finisher and an optional trimmer device.
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10. Select the Start button. 

After the test prints complete, the [New or Existing] Profile Properties window reopens. 

Note: This screen varies depending on the selected Crease Type.

11. Obtain the printed samples from the output area of the press.

12. Measure the sample output and record the crease position values on a sheet of paper.

13. Use the Up and Down Arrow buttons and enter the measurement value that you obtain during the previous 
step for each of the lengths measured into the appropriate window. 

Note: The number of measurement values ranges from 1-5 depending on the crease type.

14. To ensure that the crease positions are now correct, run more test prints.

15. Repeat steps – until the desired output is achieved.

16. When desired output is achieved, select OK to save and close the Fold Adjustment Profile. 

Note: After multiple attempts, if acceptable output cannot be achieved, select OK to save and close the 
profile. For further assistance, contact the Customer Support Center.

Xerox® Versant® 4100 Press User Documentation 161

Working With



Print Job Submission

INFORMATION TO KNOW BEFORE PRINTING A JOB

BBaassiicc JJoobb WWoorrkkffllooww

The basic workflow for setting up a job and submitting it from the print server is:

1. Within the PredictPrint Media Manager on the print server, set up and define the stock properties for the paper 
you will use and assign that paper to the feeder tray. 

2. At the press, load the appropriate paper to be used for the job that matches the tray property settings.

3. At the print server main window, customize your job such as inserting special pages and tabs and create your 
print queue that defines the attributes of those jobs sent to the queue.

4. Submit the job file from the print server to the networked press for printing. 

One of the following print servers can be used with your press: 

• Xerox® EX 4100 Print Server, Powered by Fiery®

• Xerox® EX-P 4100 Print Server, Powered by Fiery®

PPrreeddiiccttPPrriinntt MMeeddiiaa MMaannaaggeerr

Begin your job workflow at the PredictPrint Media Manager. The PredictPrint Media Manager is a separate 
application residing on the print server desktop only and not at the press. At the PredictPrint Media Manager main 
window, set up and manage the stock types, profiles associated with a stock, the Stock Library, and the feeder tray 
attributes to use when printing a job.

Note: For complete information on the PredictPrint Media Manager and on how to set up your stock and 
paper tray settings for the print job, refer to PredictPrint Media Manager.

EEnnaabbllee PPaappeerr TTrraayy FFeeaattuurreess

At the press, the System Administrator can enable the Auto Tray Switching feature and prioritize the trays to switch 
over to using when one tray with the same paper becomes empty.

DDeeffiinnee JJoobbss aanndd QQuueeuueess

Refer to the Print Server documentation to learn about programming various types of jobs including tab jobs and 
assembling different stock types from different trays for the same job.

HOW TO SUBMIT A PRINT JOB

There are a variety of ways to submit your job for printing:

• From your computer workstation (PC or Mac), using print drivers such as PostScript and Printer Command 
Language (PCL), you can submit a document file to the print server queue. From the print server, you would 
then submit the job to the press.  
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Note: Make sure the appropriate print drivers have been installed on your computer. Refer to your print 
driver documentation or the Xerox web site for more information on how to download or install print 
drivers.

• At any remote workstation, using a Hot Folders application to submit the document file to the print server.

• At the print server, importing or adding a document file to a print queue. Manage the job settings of the 
document and then submit to the press for printing.

For information on how to set up the properties for a job that you submit from the print server, refer to the 
PredictPrint Media Manager.

PRINTING FROM YOUR COMPUTER

The system supports Fiery EX and EX-P print drivers. Through print drivers installed on your computer or Mac, you 
can send a document file from your desktop to the print server, which can then be submitted to the press for 
printing.

Note: You can also use a drag and drop Hot Folders feature by which to send your files to the print server for 
printing to the press.

1. From your computer, select the file you want to print and open it in its application.

2. Select File > Print.

3. Select a print server queue.

4. For the print queue, select Properties.

5. Select output options, such as quantity or 1-sided or 2-sided printing.

6. To close the Properties window, click OK.

7. To send the job to the print server queue, click Print.

PRINTING FROM THE EX OR EX-P  PRINT SERVER

From your computer, you can submit your document files to a directory on the print server through the use of 
installed print drivers. You can also copy the document files onto a USB drive, then connect those devices to the 
print server for importing.

1. If you copied the file onto a storage device, connect your device to the print server and select Services > Print 
From File. 

2. From the EX or EX-P Print Server, select File > Import Job.

3. Click Add.

4. Locate your storage device or other directory containing the document files.

5. Select and highlight one of the document files. Click Open.

6. Click Import.

7. Select the desired queue such as Process and Hold or Print and Hold. 

The job is sent to the selected queue or to the press for immediate printing.
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INFORMATION ABOUT PRINTING ON TABS

Before you print a job with tabs, read the following information:

• You can set up your job to insert preprinted tabs into your document. 

• Use one tray for the body pages, another tray for the preprinted tab stock, and another tray for cover or back 
pages.

• While you can print tab stock from any of the paper trays on the system (Trays 1, 2, 3, 5, 6, 7, 8, or 9), the 
recommendation is to use Trays 6, 7, 8, or 9 for best results.

• If you plan to apply staple or punch finishing, use Trays 5, 6, 7, 8, or 9 only.

• Loading orientation depends on what tray you are using. 

• For information and instructions on how to load and align tab stock in the trays, refer to Paper and Media.

PPrriinntt SSeerrvveerr IInnffoorrmmaattiioonn aabboouutt PPrrooggrraammmmiinngg aa JJoobb wwiitthh TTaabbss

There are many types of tab stock and tab sequences available. Precut tabs are commonly used and have two 
different orientations: the single straight collated tab stock or the single reverse collated tab stock.

When programming tab jobs and loading tab stock, consider the following:

• Precut tabs can only print 1-sided

• There are specific job settings that you need to define such as tab order, sequence, number of bank sets, stock 
weight, paper size, and insertion before or after body pages. Refer to your print server documentation for more 
detailed setting information.

• Always load tab stock LEF into the tray where the straight edge of the stock is the lead edge and the tabs are 
oriented at the trail edge.

• Always use a complete set or bank or tabs in the paper tray.

• If staple or punch finishing, use trays 5, 6, 7, 8, 9, or T1 (Inserter).

Printing Tabs from the Print Server

1. From the print server, create and define the Tab stock for the paper tray you will be using.

2. Load the Tab stock in Trays 1, 2, 3, 5, 6, 7, 8, 9, or T1 (optional Inserter). Refer to the Paper and Media chapter.

3. From the print server window, access the Held queue that contains your document. Select the document you 
want to configure with tabs. Double-click to open the file properties.

4. Once all settings are made, select Print. 

The press prints the complete set of tabs with the body pages defined. Any extra tabs not used in the job are 
sent to the output tray.
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Feeding Devices

DUAL ADVANCED OVERSIZED HIGH CAPACITY FEEDER (TRAYS 8  AND 9)

The Dual Advanced High Capacity Feeder is an optional feeding device that can be added to the system to extend 
the paper capacities by providing two additional trays. This optional feeding device contains Trays 8 and 9. 

These trays feed a variety of stock sizes, including standard, heavyweight, and large-sized stocks. Each tray holds 
2,000 sheets of coated and uncoated stock.

The following illustrations show the Trays 8 and 9 with and without the Tray 5 (Bypass).

Trays 8 and 9 without Tray 5 Trays 8 and 9 with Tray 5 

Trays 8 and 9 Components
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1. Paper Jam and Error Indicator Panel

2. Paper Level Indicators

3. Optional Tray 5 (Bypass)

4. Circuit Breaker Switch

5. Tray 8

6. Tray 9

7. Feeder Front Cover

8. Top Drawer (on Trays 6 and 7)

Paper and Media for Trays 8 and 9

General Paper Loading Guidelines

• Fan paper before loading it in the paper tray.

• Do not overfill the paper trays. Do not load paper above the indicated maximum fill line in the tray.

• Adjust the paper guides to fit the paper size.

• If excessive jams occur, use paper or other approved media from a new package.

• Do not print on label media after a label has been removed from a sheet.

Unsupported Media

Some paper and other media types can cause poor output quality, increased paper jams, or damage the press. Do 
not use the following:

• Rough or porous paper

• Inkjet paper

• Paper that is business-card size

• Paper that is folded or wrinkled

• Paper that is curled more than 0.47 in., 12 mm

• Paper with cutouts or perforations

• Stapled paper

• Damp paper 

• Thermal or heat-transfer paper

• Envelopes with windows, metal clasps, side seams, or adhesives with release strips

• Padded envelopes

• Envelopes 

Note: For envelopes, use Trays 5, 6, or 7.

Note: In addition to the above list, there may be other media that is not recommended or supported. For 
details, please contact your local Xerox representative.
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Paper and Media Storage Guidelines

Storing paper and other media properly contributes to optimum print quality.

• Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from ultraviolet and 
visible light. Ultraviolet light, from the sun and fluorescent bulbs, is particularly damaging to paper.

• Reduce the exposure of paper to strong lights for long periods of time.

• Maintain constant temperatures and relative humidity.

• Avoid storing paper in locations that are damp or collect moisture.

• Store paper flat on pallets, cartons, shelves, or in cabinets.

• Avoid food or drinks in the area where paper is stored or handled.

• Do not open sealed packages of paper until you are ready to load the paper into the trays. Leave stored paper 
in the original packaging. The paper wrapper protects the paper from moisture loss or gain.

• Some special media is packaged inside resealable plastic bags. Store the media inside the bag until you are 
ready to use it. Keep unused media in the bag and reseal it for protection.

Supported Paper

PPaappeerr SSppeecciiffiiccaattiioonnss ffoorr TTrraayyss 88 aanndd 99

For information on paper tray specifications, refer to Paper Specifications for All Trays.

Note: Always refer to the Recommended Media List (RML) or Tested Substrate List (TSL) for a comprehensive 
list of supported media. You can access the latest RML or TSL version from www.xerox.com and https://www. 
xerox.com/predictprintmedia.

PPaappeerr SSiizzee RRaannggeess ffoorr TTrraayyss 88 aanndd 99

MINIMUM SIZE MAXIMUM SIZE 

98 x 146 mm (3.86 x 5.75 in.) 330.2 x 488 mm (13 x 19.2 in.) 

PPaappeerr TTrraayy IInnffoorrmmaattiioonn ffoorr TTrraayyss 88 aanndd 99

Note: Each feeder tray has a stock loading label. When loading media into the tray, refer to the labels on the 
inside panel of the feeder tray for the correct orientation of that stock type.

The specifications for each tray are:

• Maximum of 2000 sheets of 24 lb. (90 g/m2) uncoated paper; 2100 sheets of 82 g/m2 and 2300 sheets of 64 
g/m2

• Paper weight range of 52–400 g/m2

• Stock types include transparencies, heavyweight, coated and uncoated, hole-punched, and tabs

Loading Paper in Trays 8 and 9

1. Select the appropriate paper stock for your print job.
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2. Pull out the tray slowly until it stops. 

3. Open the ream of paper with the seam side facing up.

4. Fan the sheets before loading them into the tray.

5. Extend the paper guides outward until they stop. 

6. Load and align the edge of the paper against the right edge of the tray. 

Paper can be loaded in the LEF or portrait, or SEF or landscape direction.

7. Adjust the paper guides by pressing in the guide releases and carefully moving the guides until they lightly 
touch the edges of the material in the tray. 

Note: Do not load materials above the MMAAXX line located on the guides.
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8. Gently push in the tray until it comes to a stop. 

The Stock Wizard opens on the print server.

9. Scan the barcode on the stock, then to set up the stock, follow the steps in the Stock Wizard. 

Note: For details on setting up the stock in the Stock Wizard, refer to Scanning a Media Barcode.

Paper Feed Performance in Trays 8 and 9

If misregistration or skew occurs on printed output that was fed from Trays 8 or 9, manual adjustment of the paper- 
feed levers may improve and correct the printed output.

Important: For most print jobs, these levers should remain in their default position. The position of these 
levers should be changed only if there is a skew problem when running a specific print job or media type. 
Changing the levers may cause more skew problems when running certain media types such as coated, 
label, tab stock, hole-punched paper, transparency, film, postcards, and envelopes.

The paper-feed adjustment levers are found in Trays 8 and 9. These levers are used to improve paper feed accuracy 
and to reduce paper skew problems.

1. Rear Paper-feed Adjustment Lever

2. Right-side Paper-feed Adjustment Lever

IImmpprroovviinngg PPaappeerr FFeeeedd PPeerrffoorrmmaannccee iinn TTrraayyss 88 aanndd 99

1. Slowly pull the tray out until it stops to open it. 

2. Ensure that the desired paper is loaded into the tray.

3. Go to the PredictPrint Media Manager on the print server. 
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a. From the Tray Properties window, verify the correct paper information including size, type, weight, and 
paper curl or alignment option for the tray. 

b. Select OK and close the Tray Properties window.

4. On the tray, slide the rear paper-feed adjustment lever to the right. 

5. Close the tray by slowly pushing it in until it comes to a stop.

6. Run your print job.

7. After the print job finishes, open the tray and return the rear paper-feed adjustment lever to its default position 
by sliding it to the left. 

Leave the tray open and continue to the next step.

8. Retrieve and evaluate the printed output; choose one of the following: 

• The paper is fed accurately without skew and the printed output is satisfactory. Close the tray and your task 
is completed. 

• The paper is skewed and the printed output is unsatisfactory; proceed to the next step. 

9. Adjust the right-side paper-feed lever:  
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a. On the tray, slide the right-side paper-feed adjustment lever toward the rear of the tray. 

b. Close the tray and verify the tray settings from the PredictPrint Media Manager on the print server.

c. Run your print job.

10. Retrieve and evaluate the printed output; choose one of the following: 

• The paper is fed accurately without skew and the printed output is satisfactory; perform the following: 

1. Open the tray.

2. Return the right-side paper-feed adjustment lever to its default position by sliding it toward the front of 
the tray.  

3. Close the tray and your task is completed. 

• The paper is skewed and the printed output is unsatisfactory; proceed to the next step. 

11. Adjust both levers: 
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a. Open the tray and slide the rear paper-feed adjustment lever to the right. 

b. Ensure that the right-side paper-feed adjustment lever still is in the rear position. 

c. Close the tray and verify the tray settings from the PredictPrint Media Manager on the print server.

d. Run your print job.

12. After the print job finishes, open the tray and return both levers to their default positions:  

a. Return the rear paper-feed adjustment lever to its default position by sliding it to the left. 
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b. Return the right-side paper-feed adjustment lever to its default position by sliding it toward the front of the 
tray.  

c. Close the tray and continue to the next step.

13. Retrieve and evaluate the printed output; choose one of the following: 

• The paper is fed accurately without skew and the printed output is satisfactory; your task is completed. 

• The paper is skewed and the printed output is unsatisfactory; continue to the next step.

14. If you are still having skew adjustment problems, refer to the PredictPrint Media Manager. If necessary, perform 
one of the following: 

• Create / use an Alignment Profile to resolve the problem.

• Adjust the Aligner Roll Pressure to resolve the problem.

• Adjust the Regi-Loop to resolve the problem.
If the problem continues, contact the Customer Support Center. 

Important: If using an Advanced Stock Setup feature, always return the feature to its default setting 
before using the press.

Printing on Special Media

TTrraannssppaarreenncciieess

GGuuiiddeelliinneess ffoorr PPrriinnttiinngg oonn TTrraannssppaarreenncciieess

Always refer to the following guidelines before using transparencies:

• For optimum system performance and image projection, use Xerox removable stripe transparency materials. 
These premium transparencies are specifically designed to provide optimum print quality.

• Use of other transparencies may cause press damage and result in excessive service calls.

• Transparencies can be printed from all trays.

• Use only transparency stock listed in the Tested Substrate List (TSL). 

• Do not intermix paper with individual transparencies in a tray. Jams can occur.

• Do not load more than 100 transparencies in a paper tray at one time.

• Load 8.5 x 11 in., A4 transparencies long edge feed only (portrait).
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• Fan the transparencies to stop them from sticking together before loading.

• Load transparencies on top of a small stack of same-size paper.

• At the PredictPrint Media Manager, ensure that you select Transparency as the Paper or Media Type and 
select the tray that contains the transparencies as the Paper Source.

• The maximum output stack height should not exceed 100 transparencies.

LLooaaddiinngg TTrraannssppaarreenncciieess iinn TTrraayyss 88 aanndd 99

Load the transparencies in the LEF (portrait) direction and align the edge of the transparencies against the right 
edge of the tray, with the side to be printed on facing up.

HHoollee--ppuunncchheedd PPaappeerr

GGuuiiddeelliinneess ffoorr PPrriinnttiinngg oonn HHoollee--ppuunncchheedd PPaappeerr

Hole-punched paper is defined as having two or more holes along one edge for use in ring binders and notebooks. 

Always refer to the following guidelines before using hole-punched paper:

• Paper with punched holes can be printed from all trays.

• Hole-punched paper can be loaded in the LEF or portrait or SEF or landscape direction.

• Position the holes along the feed edge, as shown on the image on the front of the tray. 

• Load hole-punched paper with the side to be printed on facing up. 

• To prevent jams or damage, ensure that no plugs (pieces cut out of the paper to create the holes) remain in the 
stack.

LLooaaddiinngg HHoollee--ppuunncchheedd PPaappeerr iinn TTrraayyss 88 aanndd 99

LLoonngg--eeddggee ((LLEEFF)) FFeeeedd DDiirreeccttiioonn

Load and align the paper against the right side of the tray for LEF direction.
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SShhoorrtt--eeddggee ((SSEEFF)) FFeeeedd DDiirreeccttiioonn

Load and align the paper against the right side of the tray for SEF direction.

TTaabb SSttoocckk

GGuuiiddeelliinneess ffoorr PPrriinnttiinngg oonn TTaabb SSttoocckk

Always refer to the following guidelines before using tab stock:

• Tab Stock can be printed from all trays.

• Tabs are loaded in the tray only in the long-edge feed (LEF) direction.

• Tab stock is loaded so the straight edge of the stock is in the feed direction.

• You can load single straight collated or single reverse collated tab stock.

• Refer to the print server documentation for more detailed information on how to set up a tab job at your print 
server.

• If a jam occurs while running tabbed sets, cancel the job and start again.

LLooaaddiinngg TTaabb SSttoocckk iinn TTrraayyss 88 aanndd 99

Load the tab stock LEF, with the side to be printed on facing down; align the straight edge of the tab stock against 
the right edge of the tray and the tabs to the left. 
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LLooaaddiinngg SSttrraaiigghhtt CCoollllaatteedd TTaabbss

Load straight collated tabs with the first blank tab cutout toward the front of the tray.

LLooaaddiinngg RReevveerrssee CCoollllaatteedd TTaabbss

Load reverse collated tabs with the first blank tab cutout toward the rear of the tray.

LLaabbeellss

GGuuiiddeelliinneess ffoorr PPrriinnttiinngg oonn LLaabbeellss

Always refer to the following guidelines before using labels:

• Labels can be printed from all trays. 

• Trays 8 and 9 can hold a maximum of 400 g/m2.

• When submitting your print file, select Labels as the Paper Type, then select the tray containing the labels as 
the Paper Source.

• Use labels designed for laser printing.

• Do not use vinyl labels or dry gum labels.

• Only print on one side of the sheet of labels.
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• Do not use any sheet where labels are missing as it can damage the press.

• Store unused labels flat in their original packaging.

• Leave the label sheets inside the original packaging until ready to use.

• Return any unused sheets of labels to their original packaging and reseal.

• Do not store labels in extremely dry, humid, hot, or cold conditions.

• Rotate stock frequently. 

• Long periods of storage in extreme conditions can cause labels to curl and jam in the press.

LLooaaddiinngg LLaabbeellss iinn TTrraayyss 88 aanndd 99

Load labels in Trays 8 and 9 with the labels face up.

GGlloossssyy PPaappeerr

GGuuiiddeelliinneess ffoorr PPrriinnttiinngg oonn GGlloossssyy PPaappeerr

Glossy Paper is a type of coated paper that can be printed from all trays.

Always refer to the following guidelines before using glossy paper:

• Select Coated as the Paper Type, then select the tray containing the glossy paper as the Paper Source. 

• Select the correct Paper Weight and Size.

• Do not open sealed packages of glossy paper until you are ready to load them into the press.

• Store glossy paper flat in the original packaging.

• Remove all other paper from the tray before loading glossy paper.

• Load only the amount of glossy paper you plan to use. Remove the unused portion from the tray when you have 
finished printing.

• Replace the unused portion in the original wrapper and seal for later use.

• Rotate stock frequently.

• Long periods of storage in extreme conditions can cause glossy paper to curl and jam in the press 

PPoossttccaarrddss

GGuuiiddeelliinneess ffoorr PPrriinnttiinngg oonn PPoossttccaarrddss

Always refer to the following guidelines before using postcard stock:

Tip: When printing postcards in Trays 8 or 9, the Postcard Bracket is required. Always install the postcard bracket 
before loading and printing postcards from these trays.

• Postcards can be printed from Trays 5, 6, 7, 8, and 9.

• Do not open sealed packages of postcard stock until you are ready to load them into the press.

• Store postcard stock flat in the original packaging.

• Remove all other paper from the tray before loading postcard stock.
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• Load only the amount of postcard stock you plan to use Remove the unused portion from the tray when you 
have finished printing.

• Replace the unused portion in the original wrapper and seal for later use.

• If you use Trays 8 or 9, always remove and store the Postcard Bracket when you are finished printing.

• Rotate the postcard stock frequently.

• Long periods of storage in extreme conditions can cause postcard stock to jam in the press.

• When you submit your print file, from the PredictPrint Media Manager or from your print driver, select the 
following options: 

– Select Custom Paper as the Paper Type, then enter the Size dimensions of the postcard.  

– Enter the Paper Weight for the postcard stock. 

– Select Tray 8 or 9 as the Paper Source. 

SSuuppppoorrtteedd PPoossttccaarrdd SSiizzeess

POSTCARD SIZE FEED DIRECTION 

101.6 x 152.4 mm (4 x 6 in.) Short Edge Feed (SEF) 

A6, 148 x 105 mm (5.8 x 4.1 in.) Short Edge Feed (SEF) 

LLooaaddiinngg PPoossttccaarrddss iinn TTrraayyss 88 aanndd 99

Note: Install the postcard bracket before printing postcards.

1. Slowly open one of the paper trays until it stops and remove the paper. 

2. Move the paper guides out to their largest position. 
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3. To remove the postcard bracket, loosen the screw on the left side of the tray (1) and remove the bracket (2). 

4. Install the postcard bracket:  

a. Sit the bracket on the locating pins on the upper frame and in the grooves on the bottom of the tray.

b. Tighten the thumb screw so it locks the postcard bracket in place.

5. Load the postcard stock SEF and against the right side of the tray.  

6. Adjust the paper guides against the stock. 

7. Close the paper tray and confirm the new settings at the print server.

8. Run your print job.
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9. Upon completion of your print job, remove the postcard stock and the postcard bracket from the tray.

10. Store the postcard bracket by inserting it into the storage area on the left side of the tray (1) and tightening 
the screw (2). 

Trays 8 and 9 Specifications

ITEM SPECIFICATION 

Sheet size Refer to Paper Specifications for All Trays

Paper weight 52–400 g/m2 

Paper capacity 2000 sheets per tray (total of 4000 sheets)

Important: When using up to Xerox 24 lb., 90 g/m2 bond paper.
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Xerox® XLS Automatic Feeding Kit

Using the Xerox® XLS Automatic Feeding Kit

The optional Xerox® XLS Automatic Feeding Kit fluffs the media in the Multi-Sheet Inserter using blower fans. The 
Xerox® XLS Automatic Feeding Kit can improve sheet feed accuracy for long media and heavyweight media.

If the power switch for the Xerox® XLS Automatic Feeding Kit is in the On position, when you add media to the 
Multi-Sheet Inserter, the blower fans power on automatically.

XEROX® XLS AUTOMATIC FEEDING KIT COMPONENTS 

1. Power Switch 2. Blower Fans 

3. Speed Dial 

1. To power on the Xerox® XLS Automatic Feeding Kit, move the power switch to the On position. The power 
switch is located on the rear side of the Multi-Sheet Inserter tray.

2. Load media into the Multi-Sheet Inserter tray. The blower fans power on automatically.
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3. To adjust the blower fan speed, turn the dial to the appropriate speed for the weight of the media. 

BLOWER FAN SPEED MEDIA WEIGHT SUPPORTED 

Less than 100 g/m2 

100–200 g/m2 

More than 200 g/m2 

Note: When the Xerox® XLS Automatic Feeding Kit is not in use, to ensure that the blower fans power off, 
remove all material from the Multi-Sheet Inserter tray.

Note: Whenever you power off the press, Xerox recommends that you also power off the Xerox® XLS 
Automatic Feeding Kit using its power switch.

HIGH CAPACITY XLS VACUUM FEEDER AND DUAL HIGH CAPACITY XLS VACUUM FEEDER

High Capacity XLS Vacuum Feeder (HCVF) Components
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1. Error Indicator

2. Paper Level and Tray in Use Indicator

3. Tray 5, Bypass Tray

4. Extra Long Sheet (XLS) Feeder

5. Circuit Breaker Switch

6. Tray 6 of High Capacity XLS Vacuum Feeder

7. Tray 7 of High Capacity XLS Vacuum Feeder

8. Right Side Cover

The following information applies to the High Capacity XLS Vacuum Feeder:

• When a paper jam occurs, the error indicator illuminates.

• For the paper level indicator, when the corresponding tray is active, the top active indicator illuminates. The four 
center indicators, 1=25%, indicate the amount of remaining paper. When all four indicators are off, the tray is 
empty and the Empty Paper Indicator illuminates.

• In the event of fault current or a short circuit, the circuit breaker disconnects the electrical supply to the device 
automatically.

• To clear paper jams, open the right side cover.

Dual High Capacity XLS Vacuum Feeder Components

1. Paper Level and Tray in Use Indicator for Trays 6 and 7

2. Error Indicator for Trays 8 and 9

3. Paper Level and Tray in Use Indicator for Trays 8 and 9
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4. Tray 5, Bypass Tray

5. Extra Long Sheet (XLS) Feeder

6. Circuit Breaker Switch

7. Tray 8 of High Capacity XLS Vacuum Feeder

8. Tray 9 of High Capacity XLS Vacuum Feeder

9. Right Side Cover for Trays 8 and 9

10. Tray 6 of High Capacity XLS Vacuum Feeder

11. Tray 7 of High Capacity XLS Vacuum Feeder

12. Right Side Cover for Trays 6 and 7

13. Error Indicator for Trays 6 and 7

Circuit Breaker Switch

During normal operating conditions. the circuit breaker switch is in the up position. Before you move the HCVF, or if 
the HCVF is idle for an extended period of time, switch off the circuit breaker. To switch off the circuit breaker, move 
the switch to the down position.

1. Circuit Breaker Switch

2. Test Button

Note: When a fault is detected, the power to the circuit breaker is disconnected automatically. Do not touch 
the breakers under normal operating conditions.
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High Capacity XLS Vacuum Feeder Specifications

SSuuppppoorrtteedd PPaappeerr TTyyppeess aanndd WWeeiigghhttss

TRAYS PAPER SIZES WEIGHTS 

Tray 5, Bypass Tray* Standard:
• Maximum: SRA3 (320 x 450 

mm),  

320 x 488 mm (12.6 x 19.2 
in.)

• Minimum: Postcard, 100 x 
148 mm (3.9 x 5.8 in.) 

52–400 g/m2 

Custom: 
• Width: 98–330.2 mm (3.8– 

13 in.) 
• Length: 146–660 mm (5.7– 

26 in.) 

HCVF Tray 7 or  

Dual HCVF Trays 6, 7, and 9

Standard: 
• Maximum: SRA3 (320 x 450 

mm),  

320 x 488 mm (12.6 x 19.2 
in.)

• Minimum: Postcard, 100 x 
148 mm (3.9 x 5.8 in.) 

52–400 g/m2 

Custom: 
• Width: 98–330.2 mm (3.8– 

13 in.) 
• Length: 148–488 mm (5.8– 

19.2 in.) 
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TRAYS PAPER SIZES WEIGHTS 

Extra Long Sheet (XLS) Feeder Standard: 
• Maximum: SRA3 (320 x 450 

mm),  

320 x 488 mm (12.6 x 19.2 
in.)

• Minimum: A4 (210 x 297 
mm), 8.3 x 11.7 in. 

52–400 g/m2 

Custom: 
• Width: 210–330.2 mm (8.2– 

13 in.) 
• Length: 210–1200 mm (8.2– 

47.2 in.) 

* If the press is equipped with a Dual High Capacity XLS Vacuum Feeder, the Tray 5, bypass tray, is installed on 
the second HCVF. 

HHiigghh CCaappaacciittyy XXLLSS VVaaccuuuumm FFeeeeddeerr TTrraayy CCaappaacciittyy

• Tray 5, Bypass Tray: 250 sheets

• HCVF Tray 7 or Dual HCVF Trays 6, 7, and 9: 2100 sheets for each tray

• Extra Long Sheet (XLS) Feeder: 700 sheets

Note: The values are based on 90 g/m2 paper.

Paper and Media for High Capacity XLS Vacuum Feeder

Important: 

• Loading paper above the maximum fill line can cause paper jams or device malfunctions.

• Position the guides correctly to match the paper size. Incorrectly positioned guides can cause misfeeds and 
paper jams.

• When the power is reconnected while the bottom plate of the tray is rising, it is possible that the plate does not 
continue to move up. In this case, pull out the tray, ensure that the plate lowers fully, then push the tray into the 
machine slowly and firmly.

Note: When paper sheets are loaded or fed, the tray makes a sound of supplying air. This sound is caused by 
the Air Assist function and not an abnormal noise.

Loading Paper in the High Capacity XLS Vacuum Feeder (HCVF) Trays

Important: If fewer than 100 sheets of paper are loaded, the tray guides apply too much pressure to the 
paper, which causes the paper to be skewed. Skewed paper leads to paper jams.
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1. Pull out the tray toward you until it stops. 

2. Remove any paper remaining in the tray.

3. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. This 
procedure separates any sheets that are stuck together and reduces the possibility of paper jams. 

4. Load 100–500 sheets of paper. For preprinted media, load the paper with the printed side facing up. 

a. Align the edges of the paper against the right edge of the tray (1). 
Paper can be loaded in the long-edge-feed (LEF) or portrait direction, or in the short-edge-feed (SEF) or 
landscape direction.

b. To adjust the paper guides, press in the guide release lever and move the guides carefully until they touch 
lightly the edges of the paper in the tray (2).
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5. Load the remaining sheets into the tray, then align the paper edges in the direction shown (1). To adjust the 
paper guides, press in the guide release lever and move the guides carefully until they touch lightly the edges of 
the paper (2). 

6. Gently push the tray into the press until it stops.

Special Media

HHoollee--PPuunncchheedd PPaappeerr

For hole-punched paper, place the paper with the holes to the right when you face the front side of the High 
Capacity Vacuum Feeder (HCVF).

PPrreeccuutt TTaabbss

For precut tabs, place the paper with the tabs to the left when you face the front side of the HCVF. After you load 
the paper, install the appropriate tab guide on the end guide, at the short edge of the paper.

Note: Ensure that the tabs of the precut tab fit the notch of the tab guides.
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Postcard Setting

To load paper size 98–181.9 mm portrait or smaller, attach the Postcard Kit to the High Capacity Vacuum Feeder 
(HCVF) tray. The Postcard Kit can be used in the HCVF trays only. You cannot use the Postcard Kit with Extra Long 
Sheet (XLS) Trays. 

The following procedure defines how to load paper using postcard guides.

1. Pull out the tray toward you until it stops. 

2. Remove any paper that remains in the tray.

3. To install the Postcard Kit, remove the postcard guides from their storage area.

4. Remove the shutters. 

a. Fold the shutters (1).

b. Lift the stack of shutters and remove them (2).
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5. Insert guide B into the slits on the side (1) and bottom (2) of the tray. Tighten the screw to secure the guide 
(3). 

Caution: If the screw is not tightened fully, it can come off and hit the transport device, which can result 
in breakage of the transport device.

6. Insert the guide A into the slit on the interior (1) and the bottom (2) of the tray. Tighten the screw to secure 
the guide (3). 
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7. Load 100–500 sheets of paper, then align the paper edges in the direction shown (1). For preprinted media, 
load the paper with the printed side facing up. Hold the side guides by its grip, then move them to touch the 
long edges of the paper lightly (2). 

Note: Ensure that you load the paper in the short-edge-feed (SEF) direction. The right side of the short edge 
of the postcard is the leading edge (1).

8. Load the remaining sheets in the tray. 

a. Align the paper edges in the direction shown (1).

b. Move the end guide to touch the short-edges of the paper lightly (2). 
Adjust the paper guides by pressing in the guide release lever and carefully moving the guides until they 
touch the edges of the paper lightly.

9. Gently push the tray into the press until it comes to a stop.

10. To remove and store the postcard guides, perform the following: 

a. Remove any paper from the tray.

b. Unfasten the screw from the postcard guide.
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11. After removing the postcard guides, place the shutters in their original positions, then expand them. 

Note: Hang the edges of the shutters on the beveled shutter retainers on both ends of the adjustable side 
guide. Confirm that they are fixed firmly.

12. Store the postcard guides in their storage area.

Note: Align the triangular marks so that the shutters can be mounted in the correct orientation. In the 
following image, the mark on the guide at the top edge of the paper is not visible, and the mark on the 
guide at the bottom edge of the paper is shown in the correct state.

Envelope Setting

Before you load envelopes in the paper tray, read and adhere to the following envelope guidelines:

• Curled or waving edges: If there are envelopes with curled or waving edges, replace the envelopes or straighten 
the edges.

• Adhered or glued to each other: If applicable, remove the glue and ensure bonding surfaces of the envelopes do 
not touch.

• Glue protruded: If applicable, wipe off the glue.

• Folded or non-flat surfaces: To flatten the top surface of the pile of envelopes, do the following: 

1. Place 100 envelopes on a level tabletop.

2. Press down the higher side of the top surface of the stack of envelopes.

3. When the higher side are not flattened, reduce the number of loaded envelopes until it becomes flat.

4. Repeat the process for another 100 envelopes. For example, if you are required to prepare 300 envelopes, 
then perform the process three times.
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• Ensure that the top surface of the loaded envelopes is flattened. The height difference between the front and 
back edge of the envelope can be no more than 1 cm., with the front edge of the envelope on the lower side. 
This guideline applies only when the Large Envelope Kit is not used. 

Within 1 cm.

LLooaaddiinngg aanndd OOrriieennttaattiioonn IInnffoorrmmaattiioonn

• Loading side: Load envelopes with the printable side face up.

• Load direction with the flap open: Place the envelope with the flap facing to the left, when you are at the front 
of the device. 

• Load direction with the flap closed: Place the envelope with the flap facing to the right, when you are at the 
front of the device. 

• When loading self-seal envelopes, fold the flaps.

• If the weight of each envelope is different, a multifeed is detected.

• If the printed output is not as expected, due to the image orientation or the flaps being open or closed, change 
the image orientation at the print server. While changing the image orientation at the print server, do not 
change the direction of loading paper. 

Caution: If envelopes are loaded above the maximum fill line or the top of the envelope stack is not 
level, a device malfunction can occur.

If any of the following fault codes appear, reduce the number of envelopes loaded: 

• Tray 6: 078-250

• Tray 7: 078-260

• Tray 8: 178-250

• Tray 9: 178-260
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EEnnvveellooppee SSppeecciiffiiccaattiioonn

• Type: Uncoated

• Weight: Specify the weight as twice that of the actual. For example, if 70 g/m2 is indicated, specify the weight 
as 140 g/m2.

• Size: 

– Standard size: If the envelope flaps are closed, use this size. 

– Custom size: If the envelope flaps are open, use this size. 

If the output is curled, decurling is required. If the cutting surfaces of envelopes have burrs, before you load the 
envelopes in the tray, flex the envelopes back and forth and fan them.

OOppttiioonnaall LLaarrggee EEnnvveellooppee KKiitt CCoommppoonneennttss

When you load the envelope size C4 (324 x 229 mm), C5 (229 x 162 mm), or DLX (235 x 120 mm), use the Large 
Envelope Kit. The Large Envelope Kit is an optional kit. Refer to the following Large Envelope Kit components for 
loading the envelopes with open flaps:

Based on the size of the envelope, ensure the correct combination of the Large Envelope Kit components. Refer to 
the following table to identify the correct components to be used.

194 Xerox® Versant® 4100 Press User Documentation

Working With



ENVELOPE SIZE 
POSTCARD 
KIT* LARGE ENVELOPE KIT 

C4   C D E F1  

C5 A B   E  F2 

DLX A B   E  F2 

Any other sizes, 181.9 mm (7.16 in.) or less 
on the long edge in the portrait orientation 

A B      

Any other sizes, 182.0 mm (7.16 in.) or more 
on the long edge in the portrait orientation   

C D    

* When you attach the Postcard Kit (A and B), remove the shutters. 
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OOppttiioonnaall LLaarrggee EEnnvveellooppee KKiitt IInnssttaallllaattiioonn IInnssttrruuccttiioonnss

1. To install the parts A and B, refer to Postcard Setting.

2. Fasten the screws to the side guide on the rear side to fix part C. 

Fasten the screws to the side guide on the front side to fix part D.

Caution: If the screw is not tightened fully, it can come off and hit the transport device, which can 
result in breakage of the transport device.

3. Attach part E to the end guide, at the short edge of the paper. Place part F1 or F2 along the wall on the leading 
edge of the paper. Verify that the parts are firmly fixed. 

LLooaaddiinngg EEnnvveellooppeess UUssiinngg tthhee OOppttiioonnaall LLaarrggee EEnnvveellooppee KKiitt

1. Pull out the tray toward you until it stops.

2. Remove any paper remaining in the tray.

3. Attach or remove the shutter from the Postcard Kit or Large Envelope Kit, depending on the size of the 
envelopes.
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4. Load one envelope with the paper edges aligned in the direction shown (1), to place it on parts E and F. For 
preprinted media, load the paper with the printed side facing up. Hold the end guide by its grip, then move it so 
that it touches the edges of the envelope lightly (2). Adjust the paper guides as needed. 

Note: Do not press the paper guide forcefully or leave a gap between the end guide and the envelope. 
These actions can cause a paper feeding error.

5. To fill the tray easily, load the stack of envelopes in small bundles. Bend the envelope stacks to provide 
additional clearance while loading. 

6. Load each stack of envelopes and align the envelopes edges in the direction shown (1). Hold the side guide by 
its grip, then move it to touch the edges of the envelopes lightly (2). 

7. When you load envelopes repeatedly, widen the side guide, then repeat the loading process for every bundle of 
about 100 envelopes. When you are using the Postcard Kit, align the envelopes by putting your hand between 
the side guide and the envelopes. 

Note: If the envelopes do not align, misalignment on prints or a paper feed error can occur.

LLooaaddiinngg EEnnvveellooppeess WWiitthhoouutt tthhee LLaarrggee EEnnvveellooppee KKiitt

1. Pull out the tray toward you until it stops.
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2. Remove any paper remaining in the tray.

3. Load a bundle of about 100 envelopes and align the envelope edges in the direction shown (1). For preprinted 
media, load the paper with the printed side facing up. Hold the side guide by its grip, then move it to touch the 
edges of the envelopes lightly (2). Adjust the paper guides as needed. 

4. When you load envelopes repeatedly, widen the side guide, then repeat the loading process for every bundle of 
about 100 envelopes. When using Postcard Kit, align the envelopes by putting your hand between the side 
guide and the envelopes. 

Note: If the envelopes do not align, misalignment on prints or a paper feeding error can occur.

5. Move the end guide to touch the edges of the envelopes lightly. To adjust the paper guides, press in the guide 
release lever and move the guides carefully until they touch the edges of the envelopes lightly.

Loading Paper in the Automatic Extra Long Sheet (XLS) Feeder

Caution: If fewer than 100 sheets are loaded in the Extra Long Sheet (XLS) Feeder tray, the paper guides 
apply more pressure to the paper. This pressure can distort the paper, which causes paper jams. For 
example, loading 10–20 sheets of 864 mm (34 in.) or longer paper can cause paper jams.

Note: The Postcard Kit for High Capacity XLS Vacuum Feeder (HCVF) cannot be used with the Extra Long 
Sheet (XLS) Feeder tray.

Loading 488 mm (19.21 in.) or Smaller Paper

1. Remove the paper from the bypass tray, then open the two covers. 
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2. On the left of the side guides at the long edge of the paper, lower the lever. Remove any paper remaining in 
the tray. 

3. If the end guide is stored, open the end guide shutter, then rotate the end guide to latch in the vertical 
position. 

a. Pinch the lever and open the shutter (1).

b. Hold the paper guide and pull it up (2). Pull the paper guide toward you until it clicks in place.

c. Pinch the lever (3) and close the shutter.

Caution: Do not hold the paper guide clip to pull up the paper guide. The guide clip can break.

4. Load 100–500 sheets of paper with the paper edges aligned in the direction shown (1). For preprinted media, 
load the paper with the printed side facing up. Hold the side guides by its grip, then move it to touch the edges 
of the paper lightly (2). 
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5. Load the remaining sheets into the tray, then align the paper edges in the direction shown (1). Move the end 
guide to touch the edges of the paper lightly (2). Adjust the paper guides by pressing in the guide release lever 
and carefully moving the guides until they touch the edges of the paper lightly. 

6. Close the two covers.

Loading 488.1–864 mm (19.21–34.0 in.) Paper

1. Remove the paper from the bypass tray, then open the two covers. 

2. Lift the lever on the left of the side guide. Remove any paper that remains in the tray. 

3. If the end guide is standing, store it: 
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a. Pinch the lever and open the shutter (1).

b. Hold the release lever and lay down the paper guide (2).

c. Pinch the lever (3) and close the shutter.

4. Load about 100 sheets of paper with the paper edges aligned in the direction shown (1). For preprinted media, 
load the paper with the printed side facing up. Hold the side guide by its grip, then move it to touch the edges 
of the paper lightly (2). 

5. Hold the XLS rear-side guide by its grip, then move it to touch the edges of the paper lightly (1). Place the XLS 
front side guide to fit the loaded paper (2). 
The XLS front side guide is removable. Install the front side guide in the direction that ensures that the metal 
surface touches the paper.

6. Load the remaining sheets in the tray, then align the paper edges in the direction shown. 
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7. Place the rear XLS end guide to fit the loaded paper. 
The rear end guide is removable. Install the rear end guide in the direction that ensures that the metal surface 
touches the paper.

8. Close the two covers.

Loading 864.1 mm (34.02 in.) or Larger Paper

You can load a maximum of 100 sheets of 864.1 mm (34.02 in.) or larger, 90 g/m2 paper.

1. Unfasten and remove the screws on the top of the left side cover. Remove the cover. 

2. Remove the paper from the bypass tray, then open the two covers. 

3. Attach the XLS extension tray and the extension plate. 
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a. Insert the XLS extension tray, then tighten the screws to secure it, as shown. 

b. Insert the XLS extension plate. 

c. When not in use, hang the parts on the holder of the lower part. 

4. Lift the lever on the left of the front side guide. Remove any paper that remains in the tray. 

5. If the end guide is standing, store it: 
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a. Pinch the lever and open the shutter (1).

b. Hold the release lever and lay down the paper guide (2).

c. Pinch the lever (3) and close the shutter.

6. Load 100 or less sheets of paper with the paper edges aligned in the direction shown (1). For preprinted media, 
load the paper with the printed side facing up. Hold the rear-side guide by its grip, then move it to touch the 
edges of the paper lightly (2). 

7. Hold the XLS rear-side guide by its grip, then move it to touch the edges of the paper lightly (1). Place the XLS 
front side guide to fit the loaded paper (2). 
The XLS front side guide is removable. Install the front side guide in the direction that ensures that the metal 
surface touches the paper.
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8. Close the two covers (1), then wait until the bottom plate rises. Place the XLS end guide to fit the loaded paper 
(2). 
The XLS end guide is removable. Install the end guide in the direction that ensures that the metal surface 
touches the paper.
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Finishing Devices

INTERFACE DECURLER MODULE (IDM)

Important: The Interface Decurler Module is required with any inline finishing devices installed with the 
system; it is not required with the Offset Catch Tray.

The Interface Decurler Module provides the following functions:

• Communication between the press and the attached finishing device

• An aligned paper path between the press and the attached finishing device

• Cooling and decurling of the paper as it exits the press

Interface Decurler Module (IDM) Components

1. Paper Jam and Error Indicator Panel

2. Interface Decurler Module (IDM) Front Cover
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Control Panel on the Interface Decurler Module

1. Paper Jam and Error Indicator

2. Curl Up and Down Indicators

3. Manual Curl Up Button

4. Manual Curl Down Button

5. Auto Curl Button and Indicator

Interface Decurler Module Curl Correction

Tip: The purpose of this curl correction is to fix paper curl as it leaves the press but before it reaches the next inline- 
finishing device. Use the IDM curl correction feature while the press is printing. 
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1. Printed Media from the Press

2. Interface Decurler Module paper path

3. Printed media from the Interface Decurler Module to inline finishing device

As media enters the module, it is fed to the IDM Decurler for paper curl correction. The IDM Decurler has both 
upper and lower Decurler rolls that apply pressure to the media based upon the following:

• System default (Auto on)

• Manual selections made from the IDM control panel

If you want to adjust the paper curl on the printed output quickly and at the point-of-need, use the manual curl up 
or down buttons. If the printed output contains too much curl after using these buttons, refer to Advanced Stock 
Setup and Correcting the Paper Curl.

From the IDM Decurler, the print media is cooled and routed from the IDM to the optional finishing device that is 
next inline and connected to the press.

Curl Correction Modes and Functions on the Interface Decurler Module

Note: When an Interface Decurler Module (IDM) curl correction mode is selected, the new mode is applied 
to the next sheet that is delivered to the IDM.
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INDICATOR MODE  FUNCTION 

Auto This is the default mode. 
• Automatically corrects the paper curl by 

selecting the curl direction and amount. 
This is based on the paper size and 
orientation and on the finishing device that 
is receiving the output. Automatic decurl 
mode flattens output sheet-by-sheet based 
on environment, paper weight, area 
coverage, and 1-sided or 2-sided printing. 

• When Auto is selected, the indicator to the 
right of the button is illuminated. 

• This mode has seven automated settings 
for controlling paper curl: three upcurl 
settings, three downcurl settings, and mid- 
range. 

• When Auto mode is in use, an indicator 
flashes momentarily on the control panel. 
The control panel shows the preselected 
curl direction and amount of decurl applied 
to the paper. 

Mid-range When this indicator is illuminated for either 
Auto mode or Manual mode, no curl correction 
is applied to the printed output. 
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INDICATOR MODE  FUNCTION 

Manual Upward Curling • When the printed output is curled upwards, 
select the curl-up button. 

• There are three upward curl correction 
values. 

• The top three indicators show which level 
of upward curl correction is selected. 

• The top indicator is the highest amount of 
upward curl correction that can be applied 
to a printed output. 
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INDICATOR MODE  FUNCTION 

Manual Downward 
Curling 

• When the printed output is curled 
downwards, select the curl-down button. 

• There are three downward curl correction 
values. 

• The bottom three indicators show which 
level of downward curl correction is 
selected. 

• The bottom indicator is the lowest amount 
of downward curl correction that can be 
applied to a printed output. 

Pressing the curl-up button changes the curl correction levels as shown:

Pressing the curl-down button changes the curl correction levels as shown:

INSERTER DEVICE

Note: This optional finishing device requires the Interface Decurler Module. 
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Use the Inserter device to load stock, such blank, preprinted, or special stock, which is inserted into the finished 
output. This stock serves as separators and covers for the finished output. Paper fed from the Inserter device is not 
printed on; however, the paper is placed into the printed output at selected locations. 

Note: The Inserter device sometimes is referred to as the post-process inserter or the 
interposer.

Inserter Components

1. Tray T1 or Inserter Tray

2. Inserter Control Panel

3. Inserter Front Cover
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Inserter Control Panel

NUMBER COMPONENT DESCRIPTION 

1 Paper Jam Error Indicator This indicator lights when a paper 
jam occurs in the Inserter.  

2 Curl Up and Down Indicators Similar to the Interface Decurler 
Module (IDM), these indicators 
show the direction of the curl 
correction. However, there are only 
three curl correction options for the 
Inserter: 
• One upward curl correction; this 

is the top indicator. 
• One downward curl correction; 

this is the bottom indicator. 
• Off (no curl correction); this is 

the middle indicator. 

Important: Use one of the following buttons only if paper curl continues after setting the curl correction 
level to the highest or lowest setting on the Interface Decurler Module (IDM). 

3 Manual Curl Up Button When the printed output is curled 
upwards, select the curl-up button.  

4 Manual Curl Down Button When the printed output is curled 
downwards, select the curl-down 
button. 

5 Auto Curl Button Automatically corrects the paper 
curl by selecting the curl direction 
and amount.  

Paper and Media for Inserter Tray T1

Tip: Paper fed from the Inserter device is not printed on; however, the paper is placed into the printed output at 
selected locations. 
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Supported Paper for the Inserter Tray T1

PAPER SIZE PAPER WEIGHT TRAY CAPACITY 

182 x 148–330 x 488 mm (7.2 x 
5.8–13 x 19.2 in.), A3 

52–400 g/m2 coated and uncoated 250 sheets (based on Colotech+90) 

Note: When the Inserter Tray is filled with 8.5 in. wide (SEF) media, its default size is 8.5 x 14 in. If you insert 
8.5 x 11 in. media, it is necessary to use Admin Mode Tools to adjust the default value of NVM 769-503. For 
more information, refer to the System Administrator Guide.

When you combine the following paper types with saddle stitch or bi-fold, use Tray 5 (Bypass): 

• Coated paper that weighs 127 g/m2 or less

• Blank sheets or unprinted paper that weighs 80 g/m2 or less

Note: If a tray other than Tray 5 is used, the combination can cause misalignment of folding positions and 
wrinkle.

Loading Paper in Inserter Tray T1

Before you use tray T1, review the following guidelines: 

• Remove the remaining paper from the tray.

• Load all the paper required for the job into the tray.

• To use saddle stitch and bi-fold options, ensure that the paper loaded in the main feeding tray is the same size 
as the paper loaded in tray T1. 

• For supported paper information, refer to Supported Paper for the Inserter Tray T1. 

To insert separator sheets or cover sheets, such as blank or preprinted sheets, use the Inserter Tray T1. Paper loaded 
in tray T1 is inserted into the finished or printed output. A maximum of 250 sheets (Colotech+90) may be loaded in 
tray T1.

Tip: Paper fed from the Inserter device is not printed on; however, the paper is placed into the printed output at 
selected locations. 

1. Load the paper, aligning all edges.  

If the paper is preprinted, load the paper with the printed side facing up. 

Note: Do not load paper above the maximum fill line. It may cause paper jams or press malfunctions.
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2. Hold the center of the paper guides and gently slide them to the desired paper size so that they are touching 
the edges of the paper. 

If the distance between the guides is too long or short relative to the paper, paper jams may occur.

If set by the system administrator, the Tray Properties window displays on PredictPrint Media Manager on 
the print server.

3. From the Tray Properties window, enter or verify the correct paper information.

4. Select OK to save the information and close the Tray Properties window.

Printing on Special Media

HHoollee--ppuunncchheedd PPaappeerr

Load hole-punched paper into tray T1 long-edge feed (LEF) with the holes on the right side as you face the front of 
the Inserter device.

TTaabb SSttoocckk

Load tab stock paper in tray T1 long-edge feed (LEF) with the tabs on the left side as you face the front of the 
Inserter device.
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Purge Function for Tray T1

If tray T1 runs out of paper, the press stops printing. When this happens, any printed output leaving the press is 
delivered to the inline finishing device output tray.

Tip: Do not reuse the output that is ejected by the purge function as this may cause paper jams.

To prevent the purge function from occurring when tray T1 runs out of paper, the function may be disabled or 
switched off from the press Tools mode. 

Important: Only a system administrator for the press can change the setting for the purge function for tray 
T1.

Tray T1 Purge Function Settings

The purge function allows you to specify how the press behaves when tray T1 is used. The purge function has two 
settings:

SSttaannddaarrdd

For each printed set that requires the inclusion of paper into the finished set, the press checks that paper Is 
loaded in tray T1 before it starts printing. 
This setting increases the wait time between sets, which causes decreased productivity. However, paper purging 
does not occur even if tray T1 runs out of paper.

SSppeeeedd FFiirrsstt

The printer starts printing regardless of the paper status of tray T1.
This setting maintains productivity based on press productivity. However, paper is purged from the press and 
the press stops printing when tray T1 runs out of paper. 

Note: Speed First is the default setting for the tray T1 purge function.

Changing the Purge Function Setting for Tray T1

Important: The following procedure must be performed by a system administrator with press administrator 
login authority.

1. Log in as the administrator.

2. On the control panel, press the Machine Status button.

3. Touch the Tools tab.

4. Select System Settings > Common Service Settings.
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5. Select Maintenance. 

The Maintenance screen displays.

6. Use the up/down arrows to scroll through the Maintenance screens until you see Print Action When Using 
Tray T1 (Inserter)

7. Select Print Action When Using Tray T1 (Inserter). 

The Tray T1 purge function screen displays.

8. Select the desired purge function option: 

• Standard: Select this option to switch off the purge function. It decreases productivity, but the press 
continues to run even when tray T1 runs out of paper. This may cause some printed output sets to be 
delivered to the designated finishing tray without inserts.

• Speed First: This setting maintains productivity. Select this option to have the press stop printing and 
purge paper when tray T1 runs out of paper. 

Note: Speed First is the default setting. 

9. Select Save or OK. 

The Maintenance screen displays.

10. Select Close. 

The main Tools tab screen displays.

11. Exit the administrator mode.

GBC ®  ADVANCEDPUNCH ™  PRO

The GBC® AdvancedPunch™ Pro is an automatic hole punch module that integrates with the press to streamline the 
production of reports, directories, pricing guides, and other bound books. It equals or betters traditional quality 
while saving time and increasing productivity by eliminating the labor-intensive steps of manual punching. The 
compact AdvancedPunch® Pro takes minimal space and accepts a variety of optional multiple hole punch die sets.

The AdvancedPunch® Pro can be connected to a variety of optional finishing devices and sits inline with these 
devices.

Note: This optional finishing device requires the Interface Decurler Module. 

The AdvancedPunch® Pro provides the following capabilities:

• A bigger range of media sizes and types

• Trail edge, LEF, and SEF punching
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• Die set detection control panel shows die type and cycle count

• User Die set options include comb, wire, coil, and 3-7 hole varieties to enable most popular binding formats

• Operates at rated print engine speed for most paper sizes

• Quick-change die sets that can be interchanged without any tools

• All die sets include an Identification Label providing the user with the hole pattern and name

• Convenient storage area for two extra Die Sets which is located above the sheet bypass on the device

For detailed information and instructions to use the AdvancedPunch® Pro, refer to the press User Documentation or 
go to www.xerox.com/gbc-advancedpunch-pro.

HIGH CAPACITY STACKER (HCS)

Note: This optional finishing device requires the Interface Decurler Module. 

The High Capacity Stacker (HCS) is an optional finishing device that provides large-capacity stacking and offsetting 
capabilities for production output to a stacker tray or cart. The HCS also provides a top tray convenient for short 
stack runs.
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High Capacity Stacker (HCS) Components

NUMBER 
COMPO
NENT DESCRIPTION 

1 Paper jam 
and error 
indicators 

These indicators light when a paper jam occurs in HCS areas E1–E8. 

2 Sample 
button 

Press this button to have the HCS deliver a sample sheet to the top tray.  

The indicator to the left of the button blinks until a sample sheet is delivered to the 
top tray.

3 Unload 
button 

Press this button to stop printing and remove paper. 

4 Top tray Receives the printed output. Sample sheets also are delivered here. 

Holds a maximum of 500 sheets, 330 x 488 mm (13 x 19.2 in.)

5 Circuit 
breaker 
switch 

The circuit breaker switch is located on the rear of the HCS. This switch 
automatically shuts off electricity in the event of electrical failure or a short circuit. 

6 Top cover Open this cover to clear paper jams. 

7 Stacker tray 
/ cart 

Collated sets (up to a total of 5000 sheets) are transported to the stacker tray, 
which is located on a movable stacker cart. 
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NUMBER 
COMPO-
NENT DESCRIPTION 

8 Front door Open this door to remove paper or printed output. 

9 Optional 
second HCS 

A second, optional HCS can be added to the system configuration for additional 
output productivity. 

HCS Circuit Breaker

The HCS circuit breaker is located on the rear of the HCS unit.

1. Test Button

2. On or Off Switch

The circuit breaker switch is normally in the ON position.

Note: When an electrical interruption is detected, the circuit breaker automatically switches off to 
discontinue the electrical flow to the HCS. For electrical information, refer to Safety.

Output Trays

The High Capacity Stacker (HCS) has two output trays.
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1. Top Tray

2. Stacker Tray or Cart

The Top Tray offers the following: 

• Convenience for short stack runs (up to 500 sheets) without offsetting

• Delivery of purged sheets

Control Buttons

1. Sample button: Press this button to output a sample sheet to the top tray.

2. Unload button: Press this button to stop printing and remove paper.

Unloading the Stacker Tray or Cart

Note: The HCS may be unloaded while it is running.

1. Press the Unload button on the HCS control panel.

2. After the Unload Indicator lights, open the HCS front door. 

3. Position the securing bar on top of the stacked paper.

4. Pull the Stacker Cart straight out of the HCS. 

5. Remove the securing bar.

6. Remove the paper from the stacker tray.

7. Push the empty Stacker Cart straight into the HCS.

8. Position the securing bar on the fixed area inside the HCS.

9. Close the front door; the tray will rise to the operate position.
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HCS Specifications

ITEM SPECIFICATION 

Tray capacity Top tray 500 sheets 

Stacker tray or cart 5000 sheets 

Note: The values are based on paper less than 80 g/m2

Paper size Top tray Standard size Minimum Postcard  

4 x 6 in.

100 x 148 mm

Maximum 13 x 19 in. 

A3

Custom size Height 3.9–13 in.  

98.0–330.2 mm

Width 6-26 in.  

148.0–660.4 mm

Stacker tray or 
cart 

Standard size Minimum JIS BS 

Maximum 13 x 19 in. 

A3

Custom size Height 8–13 in.  

203.0–330.2 mm

Width 7.2–19.2 in.  

182.0–488.0 mm

Paper weight Top Tray 52–400 g/m2  

Stacker tray or 
cart 

52–400 g/m2, coated and uncoated 

HCS Media Guidelines

• Stacker tray/cart accepts 52–400 g/m2 coated or uncoated stock with the possibility of degraded stack quality 
and increased jam rate for stocks that are heavier than 300 g/m2.

• Transparencies may be run to the top tray or to the stacker tray/cart. Stack height should be limited to 100 
transparencies.

• Coated paper lighter than 100 g/m2 may not run as reliably as coated paper heavier than 100 g/m2. 

• Non-standard papers longer than 305 mm (12 in.) in the feed direction require 210 mm (8.3 in.) minimum 
measurement across the feed direction.
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• Non-standard papers shorter than 254 mm (10 in.) in the cross-feed direction require 330 mm (13 in.) 
minimum measurement in the feed direction.

CREASE AND TWO-SIDED TRIMMER

Note: This optional finishing device requires the Interface Decurler Module. 

The Crease and Two-Sided Trimmer is an optional finishing device that provides trimming on two sides of the 
output.

• Trims 6–25 mm (0.24–0.99 in.) from the top and bottom of prints or booklets to produce an even edge.

• When paired with the SquareFold® Trimmer, all sides of booklets are trimmed except the binding, which enables 
full-bleed booklets. For more information, refer to SquareFold® Trimmer Device.

• Trims paper sizes 182 x 257–330 x 488 mm (7.2 x 10.1–3 x 19.2 in.). If the trimmed output is for booklet 
making, the minimum paper size is 194 x 257 mm (7.6 x 10.1 in.).

• Handles uncoated and coated paper 52–350 g/m2.

Crease and Two-Sided Trimmer Components
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NUMBER COMPONENT DESCRIPTION 

1 Paper jam and error indicator This indicator lights when a paper jam occurs.If the indicator 
blinks, you must clear the paper jam before printing can 
resume. 

2 Trimmer Waste Container Full 
indicator 

This indicators lights when it is time to empty the Trimmer 
Waste Container and blinks when the container is full. 

3 Upper cover Open this cover to clear paper jams. 

4 Lower cover Open this cover to empty the Trimmer Waste Container. 

Crease and Two-Sided Trimmer Specifications

ITEM SPECIFICATION 

Two-sided Trim                Paper size Standard size Minimum  Letter (8.5 x 11 in.) 

A4

Maximum 13 x 19 in. 

A3

Custom size Height  7.7–13 in. 

194.0–330.2 mm 

Width  8.26–19.2 in. 

10.0–488.0 mm

Paper weight Uncoated 52–350 g/m2 

Coated 106–350 g/m2 

Trimming size 0.24–0.99 in. 

6–25 mm

Note: Setting a head-to-toe trimming area size of 7 mm 
(0.275 in.) or less can cause damage to the trimmed 
edges.

C/Z FOLDER

The C/Z Folder is available only with one of the optional Production Ready (PR) Finishers. For more information, 
refer to Production Ready (PR) Finishers.

Note: This optional finishing device requires the Interface Decurler Module.

The C/Z Folder is an optional finishing device that provides Envelope Folding (C-Fold and Z-Fold) for 8.5 x 11 in. and 
A4 media and large sheet folding (Half-Sheet Z-Fold) for 11 x 17 in. and A3 media.
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Folded output is produced by selecting the Fold feature.

• For network print jobs, select the Fold feature from the print driver.

• For copy and scan jobs, select the Fold feature from the scanner. 

Note: Copy and scan jobs are applicable only if the press includes a scanner.

• To use the Fold feature, the orientation of documents must be short-edge feed (SEF).

• Select a tray that contains SEF media.

• There are three types of folds available: C-fold, Z-fold, and Z-fold Half-Sheet.

The C/Z Folder is available with all three Production Ready (PR) Finishers and the Crease and Two-Sided Trimmer 
device.

C/Z Fold Types

CC--FFoolldd

A C-Fold has two folds, which create a three-panel output. 

ZZ--FFoolldd

A Z-Fold has two folds that are folded in opposite directions, resulting in a type of fan fold. 
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ZZ--FFoolldd HHaallff SShheeeett ((sshhoowwnn hheerree wwiitthh 33--hhoollee ppuunncchh))

As with a regular Z-Fold, the Z-Fold Half-Sheet has two folds that are folded in the opposite directions. The 
difference between a regular Z-Fold and a Z-Fold Half Sheet is that the Z-Fold Half Sheet is not folded in two 
equal folds. The two folds are unequal which allows one edge of the Z-Fold Half Sheet to have a longer edge. 
The longer edge allows for stapling or hole punching. 

Note: Each Z-Fold Half Sheet added to a stapled set counts as 10 sheets. It reduces the total number of 
sheets for any given specified weight range.

C/Z Folder Components

Note: For detailed information about the folding feature, refer to Fold Adjustments.
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NUMBER COMPONENT DESCRIPTION 

1 C/Z fold output tray Receives output sheets. 

2 C/Z fold output tray button Press this button to open 
the C/Z fold output tray. 

C/Z Fold Output

NUMBER COMPONENT DESCRIPTION 

1 C/Z fold output tray button When you press the button, the indicator flashes. 
When the output tray is unlocked and the indicator 
shows a steady light on (no blinking), pull out the 
output tray. 

2 C/Z fold output tray  C-Fold or Z-Fold jobs are delivered to this tray only.  

Note: C/Z Fold jobs cannot be delivered to 
any other tray.
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C/Z Folder Specifications

ITEM SPECIFICATION 

Z-Fold Half Sheet Paper size 11 x 17 in. (Tabloid) 

A3

JIS B4

Paper weight 60–105 g/m2, uncoated 

Note: Each Z-Fold Half Sheet added to a stapled set counts as 10 sheets. It 
reduces the total number of sheets for any given specified weight range.

Tri-fold (C or Z) Paper size 8.5 x 11 in. (Letter) 

A4

Paper weight 60–105 g/m2, uncoated 

Tray capacity 30 sheets 

Note: Values are based on Colotech+90.

PRODUCTION READY (PR)  FINISHERS

Note: These optional finishing devices require the Interface Decurler Module. 

Three Production Ready (PR) Finishers are available with your press.

• Product Ready (PR) Finisher

• Product Ready (PR) Booklet Maker Finisher

• Product Ready (PR) Finisher Plus

Note: Throughout this section, the three PR Finishers are referred to simply as the Finisher. Any 
differences between the finishers are distinguished by using the specific finisher name.

The Production Ready (PR) Finishers provide the following capabilities: 

• Handling media that is smaller than 5.83 x 8.27 in., A5.

• Stapling up to 100 sheets with one or two staples.

• Handling large-sized paper, maximum size of 330.2 x 488 mm (13 x 19.2 in.).

• For coated stocks, stapling a maximum of 35 pages.

• For the PR Finisher Plus only: Feeding the output media from the press and any inline finishing devices to a 
third-party DFA device.

Note: The optional C/Z Folder is available with all three Production Ready (PR) Finishers.
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Production Ready (PR) Finisher

The PR Finisher consists of: 

• Two output trays: Top Tray and Stacker Tray

• Stapler

• Optional Basic Punch

Production Ready (PR) Booklet Maker Finisher

The Production Ready (PR) Booklet Maker Finisher provides all the same features as the PR Finisher plus it 
automatically creates saddle-stitched booklets of up to 30 sheets and bi-folding, also called single-folding.

The Production Ready (PR) Booklet Maker Finisher consists of: 

• Three output trays: Top Tray, Stacker Tray, Booklet Output Tray

• Booklet Maker Unit

• Stapler

• Optional Basic Punch

Xerox® Versant® 4100 Press User Documentation 229

Working With



Production Ready (PR) Finisher Plus

The Production Ready (PR) Finisher Plus consist of:

• Two output trays: Top Tray and Stacker Tray

• Stapler

• Optional Basic Punch

The Production Ready (PR) Finisher Plus serves as an interface to transfer paper between the press and any third- 
party, Document Finishing Architecture (DFA) device attached to the press.

Finisher Components

1. Paper Jam and Error Indicator

2. Top Tray

3. Stacker Tray

4. Booklet Tray*

5. Booklet Output Button*

6. Front Cover
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7. Staple Waste Container

8. Basic Staple Cartridge for Side Stitch

9. Two Booklet Staple Cartridges for Saddle Stitch*

10. Hole Punch Waste Container

Note: * Available only with the PR Booklet Maker Finisher.

PR Finisher Plus Components

1. Finisher Module

2. Finisher Module Paper Jam and Error Indicators

3. Finisher Top Tray

4. Finisher Stacker Tray

5. Finishing Transport

6. Finishing Transport Paper Jam and Error Indicators

7. Finishing Transport Front Cover

8. Finisher Module Front Cover

9. Finisher Staple Waste Container

10. Finisher Basic Stapler for Side Stitching

11. Finisher Hole Punch Waste Container

Note: For details on the functions of your third-part finishing device, refer to the manual supplied with the 
device.

Xerox® Versant® 4100 Press User Documentation 231

Working With



Finisher Output Trays

1. Top tray

2. Stacker tray

3. Booklet tray*

*Available only with the PR Booklet Maker Finisher.

Top Tray

If output sheets are not fully ejected, this causes the press to detect a Paper Full condition. If this condition is 
detected frequently, change the angle of the top tray. 

Refer to the following guidelines for changing the top tray angle:

• For normal usage, keep the tray in its lower, default position. 

Important: Continual usage of the tray in the upper position, may cause paper jams or output 
sheets to fall from the tray upon delivery.

• When using the following paper types, change the angle of the tray to its upper position. These paper types 
may cause frequent Paper Full conditions: 

– Light-weight (106 g/m2 or lighter) coated paper 

– Coated paper whose edges are 364 mm or longer 

– Long paper 

Note: If sheets are curled, changing the tray angle has no effect.
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A B 

Default, lower angle  Raised, upper angle 

To change the angle of the tray:

1. Pull the top tray from the lower seating (A) by pulling it toward the right.

2. Insert the clutches at the lead edge of the tray into upper seating (B). 

Stacker Tray

Side stitch jobs are delivered to this tray only.

Note: Delivering 2,000 or more sheets to this tray with excessive downward curl may cause the output stack 
to fall out of the tray. If this happens, set the curl correction level on the Interface Decurler Module to its 
lowest level and set curl correction on the Inserter setting to downward. For information, refer to Paper Curl 
Correction with the PR Finishers.

Booklet Tray

Note: The booklet tray is attached to PR Booklet Maker Finisher. However, if the SquareFold Trimmer is 
installed, the booklet tray is attached to SquareFold Trimmer.

Bi-Fold and Bi-Fold with Saddle Stitch jobs are delivered to this tray only.
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Top Tray Aligner Accessory

The Xerox Top Tray Aligner Accessory is an additional component for the top tray of the Production Ready Finishers. 
This accessory improves the stack quality of the Production Ready Finishers. The Top Tray Aligner Accessory aligns 
any small-size stock that goes on the top tray, such as small sheets, postcards, and envelopes. 

To install the Top Tray Aligner Accessory on a Production Ready Finisher, do the following:

1. Empty the top tray of the Production Ready Finisher. 

2. Place the Top Tray Aligner Accessory on the top tray of the PR Finisher. Adjust the alignment between the top 
tray and the Tray Aligner Accessory. 
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3. To achieve better stacking of the media, adjust the movable document guides on the Top Tray Aligner 
Accessory. To align the document guides with the media, put the media on the Top Tray Aligner Accessory, then 
adjust the guides. 

4. To align the document guides for envelopes or small stocks, put an envelope on the Top Tray Aligner Accessory, 
then adjust the document guides.

Paper Curl Correction with the PR Finishers

If sheets are curled when delivered any of the finisher trays, refer to the following information:

• Printing on 5.83 × 8.27 in., A5, LEF paper with upward curl may cause paper jams. If this occurs, set the curl 
correction level on the Interface Decurler Module to its highest setting. On the Inserter, set the curl correction 
to upward.

• Printing on heavyweight paper with downward curl may cause paper jams. If this occurs, set the curl correction 
level on the Interface Decurler Module to its lowest setting. On the Inserter, set the curl correction to 
downward.

• Printing on paper weighing 157 g/m2 or heavier with up curl may cause paper jams. If this occurs, set the curl 
correction level on the Interface Decurler Module to its highest setting. On the Inserter, set the curl correction 
to upward.

For more information about the paper curl correction features, refer to Curl Correction Modes and Functions on the 
Interface Decurler Module and Inserter Control Panel.

Bi-Fold Feature for the Production Ready Booklet Maker Finisher

Note: The Bi-Fold feature is available only with the Production Ready (PR) Booklet Maker Finisher. 

• To use the Bi-Fold feature, the orientation of documents must be short-edge feed (SEF). You must select a tray 
that contains SEF stock.

• The Bi-Fold feature is selected from the print driver for network print jobs, or from the scanner for copy and scan 
jobs; applicable only if the press is a combination copier and printer.

• Bi-Fold is sometimes referred to as Single Fold.

Important: The C-Fold and Z-Fold options are available only with the C/Z Folder. For more information on 
this device, refer to C/Z Folder.
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A Bi-Fold has one fold which creates two panels to the output.

There are three Bi-Fold options available:

• Bi-Fold Single Sheet

• Bi-Fold Multiple Sheets

• Bi-Fold Multiple Sheets Stapled

Note: For detailed information about the fold types and the fold adjustment feature, refer to Fold 
Adjustments.

Booklet Output Button on the Production Ready Booklet Maker Finisher

Press this button to remove finished booklets from the finisher.

Note: If the SquareFold Trimmer is installed, pressing this button moves the booklets to the booklet tray 
installed on SquareFold Trimmer.
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PR Finisher Specifications

ITEM SPECIFICATION 

Tray Top tray Collate and stack 

Stacker tray Collate (offsetting supported) and stack (offsetting supported) 

Booklet tray Collate and stack 

Paper size Top tray Standard size Minimum Postcard (100 x 148 
mm) 

Maximum 13 x 19 in., A3 

Custom size Height 98–330.2 mm 

Width 148–660.4 mm 

Stacker tray Standard size Minimum 5.83 x 8.27 in., A5 

Maximum 13 x 19 in., A3 

Custom size Height 148–330.2 mm 

Width 148–488 mm 

Booklet tray Standard size Minimum JIS B5 

Maximum 13 x 19 in., A3 

Custom size Height 182–330.2 mm 

Width 257–488 mm 

Paper weight Top tray 52–400 g/m2 

Stacker tray 52–400 g/m2 

Booklet tray 60–350 g/m2 

Tray capacity Top tray 500 sheets 

Stacker tray 
(without staples) 

8.5 x 11 in., A4 PR Finisher: 3000 sheets 

PR Booklet Maker Finisher: 2000 sheets

JIS B4 or larger 1500 sheets 

Mix stack 350 sheets 

Stacker tray (with 
staples) 

8.5 x 11 in., A4 PR Finisher: 200 sets or 3000 sheets  

PR Booklet Maker Finisher: 2000 sheets

JIS B4 or larger 100 sets or 1500 sheets 

Booklet tray 20 sets 
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ITEM SPECIFICATION 

Note: The values are based on Colotech+90. Mix stack means a set of paper sheets where larger sheets 
are placed over smaller ones. For example, A4 over JIS B5 or JIS B4 over A4. The booklet tray capacity is 
16 sets if one set consists of 17 or more sheets.

Staple Capacity 100 sheets 

Note: The values are based on Colotech+90. Five sheets larger than A4 Letter (8.5 
x 11 in.)

Paper size Standard size Minimum 5.83 x 8.27 in., A5 

Maximum Tabloid (11 x 17 in.), 
A3 

Custom size Height 182–297 mm 

Width 148–432 mm 

Paper weight Uncoated 52–350 g/m2 

Coated 52–350 g/m2 

Stapling position 1 place, 2 places or 4 places 

ITEM SPECIFICATION 

Punch  

(with Punch 
Unit)

Paper size Standard size Maximum A3, Tabloid (11 x 17 in.) 

Minimum 2-hole or 3- 
hole 

JIS B5 

4-hole  A4,16K 

Custom size Height 203–297 mm 

Width 182–431.8 mm 

Paper weight Uncoated 52–220 g/m2  

Coated 72–200 g/m2 

Number of 
Holes 

2, 4-hole or US 2, 3-hole    

Note: The number of punch holes you can choose depends on the 
paper size.

Saddle Stitch / 
Bi-Fold 

Capacity Saddle Stitch 30 sheets 

PR Booklet 
Maker Finisher 

Bi-Fold 5 sheets 

Note: The values are based on Colotech+90.
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ITEM SPECIFICATION 

Paper size Standard size Maximum A3, 13 x 19 in. 

Minimum JIS B5 

Custom size Height 182–330.2 mm 

Width 257–488 mm 

Paper weight Uncoated 52–300 g/m2 

Coated 52–300 g/m2 

Staple Output Capacity

PAPER WEIGHT 
(G/M2) 

SIDE STITCH SADDLE STITCH 

A4 OR SMALLER LARGER THAN A4 

UNCOATED COATED 
UN
COATED COATED UNCOATED COATED 

52–59 100 35* 65 35* 30* 25* 

60–71 30 

72–80 35 35 25 

81–90 

91–105 50 30 50 30 20 

106–128 45 15 

129–150 20 20 20 20 10 

151–176 

177–220 5 

221–256 4 

257–300 10 10 10 10 3 

301 - 350 

* Can be stapled; however, binding accuracy or paper feed performance cannot be guaranteed. 

Values in the table indicating the maximum number of sheets that can be stapled have been evaluated using the 
following paper types: 82 g/m2, Colotech+ (200 g/m2, 250 g/m2, 350 g/m2).

Even for a print job whose number of pages is within the limit, staple faults can occur depending on the following 
conditions: 

• Type of paper, such as Gloss Coated Paper

• Environment where the press is installed, such as room temperature, humidity, and others

• Print data, even if you use recommended paper types
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• The job is made of a mixture of paper type or paper weight

Important: In an environment at a low temperature and low humidity, stapling of 40 sheets or more can 
cause paper jams.

Note: The press determines paper type and paper weight based on paper information set for the job, not 
based on paper actually loaded in the tray. The press determines the number of sheets per job based on job 
information. Therefore, when multifeeds occur, stapling can be performed even if the number of sheets 
being fed exceeds the limit. However, this can cause staple faults.

PLOCKMATIC MPS XL (MULTI-PURPOSE STACKER)

The Plockmatic Multi-Purpose Stacker XL is a flexible stacking solution that assists operators with paper stacking and 
handling during the finishing process. The stacker offers a unique combination of features with a printer in a single 
product.

The stacker can stack a wide variety of media such as A4 or Letter trifold or gatefold, A4 or Letter Landscape 
brochures, leaflets, menus, business cards, postcards, and so on.

The stacker is fully integrated into the Xerox® Digital Presses.

The stacker provides the following features: 

• Provides the link between printing and the finishing device that will help to create the complete application.

• Offers a unique combination of features such as stacking, lifting, transporting, and integration with a printer in a 
single product.

• The stacker has multiple sensors that can detect jams and stack capacity limits, which triggers a soft stop within 
the printer.

• Integration and communication with the printer conveniently allows the operator to pause and resume jobs 
directly from the stacker control panel.

• Simple docking mechanism and large casters allow frequent docking or undocking and easy transportation of 
paper from the printer to finishing system. 
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Note: When docked, the stacker is powered through the docking bracket that is attached to the 
upstream device.

• Capable of stacking a wide range of media, sheets as large as 330 x 1200 mm (13 x 47.2 in.) and as thick as 
400 g/m2.

• The stacking table has a default length of 715 mm (28 in.) for longer sheets, and the table can be extended all 
the way up to 1200 mm (47.2 in.). The upstream print engine determines the maximum sheet size.

• Supports a maximum stacking load of 40 kg (88.2 lbs.) and a maximum stacking height of 330 mm (13 in.) for 
sheets within 715 mm (28 in.) in length and 140 mm (5.5 in.) for the sheets over 715 mm (28 in.) in length. 

Note: Maximum stack height can vary between -10 mm (-0.4 in.) and +5 mm (+0.2 in.) depending on 
media type and weight.

• An active Infeeder Unit receives paper from the upstream device and drives each sheet into the stacker. It also 
contains a fan which helps to cool media down and prevents sheets from sticking to each other.

• An active side jogger on the Infeeder Unit helps to align sheets and produce high quality stacks.

• The Motorized Stacking Table eliminates the need to manually lift heavy paper stacks.

For detailed information and instructions to use the Plockmatic Multi-Purpose Stacker XL, go to https://www.support. 
xerox.com, then search for your Press and Plockmatic MPS XL.

SQUAREFOLD ®  TRIMMER DEVICE

Note: This optional finishing device requires the Interface Decurler Module. 

Tip: SquareFold® Trimmer device is available only with booklet maker finisher. 

The SquareFold® Trimmer device is an optional finishing device that flattens the spine of a booklet and performs 
face trim of the booklet.

The SquareFold® Trimmer device:

• Receives the booklet from the booklet maker area of the finisher.

• Flattens the booklet spine, thereby reducing the booklet thickness and giving it the appearance of a perfect- 
bound book.

• Trims and cuts away the face edge of the booklet, resulting in a neat finished edge.

The booklet is assembled and stapled in the booklet area of the finisher. The booklet then enters the SquareFold® 

Trimmer device already assembled. Any adjustments to the image of the original and its placement on the booklet 
page must be set at the print server.
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SquareFold® Trimmer Components

NUMBER COMPONENT DESCRIPTION 

1 Left Cover * Open this cover to remove paper jams.  

2 Right Cover * Open this cover to remove paper jams.  

3 Circuit Breaker Switch on the rear of 
device 

Automatically shuts off electricity in the event of 
an electrical fault or a short circuit. 

4 Booklet Tray This tray receives square-fold booklet output from 
the finisher. 

5 Square-fold Adjustment Button Press this button to adjust the thickness of 
printed booklets. 

6 Paper Jam and Error Indicator Lights when a paper jam occurs. 

7 Trimmer Waste Container Collects waste from the trimmer area of the 
device. 

* The covers cannot be opened during normal operation or when the press is idle. The covers can be 
opened only when an indicator is lit and a jam or fault occurs within the SquareFold® Trimmer device.  
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SquareFold® Trimmer Circuit Breaker

The circuit breaker is located on the rear of the device. The circuit breaker is normally in the ON position. 

Note: When an electrical interruption is detected, the circuit breaker automatically switches off to 
discontinue the electrical flow to the device. For electrical information, refer to Safety.

Under normal operating conditions, this switch should not be touched. If the press is moved, press this button to 
switch off power to the device.

Output Trays

1. Finisher Output Tray: Unused sheets that are purged by the press are ejected to this output tray.

2. Booklet Tray: Saddle Stitch/Bi-fold and Trim/Square-fold jobs are delivered only to this tray.
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Control Panel

NUMBER DESCRIPTION 

1 Fault indicators: These indicators light when a fault or jam occurs in a particular 
area of the SquareFold® Trimmer device. The lower indicator (with the lock icon) 
lights when the trimmer waste container is pulled out or when it is full. 

Note: If El, E2, or E3 is lit, the left and right covers can be opened and the 
jam or fault cleared. Otherwise, during normal operation or when the press is 
idle, the covers cannot be opened.

2 Select the desired square-fold setting; for more information refer to the Square Fold 
Adjustment Settings. 

3 Press this button to adjust the square-fold, book thickness setting. 

SquareFold® Trimmer Paper Path

NUMBER DESCRIPTION 

1 The booklet leaves the booklet area of the finisher and enters the SquareFold® 

Trimmer device. The booklet exit sensor, in the SquareFold® Trimmer device, detects 
the lead-edge spine of the booklet and moves the booklet to the square-fold area. 

2 Once the booklet spine reaches the square-fold area, the booklet is clamped and 
the square-folding operation begins. 
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NUMBER DESCRIPTION 

3 The booklet is flattened and the spine squared according to the square-fold setting 
indicated on the control panel. 

4 After the booklet is flattened and the spine squared, it is moved to the trimmer 
area. 
• Based on the finished booklet size, the booklet is moved until the trail edge 

reaches the trimmer cutter. 
• The trail edge is trimmed (cut); this is based on the finished booklet size entered 

for the trimmer mode setting. 

5 The booklet is then moved to the exit area where it is transported to the booklet 
tray. 

Note: Booklets exiting the SquareFold® Trimmer device may contain trim remnants or scraps from the 
previously trimmed booklet. This is due to static electricity build-up and is normal. If booklets contain trim 
remnants or scraps, simply remove and discard them.

Square Fold and Trim Features

Square Fold Feature

Press Square-fold button to adjust the thickness, the square-folding, of the printed booklets.

The Square Fold feature can be selected or accessed from your computer print driver, the press user interface, or the 
print server.

Note: The term Book Pressing is used synonymously with the terms Square Fold or Square Folding.

SSqquuaarree FFoolldd AAddjjuussttmmeenntt SSeettttiinnggss

The square fold feature can be switched on or off based on user preference. When the feature is switched on, you 
can select one of five options depending on your requirements for the finished booklet job.

Note: Run one or more test prints before running large jobs.
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NUMBER DESCRIPTION 

1 Select this setting (-2 / Lower / Low 2) when your finished booklet is five pages or 
less and on lightweight paper (100 g/m2 or lower). The least amount of pressure 
that can be applied to the booklet is -2. 

2 Select this setting (-1 / Low / Low 1) when you want less pressure applied to the 
spine of the booklet. The less pressure applied to the booklet, the more rounded the 
booklet spine will be. 

3 Auto / Normal is the default setting and is used for most jobs. 

4 Select this setting (+1 / High / High 1) when you want a greater amount of 
pressure applied to the spine of the booklet, but not as much as the +2 setting uses.  

5 Select this setting (+2 / Higher / High 2) when you want the most amount of 
pressure applied to the spine of the booklet. The more pressure applied, the more 
square the booklet spine will be. The greatest amount of pressure that can be 
applied to the booklet is +2. 

BBooookklleett EExxaammppllee

The following illustration shows two different booklet types:

1. This booklet is not square-folded; it has a rounded, thicker appearance to the spine.

2. This booklet is square-folded; the booklet spine is flattened and squared, giving a perfect-bound book 
appearance.
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Trim Feature

Access the trim feature from your computer print driver or from the print server.

TTrriimm OOppttiioonnss

When using the trim options, always consider the following:

• Booklets exiting the SquareFold® Trimmer device can contain trim remnants or scraps from the previously 
trimmed booklet. Static electricity causes this build-up and it is normal. If booklets contain trim remnants, simply 
remove and discard them.

• The trim feature can be switched on or off. When the feature is on, you can adjust the trim setting in 0.1 mm 
(0.0039 in.) increments depending on your requirements for the finished booklet job.

The trim options include the following:

• Trimming On/Off: Switch On/Off the Trimming feature. The default setting is Off.

• Cut to Size: Use the Left/Right Arrow buttons to decrease or increase the trimmer setting. Adjustments are 
made in 0.1 mm (0.0039 in.) increments.

The trim setting is based on:

• The number of sheets in the finished booklet

• The finished booklet width size

• The media type (coated or uncoated)

• The media weight

Note: Experiment with various settings to determine the best selections for your job. You may want to run 
one or more test prints before running larger jobs for best booklet output.

Note: Trim settings cannot be adjusted to remove less than 2 mm (0.078 in.) or more than 20 mm (0.787 
in.) of edge material from the booklet. Adjustments less than 2 mm may produce poor trim quality. 
Adjustments greater than 20 mm result in no trimming to the booklet edge.

TTrriimm GGuuiiddeelliinneess

The following table shows various scenarios using different paper weights, media types, and trim setting selections. 
Use this table as a guideline when selecting a trim setting for your specific job.

Note: The settings shown in the following table are provided as examples and are not meant to represent 
every possible job scenario; again, use this table as a guideline only.

SCE
NARIO 
NUM
BER 

PAPER SIZE 
FINISHED 
BOOKLET SIZE 

PAPER WEIGHT 
(LBS./ G/M2) 

APPROXIMATE 
TRIM SETTING 
(MM) 

NUMBER OF 
PAGES IN 
FINISHED 
BOOKLET 

1 
210 x 298 mm (8.5 
x 11 in.), A4 

149 x 210 mm 
(5.5 x 8.5 in.) 

20 lbs./ 75 g/m2 130 20 

2 
210 x 298 mm (8.5 
x 11 in.), A4 

149 x 210 mm 
(5.5 x 8.5 in.) 

24 lbs./ 90 g/m2 125 14 
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SCE-
NARIO 
NUM-
BER 

PAPER SIZE 
FINISHED 
BOOKLET SIZE 

PAPER WEIGHT 
(LBS./ G/M2) 

APPROXIMATE 
TRIM SETTING 
(MM) 

NUMBER OF 
PAGES IN 
FINISHED 
BOOKLET 

3 
210 x 298 mm (8.5 
x 11 in.), A4 

149 x 210 mm 
(5.5 x 8.5 in.) 

32 lbs./ 120 g/m2 135 10 

4 
210 x 298 mm (8.5 
x 11 in.), A4 

149 x 210 mm 
(5.5 x 8.5 in.) 

20 lbs./ 75 g/m2 125 10 

5 
210 x 298 mm (8.5 
x 11 in.), A4 

149 x 210 mm 
(5.5 x 8.5 in.) 

80 lbs./ 120 g/m2 135 12 

6 
250 x 353 mm (8.5 
x 14 in.), B4 

250 x 176.5 mm 
(8.5 x 7 in.) 

20 lbs./ 75 g/m2 172 6 

7 
250 x 353 mm (8.5 
x 14 in.), B4 

250 x 176.5 mm 
(8.5 x 7 in.) 

24 lbs./ 90 g/m2 170 6 

8 
297 x 420 mm (11 
x 17 in.), A3 

210 x 297 mm 
(8.5 x 11 in.), A4 

24 lbs./ 90 g/m2 200 14 

9 
297 x 420 mm (11 
x 17 in.), A3 

210 x 297 mm 
(8.5 x 11 in.), A4 

80 lbs./ 216 g/m2 205 5 

10 
297 x 420 mm (11 
x 17 in.), A3 

210 x 297 mm 
(8.5 x 11 in.), A4 

20 lbs./ 80 g/m2 210 22 

11 
297 x 420 mm (11 
x 17 in.), A3 

210 x 297 mm 
(8.5 x 11 in.), A4 

24 lbs./ 90 g/m2 210 8 

12 
297 x 420 mm (11 
x 17 in.), A3 

210 x 297 mm 
(8.5 x 11 in.), A4 

80 lbs./ 120 g/m2 205 10 

13 
305 x 458 mm (12 
x 18 in.) 

152 x 229 mm 
(6 x 9 in.) 

80 lbs./ 120 g/m2 220 6 

14 
305 x 458 mm (12 
x 18 in.) 

152 x 229 mm 
(6 x 9 in.) 

80 lbs./ 120 g/m2 215 5 

15 
305 x 458 mm (12 
x 18 in.) 

152 x 229 mm 
(6 x 9 in.) 

80 lbs./ 120 g/m2 210 4 

16 
305 x 458 mm (12 
x 18 in.) 

152 x 229 mm 
(6 x 9 in.) 

28 lbs./ 105 g/m2 220 16 

17 
305 x 458 mm (12 
x 18 in.) 

152 x 229 mm 
(6 x 9 in.) 

80 lbs./ 120 g/m2 210 14 
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SquareFold® Trimmer Specifications

ITEM SPECIFICATIONS 

Paper size • Maximum: 330 x 457 mm (13 x 18 in.) 
• Minimum: 216 x 270 mm (8.5 x 11 in.), A4 SEF 

Trim capacity • 5–20 sheet booklet (up to 80 imaged sides) at 90 g/m2, 24 lb. 
• 5–25 sheet booklet (up to 100 imaged sides) at 80 g/m2, 200 lb. 

Trim size 2–20 mm, adjustable in 0.1 mm increments 

Paper weights 16 lb. bond–90 lb. cover 

60–350 g/m2 uncoated and coated
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Job Workflows

PRINTING EXTRA-LONG SHEETS

Printing Extra-Long Sheets (XLS) with the EX and EX-P Print Servers

You can print on long sheets up to 330 x 660 mm (26 in.) using the standard XLS feature. This lets you create 
Banners, Advertisements, A4 Landscape Book Covers, Calendars, and Long Sheet Prints.

XLS specifications include:

• Print Speed: Up to 9 ppm, Simplex Mode only

• Paper Weights: Uncoated: 52–220 g/m2, Coated: 52–220 g/m2

• Maximum Paper Size: 330 x 660 mm

• Maximum Printable Area: 323 x 654 mm

To use this feature, you must feed sheets from Tray 5 and send them to an output destination of the Offset Catch 
Tray or a Top Tray of the High Capacity Feeder or Finisher.

To print Extra Long Sheets, follow these steps:

1. Load the paper into the Tray 5 (Bypass) located on top of the 2-Tray Advanced Oversized High Capacity Feeder. 
When no optional feeders are configured with the system, load the paper directly on the side of the press. 
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a. Open the Tray 5 paper guides wider than the paper so you can easily insert the paper.

b. Hold the center of the paper guides and close them so that they touch the edges of the stack.

c. Gently push the paper stack into Tray 5 until it stops.

2. From the print server, go to PredictPrint Media Manager > Stock Wizard.

3. Scan the barcode on the stock, then select Tray 5 from the Stock Wizard Load screen. To set up the stock, follow 
the steps in the Stock Wizard. 

Note: For details on setting up the stock in the Stock Wizard, refer to Scanning a Media Barcode.

4. Submit the job file to the print server Hold queue. Send the job using File > Print from a PC on the network, or 
use the Import function at the print server: 

a. On the Fiery print server, click the Import shortcut.

b. Click Add.

c. Navigate to the file and select it.

d. Click Hold. 

The job is sent to the Hold queue.

5. Set the Job Properties at the print server:  

a. To open the Job Properties, in the Hold area, double-click the job.

b. On the Quick Access tab, set Copies to the number of prints that you want to make.

c. On the Quick Access tab, for Paper size, click Custom.

d. Set the Width and Height of the paper, as you did at the press Control Panel. 

Note that the terms for the paper dimensions are different on the server:

The width is the measurement in the cross-process direction, and the height is the length of the paper in the 
process direction. The process direction is the direction in which the paper moves in the press.

e. Click OK.

f. On the Media tab, set Paper source to Tray 5 (bypass).

g. On the Finishing tab, for Delivery options, select the OCT or specific top tray that you want to use to collect 
the prints. Output is delivered to the Offset Catch Tray or Top Tray.

6. Click Print and monitor the job.

PRINTING SADDLE-STITCHED BOOKLETS WITH FULL BLEED,  TRIMMED EDGES,  AND 

INSERTING PREPRINTED COVERS

Important: The following print job workflow requires you to have an Inserter device, a Production Ready (PR) 
Booklet Maker Finisher, a Two-Sided Trimmer, and a SquareFold Trimmer device. 

This workflow produces an appealing look on the printed output by doing the following: 
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• The booklet maker creates saddle-stitched booklets

• The two trimmers cut off the edges on three sides of the booklets so that the images extend to the edge of the 
pages

• Preprinted cover pages are inserted into the workflow with the Inserter device

Creating Booklets with Full Bleed on the EX and EX-P Print Servers

Important: This procedure requires you to have an Inserter, a Production Ready (PR) Booklet Maker Finisher, 
a Two-Sided Trimmer, and a SquareFold Trimmer. 

The booklet maker creates saddle-stitched booklets, and the two trimmers cut the edges from three sides of the 
booklet so that the image prints to the edge of the page. Additionally, you can use the Inserter to include pre- 
printed cover pages. This full bleed can produce an appealing look for some documents. The setup for this type of 
workflow is as follows:

• Loading the paper and programming it from the print server

• Submitting the job and opening Job Properties

• Setting properties for the media, layout, folding, and trimming.

• Making settings to insert pre-printed covers

• Releasing the job for a proof copy

• Checking the output and making any adjustments to the trim settings or imposition

• Printing the job

Note: It is useful to print the file first with no trim to see how much trim is needed to achieve the full bleed 
of page images.

To produce booklets with three-sided trimming for a full bleed, perform the following steps:

1. Load the paper into a press tray. 
If you want the finished size to be 8.5 x 11 in. (A4), load 12 x 18 in. (A3) paper and impose two 8.5 x 11 in. 
images onto each side of the sheets. This provides an edge around the images for trimming. If you load 11 x 
17 in. paper, you can still impose two 8.5 x 11 in. images onto each side of the sheets, but after the edges are 
trimmed the resulting size will be less than 8.5 x 11 in.

The Stock Wizard opens on the print server.

2. Scan the barcode on the stock, then to set up the stock, follow the steps in the Stock Wizard. 

Note: For details on setting up the stock in the Stock Wizard, refer to Scanning a Media Barcode.

3. Submit the job file to the Hold queue on the print server.

4. At the print server Hold queue, double-click the job to open its properties. 

5. On the Quick Access tab, enter the Paper size and Paper source (where you loaded the paper) and the 
number of Copies.

6. On the Media tab, for Duplex select Top-top if printing on two sides of the paper.  
For 1-sided (Simplex) printing, leave the setting Off.

7. On the Finishing tab, under Fold, set Fold style to Booklet-fold.
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8. On the Finishing tab, under Stapler, set Stapler mode to Center. 

9. On the Finishing tab, under Trim, select the box for Head and foot trim.

10. Use the up and down arrows to set the Finish Size of pages.  
This is the distance from the top of the page to the bottom.

11. For Spine printing, select Normal.

12. Select the box for Engage fore (face trim).

13. Use the up and down arrows to set the face trim.  
You can set the Finish Size, which is the distance from the spine to the right side of the page for a right-bound 
booklet, or the amount of the face to be trimmed.

14. If your file has been pre-imposed, the settings are now complete and you can release the job to print. 
However, if the file is not pre-imposed, to set the imposition for the job, on the Layout tab, select Booklet.

15. If you are not inserting pre-printed covers, proof the job now, check the output, then print the full job.

16. To insert covers when the job is pre-imposed: 
If you have an Inserter configured with your press, optionally, you can insert pre-printed cover sheets for 
booklets. The size of the cover sheets should be the same as the body sheets. The Booklet Maker wraps the pre- 
printed cover sheet around the body pages to form front and back covers.

a. Load the pre-printed cover stock into the Inserter (Tray T-1).

b. From the print server, go to PredictPrint Media Manager > Stock Wizard.

c. Scan the barcode on the stock, then select Tray T1 from the Stock Wizard Load screen. To set up the stock, 
follow the steps in the Stock Wizard. 

Note: For details on setting up the stock in the Stock Wizard, refer to Scanning a Media Barcode.

d. At the print server, in Job Properties, select the Media tab, then scroll down and select Define Cover.

e. For Front Cover, select the check box, then from the drop-down menu, select Insert.

f. For Paper Source, select T1.

g. If the cover stock is different from the body stock, set any other unique paper properties for the cover 
stock. For example, the g/m2 weight may be heavier.

h. On the Cover Media window, select OK.

i. To release the job, on the Media tab, select Print.

17. For inserting covers when the job is not pre-imposed: 

a. Load the pre-printed cover stock into the Inserter (tray T-1). 

The Stock Wizard opens on the print server.

b. Scan the barcode on the stock, then to set up the stock, follow the steps in the Stock Wizard. 

Note: For details on setting up the stock in the Stock Wizard, refer to Scanning a Media Barcode.

c. At the print server, select the Layout tab.

d. Scroll down to the Cover area.

e. Select Pre-Printed.
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f. Select Define Cover.

g. For Cover source, select T-1.

h. For Media Weight, select the g/m2 for the cover stock and set any other unique cover stock properties.

i. Select OK.

18. To release the job, on the Layout tab, select Print.

ADJUSTING BOOKLET FOLD AND STAPLE POSITIONS

Use this procedure:

• To adjust the staple position horizontally on the paper

• To ensure that the booklet staples lay precisely on the fold, and not off the fold

Note: This procedure does not enable you to move the staples up or down on the fold. A Customer Service 
Engineer must make vertical adjustments for staple positions on the fold.

To adjust the fold and staple positions for booklets and create a profile with the adjustments, use the PredictPrint 
Media Manager. To apply the profile to the booklet job, associate the created profile with the media to be used for 
the job. Perform adjustments separately for a small set of sheets (Set 1) and a large set of sheets (Set 2). 

The system calculates and automatically uses the required adjustments for booklets that vary in size between Set 1 
and Set 2. The paper weight for the booklet media is important when creating the profile. The number of sheets 
used in the sets varies based on the selected paper weight.

Creating a Profile for Adjusting the Fold and Staple Positions

1. For the booklet job, load the paper, short-edge feed (SEF), in the tray.

2. Confirm or change the media settings at the press user interface.

3. Log in to the PredictPrint Media Manager as System Administrator.

4. On the main window, select Profiles.

5. Select the Fold Adjustment tab.

6. To create a new profile, click New. To make adjustments to an existing profile, click Edit.

7. From the Fold Type drop-down menu, select Bi-Fold-Multiple Sheets Stapled.

8. For Name, enter a unique and meaningful name for the profile so that it can be selected when needed. 
Optionally, you can accept the default name that is automatically provided (Fold Profile 1, Fold Profile 2, and so 
on.)

9. Enter the Paper Size, Weight, and Coating for the stock to be used for the booklets.

10. On the left of the window, click Test Print.

11. From the Tray menu, use the arrow to select the tray with the loaded stock you are using.

12. If you are using the trimmer to cut edges on the booklets, set Trim to On. Otherwise, leave this setting Off.

13. Click Start. An information message lets you know that the test print is being created, followed by a message 
that the print is complete.
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14. A message appears that tells you that the test print is complete. Click Close. An adjustment window opens that 
shows you the two dimensions that need to be measured and entered: A and B. 

15. Collect the Test Print and hold it in front of the adjustment window in the position shown on the left of the 
window, with the large black arrow facing up and pointing left. 

16. Determine whether the left and right sides are equal or if one of the sides is longer. If the sides are equal, you 
do not need to make any adjustments and you can go to Step 20.

17. If one side is longer, measure the amount of overlap – the distance between the edges. Determine the 
difference in millimeters.

18. Select Left Side of Fold is Longer or Right Side of Fold is Longer. Note that the left side is the top side in the 
drawing and the right side is shown on the bottom.

19. Set the distance of the overlap using the up arrow. As you enter the amount in millimeters, the image of the 
fold changes to confirm which edge you selected as longer. Look at the image and verify that it represents the 
layout of your test print.

20. Now evaluate the staple position. If the staple lies exactly on the fold, you do not need to make any 
adjustments and you can go to next step. If the staple is positioned off from the center of the fold, measure 
the distance from the fold in millimeters.

21. If the staple is too far up and onto the top sheet, select Left of Fold. If the staple is rotated too far down and 
onto the bottom sheet, select Right of Fold. 

22. Set the distance of the offset using the Up Arrow. As you enter the amount in millimeters, the image of the 
staple position changes to confirm which direction you selected. Look at the image and verify that it represents 
the staple position on your test print. This completes the adjustments for Set 1. 

23. To output a sample with the new settings, select Test Print. If you are satisfied with the new fold and staple 
positions, go to the next step. If further adjustments are needed, return to the earlier steps to measure and 
adjust the fold position in Step 19, or the staple position in Step 22, or both positions.

24. On the right side of the screen, notice the Sheets in Set 2 field. This is the number of sheets in Set 2. You can 
leave this number as it is and complete the steps. This ensures that the profile is flexible enough to be 
appropriate for booklets with a range of pages. However, if you always print booklets of a certain size, you can 
set this number to the exact number of pages in your booklets for greater accuracy. The maximum is 30. You 
can set this now or leave it at the default setting for greater flexibility.

25. On the right side of the adjustment window, click Test Print.

26. From the Tray menu that opens, select Start. To make adjustments for Set 2, repeat Step 13–Step 22.

27. When all adjustments are complete, click OK. On the Fold Adjustment tab, you can see your new profile listed.

28. Click Close.

Applying the Fold and Staple Position Profile to a Stock Type

1. On the main window of the PredictPrint Media Manager, select Stock Library.

2. When the Stock Library window opens, select the specific stock to which you want to apply the profile.

3. Click the Edit icon. 

The Stock Properties window appears.

4. Click Advanced Setup. 
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a. Select the various Advanced Stock Setup options as needed. For details, refer to Advanced Stock Setup 
Options.

b. To save your selections and close the Advanced Stock Setup window, click OK.

5. Click Fold Adjustment Profile.

6. Click the radio button for Select from List.

7. Select the specific Fold Adjustment Profile that you created for this stock, then click OK.

8. On the Advanced Stock Setup window, click OK, then on the Stock Properties window, click OK.

PRODUCING SIMPLE FOLDED SHEETS AND INSERTING FOLDED SHEETS INTO A DOCUMENT

Use the Production Ready (PR) Finisher, Basic Punch, and C/Z Folder to produce simple folded sheets or insert folded 
sheets into a document.

With the optional C/Z Folder, you can produce C and Z folds on 8.5 x 11 in. or A4 sheets. You also can create 
engineering Z-Fold on 11 x 17 in. or A3/B4 stock. This is also called “Z-Fold Half Sheet.” The Z-Fold or Z-Fold Half 
Sheet folds the 11 x 17 in. or A3/B4 paper and reduces the sheet to 8.5 x 11 in. or A4 paper. This lets you insert the 
folded sheet into an 8.5 x 11 in. (A4) document so that the reader can pull out the folded portion to see an extra- 
large image.

C-Fold or Trifold Z-Fold Z-Fold Half Sheet or Engineering Z- 
Fold 

Important: When loading or selecting stock for folding, it is important to note that the paper must be 
positioned Short Edge Feed (SEF).

Note: Each Z-Fold Half Sheet added to a stapled set counts as 10 sheets. It reduces the total number of 
sheets for any given specified weight range.

Producing Simple Folded Sheets with the EX and EX-P Print Servers

1. For the job, load the paper short-edge feed (SEF) into the required tray and program the stock in the 
PredictPrint Media Manager.

2. Submit the job to the Hold queue on the print server.

3. From the print server, double-click the job to open its Properties, and set the quantity of copies that you want to 
print.

4. Set all required properties for the job, such as quantity, paper size, source tray, and 1-sided or 2-sided.

5. For C and Z folds, use 8.5 x 11 in. or A4 sheets. For Engineering Z Fold (Half Z Fold), use 11 x 17 in. or A3/B4 
paper.
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6. Select the Finishing tab and scroll down to the Fold area.

7. Under Fold, set the fold type that you require:  

a. C or Tri-fold

b. Z fold

c. Half Z fold

d. Half fold

8. Set the fold to Inside or Outside. When you select Inside, page 1 is within the fold. For Outside, page 1 is on 
the back of the fold.

9. If a message opens stating that the output delivery is Face down - normal order and should be Face 
down - reverse order, select OK to correct the setting.

10. If you want the sheets punched, under Punch, set Punch edge to Left, Right, or Top, and set Punch to 2 hole 
punch or 3 hole punch.

11. Select Print.

12. Collect the folded output from the top tray of the finisher or the bottom drawer of the C/Z Folder. To open the 
bottom drawer of the C/Z Folder, push the button on the top left of the front of the unit.

Inserting Folded Sheets into a Document with the EX and EX-P Print Servers

You can insert printed and folded sheets into documents as long as they are not booklets created by imposing and 
folding large sheets. For example, document sets can receive folded sheets if they are stapled and/or hole-punched, 
but not booklets. Inserting an Engineering Z Fold or Half Z Fold can create a useful and attractive fold-out sheet for 
large images in technical manuals or advertising pieces. The folded sheet is printed as a regular sheet in the 
document, but programmed as an exception page for folding.

1. If needed, load the paper for the job and program it in the PredictPrint Media Manager.

2. Submit the job to the Hold queue on the print server.

3. From the print server, double-click the job to open its properties.

4. Set all required properties for the job, such as Copies, Paper size, Source tray, and 1-sided or 2-sided.  

In most cases, you will be printing the document on 8.5 x 11 in. or A4 paper, and printing 2-sided, top-to-top.

5. Select the Finishing tab and scroll down to the Fold area.

6. Under Fold, set the fold type to Half Z fold.  
Although you are not applying the fold to all pages in the document, you need to select the fold setting here so 
that it will display as a selection in the Mixed Media definition that you set in the following setps.

7. If you want the document stapled, under Stapler, set Stapler mode to the location of the staples. 

8. If you want the document punched, under Punch, set the Punch style to your preference.

9. Scroll down to the Mixed Media area and select the New Page Range button.

10. Under Define Media for Page(s), enter the page or pages that you want to be folded.  
If you are printing 2-sided, select 2 pages, which will be the front and back of the folded page.

11. For Paper size select 11 x 17 in. (A3).

12. For Fold style, select Half Z-Fold.
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13. Select Add Definition.

14. Select Close. 

15. Select Print.

USING THE INSERTER DEVICE TO INCLUDE SHEETS OR TABS INTO THE PRINTED OUTPUT

When inserting covers, sheets, or tabs into printed documents using the Inserter device, the insertion is done after 
documents exit the press and before they reach the end of the chain (the final finishing device where the output is 
retrieved). Therefore, the inserted material must be either preprinted or blank. 

Note: If you want to print on the inserted sheets, use Tray 5 (Bypass) or another tray.

The setup for inserting sheets or tabs involves using Exception Pages to define the location of the inserts and 
selecting the tray from which to pull the inserts. In the case of this workflow, the selected tray will be tray T1 
(Inserter device).

Inserting Sheets and Tabs into the Printed Output with the EX and EX-P Print Servers

1. If needed, load the main stock for the document into a feeder tray with a LEF (Long Edge Feed) orientation. If 
it is a new stock for the tray, program the stock in the PredictPrint Media Manager. 

2. Load the sheets or tabs into the Inserter tray T1 with a LEF (Long Edge Feed) orientation.  
If loading tabs, place the tabs facing up and out, at the trailing edge of the stock. When inserting pre-printed or 
blank tabs, the system does not know how many tabs are in a set, and simply inserts the tabs, one at a time, in 
the same order they are placed in the tray. This means that you should check the tab sets and ensure that 
there are no partial sets. In addition, if you have a jam and lose some tabs, you will have to restart the job on a 
full tab set in the Inserter.

3. Program the stock to insert in the PredictPrint Media Manager:  

Note: When feeding Special Pages from a specific tray, the properties for that stock must be unique when 
compared to other loaded stocks, otherwise the print server could select the same type of stock from 
another tray. Since you only want the preprinted stock in tray T1 to be used, check that no other stocks in 
other trays have the same properties (name, size, and weight). If they do, go to the print server and define 
the stock that you want to use with a unique name. In most cases, a cover stock being fed from tray T1 will 
have a heaver weight than other loaded papers, which will make it unique.

a. Open the PredictPrint Media Manager, and select Tray T1.

b. If the tab stock that you loaded is defined in your Stock Library, select the Stock Library button and select 
the tab stock. Otherwise, select Create Temporary Stock and enter the following:  

• A size of 8.5 x 11 in. (A4)

• The weight of the tab stock. This is usually about 164 g/m2, but will depend on your stock.

• For Type, select the type of stock to be inserted, for example, Precut tab - Plain.

4. Select the Long Edge Feed radio button.

5. Select OK to close the Tray Properties window.

6. Minimize the PredictPrint Media Manager.

7. Submit the job file to the Hold queue on the print server.
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8. Double-click on the job to open its properties.

9. Set all the properties for the job, such as paper size, 1-sided or 2-sided, and number of copies.

10. Select the Media tab, then scroll down to the Mixed Media section.

11. Select New Insert.

12. With Page Number selected, enter the page numbers after which you want to insert pre-printed or blank 
sheets or tabs. Use a comma to separate the numbers.

13. For Paper Size, select the size of your tabs: 8.5 x 11 in. Tab LEF or A4 Tab LEF.

14. For Media Type, select Tab stock (uncoated) or Tab stock (emboss).

15. Select Insert.

16. Select Close.

17. Select Print.

USING THE GBC ®  ADVANCEDPUNCH ®  PRO

Using the GBC® AdvancedPunch® Pro with the EX and EX-P Print Servers

1. If needed, load the paper for the job and program it in the PredictPrint Media Manager.

2. Submit the job to the Hold queue on the print server.

3. Double-click the job that is held to open its properties.

4. Set all required properties for the job, such as copies, paper size, source tray, and 1-sided or 2-sided.

5. Select the Finishing tab.

6. Scroll down to the Punch area. 

7. For Punch edge, select the location of the punch on the paper: Left, Right, or Top.

8. For Punch, select Advanced Pro-ANSI or Advanced Pro-ISO.  

The exact name of the unit depends on your geographic region.

9. Select Print on the finishing tab to release the job.
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Maintenance

GENERAL PRECAUTIONS AND WARNINGS

Warning: Precision components and high-voltage power supplies are used on the press: 

• Never open or remove covers that are screwed shut unless specifically instructed in the User Guide. 

• A high-voltage component can cause electric shocks. 

• When opening the panels and covers that are screwed shut to install or detach optional accessories, be 
sure to follow instructions in the User Guide. 

• Do not try to alter the press configuration or modify any parts; doing so might cause press malfunction 
or fire.

Caution:  

• Do not place the equipment where people may step or trip on the power cord.

• Do not place objects on the power cord.

• Do not override or disable electrical or mechanical interlocks.

• Do not obstruct the ventilation openings. These openings prevent overheating of the equipment.

• Never push objects of any kind into slots or openings on this equipment. Making a contact with a 
voltage point or shorting out a part may result in fire or electrical shock.

• Use the materials and supplies specifically designed for your equipment. The use of unsuitable 
materials may result in poor performance of the equipment and possibly a hazardous situation.

• Follow all warnings and instructions that are marked on or supplied with the equpiment.

• Do not block or cover the slots and openings on the equipment.

• Do not attempt to override any electrical or mechanical interlock devices.

CLEANING THE PRESS 

Read and adhere to the following information when cleaning the press:

• Before you start to clean the press, be sure to switch off the power using the circuit breaker switch and unplug 
the press.  

WARNING: Cleaning the press without switching off the power may cause an electric shock.

• Always use a dry lint-free cloth for all cleaning actions unless otherwise directed. 

Caution: Do not use benzene, paint thinner, other volatile liquids, or spray insect repellent on the 
press as doing so may discolor, deform, or crack covers.

• If a moistened cloth is used, wipe afterwards with a dry lint-free cloth.  
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Caution: Cleaning the press with an excessive amount of water can cause the press to malfunction 
and damage the documents during printing.

Cleaning the Exterior

1. Wipe the exterior with a soft cloth moistened with water. If dirt is difficult to remove, try gently wiping with a 
soft cloth moistened with a small amount of neutral detergent. 

2. Wipe off any excess water from the exterior with a soft cloth. 

Clean Fuser Assembly Routine

Run the Clean Fuser Assembly routine from the Tools menu when you encounter an image quality issue caused 
by contaminants in the fuser. For example, use this feature when you see dry ink/toner debris on the back side of 
prints.

The press automatically runs this routine periodically. If you see image quality problems with dry ink/toner on the 
back of prints, you can initiate this procedure manually.

Cleaning the Fuser Assembly with Paper

Note: If you still notice contaminants on the back of the prints after running this procedure, contact your 
Xerox Service Representative. Dry ink/toner debris may be coming from the transfer roll area instead of the 
fuser.

1. Select the Tools button on the press control panel.

2. Select Clean Fuser Assembly. 

3. For Paper Supply, select the paper tray to use. 

Note: Any type of paper and size can be used. However, the smooth surface of coated paper does offer 
more contact area to the pressure roll.

4. For Number of Sheets, select the number of blank sheets to print (1 to 5). 

Note: For best results, run fewer sheets for a multiple number of times. It is more effective to run one or two 
sheets for multiple times than to run five sheets for one time only. This is especially important when running 
larger sheets, in the short-edge-feed (SEF) direction, such as 11 x 17 in. or A4 paper.

5. Select Save.
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6. Press the Start button.  
The system begins the cleaning process.  

Note: When running five sheets of paper, the process takes approximately one minute.

When the cleaning process is finished, a Completed Successfully message displays.

7. Select OK.

Cleaning the Raster Output Scanner (ROS) Window Areas

Unfused dry ink/toner collects on the four color raster output scanner (ROS) window areas located just above the 
drum cartridge drawer inside the press. Contaminated ROS windows can cause a white streak defect on your printed 
output. 

If you notice white or light streaks on prints, to resolve this issue, clean the ROS windows with the following 
procedure.

Important: Use only the cleaning wand and cloth pad provided when performing this procedure. Do not use 
any other cleaning device, liquid solutions, or cloths.

1. Open the left and center front doors of the press. 

2. Locate and remove the cleaning wand tool stored on the inside panel of the left front door. 

262 Xerox® Versant® 4100 Press User Documentation

Working With



3. Make sure the pad at the tip of the wand is clean. 
Several pads are provided with the cleaning wand when the press is installed.  

Note: Replace the pad when it becomes a dark color. Always use a clean pad in order to ensure optimum 
image quality on the printed output. 

To acquire extra pads, contact your Xerox Service Representative. 

4. Clean one of the ROS windows: 

a. With the pad that faces upward and the felt-tip first, insert and gently push the wand fully into the ROS 
window opening.  

b. Pull the wand fully out toward you. 

c. Repeat the push-in and pull-out motion two or three times more.

5. Remove the tool and insert it into the next hole, then repeat the previous step.  
Continue until you complete the procedure for all four ROS windows.

6. Replace the cleaning wand tool into the storage area on the inside panel of the left front door.

7. Close the left and center front doors of the press.
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Performing the Clean Toner Procedure

Important: The following procedure is performed only by a person who has press administrator privileges 
and is logged onto the press as administrator. Non-administrator users must contact an administrator in 
order to to complete this procedure.

Use the Clean Toner procedure after running a low area coverage job followed by large area coverage job, which 
caused toner agglomerates and clumps on the output prints. The press runs a full-page halftone to purge the debris 
and any residual dry ink/toner from the system.

Note: It is recommended that you run a few test prints before performing the cleaning procedure. After the 
Start Cleaning button is selected, the system automatically generates a test print. This allows you to 
compare the before and after prints for image quality.

1. At the press control panel, log in as the administrator.

2. Press the Machine Status button.

3. Select the Tools tab.

4. Select System Settings > Common Service Settings > Maintenance.

5. Scroll through the Maintenance pages and select Clean Toner.

6. Select the desired dry ink/toner colors to clean. 
If desired, you can select all the toner colors.

7. Press Start. 

After the purge page prints, a Successfully Completed message appears.

8. To ensure that the problem is resolved, select Sample Print.

9. Select Close repeatedly until the main Tools screen appears.

10. Exit the administrator mode.

CALIBRATING THE PRESS

Note: The information contained in this section is about calibrating the press only. 

For information about calibrating the print server, refer the System Administrator Guide for the press. Also refer to 
the print server documentation.

Full Width Array

Accessed from the press control panel, the Full Width Array feature calibrates the print engine only. The in-line Full 
Width Array adjusts print engine color controls, provides image density uniformity, and enables print server 
calibration and profiling without the need to use an external spectrophotometer.

The Full Width Array uses xerographic parameters and diagnostics to analyze the finished image and correct errors 
in output color and density uniformity. This feature uses internal color calibration strips (or tiles) as reference for 
known colors of a test pattern. These color values are automatically adjusted to produce accurate and consistent 
reproductions.

The Full Width Array is located in the paper path after the fuser and contains an inline scanner to provide print 
engine adjustments. The adjustments ensure uniformity of dry ink/toner on prints and image alignment.
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The Full Width Array provides these two adjustments:

• Automatic Density Uniformity Adjustment: Run this image quality adjustment when the printed output 
density is inconsistent (non-uniform) within the printed page. Non-uniform, inconsistent density may appear as 
faded colors on portions of the printed page (jobs running light and dark). 

The press operator may perform this procedure. It does not require system administrator access.

• Automatic Alignment: This feature adjusts the print image position on paper. Image-to-media alignment 
ensures correct positioning of the print image on paper and is important for calibrating new media. For more 
information on this feature, refer to the Automatic Alignment Information. 

Note: This feature is available only from the PredictPrint Media Manager on the print server and not 
from Tools on the press control panel. It is available only to system administrators using the Profiles 
function of the PredictPrint Media Manager.

These Full Width Array quality control measurements and adjustments are automatic after you initiate them from 
the Tools menu on the press control panel or from the PredictPrint Media Manager Profiles feature.

The Full Width Array improves operator and press productivity because it replaces lengthy manual procedures for 
press print engine adjustment, saves time from scanning targets with an external spectrophotometer, and uses 
simple steps that previously required a service engineer for some procedures. The Full Width Array can also be used 
to save time by automatically scanning and measuring targets when performing print server calibration and 
profiling initiated from the print server. For more information, refer to the System Administrator Guide.

Tip: Before running color-critical jobs, run the Density Uniformity Adjustment procedure and use the calibration 
features at the print server to ensure that your press maintains the best image quality with less or no down time. 

Note: Refer to your print server user documentation when performing the calibration workflow of the print 
server in conjunction with the print engine. Alignment and registration adjustments are performed at the 
print server.

Density Uniformity Adjustment

Density Uniformity Adjustment is done to ensure even dry ink/toner density across each page. 

The press prints density test patterns, scans them and automatically corrects for variations by resetting software 
controls. Uniformity is important for high area coverage applications where density drift from edge to edge can 
impact image quality. Density Uniformity Adjustment saves time because without it a service call is required to 
make this type of adjustment. 

Run Density Uniformity Adjustment to correct inboard to outboard density uniformity defects; for example, the 
image quality is lighter (faded) or heavier (thicker) on the left or right sides of the output (inboard or outboard). 
Also run Density Uniformity Adjustment after xerographic components are replaced. 

Note: Density Uniformity Adjustment does not require system administrator access and may be performed 
by the operator from the press control panel.

Adjusting Automatic Density Uniformity

1. Press the Tools button on the control panel.

2. Select Full Width Array Density Uniformity Adjustment.

3. Select the Paper Supply button.
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4. Select a tray which contains 11 x 17 in. or A3 paper, or 12 x 18 in. or SRA3 paper.

5. Select Save. 
You may have to wait a few minutes while the Full Width Array gets ready. 

6. Select Start. 

The press prints the test targets, measures them, and automatically adjusts the dry ink/toner density for 
consistent application across the page.  

Note: The printed sheets do not yet reflect the new settings but are the sheets that were used to make the 
adjustments.

7. Decide if you want to visually check the new settings: 

• If you do nnoott want to print sheets with the revised settings, select Save and Close.

• If you ddoo want to print sheets with the revised settings, select the Sample Printout button to view the 
adjustment prints. 

Sample sheets print using the updated settings.

8. Check the printed samples for density uniformity and consistency.  

• Verify that each line of color shows even density across the page, as shown in the following illustration: 

* Check for uniform, consistent density across all color bars as indicated by the arrows in the above 
illustration.

If acceptable, select Save and Close.

• If the results are not acceptable, repeat the previous steps of this procedure.

9. Select Close to complete the Density Uniformity Adjustment.

REPLACING CONSUMABLE SUPPLIES

Note: Refer to www.xerox.com for the latest consumable part numbers.

The following items are the Customer Replaceable Units (CRU) for the press. It is recommended that you have a 
supply of these items available to eliminate down time when they need to be replaced.

• Dry Ink/Toner cartridges (C, M, Y, K)

• Drum cartridges (C, M, Y, K)

• An empty Waste Dry Ink/Toner bottle
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• Trays 5–9 feed rolls

• Suction Filter

Note: Store supply items and Xerox parts in their original packages in a convenient location. Always recycle / 
dispose the used CRU according to the disposal instructions supplied with the new CRU.

Ordering Supplies

Xerox supplies, paper, and throughput material can be ordered from the website www.xerox.com and clicking the 
Supplies link. For any item that is not orderable from the website, contact your Xerox Service Representative.

Note: The cleaning pads used with the Raster Output Scanner Window cleaning wand are not orderable. 
Contact your Xerox service representative for any additional cleaning pads. 

CRUS SUPPLY ITEM REORDER QUANTITY 

APPROXIMATE PRINT YIELD  

(FULL COLOR 8.5X11, A4 
PRINTS)

Black Dry Ink/Toner Cartridge 1 per box, 2 per press 50,000* 

Cyan Dry Ink/Toner Cartridge 1 per box 55,000* 

Magenta Dry Ink/Toner Cartridge 1 per box 51,000* 

Yellow Dry Ink/Toner Cartridge 1 per box 51,000* 

Waste Dry Ink/Toner Bottle 1 45,000 

* Dry Ink/Toner yield projections are based on 7.5 percent-area coverage per color (4 colors = 30 percent) at 
standardized conditions on A4 or 8.5 x 11 in., for Xerox Digital Color Xpressions+, 24 lb. (90 g/m2) and for 
Colotech Plus 90 g/m2 reference paper.

Suction Filter 1 200,000 

Drum Cartridge (R1) 1 per box 348,000 

Drum Cartridge (R2) 1 per box 348,000 

Drum Cartridge (R3) 1 per box 348,000 

Drum Cartridge (R4) 1 per box 348,000 

Feed Roll Kit (Trays 5–9)**  1 kit 500,000 

**Each tray requires its own feed roll kit. Each kit contains all the required items for replacing the feed rolls.

Important: Two feed roll kits are available:  

• Reorder number: 000088RR1133119966 for Tray 5 
• Reorder number: 000088RR1133116699 for Trays 6-9, 2-Tray Advanced Oversized High Capacity Feeder or Dual 

Advanced Oversized High Capacity Feeder; 1 roll kit is required for each tray  

For more information, contact the Customer Support Center.
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Checking the Status of Consumables

The Supplies area of the Home window on the press control panel displays an overview of the level of dry ink/toner 
remaining in each cartridge. As the dry ink/toner is used, the colored line representing each cartridge becomes 
shorter. 

When a consumable is reaching the time it needs to be replaced, a message is displayed on the control panel touch 
screen. This indicates when it is time to order or install a new consumable item. With some customer replaceable 
units (CRUs), the screen indicates that the press may continue to run print jobs without immediately replacing the 
item. Otherwise, when it is time to replace it, a message appears and the press stops running.

To check the status of your consumables:

1. Press the Home button on the control panel. 

Notice the Supplies area showing a 1-to-100% indicator bar that shows the remaining amount of dry ink/ 
toner.  

Note: Remaining dry ink/toner is updated in 10-percent increments.

2. To display the exact percentage of remaining dry ink/toner for each cartridge, touch the Information button. 

The Supplies screen displays.
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3. From the menu, select Other Consumables to see the status of other consumables. 

The Other Consumables window displays and provides information about the percentage of remaining life for 
each consumable. 

4. Use the up or down arrows to see additional consumables, such as the drum cartridges, the dry ink/toner waste 
container, trays 6–9 feeder rolls, and consumables for any additional optional devices that are configured with 
the press. 

Note: The status of the suction filter is not shown, but a message displays when it requires replacement.

Replacing the Tray 5 Feed Rolls

To perform this procedure, the feed roll kit is required. The kit contains all the required items for replacing the feed 
rolls.
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Tip: Perform the following procedure when Tray 5 is installed on top of Trays 6 and 7.

Replace the feed rolls for Tray 5 (Bypass) when experiencing frequent multifeeds, single feeds, or blank prints in the 
stack of the output prints.

1. Feed Roll

2. Nudger Roll

3. Separator Roll

1. Locate Tray 5 (Bypass) on top of Trays 6 and 7.

2. Lift up and open the bypass tray cover to access the feed roll components. 

3. Remove the feed roll and install a new one. 
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a. Remove the feed roll by squeezing the metal shaft at both ends and lifting it up and out of the tray. 

b. Install a new feed roll by squeezing the metal shaft at both ends and sliding it into place. 

4. Remove the nudger roll and install a new one. 

a. Remove the nudger roll by squeezing the metal shaft at both ends and lifting it up and out of the tray. 
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b. Install a new nudger roll by squeezing the metal shaft at both ends and sliding it into place. 

5. Remove the separator roll and install a new one. 

a. Remove the separator roll by squeezing the metal shaft at both ends and lifting it up and out of the tray. 

b. Install a new separator roll by squeezing the metal shaft at both ends and sliding it into place. 

6. Close the bypass tray cover.

7. Verify that the tray is operating correctly by feeding paper from the bypass tray.

8. Log in as the administrator or ask the administrator to perform the following steps to reset the High Frequency 
Service Item (HFSI) count to zero (0): 

a. At the control panel, press the Tools button.

b. From the screen that displays, select the Tools icon.

c. Select System Settings > Common Service Settings > Maintenance.

d. Use the arrow buttons to access the next Maintenance screens.
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e. Select the Technical Key Operator (TKO) icon.  

The Technical Key Operator feature displays.

f. Log in to the Technical Key Operator mode. 

AAtttteennttiioonn

If you cannot log in as TKO, or do not have the TKO password, call your Customer Service Engineer.

g. Select the bypass roll items that corresponds with the newly-replaced components.

h. Select Reset Current Value. The system resets the High Frequency Service Item (HFSI) to 0.

i. Exit the administrator mode by pressing the Log In / Out button on the control panel.  

When prompted, select Logout.

Replacing the Feed Rolls for Tray 6 and 7

To perform this procedure, the feed roll kit is required. The kit contains all the required items for replacing the feed 
rolls. 

Important: If replacing the feed rolls for both trays, ensure to obtain two feed roll kits (one for each tray).

Replace the tray feed rolls every 300,000 prints or when experiencing frequent multifeeds, single feeds, or blank 
prints in the stack of the output prints.  

The tray feed rolls include the following components:

1. Nudger Roll

2. Feed Roll

3. Separator Roll
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1. To access the feed components, pull out the tray slowly until it stops. 

2. Replace the nudger roll: 

a. Remove the nudger roll by pushing down on the black tab with one hand (which raises the roll upward) and 
then squeezing the metal shaft on both ends with your other hand.  

b. Lift out the nudger roll.

c. Install a new nudger roll by squeezing both ends of the metal shaft and while pushing down on the black 
tab, insert and release the roll ends into the notches.  

3. To access the separator roll, remove the separator roll assembly at the side of the tray: 
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a. Unscrew the three thumbscrews. 

b. Slide the separator roll assembly all the way to the left so it is out of the slots. 

c. Pull the assembly out towards you until completely removed from the tray and set aside the assembly.

4. With the separator roll assembly out, replace the feed roll: 

a. To remove the feed roll, squeeze both ends of the metal shaft and lift out.  

b. To install a new feed roll, squeeze both ends of the new roll shaft, insert and release the roll ends into the 
notches.  

5. Replace the separator roll:  
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a. To remove the roll from the assembly, squeeze the shafts of the separator roll and lift out of the assembly.  

b. To install a new separator roll, squeeze both ends of the new roll shaft, insert and release the roll ends into 
the notches on the separator roll assembly. 

6. Reinstall the separator roll assembly into the tray.  

a. Align the cutout holes of the assembly with the frame of the tray so the pin holes match up. 

b. Insert the assembly into the frame. 

c. Slide the assembly all the way to the right using the pin as a guideline. 

d. Ensure the device is all the way into the slots and the three screw areas align.  

e. Screw in the three thumbscrews to attach the assembly. Do not over tighten. 

7. Close the tray and verify that the tray is operating successfully by feeding paper using that tray.

8. Log in as the administrator or ask the administrator to perform the following steps to reset the High Frequency 
Service Item (HFSI) counters to zero (0) for each component. 
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a. At the control panel, press the Tools button.

b. From the screen that displays, select the Tools icon.

c. Select System Settings > Common Service Settings > Maintenance. 

d. Use the arrow buttons to access the next Maintenance screens.

e. Select the Technical Key Operator icon. 

The Technical Key Operator feature displays.

f. Log in to the Technical Key Operator mode. 

AAtttteennttiioonn

If you cannot log in as TKO or do not have the TKO password, call your Customer Service Engineer.

g. Select the item that corresponds with the newly-replaced components.

h. Select Reset Current Value. The system resets the High Frequency Service Item (HFSI) to 0.

i. Repeat the previous steps until the counters for all three components are reset to zero (0).

j. Exit administrator mode by pressing the Log In or Out button on the control panel. 

When prompted, select Logout.

Replacing a Dry Ink/Toner Cartridge

Note: The dry ink/toner cartridge can be replaced while a job is printing.

1. Open the dry ink/toner cover, located just above the press front door or cover. 

2. Lay paper on the floor before removing the cartridge. This will allow any excess dry ink/toner to fall on the 
paper.

3. Slowly remove the dry ink/toner cartridge by placing fingers under the end of the cartridge and gently pulling it 
straight out. While pulling out, hold the bottom of the cartridge with your other hand to give it support.  

Ensure that you remove the same cartridge that matches the color as indicated in the message.
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4. Dispose of or recycle the cartridge per your local authorities and regulations. 
In the United States, also refer to the Electronic Industries Alliance website: www.eiae.org. For more information 
about Xerox environmental programs, go to www.xerox.com/environment.

5. Remove the new dry ink/toner cartridge from its packaging.

6. Prepare the cartridge for installation:  

Note: The dry ink/toner material inside the new cartridge is compact. Loosen and redistribute the dry ink/ 
toner material before placing into the dry ink/toner slot.

a. With one hand on either side of the cartridge, vigorously shake and rotate the new cartridge up and down 
and then left and right for 30 seconds.

b. Test whether the dry ink/toner material is distributed sufficiently by turning the auger on the end of the 
cartridge. 

c. If the auger does not turn easily, continue to shake the cartridge and loosen the dry ink/toner material. 
When the auger turns without resistance, the dry ink/toner cartridge is ready for installation.

7. Install the dry ink/toner cartridge by aligning it straight out from the press and gently sliding in until it stops. 

8. Close the dry ink/toner cover.  
If the cover does not close completely, make sure the cartridge is in the lock position and is installed into the 
appropriate dry ink/toner location.

Note: After you replace a dry ink/toner cartridge, the system automatically resets the High Frequency Service 
Item (HFSI) usage counter for this CRU to zero (0). Check the consumables Supplies screen to verify the 
reset and new status.

Replacing the Dry Ink/Toner Waste Bottle

The dry ink/toner waste bottle collects dry ink/toner that accumulates during the printing process. 

Note: When the waste bottle is full, a message displays on the press touch screen informing you to 
exchange the full bottle with an empty one. 

1. Ensure that the press is not in operation (not running any jobs).
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2. Open the center front door and locate the waste bottle. 

3. Grasp the handle of the dry ink/toner waste bottle and slowly pull it halfway out of the press. 

Slowly pulling out the bottle prevents any dry ink/toner from spilling.

4. Continue slowly pulling out the bottle until it is removed from the press: 

a. While grasping the handle with one hand, grip the top of the bottle with the other hand. 
The waste bottle may be heavy. Support the bottle with both hands to ensure that no dry ink/toner is 
spilled while removing the bottle.
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b. Continue slowing pulling out the bottle from the press until it is completely removed. 

Caution: Never use a vacuum cleaner when cleaning up any spilled dry ink / toner. Use a broom or a 
cloth moistened with a neutral detergent.

5. Place the full waste bottle into the plastic bag provided with the bottle.

6. Remove a new, empty waste bottle from the packaging.

7. Hold the center part on the top of a new bottle and insert it gently into the press until it comes to a stop.  

8. Close the center front door. 

Note: After you replace the dry ink/toner waste bottle, the system automatically resets the High Frequency 
Service Item (HFSI) usage counter for this CRU component to zero (0). Check the consumables Supply 
screen to verify the reset.

Replacing the Suction Filter

Important: Before performing this procedure, ensure that you have the required T10 Torx driver tool.

After replacing the filter, contact the system administrator. The administrator must log into administrator mode and 
reset the High Frequency Service Item (HFSI) counter for this CRU to zero (0).

Caution: Make sure the press is powered off before performing this procedure.

1. At the back of the press, locate the suction filter cover on the lower panel.
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2. Us the Torx driver to remove the screw on the right side of the cover by turning the screw counterclockwise.  

3. Pull out and remove the suction filter cover.

4. Grasp the handle of the filter box and pull straight out. 

5. Remove the suction filter from the box.

6. Place the new suction filter into the box and push the filter box in until it stops and is flush with the press.

7. Place the cover onto the filter box area. 

a. Make sure to first insert the left two tabs of the cover into the left side of the box area.

b. Then push the entire cover flush to the press.

8. Insert the Torx driver with the screw attached into the cover and turn clockwise to tighten.

9. Log in as the Administrator or ask the Administrator to perform the following steps to reset the High Frequency 
Service Item (HFSI) count to zero (0), which indicates a new filter has been installed. 

a. At the control panel, press the Tools button.

b. Select the Tools icon.

c. Select System Settings > Common Service Settings > Maintenance. 
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d. Use the arrow buttons to access the next Maintenance options. 

Note: After selecting the icon in following step, there is a 4 second delay before the Technical Key Operator 
feature displays.

e. Select the Technical Key Operator (TKO) icon.  

The Technical Key Operator feature displays.

f. Log in to the Technical Key Operator mode. 

AAtttteennttiioonn

If you cannot log in as TKO or do not have the TKO password, call your Customer Service Engineer.

g. In the Part Number list, select Suction Filter.

h. Select Reset Current Value. The system resets the HFSI to 0.

10. Exit administrator mode. 

a. To return to Tools tab, select Close twice. 

The main Tools screen displays.

b. Select the Log In or Out button on the Control Panel. 

c. When prompted, select Logout.

Replacing a Drum Cartridge

You need to replace a drum cartridge if it has reached the end of its component life, if it is damaged by light, or if 
you are experiencing spots and streaks on the printed output.

Note: All four Drum cartridges are interchangeable.

Important: After replacing the drum cartridge, the system automatically resets the High Frequency Service 
Item (HFSI) usage counter of this CRU component to zero (0). Check the Consumables screen for the reset 
and new status. 

Caution: Do not leave the Drum Cartridge Drawer open for more than one minute. Exposing the drum 
cartridges to direct sunlight or strong light from indoor fluorescent lighting for more than one minute may 
cause image quality defects.

Caution: Replace drum cartridges while the press is powered ON.

1. Ensure that the press is not in operation and not currently printing jobs. 
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2. Open the press left and center front doors. 

3. Turn the R1-R4 Drum Drawer Handle clockwise to the unlock position. 

4. Grasp the Release Handle and pull out the Drum Drawer until it stops. 
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5. Remove the old drum cartridge by holding the finger rings provided at both ends of the drum cartridge and 
gently lifting up. 

Caution: Drums are light sensitive. Do not leave the Drum Cartridge Drawer open for more than one 
minute when replacing cartridges. Exposing the drum cartridges to direct sunlight or strong light from 
indoor fluorescent lighting for more than one minute may cause image quality defects.

6. Clean under drum cartridge area: 

a. With the Drum Cartridge Drawer open, look for dry ink/toner waste on the bottom of the catch pan under 
the drum cartridges. 

b. Use a clean cloth to wipe down the catch pan.

7. Open the bag containing the new drum cartridge. Place the new drum cartridge near the press. 

Caution: Do not touch or scratch the surface of the drum when you take it out from the bag.

8. Unwrap the sheet covering the new drum cartridge and place it under the cartridge.  

Note: Some drum cartridges may include a protective film. If the film is present, remove the film on the 
drum cartridge.

9. Using the finger rings, install the new drum cartridge into the press with the side marked ffrroonntt facing the front.  
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10. Press both ends of the drum cartridge to place it in a horizontal position. 

11. Immediately close the drum cartridge drawer to protect the other drums from light.

12. Return the Release Handle to its original position.

13. Return the R1-R4 handle to the original position and close the press left and center front doors.

14. Insert the used drum cartridge into an empty container for recycling.

Extending Fuser Life with Multiple Fusers

While the press is installed with only one type of fuser (standard type), the system is able to detect three different 
fuser width settings. Discuss the usage of multiple fusers with your Service Representative. Multiple fusers provide 
maximum print output for longer periods of time and ensure image defects on output are avoided. Depending on 
the types of jobs run and their frequency, you may want more than one fuser available, such as the following for 
example:

• One fuser roll for narrower paper

• One fuser for wider paper

Note: The additional fuser can be stored in its original packaging if a fuser stand is not available.

Preventing Fuser Damage

Refer to the following information for tips on preventing damage to the fuser:

• To reduce 11 in./279.4 mm lines and wear marks, you may require the use of two fusers - one when running 8. 
5x 11 in./A4 stock and the other when running 12 x 18 in./304.8 x 457.2 mm or larger stock. This is especially 
true for the graphic arts people.

• Image quality defects such as marks or spots will occur every 110 mm/4.3 in. on the prints if the fuser roll is 
damaged. Defects which occur every 98 mm/3.89 in. indicate a damaged fuser belt.

Fuser Paper Width Information

The press is delivered and installed with a standard type fuser that accommodates all paper width sizes. However, 
the press allows for the installation of other fuser assemblies and paper width types for printing specific paper width 
ranges. When installing a new fuser, the customer can indicate that the fuser be used for certain paper widths only. 
Identifying the fuser width type is performed by connecting the appropriate fuser jumpers provided in the 
nationalization kit as well as attaching a colored fuser width clip. 

To optimize your image quality, you can exchange the standard fuser with a maximum of three different width 
fusers. Use the different jumper resistance connectors to identify a specific fuser and match the fuser with the 
designated paper width NVM settings. Also, a clip on the fuser front cover identifies the width of the fuser being 
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used.

Note: Before using the new fuser, the system administrator must update the NVM width setting values to 
match the specific width used for this fuser.

The following table defines the media sizes, width ranges, and default NVM values that can be set for the fuser.

TTaabbllee 22..11 BByyppaassss CCoonnnneeccttoorr UUsseedd ffoorr DDeeffaauulltt PPaappeerr WWiiddtthh NNVVMM SSeettttiinnggss 

RANGE 
NUMBER 

BYPASS 
CONNECTOR MEDIA SIZE WIDTH RANGE NVM DEFAULT VALUE 

1 None All paper widths 98.0–330.2 mm  

(3.858–13.0 in.)

980–3302 

2 Black Resistor Type • A4 LEF 
• Letter LEF 
• A4 SEF 
• Letter SEF 
• A3 SEF 
• 11 x 17 in. 

SEF 

270.4–298.0 mm 

(9.84–11.69 in.)

2704–2980 

3 Blue Type SRA3 

12 in.

13 in.

300.0–330.2 mm 

(12.09–13.00 in.)

3000–3302  

Note: Refer to the System Administrator Guide for the procedure on how to reset NVM settings for 
other widths not shown in this table. 

Changing the Fuser Width ID 

The press is installed with a default standard fuser type that is suitable for all media sizes (paper widths). However, 
when removing the fuser module, you can optimize its life and maintain the system image quality output by 
attaching a jumper connector to the fuser assembly that identifies the specific paper width range to use. For 
assistance and information on changing the fuser width ID, contact Customer Support.

If you plan to print jobs using a specific paper width, use this procedure to attach the bypass connector for that 
fuser to the fuser assembly. This identifies to the system that a different fuser is being used and only certain paper 
widths will be allowed to print. 

The fuser types available are:

• 11 inch (A4, Letter SEF) width fuser

• 12 inch (A3 SEF, A4, Letter LEF, 304.8 mm) width fuser

• 13 inch (SRA 3, 330.2 mm) width fuser
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• Custom and other size papers 

Important: To identify the fuser type and set minimum and maximum NVM width values, inform the system 
administrator. The administrator must set the NVM settings from Tools mode on the press control panel. 
When using a bypass connector with the fuser, the press detects the fuser type and width and confirms it is 
appropriate for the system.

Note: The bypass connectors required for each fuser width type are located in the nationalization kit which 
come with the press. To order additional fusers for this product, contact your Customer Support Center. 

Warning: Before you perform this procedure, power off the press and allow fifty minutes for the fuser to 
cool down. Always observe the warning labels inside the press.

1. If required, have the system administrator update the NVM width range settings for the fuser from Tools mode 
and identify the specific width range of media that can be run through the fuser. 
Refer to the System Administrator Guide, DDeeffaauulltt aanndd CCuussttoomm PPaappeerr WWiiddtthh SSeettttiinnggss tables in the UUssiinngg tthhee 
FFuusseerr NNVVMM RReeaadd//WWrriittee SSeettttiinngg procedure. Always set the NVM settings before using the new fuser.

2. Open both the left and center front doors.

3. Locate the black fuser front cover. 

4. Remove the fuser front cover by using the T10 Torx driver to unscrew the one mounting screw at the center of 
the cover. 
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5. Locate the fuser identifier clip on the fuser assembly and, using a marker, write on the identifier the fuser width 
being used. 

6. Locate the two bypass fuser connectors in the kit. The black resistor jumper (left) is used for the number 2 
range value and the blue jumper (right) represents the number 3 range value. For the range numbers, refer to 
the bypass connector table in Fuser Paper Width Information. 

7. Attach the appropriate jumper to the exposed white connector at the front of the fuser assembly by pushing 
the two ends together. There is no release. To disconnect, simply pull apart. 

8. Position the fuser front cover on the assembly and screw tightly in place.
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9. Close the left and center front doors of the press. 

Note: If the paper in the print job does not match the width set for the fuser, an error message displays and 
the job does not print. Cancel the job and submit the correct paper width for that job or change fusers so 
that the correct width-range fuser is installed.

TRAY 8  AND 9 MAINTENANCE

Ordering the Feed Roll Kit for Tray 8/9

Xerox supplies, such as the feed roll kit for Trays 8 and 9, can be ordered from the web site www.xerox.com and 
clicking on the Supplies link. For items that are not orderable from the web site, contact your Xerox Service 
Representative.

CRUS (SUPPLY ITEM) REORDER QUANTITY 

APPROXIMATE PRINT YIELD  

(FULL COLOR 8.5X11/A4 
PRINTS)

Tray 8/9 Feed Roll Kit*  1 kit 500,000 

*Each tray requires its own feed roll kit: one kit for Tray 8 and one kit for Tray 9. Each kit contains all the required 
items for replacing the feed rolls.

Checking the Status of Consumables

When a consumable is reaching the time it needs to be replaced, a message is displayed on the control panel touch 
screen. This indicates when it is time to order and/or install a new consumable item. With some Customer 
Replaceable Units (CRUs), the screen indicates that the press may continue to run print jobs without immediately 
replacing the item. Otherwise, when it is time to replace it, a message appears and the press stops running.

To check the status of your consumables:

1. Press the Home button on the press control panel. 
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2. To display more information about supplies and their status, touch the Information button. 

The Supplies screen displays.

3. From the menu, select Other Consumables to see the status of other consumables. 

The Other Consumables window displays and provides information about the percentage of remaining life for 
each consumable. 

4. Use the up/down arrows to see additional consumables, such as the trays 6, 7, 8, and 9 feeder rolls and other 
consumables for any additional optional devices that are configured with the press.

Replacing the Tray 5 Feed Rolls

To perform this procedure, the feed roll kit is required. The kit contains all the required items for replacing the feed 
rolls.
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Tip: Perform the following procedure when Tray 5 is installed on top of Trays 8 and 9.

Replace the feed rolls for Tray 5 (Bypass) when experiencing frequent multifeeds, single feeds, or blank prints in the 
stack of the output prints.

1. Feed Roll

2. Nudger Roll

3. Separator Roll

1. Locate Tray 5 (Bypass) on top of Trays 8 and 9.

2. Lift up and open the bypass tray cover to access the feed roll components. 

3. Remove the feed roll and install a new one. 
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a. Remove the feed roll by squeezing the metal shaft at both ends and lifting it up and out of the tray. 

b. Install a new feed roll by squeezing the metal shaft at both ends and sliding it into place. 

4. Remove the nudger roll and install a new one. 

a. Remove the nudger roll by squeezing the metal shaft at both ends and lifting it up and out of the tray. 

b. Install a new nudger roll by squeezing the metal shaft at both ends and sliding it into place. 
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5. Remove the separator roll and install a new one. 

a. Remove the separator roll by squeezing the metal shaft at both ends and lifting it up and out of the tray. 

b. Install a new separator roll by squeezing the metal shaft at both ends and sliding it into place. 

6. Close the bypass tray cover.

7. Verify that the tray is operating correctly by feeding paper from the bypass tray.

8. Log in as the administrator or ask the administrator to perform the following steps to reset the High Frequency 
Service Item (HFSI) count to zero (0): 

a. At the control panel, press the Tools button.

b. From the screen that displays, select the Tools icon.

c. Select System Settings > Common Service Settings > Maintenance.

d. Use the up / down arrow buttons to access the next Maintenance screens.

e. Select the Technical Key Operator icon. The Technical Key Operator feature displays.

f. Select the bypass roll items that corresponds with the newly-replaced components.

g. Select Reset Current Value. The system resets the High Frequency Service Item (HFSI) to 0.

h. Exit the administrator mode by pressing the Log In / Out button on the control panel. When prompted, 
select Logout.

Replacing the Tray 8 and 9 Feed Rolls

Use this procedure to replace the Tray 8 and 9 feed rolls.

To perform this procedure, the feed roll kit is required. The kit contains all the required items for replacing the feed 
rolls. 
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Important: If replacing the feed rolls for both trays, ensure to obtain two feed roll kits (one for each tray).

Replace the Tray 8/9 feed rolls every 300,000 prints or when experiencing frequent multifeeds, single feeds, or blank 
prints in the stack of the output prints.  

The Tray 8/9 feed rolls which include the following components:

1. Nudger Roll

2. Feed Roll

3. Separator Roll (shown with the feed roll removed)

1. To access the feed components , pull out the tray slowly until it stops. 

2. Replace the nudger roll: 
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a. Remove the nudger roll by pushing down on the black tab with one hand (which raises the roll upward) and 
then squeezing the metal shaft on both ends with your other hand. 

b. Lift out the nudger roll.

c. Install a new nudger roll by squeezing both ends of the metal shaft and while pushing down on the black 
tab, insert and release the roll ends into the notches. 

3. To access the separator roll, remove the separator roll assembly at the side of the tray: 

a. Unscrew the three thumbscrews. 
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b. Slide the separator roll assembly all the way to the left so it is out of the slots.

c. Pull the assembly out towards you until completely removed from the tray and set aside the assembly.

4. With the separator roll assembly out, replace the feed roll: 

a. To remove the feed roll, squeeze both ends of the metal shaft and lift out. 

b. To install a new feed roll, squeeze both ends of the new roll shaft, insert and release the roll ends into the 
notches. 

5. Replace the separator roll: 

a. To remove the roll from the assembly, squeeze the orange shafts of the separator roll and lift out of the 
assembly. 
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b. Install a new separator roll into the black notches of the assembly using the same technique. 

6. Reinstall the separator roll assembly into the tray. 

a. Align the cutout holes of the assembly with the frame of the tray so the pin holes match up.

b. Insert the assembly into the frame. 

c. Slide the assembly all the way to the right using the pin as a guideline.

d. Ensure the device is all the way into the slots and the three screw areas align. 

e. Screw in the three thumbscrews to attach the assembly. Do not over tighten.

7. Close the tray and verify that the tray is operating successfully by feeding paper using that tray.

8. Log in as the administrator or ask the administrator to perform the following steps to reset the High Frequency 
Service Item (HFSI) counters to zero (0) for each component. 

a. At the control panel, press the Tools button.

b. From the screen that displays, select the Tools icon.

c. Select System Settings > Common Service Settings > Maintenance.

d. Use the up / down arrow buttons to access the next Maintenance screens.
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e. Select the Technical Key Operator icon. 

The Technical Key Operator feature displays.

f. Select the item that corresponds with the newly-replaced components.

g. Select Reset Current Value. The system resets the High Frequency Service Item (HFSI) to 0.

h. Repeat the previous steps until the counters for all three components are reset to zero (0).

i. Exit administrator mode by pressing the Log In / Out button on the control panel. 

When prompted, select Logout.

FINISHING DEVICES MAINTENANCE

Crease and Two-Sided Trimmer Maintenance

Emptying the Crease and Two-Sided Trimmer Waste Container

When the trimmer waste container is nearing the full condition, an indicator lights on the top of the Crease and 
Two-Sided Trimmer. 

Note: The waste container can be emptied before it is full and also while the printer is running.

When the waste container reaches the full condition, the following changes occurs: 

• The indicator changes from a steady lighted condition to blinking.

• A message appears on the press indicating that the waste container is full.

Perform the following steps to empty the trimmer waste container.
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1. Open the lower cover of the Crease and Two-Sided Trimmer. 

2. Pull out and remove the waste container. 

3. Discard all waste.  

Important: Ensure that the waste container is empty. If waste or debris remains in the container, the 
trimmer may malfunction.

4. To ensure that you remove all waste and debris, especially beneath the frame that is located behind the 
container, use the cleaning rod to remove any remaining waste from inside the trimmer. 

5. Return the cleaning rod to its original position on the inside of the lower cover.
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6. Reinsert the waste container and push it in fully. 

7. Close the lower cover.

Production Ready Finishers Maintenance

Finisher Consumable Supplies

Xerox supplies, including staples, staple cartridges, and staple waste containers can be ordered from Xerox by going 
to www.xerox.com and clicking on the Contact Us link for specific contact information and telephone numbers in 
your area or by clicking on the Supplies and entering/selecting your specific machine information (product family 
and model type).

Note: Always refer to www.xerox.com for the latest Customer Replaceable Units (CRUs) part numbers.

Store supply items and Xerox parts in their original packages in a convenient location.

SUPPLY ITEM 
SUPPLY UNIT SHIPPED WITH FINISHER/REORDER 
QUANTITY 

Staple Cartridge and Staple Waste Container 
(for the PR Finisher, the PR Booklet Maker 
Finisher, and the PR Finisher Plus) 

4 staple cartridges (5,000 staples per cartridge) and 1 staple 
waste container per carton 

PR Booklet Maker Finisher Staple Cartridge 4 pack: 5,000 staple refills each 

Checking the Status of Finisher Consumables

When a consumable is nearing the time for replacement, a message is displayed on the control panel touch screen. 
This indicates when it is time to order and install a new consumable item. With some Customer Replaceable Units 
(CRUs), the screen indicates that the press may continue to run print jobs without immediately replacing the item. 
Otherwise, when it is time to replace it, a message appears and the press stops running.

To check the status of your consumables:
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1. Press the Home button on the press control panel.  

2. To display more information about supplies and their status, touch the Information button. 

The Supplies screen appears.
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3. From the menu, select Other Consumables to see the status of other consumables. 

The Other Consumables window appears and provides information about the percentage of remaining life for 
each consumable. 

4. Use the up and down arrows to see additional consumables, such as the finisher staples, the staple waste 
container, and other consumables for any additional optional devices that are configured with the press.

Replacing the Basic Staple Cartridge for Side Stitching

Note: Ensure that the press is not running before performing this procedure.

1. Open the finisher front cover. 
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2. Pull out R1.  

3. Holding the staple cartridge at the position indicated by the arrow, remove it from the unit. 

4. Insert a new staple cartridge into the unit. 
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5. Insert the unit to its original position. 

6. Close the finisher front cover.

Replacing the Booklet Staple Cartridge for Saddle Stitching

Note: Ensure that the press is not running before performing this procedure.

Note: This procedure is applicable only or the PR Booklet Maker Finisher.

1. Open the finisher front cover. 

2. Pull out the Saddle Stitch Unit 3 toward you until it stops.  
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3. While holding the tabs on the staple cartridge, pull out the cartridge to remove it. 

Note: There are two booklet staple cartridges provided. Check the message to see which cartridge needs 
replacing.

4. While holding the tabs on the new staple cartridge, push in the cartridge until it seats. 

Note: Make sure that the marks are aligned.

5. Push the Saddle Stitch Unit 3 gently into the finisher until it stops. 

6. Close the finisher front cover.
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Replacing the Finisher Staple Waste Container

WARNING: To avoid personal injury, use care when removing staple waste container.

The press displays a message when staple waste container is full. When the message appears, replace the container 
with a new one.

Important: 

• Before you perform this procedure, ensure that the press is not running.

• When you replace the staple waste container, keep the press powered on. If the press is powered off, it does not 
recognize that the waste container was replaced, and the full message remains displayed.

• To ensure that the press continues running after you replace the waste container, close the finisher front cover.

Note: A staple waste container comes with the basic staple cartridge.

1. Open the finisher front cover. 

2. Move the lock lever under R5 toward the left to the opened-lock mark.  
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3. Pull out R5.  

4. Place the used staple waste container into the supplied plastic bag. 

Note: Do not disassemble the used waste containers. Return the used staple waste containers to the 
Customer Support Center. 

5. Insert the new staple waste container by lowering it into position and gently pushing it into place. 

WARNING: To prevent injury, do not put your fingers on top of the container.
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6. Move the lock lever under R5 toward the right to the closed-lock mark. 

7. Close the finisher front cover.

Emptying the Hole Punch Waste Container

The press displays a message when hole punch waste container is full. When the message appears, empty the 
container of all paper scraps.

Important: 

• Before you perform this procedure, ensure that the press is not running.

• When you empty the container, keep the press powered on. If the press is powered off, it does not recognize 
that the container was emptied, and the full message remains displayed.

• To ensure that the press continues running after you empty the container, close the finisher front cover.

1. Open the finisher front cover. 
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2. Pull out the R4. 

3. Discard all waste from the container. 

Important: Be sure to completely empty the container. If any waste or scraps remain, the container 
becomes full before a full message displays causing a fault to occur.

4. Return R4 to its original position.

5. Close the finisher front cover.

PR Finisher Plus Maintenance

For information on consumable supplies and maintenance procedures for the PR Finisher Plus, refer to the following:

• Finisher Consumable Supplies

• Checking the Status of Finisher Consumables

• Replacing the Basic Staple Cartridge (for Side Stitching)

• Replacing the Finisher Staple Waste Container

• Emptying the Hole Punch Waste Container
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SquareFold® Trimmer Maintenance

Emptying the SquareFold® Trimmer Waste Container

When the waste container reaches the full condition, an indicator lights on the top of the SquareFold® Trimmer 
device. A message also appears on the press indicating that it is full. When the message appears, dispose of the 
paper scraps.

Note: Keep the press powered on when disposing of the waste. If powered off, the press does not recognize 
that the container was emptied. 

Perform the following steps to empty the trimmer waste container.

1. Ensure that the press is not running, then slowly pull out the Trimmer Waste Container. 

2. Hold the belt on the waste container, then remove the container with both hands.  
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3. Discard all waste and scraps. 

Note: Ensure that the container is completely emptied. If any waste or scraps remain, the container will 
become full before a message appears causing the press to malfunction.

4. Reinsert the empty waste container and slowly push it in completely. 
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General Troubleshooting

The information in this section helps you resolve some basic problems you may encounter with the press. If the 
problem persists after following the instructions, contact your Xerox Representative or the Customer Support Center.

Tip: Before contacting Customer Support, refer to the other topics within this troubleshooting section.

Note: If your print server indicates that the press has a fault and the press touch screen does not readily 
display a message, refer to the Print Reports > Job Status > Error History Report.

PRESS DOES NOT POWER ON

PPrroobblleemm

The press does not power on.

SSoolluuttiioonn

1. Ensure the power cord from the press is plugged into the power outlet or receptacle correctly.  

a. If problem persists, press the main power switch inside the center front door to Off.

b. Firmly plug in the power cord. 

c. Press the power switch on.

2. Ensure the power switch inside the center front door is set to the On position, then at the control panel, 
press firmly on the Off button.

3. Ensure that the power supply is 200–240 V (volts), 30A (amperes).

4. Ensure that supplied power capacity is compatible with the specified maximum power consumption of the 
press, which is 2.8–3.1 kVA (kilo-volt-ampere).

5. Check the ground fault interrupter (GFI) circuit breakers.

6. If the power in your location is working properly, and you have tried the suggested solutions but the press 
does not power on, contact the Customer Support Center for assistance.

CANNOT OBTAIN THE PRESS SERIAL NUMBER FROM THE MACHINE STATUS SCREEN

PPrroobblleemm

There is no power to the press and you cannot access the Machine Status screen to get the press serial number.

SSoolluuttiioonn

Open paper tray. On the left frame, near tray, locate the serial number. For information, refer to Locating the 
Press Serial Number.

PRESS CONTROL PANEL IS  NOT WORKING

PPrroobblleemm

The press control panel is locked up, or the touch screen is completely dark.
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SSoolluuttiioonn

• If the control panel buttons or keyboard do not work, press the power button Off. Wait thirty seconds, then 
reboot the system by pressing the power button On.

• If the Power Saver button light is on, the press is in the Power Saver mode. To cancel the Power Saver mode, 
press the Power Saver button.

PRESS DOES NOT COMPLETE A PRINT JOB

PPrroobblleemm

The press does not complete the entire print job.

SSoolluuttiioonn

• To verify that the press is connected to the network, print a test page from the print server.

• Verify that the power cable is connected to the press and to a suitable power outlet.

• Verify that the network cables are attached securely to the press and seated properly.

• Clear out the print job from the print queue and resend a print job.

• To restart the press, power Off the press, and then power it On.

• Your press may not be configured on the network. To connect the press to the network, contact your system 
administrator.

TIME INTERVAL BETWEEN PRINT JOBS IS  LONGER THAN 1 MINUTE

PPrroobblleemm

The press is taking longer than 1 minute before printing the next job.

SSoolluuttiioonn

The system requires approximately two minutes when switching print modes in order to make any necessary 
adjustments for the next print job, including color-to-color registration, density, charge levels, bias levels, or other 
adjustments. 

• The system has two print modes selectable at the print server: 

– Four color mode, CMYK: cyan, magenta, yellow, and black 

– Black and white mode only 

• If the next print job is switching print modes, for example from black-only to four-color, the system requires 
approximately two minutes to make any necessary adjustments.

• During this time, the touch screen displays the Adjusting Image Quality message.

• The next job begins printing once the system completes its adjustments.

Other information to remember includes:

• From a cold start, either power on or power saver, the system takes less than five minutes to start printing.

• From standby mode, the system usually takes less than one minute to start printing.
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PRINT OUTPUT CONTAINS CORRUPTED TEXT

PPrroobblleemm

Print output contains corrupted text, or the text prints incorrectly.

SSoolluuttiioonn

Check the application or print driver settings on whether non-standard fonts are being used for printing.

TRAYS DO NOT RECOGNIZE THE MEDIA

PPrroobblleemm

Trays do not recognize the media.

SSoolluuttiioonn

• Access the PredictPrint Media Manager App and verify the paper settings for the tray.

• Check the print server settings.

• Check that the paper is loaded correctly as short-edge feed (SEF) or long-edge feed (LEF) and ensure it 
matches the paper settings programmed at the print server.

PRINTS ARE NOT ON DESIRED PAPER SIZE

PPrroobblleemm

Prints are not on the desired paper size.

SSoolluuttiioonn

• Ensure that the correct paper size and type is loaded in the paper trays.

• Set the paper guides to the correct positions.

• Select the paper size, tray and weight at the print server and ensure these paper attributes are set correctly 
at the Tray Properties window.

• Ensure that Fit to Paper or an equivalent selection is not selected in your print driver.

PAPER JAMS OR WRINKLES IN THE FUSER AREA

PPrroobblleemm

Paper jams or wrinkles in the fuser area.

SSoolluuttiioonn

The stripper finger assembly can be misaligned or damaged. Contact Xerox Technical Customer Support.

316 Xerox® Versant® 4100 Press User Documentation

Troubleshooting



REPEATED PAPER MISFEEDS,  JAMS,  OR WRINKLES

PPrroobblleemm

Paper repeatedly misfeeds, jams often, or wrinkles.

SSoolluuttiioonn

• If a message appears on the press touch screen, follow the instructions displayed.

• Ensure the paper and paper tray selected match the paper size settings. Refer to the Recommended Media 
List and to Matching the Tray and Stock Information.

• Ensure the trays are loaded properly with acceptable media and do not exceed the MAX fill line.

• Ensure the paper tray edge guides are in the correct position. To ensure tray closure, firmly push it in as far as 
possible. 

• Turn the paper stack around and/or over in the selected paper tray.

• Remove a few sheets from the top and the bottom of the stack in the paper tray.

• Fan all four edges of the paper in the selected paper tray.

• Replace the paper in the selected paper tray with paper from a new package. 

• Remove any partially fed paper from the trays. Remove any torn pieces of paper still remaining inside the 
press.

• Ensure the paper you are using came from a properly-stored ream.

• Manage the Stock Library for the media in use. Refer to Editing an Existing Stock in the Stock Library

• Check the consumable status of the feed rolls for tray 5, 6, 7, 8, or 9; if the status for one of the trays is 
Replace Now, replace the feed rolls for that tray. For information, refer to the following procedures: 

– When Tray 5 is installed on top of Trays 6 and 7, refer to Replacing the Tray 5 Feed Rolls. 

– When Tray 5 is installed on top Trays 8 and 9, refer to Replacing the Tray 5 Feed Rolls. 

– Replacing the Feed Rolls for Tray 6 and 7

– Replacing the Tray 8 and 9 Feed Rolls

• If the problem is occurring only from Trays 6 and 7 or 8 and 9, refer to Multifeeds, Misfeeds, and Paper Jams 
in Trays 6–9.

MULTIPLE SHEETS FED FROM THE SAME TRAY

PPrroobblleemm

Multiple sheets are fed from the same tray.

SSoolluuttiioonn

• Do not fill the paper trays above the MAX fill line indicator.

• Remove the paper from the tray and fan the sheets to separate the joined sheets. 

• Predrilled (hole-punched) sheets may stick together at the holes. Remove the paper from the tray and fan 
the sheets to separate the joined sheets. 
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• Paper and transparencies may stick together if environmental conditions are too dry and cause excessive 
static. Increase the humidity level in the room to minimize static. 

• Gently fan transparencies to separate the sheets before you load them.

• If the problem is from Trays 6 and 7 or 8 and 9, refer to Multifeeds, Misfeeds, and Paper Jams in Trays 6–9.

EXCESSIVE PAPER CURL ON PRINTED OUTPUT

PPrroobblleemm

The printed output has excessive paper.

SSoolluuttiioonn

Potential impacts include: 

• Incorrect paper weight or type selected; ensure that the correct paper weight and paper type are selected

• The mass amount of dry ink/toner coverage on the print output; the greater amount of the dry ink/toner 
mass, the more the paper curls

• The paper weight and whether or not it is coated or uncoated

• The humidity conditions at the press

• An attempt to print on thicker paper or on paper stock that is less sensitive to moisture

Reducing potential impacts:

• You can minimize curl problems by flipping the paper over in the tray. If excessive curl is still present, use a 
heavier paper. 

• To ensure continuous production, empty the output device when the output approaches the maximum 
amount that the device can hold; refer to the specifications for that output device for output limit amount. 

– The Offset Catch Tray (OCT) holds a maximum capacity of 500 sheets of 24 lb., 90 g/m2 paper. 

– For all other optional finishing devices, for output specifications, refer to the respective finishing device 
section. 

Paper curl can be adjusted in the following ways:

• If the Interface Decurler Module is attached, use the manual decurl buttons on the module control panel. 
Refer to Interface Decurler Module (IDM).

• Refer to Paper Curl Correction.

REDUCING DRY INK/TONER CONSUMPTION

PPrroobblleemm

In order to maintain image quality (IQ), the press will enter Adjust Image Quality mode. In this mode, dry ink/ 
toner is consumed in the form of dry ink/toner bands and process control patches being laid down. Frequency of 
image quality adjustment is dependent on many factors including area coverage. While printing jobs of low 
area coverage or low image density, the frequency of image quality adjustment may be greater.
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SSoolluuttiioonn

Three NVM values can be adjusted to reduce dry ink/toner consumption based on user requirements. Refer to 
the following table. From the first column of the table, select the solution which best fits user requirements. To 
implement the appropriate outcome for your environment, contact your customer service representative.  

Important: NVM values must be set or changed only by the customer support representative.

USER REQUIREMENT SOLUTION 

1. Image Quality (IQ) Priority 

These are the press default settings which provide 
optimum IQ output, but increase dry ink/toner 
consumption and may reduce productivity. 

For this user requirement, to change the NVM values 
for 762–075, 752–175, and 762–098, contact your 
customer support representative. 

2. Middle Setting 

This is the recommended setting.

These settings configure the press for less dry ink/toner 
usage if image quality is not the highest priority. IQ may 
be slightly reduced.

For this user requirement, to change the NVM values 
for 762–075, 752–175, and 762–098, contact your 
customer support representative. 

3. Lower Toner Consumption Priority 

These settings decrease dry ink/toner usage and increase 
productivity, but may result in degraded IQ.

For this user requirement, to change the NVM values 
for 762–075, contact your customer support 
representative. For the NVM values 752–175 and 
762–098, no change is required. 

BARCODE SCANNER FAULTS AND ERRORS

PROBLEM SOLUTION 

A Barcode Scanner Fault message appears in 
PredictPrint Media Manager that indicates one 
of the following conditions: 
• The barcode scanner is not connected. 
• The barcode scanner is not detected 

during startup. 

• Ensure that the barcode scanner is connected to the print 
server. 

• Restart the system. 

More than one barcode scanner is detected Ensure that only one barcode scanner is connected to the print 
server. 

The following Barcode Scan Error appears: 

The last attempted barcode scan 
was unsuccessful.

• Ensure that the barcode is a valid and complete barcode. 
• Rescan the barcode. 
• If the error message persists, scan another barcode. 
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Image Quality (IQ) Troubleshooting

To improve image quality, perform these actions: 

• Manage the Stock Library for the media in use. Refer to Editing an Existing Stock in the Stock Library

• Run print samples and evaluate the defect. 

• From the following list, determine which problem description matches the image quality defect and perform the 
appropriate suggested solution.

Important: Many of the solutions found in this section can be performed from the PredictPrint Media 
Manager App.

CONTAMINATION ON THE BACK SIDE OF PRINTS

PPrroobblleemm

The back side of the printed output contains contamination. The contamination is a specific toner defect of 10– 
15 mm wide running from long-edge (LE) or trail-edge (TE), and is near the outboard (OB) side of the print. 

SSoolluuttiioonn

• Contamination can be media related.  

– Look for paper damage, paper dust, or environmental conditions that may contribute.  

– Ensure the media is fresh and properly loaded in the tray. 

• Defects occur on heavyweight stock with lightweight stock settings. Manage the Stock Library for the 
media in use. Refer to Editing an Existing Stock in the Stock Library.

• Contamination can be media related. Look for paper damage, paper dust, or environmental conditions that 
may contribute. Ensure media is fresh and properly loaded in the trays.
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• If the defect is the specific streak on the back of prints, there may be a secondary-bias transfer roll (2nd BTR) 
failure. Perform the Cleaning the Fuser Assembly with Paper procedure. If the problem continues, contact the 
customer support center.

BANDING ON PRINTS

PPrroobblleemm

The print shows lines or bands running from the inboard-to-outboard (IB/OB) direction (side-to-side direction). 

For defects running from the lead-edge to trail-edge (LE/TE) direction, refer to Streaks or Lines on Prints.

SSoolluuttiioonn

Measure the frequency of the spot intervals:

• Acquire the measuring tool either from www.xerox.com/VERSANT_4100docs or from the Nationalization Kit.

• Using the measuring tool, measure the intervals of the defects.

• If the defect is at the interval of 37.5 mm or 147 mm, replace the appropriate drum cartridge. Refer to 
Replacing a Drum Cartridge. 

• If the defect is at the interval of 154 mm, replace the pressure roll assembly. To replace the pressure roll 
assembly, contact your Xerox Technical Customer Support.

• If the defect is at the interval of 375 mm, replace the fuser assembly. To replace the fuser assembly, contact 
your Xerox Technical Customer Support.

COLOR NONUNIFORMITY ON PRINTS

PPrroobblleemm

The print has variations in color uniformity, such as: 
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• Uneven density

• Light or dark areas running from the side-to-side direction (inboard-to-outboard)

• Color shift or inconsistent color throughout the page

SSoolluuttiioonn

• Perform Cleaning the Raster Output Scanner (ROS) Window Areas. 

• Run the Performing the Clean Toner Procedure.

• Perform Adjusting Automatic Density Uniformity. 

• Refer to Uneven Density or Mottle.

RANDOM WHITE OR DARK SPOTS ON PRINTS

PPrroobblleemm

The prints show random spots that do not repeat at regular intervals. 
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SSoolluuttiioonn

• Ensure that the media being used is approved, clean and clear of contamination, and is within press 
specifications. Refer to the Recommended Media List for the press and to Paper and Media.

• Check that the press is within environmental specifications and humidity levels; refer to Environmental 
Specifications.

• Load a new ream of paper or different type of media. 

• Run the Performing the Clean Toner Procedure.

• Measure the frequency of the spot intervals.  

– Acquire the measuring tool either from www.xerox.com/VERSANT_4100docs or from the 
Nationalization Kit. 

– If spots occur every 147 mm on the output, print the Halftone Test Pattern to determine which color 
drum is affected. To print the Halftone Test Pattern, go to www.xerox.com/VERSANT_4100docs and 
download the Halftone Test Pattern PDF. 

– Replace or swap the appropriate drum cartridge; refer to Replacing a Drum Cartridge.  

REPEATING DEFECTS AT REGULAR INTERVALS ON PRINTS

PPrroobblleemm

The prints show any defect type that repeats at intervals that can be measured. 
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SSoolluuttiioonn

Measure and check the frequency of the defect: 

• Acquire the measuring tool either from www.xerox.com/VERSANT_4100docs or the Nationalization Kit.

• Check the frequency of the defect interval.

• If the defect occurs every 44 mm on the prints, do not replace the drum. This interval is caused by a 
damaged or defective developer housing. Contact the Customer Support Center. 

• If spots or bands occur every 147 mm on the prints, a drum cartridge is damaged or light shocked. Replace 
or swap the appropriate drum cartridge; refer to Replacing a Drum Cartridge.

• If the defect occurs every 374 mm on the prints, replace the fuser belt assembly. For details, contact the 
Customer Support Center.

STREAKS OR LINES ON PRINTS

PPrroobblleemm

The prints show solid color streaks or lines running from lead-edge (LE) to trail-edge (TE) on the prints. 
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For image quality defects that run in the inboard-to-outboard (IB/OB) direction, refer to Banding on Prints.

SSoolluuttiioonn

• Perform Cleaning the Raster Output Scanner (ROS) Window Areas. 

• If streaks or lines continue after cleaning the ROS windows, check for drum failure: 
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– Acquire the measuring tool either from www.xerox.com/VERSANT_4100docs or from the 
Nationalization Kit. 

– To determine which drum cartridge is affected, download and print the Halftone Test Pattern. Refer to 
www.xerox.com/VERSANT_4100docs. 

– Replace or swap the appropriate drum cartridge; refer to Replacing a Drum Cartridge. 

EDGEWEAR OR GLOSS DIFFERENTIAL ON PRINTS

PPrroobblleemm

The inboard and outboard edges of the output prints shows dry ink/toner deletions, density inconsistency, or is 
lacking in color depth. This occurs mainly when using heavier or lighter weight stock. 

SSoolluuttiioonn

If you run multiple width papers, for more information, refer to Extending Fuser Life with Multiple Fusers and 
Preventing Fuser Damage.

HALO OR SMUDGES ON PRINTS

PPrroobblleemm

The printed output contains halo or smudges on them. 
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SSoolluuttiioonn

Refer to Uneven Density or Mottle.

IMAGE DENSITY

PPrroobblleemm

Print output is too light, faint, or washed out; solid areas not black or inconsistent shading; part of image 
missing. 
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SSoolluuttiioonn

• Check the status of the consumables and supplies by pressing the Home button on the control panel. Refer 
to Checking the Status of Consumables. 

• Run the Performing the Clean Toner Procedure.

• Shake or replace the affected dry ink/toner cartridge. Refer to Replacing a Dry Ink/Toner Cartridge. 

• Determine if a drum cartridge is contaminated or light shocked by running a set of halftone test patterns to 
identify which color is affected: 

– Go to www.xerox.com/VERSANT_4100docs and download the Halftone Test Pattern PDF. 

– Print several sets of the Halftone Test Pattern PDF. 

– Determine which color drum is affected. 

– Swap or replace the required drum cartridge. Refer to Replacing a Drum Cartridge. 

• Refer to Uneven Density or Mottle.

IMAGE-ON-PAPER REGISTRATION

PPrroobblleemm

The entire image on the printed output is misregistered, shifted, skewed, or crooked. 
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SSoolluuttiioonn

• Ensure that the paper is loaded correctly and within press specifications. For detailed specifications, refer to 
the Paper and Media. 

– Set the horizontal and vertical paper guides to the correct positions 

– Ensure the paper tray guides are touching the edges of the loaded paper.  

– Push the tray in completely. 

• Refer to Image Registration, Perpendicularity, Skew, and Magnification.

UNFUSED PRINTS OR FUSER OFFSET

PPrroobblleemm

The image is not properly fused. Dry ink/toner on print is not permanent, smears or flakes, or rubs off the print. 
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SSoolluuttiioonn

• Check that the paper weight settings at the print server match the actual paper loaded in the tray. Refer to 
Matching the Tray and Stock Information.

• Ensure that the paper loaded is within press specifications. For information, refer to the Paper and Media. 

• After reviewing Paper and Media Storage Guidelines, load a new ream of paper into the selected paper tray. 

• Perform the Cleaning the Fuser Assembly with Paper procedure.

• Refer to Unfused Dry Ink or Toner on Output.

TRAIL-EDGE DELETIONS

PPrroobblleemm

Trail edge of the output contains dry ink/toner deletions, density inconsistency, or is lacking in color depth. This 
occurs mainly when using heavier or lighter weight stock. 
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For inboard or outboard edge deletions, refer to Edgewear or Gloss Differential on Prints.

SSoolluuttiioonn

• Create a custom stock and add to the Stock Library. Refer to Creating a New Stock from the Stock Library 
Feature or Creating a New Stock from Tray Properties.

• Refer to Uneven Density or Mottle.
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PredictPrint Media Manager Troubleshooting

This section helps you locate and resolve specific problems through the use of the PredictPrint Media Manager.

Important: Many of the following solutions must be performed from the PredictPrint Media Manager 
application.

To improve print quality, confirm the following:

• The media is compatible with the press.

• The media is within the supported specifications and is in good condition.

• The media is assigned to a designated tray, and that designated tray was selected for the print job.

FAULTS DURING THE SETUP ROUTINES IN THE STOCK WIZARD

PPrroobblleemm

Unable to run any of the setup routines, including calibration and profiling, or print custom barcodes in the Stock 
Wizard while the press is busy.

SSoolluuttiioonnss

Before you perform any of the setup routines in the Stock Wizard, ensure that the press is not busy.

UNABLE TO LOAD A STOCK IN THE STOCK WIZARD

PPrroobblleemm

When there is a faulted job on the press, the Stock Wizard does not recognize loading of the paper tray, or the 
action of opening and closing a paper tray.

SSoolluuttiioonnss

Clear all faulted jobs on the press, then scan the barcode again or load paper in the paper tray.

DUPLICATE BARCODES FOR MEDIA

PPrroobblleemm

Same barcode is used by some media suppliers or distributors for multiple medias. The duplicate barcodes are 
flagged in the PredictPrint Cloud Server, but they are not prohibited to use in the trays. Press detects the duplicate 
barcode as unknown. A barcode can be used at least once per press serial number and share code when used while 
creating the barcode. Once programmed, the specific system can be able to use only the first programmed stock 
properties.

SSuuggggeesstteedd SSoolluuttiioonnss;

Use the Stock Wizard button to create a new custom barcode for each media using a known duplicate barcode. 
Create new custom barcode for any media with different stock properties that are reusing the same barcode.
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MULTIFEEDS,  MISFEEDS,  AND PAPER JAMS IN TRAYS 6–9

PPrroobblleemm

Multifeed or misfeed paper jams are occurring in Tray 6, 7, 8, or 9.

SSoolluuttiioonnss

Important: The following solutions must be performed from the PredictPrint Media Manager application.

Tip: All solutions provided are accessed from the Advanced Stock Setup feature. 

For information, refer to the Advanced Stock Setup.

1. Change the Tray Air Assist setting. 

• Use this feature to adjust the amount of air volume generated by the tray blowers which assist in separating 
sheets when feeding paper. When using light-weight or heavy-weight paper, which stick together easily, 
select a stronger air flow setting in order to better separate sheets and prevent paper jams or multifeeds.

• This feature can be found in PredictPrint Media Manager > Stock Library > Stock Properties > 
Advanced Setup > Tray Air Assist.

• The settings available for this feature are: 

– System Default: The air volume is set to the appropriate amount based on the Stock and 
environmental conditions. 

– Multifeed Support Table: Select this option if you use paper that tends to trigger multifeeds. This 
setting increases the air volume to a level higher than System Default. 

– Mis-Feed Support Table: Select this option if you use paper that tends to trigger paper jams. This 
setting increases the air volume to a level higher than Multifeed Support Table. 

– Forced Off: Select this option when working with special media that tends to jam as a result of the air 
flow that is introduced by Tray Air Assist. This setting turns off Tray Air Assist. 

2. Change the Enable Tray Heater setting. 

• Use this feature to Enable or Disable the tray heater. The tray heater warms the air that is blown into the 
tray by Tray Air Assist to help prevent paper jams and multifeeds by loosening contact between sheets. 

• The tray heater may partially dry paper and affect print quality. If print quality is affected by dry paper, to 
disable the tray heater, remove the check mark from Disable check box. 

Note: Disabling the tray heater may result in an increase of multifeeds.

• This feature can be found in PredictPrint Media Manager > Stock Library > Stock Properties > 
Advanced Setup > Enable Tray Heater

• To Disable (unchecked) the tray heater:

a. Remove any paper loaded in the tray. 

b. In Tray Air Assist select any option except Forced Off . 
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c. Disable the tray heater and register the stock. 

The printer performs a forced exhaust action for approximately one minute. During the forced exhaust 
action, do not change any settings or open a tray.

Important: A forced exhaust with paper loaded in tray can lead to image quality problems.

d. After the forced exhaust is complete, load paper in tray.

3. Change the Multifeed Detection setting. 

• Use this feature to Enable or Disable multifeed notifications; this feature does not make any other 
adjustments.

• The Multifeed Detection feature is accessed from PredictPrint Media Manager > Stock Library > Stock 
Properties > Advanced Setup > Multifeed Detection.

• The settings available for the Multifeed Detection option include: 

– Enabled: To switch On multifeed notifications, select the check box. 

– Disabled: To switch Off multifeed notifications remove the check mark from the check box. 

Note: To prevent the system from reporting faults due to multifeeds, tteemmppoorraarriillyy disable notifications. 
This allows the user to continue their workflow until the cause of the problem is resolved. Be aware that 
disabling this feature has no impact on the occurrence rate of actual multifeeds and, if disabled, 
multifed sheets may cause jams elsewhere in the system and/or result in additional blank sheets in the 
final output.

4. To replace the feed rolls, refer to Replacing the Feed Rolls for Tray 6 and 7.

PAPER CURL

PPrroobblleemm

The output contains paper curl.
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SSoolluuttiioonnss

1. If your press configuration includes the Interface Decurler Module (IDM)s, confirm that the IDM Curl 
Correction option on the IDM control panel is set to Auto. 

For more information, refer to Interface Decurler Module (IDM).

2. Change the Paper Curl Correction setting from the PredictPrint Media Manager application. 

Tip: Changing the default setting is considered a temporary solution because environmental 
conditions vary from day to day. It is recommended that upon completion of the print job you 
return the option to its default setting.

• Use the Paper Curl Correction feature to correct paper curl caused by heat and pressure and to apply fine 
adjustments based on the characteristics of each paper type. Paper curl may cause paper jams and wrinkled 
output.

• This feature can be found in PredictPrint Media Manager > Stock Library > Stock Properties > 
Advanced Setup > Paper Curl Correction

• From the Paper Curl Correction screen, select the Edit Settings button.  

Paper Curl Correction options include 1 Sided Face Up, 1 Sided Face Down, or 2 Sided.

• When changing the Paper Curl Correction setting, make the change by moving up or down the available 
selections one at a time. 

• Use the following sequential order when making changes to the paper curl. This ensures that the desired 
output is achieved: 

a. Default

b. Type A

c. Type B

d. Type C

e. Custom Curl Correction: Slight (Very Small) Upward or Slight (Very Small) Downward

f. Custom Curl Correction: Moderate (Small) Upward or Moderate (Small) Downward

g. Custom Curl Correction: Medium Upward or Medium Downward

h. Custom Curl Correction: Severe (Large) Upward or Severe (Large) Downward

For more information, refer to Types A, B, and C.

Tip: Paper jams and wrinkled output may occur if the change is not performed in the 
recommended sequential order; for example, using Default and then skipping to Type C. 

Note: Always run test prints every time a setting is changed or selected; this allows you to evaluate the 
output and determine if additional changes are necessary. 

• If paper curl continues to persist after trying several or all of these settings, try decreasing the image density 
on the print job or use a different type of paper.

• If paper curl is still a problem after decreasing the image density and after using a different type of paper, 
contact the Customer Support Center for further assistance.

For more information, refer to the Paper Curl Correction
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UNEVEN DENSITY OR MOTTLE

PPrroobblleemm

Uneven Density or Mottle

SSoolluuttiioonnss

1. Perform Secondary Transfer Voltage Adjustment. 

• Use this feature to adjust the voltage ratio on the secondary bias transfer roll (2nd BTR). For heavy-weight 
paper, such as 220 g/m2 or greater, the 2nd BTR is where the image is transferred from the belt to the paper. 
However there are times when it is also used with lightweight paper.

• This feature is accessed from PredictPrint Media Manager > Stock Library > Stock Properties > 
Advanced Setup > Secondary Transfer Voltage Adjustment.

• The Secondary Transfer Voltage Adjustment procedure can be performed by selecting Auto or Manual. 

Note: An automatic adjustment fixes most image quality issues. Always perform the Auto procedure 
before performing the Manual adjustment.

– Auto: The adjustment is done automatically by the press. It eliminates the need for you to interpret 
printed targets and enter adjustment values manually. This saves time and avoids errors. 

– Manual: The user must manually perform the adjustment, including printing test patterns, interpreting 
the printed targets on those patterns, and then manually entering the adjustment values.  

Tip: Use the Manual adjustment option only when the Auto adjustment does not 
provide the desired output.

– For detailed information and instructions on using the Auto and Manual adjustment options, refer to 
Secondary Transfer Voltage Adjustment.  

2. If the issue is observed on the tail edge of the printed output and is not corrected by performing a Secondary 
Transfer Voltage Adjustment, change the Transfer Output Adjustment for Trail Edge setting. 

• Use this feature to adjust the voltage ratio on the secondary bias transfer roll (2nd BTR); this is where the 
image is transferred from the belt to the paper.

• This feature is accessed from PredictPrint Media Manager > Stock Library > Stock Properties > 
Advanced Setup > Transfer Output Adjustment for Trail Edge.

• Decrease the Transfer Output Adjustment for Trail Edge in increments of 10%. After every incremental 
adjustment, run test prints and evaluate the output to determine if additional adjustment is necessary.

3. Perform an Automatic Density Uniformity Adjustment. 

Note: This is a press feature and is not a PredictPrint Media Manager feature.

• Use this feature to correct image quality issues on the output when that image quality is not consistent 
throughout the entire output. For example, the image quality is lighter or faded or it is heavier or thicker on 
the left or right sides of the output, inboard or outboard.

• For information and instructions on how to use this feature, refer to Adjusting Automatic Density Uniformity.
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IMAGE REGISTRATION,  PERPENDICULARITY,  SKEW,  AND MAGNIFICATION

PPrroobblleemm

The image on the printed output is misregistered, or is perpendicular, skewed, or magnified.

For information, refer to Alignment Options.

SSoolluuttiioonnss

1. If using trays 1, 2, or 3, try switching to tray 6 or 7 or optional tray 8 or 9. 

Note: Trays 6-9 have better registration and skew performance.

2. Create or use an existing Alignment Profile. 

Before creating a new and/or using an existing manual alignment, read all the information in the Alignment 
Profiles.

• Use CCeenntteerr LLiinnee SSttoocckk for Alignment Profiles. If the problem occurs when using this stock, call the 
Customer Support Center.

• The following steps are required for each procedure. For complete instructions, refer to the Creating or 
Editing an Alignment Profile.

• To create a New Alignment Profile, perform the following: 

a. From the PredictPrint Media Manager application, select Profiles > Alignment Profile.

b. From the Alignment tab, select the New button. 

A New Profile Properties window displays. 

c. Enter the Name you want to assign to the profile.

d. Perform the Auto Alignment procedure.

e. Run a set of test prints to evaluate the output and evaluate the results.

f. If necessary, depending on the results, perform a Manual Adjustment.

g. When making manual adjustments to multiple items, use the following guidelines: 

• Adjust the image in the following order: Registration, Perpendicularity, Skew, and Magnification.

• Choose oonnllyy oonnee ooppttiioonn at a time, then run a set of test prints to evaluate the output. Determine if the 
printed output for the selected option is acceptable and if it is acceptable, then select and adjust the 
next alignment option.

• After each option is selected, always run a set of test prints and evaluate the output. Determine if the 
output for the selected feature is acceptable, and if it is, continue to adjust another alignment option, as 
required.

• To use an existing Alignment Profile, perform the following: 

Note: The option may be found by selecting PredictPrint Media Manager > Stock Library > Stock 
Properties > Advanced Setup > Alignment Profile.
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a. From the Stock Properties of the desired stock, select Advanced Setup > Alignment Profile.

b. Select Use Default or Select from List.  

If using Select from List, make a selection from the list of saved Alignment Profiles.

3. Change the Aligner Roll Pressure setting. 

Tip: Changing the default setting of 0 (zero) is a temporary solution because environmental 
conditions vary from day to day. Upon completion of the print job, the recommendation is to 
return the option to its default setting.

• Use this feature to adjust the aligner roll pressure.

• Some types of coated paper slip and skew, thereby misregistering the image on the output prints. In this 
case, you may need to increase the Aligner Roll Pressure to apply more force to hold down the paper to 
compensate for the slippage and skewing.

• Some lightweight papers may have too much roll pressure applied to them, causing edge damage to the 
output prints. In this case, you may need to decrease the roll pressure to apply less force to hold down the 
paper.

• To change the Aligner Roll Pressure setting, perform the following:

a. Switch On the Pre Gate Roll Adjustment.  

Important: This option must be On to allow for the custom setting of the Aligner Roll Pressure 
option.

• Access the option from PredictPrint Media Manager > Stock Library > Stock Properties > Advanced 
Setup > Pre Gate Roll Adjustment.

• Select On under the Pre Gate Roll Adjustment from the drop-down menu.

b. Adjust the Aligner Roll Pressure. 

• Access the feature from PredictPrint Media Manager > Stock Library > Stock Properties > Advanced 
Setup > Aligner Roll Pressure.

• Based on the output, increase or decrease the Aligner Roll Pressure in increments of five or ten. 

• After each incremental adjustment, run test prints and evaluate the output prints to determine if 
additional adjustments are required.

4. Change the Regi-Loop setting. 

Note: Use Regi-Loop only if Alignment Profile or Aligner Roll Pressure did not correct registration 
and/or skew problems.

• Use this feature to adjust Regi-Loop. 

• When paper feeds through the press, it stops once and pressure is applied in order to correct registration 
and skew. The loop created when paper is stopped and pressured is Regi-Loop. 

– To correct for registration and skew, and if the degree of skew varies from sheet to sheet, increase the 
Regi-Loop value to increase pressure on the Lead Edge (LE) of the paper. Increasing the value too 
much may cause unintended folds or scratches on the Lead Edge paper. 

– In hot and humid environments, decrease the Regi-Loop value to lower the pressure on the Lead Edge 
of light weight paper to avoid ripping the paper. 
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• This feature is accessed fromPredictPrint Media Manager > Stock Library > Stock Properties > 
Advanced Setup > Regi-Loop.

• Based on the output, increase or decrease the Regi-Loop in increments of 0.3 mm. After each incremental 
adjustment, run test prints and evaluate the output to determine if additional adjustments are required.

• If feeding paper from tray 1, 2, or 3 and repeated Regi-Loop adjustments do not make any improvements 
in a registration problem, return the Regi-Loop value to its default and adjust the Pre Gate Roll Adjustment
setting. 

5. Change the Pre Gate Roll Adjustment setting. 

• This feature is enabled only when printing on paper that is 290 mm or larger in landscape, or on front and 
back sides of trays 1, 2, or 3, or the back sides of trays 6–9.

• Use this feature to adjust the behavior of the pregate roll mechanism. When paper feeds through the press, 
it stops once and pressure is applied in order to correct registration and skew. The pregate roll is one of the 
mechanisms that applies pressure to the paper.

• The settings available for the this feature include: 

– System Default: The pregate roll setting is automatically switched according to paper weight. 

– On: To hold the paper with the pregate roll for paper weight 220 g/m² or less, select this option only if 
the Regi-Loop adjustments did not correct misregistration or if Alignment Profile did not correct 
image skew. 

– Off: For paper weight 221 g/m² or greater where the leading edge of the paper is torn, select this 
option to release the paper from the pregate roll.  

Note: Selecting Off disables the Alignment Roll Pressure setting.

• After changing the setting run test prints and evaluate the output.

6. Change the Fuser Speed Adjustment setting. 

• This feature is used to adjust the fusing speed to improve print quality when the image is distorted, 
stretched, or shrunk. 

– If the image is shrunk, increase the fuser speed. If the fuser speed is set too high, it may cause paper 
jams. 

– If the image is stretched, decrease the fuser speed. 

• This feature is accessed from PredictPrint Media Manager > Stock Library > Stock Properties > 
Advanced Setup > Fuser Speed Adjustment.

• Increase or decrease the fuser speed in increments of 0.1%. 

• After each incremental adjustment, run test prints and evaluate the output to determine if additional 
adjustments are required.

UNFUSED DRY INK OR TONER ON OUTPUT

PPrroobblleemm

The output contains unfused dry ink or toner.
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SSoolluuttiioonnss

1. Change the Fuser Temperature Adjustment setting. 

Tip: Changing the default setting of 0 (zero) is a temporary solution because environmental 
conditions vary from day to day. Upon completion of the print job, the recommendation is to 
return the option to its default setting.

• User this feature to adjust the fuser temperature.

• If dry ink/toner comes off the paper, especially with special media, resolve the problem by increasing the 
fusing temperature. 

• If the fuser temperature is too high when printing on lightweight paper, it may cause blocking, media 
damage, or paper jams at the peeling unit in the fusing module. 

• If the fuser temperature is too low, it may cause poor fusing on higher-density image areas and dry ink/ 
toner may peel off the printed output. 

• This feature is accessed from PredictPrint Media Manager > Stock Library > Stock Properties > 
Advanced Setup > Fuser Temperature Adjustment.

• Based on the printed output, increase or decrease the Fuser Temperature Adjustment in increments of 1° 
or 2°. 

• After each incremental adjustment, run test prints and evaluate the output to determine if additional 
adjustments are required.

2. If feeding paper from trays 6-9 and if the paper is damp, confirm that the Enable Tray Heater feature is 
Enabled (checked). 

Note: Enable Tray Heater is available only for trays 6-9.

• Use this feature to Enable or Disable the tray heater. 

• The tray heater warms the air that is blown into the tray by Tray Air Assist and helps prevent paper jams 
and multifeeds by loosening contact between sheets. 

• The tray heater may partially dry paper and affect print quality. If print quality is affected by dry paper, 
disable the tray heater.  

Note: Disabling the tray heater may result in an increase of multifeeds.

• This feature is accessed from PredictPrint Media Manager > Stock Library > Stock Properties > 
Advanced Setup > Enable Tray Heater.

• To Enable the heater, check the box for Enable Tray Heater.

For more information, refer to the Advanced Stock Setup.

EDGE DAMAGE

PPrroobblleemm

On the output prints, if the following issues occur, adjust the aligner roll pressure.
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• Some types of coated paper slip and skew, thereby misregistering the image on the output prints. In this case, 
you may need to increase the Aligner Roll Pressure to apply more force to hold down the paper to compensate 
for the slippage and skewing.

• Some lightweight papers may have too much roll pressure applied to them, causing edge damage to the output 
prints. In this case, you may need to decrease the roll pressure to apply less force to hold down the paper.

SSoolluuttiioonnss

Change the Aligner Roll Pressure setting.

Tip: Changing the default setting of 0 (zero) is a temporary solution because environmental conditions vary from 
day to day. Upon completion of the print job, the recommendation is to return the option to its default setting.

To change the Aligner Roll Pressure setting, perform the following: 

1. Switch On the Pre Gate Roll Adjustment.  

For information, refer to Pre Gate Roll Adjustment.

Important: To select a setting for the Aligner Roll Pressure option, the Pre Gate option must be On.

• Access the option from PredictPrint Media Manager > Stock Library > Stock Properties > Advanced 
Setup > Pre Gate Roll Adjustment.

• From the Pre Gate Roll Adjustment menu, select On.

2. Adjust the Aligner Roll Pressure. 

• Access the feature from PredictPrint Media Manager > Stock Library > Stock Properties > Advanced 
Setup > Aligner Roll Pressure.

• Based on the output, increase or decrease the Aligner Roll Pressure in increments of five or ten.

• After each incremental adjustment, run test prints and evaluate the output prints to determine if additional 
adjustments are required.

FOLD ADJUSTMENT

PPrroobblleemm

The fold on the output is not correct or as desired.

Tip: The Fold Adjustment Profile is available only when the system configuration includes a finishing device with a 
booklet maker or the C/Z Folder.

SSoolluuttiioonnss

For detailed information about these finishing devices, refer to Finishing Devices.

Create or use an existing Fold Adjustment Profile.

Before creating a new or using an existing profile or performing any alignment adjustments, read/review the entire 
Fold Adjustments section in the PredictPrint Media Manager. 

• Depending on your system configuration, the following fold adjustments are available: 
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– Bi-Fold Single Sheet (available only with the PR Booklet Maker Finisher) 

– Bi-Fold Multiple Sheets (available only with the PR Booklet Maker Finisher) 

– Bi-Fold Multiple Sheets Stapled (available only with the PR Booklet Maker Finisher) 

– C-Fold (available with the optional C/Z Folder) 

– Z-Fold (available with the optional C/Z Folder) 

– Z-Fold Half-Sheet (available with the optional C/Z Folder) 

Create a new or use an existing Fold Adjustment Profile. The following steps are required for creating a new or 
using an existing procedure.

Note: This option is accessed from PredictPrint Media Manager > Profiles > Fold Adjustment Profile.

1. From the PredictPrint Media Manager main screen, select Profiles. 

2. Select the Fold Adjustment tab.

3. Select New or Edit. 

If you edit an existing fold adjustment, select the desired profile from the list and then select Edit.

4. Type in a new name or, if desired, edit the existing name.

5. To complete the procedure, refer to Fold Adjustment Procedures. Select the desired fold adjustment procedure 
and complete the procedure for creating a new or editing an existing Fold Adjustment Profile.

SMEAR 208 MM FROM THE LEAD EDGE

PPrroobblleemm

On the printed output, a smear occurs at 208 mm from the lead edge of the paper.

For more information, refer to the Advanced Stock Setup.

SSoolluuttiioonnss

1. Confirm the media being used is compatible with the press, is within supported specifications, and in good 
condition.

2. Change the Adjustment of Paper Speed at Transfer setting. 

• Use this feature to adjust the paper speed in the transfer unit.

• The option can be found in PredictPrint Media Manager > Stock Library > Stock Properties > Advanced 
Setup > Adjustment of Paper Speed at Transfer.

• Based on the output, decrease Adjustment of Paper Speed at Transfer in increments of 0.05%. After 
every increment adjustment run test prints and evaluate the output to determine if additional adjustment is 
necessary.
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• Transfer defects may occur when paper speed is too fast or too slow.

3. Change the Fuser Speed Adjustment setting. 

• This feature can be used to correct the issue of a smear at 208 mm from the Lead Edge (LE). Increase the 
fuser speed to correct the issue.

• This feature also impacts print quality. 

– Increasing fuser speed extends the image. If fuser speed is set too high it may cause paper jams. 

– Decreasing fuser speed shrinks the image. 

• The option can be found in PredictPrint Media Manager > Stock Library > Stock Properties > Advanced 
Setup > Fuser Speed Adjustment.

• Increase fuser speed in increments of 0.5%. After every increment adjustment run test prints and evaluate 
the output to determine if additional adjustment is necessary.

TRAIL EDGE DELETIONS

For information, refer to the Advanced Stock Setup.

PPrroobblleemm

The printed output contains trail edge deletions.

SSoolluuttiioonnss

Change the Transfer Output Adjustment for Trail Edge setting.

• This feature is used to adjust the voltage ratio on the Secondary Bias Transfer Roll (BTR), where the image is 
transferred from the belt to the paper.

• This feature can be found in PredictPrint Media Manager > Stock Library > Stock Properties > Advanced 
Setup > Transfer Output Adjustment for Trail Edge.

• Decrease the Transfer Output Adjustment for Trail Edge in increments of 5 to 10%. After every increment 
adjustment run test prints and evaluate the output to determine if additional adjustment is necessary.

PREDICTPRINT MEDIA MANAGER DEFAULT SETTINGS

The following information provides the default values, ranges, and recommended incremental adjustments for the 
various PredictPrint Media Manager features, options, and settings.
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Alignment Profile

TTaabbllee 33..11 RReeggiissttrraattiioonn

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Side 1, Side 0.0 0.1 -2.0 to 2.0 mm Determined by test print output 

Side 1, Lead 0.0 0.1 -2.0 to 2.0 mm Determined by test print output 

Side 2, Side 0.0 0.1 -2.0 to 2.0 mm Determined by test print output 

Side 2, Lead 0.0 0.1 -2.0 to 2.0 mm Determined by test print output 

TTaabbllee 33..22 PPeerrppeennddiiccuullaarriittyy

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Side 1 0.0 0.1 -1.0 to 1.0 mm Determined by test print output 

Side 2 0.0 0.1 -1.0 to 1.0 mm Determined by test print output 

TTaabbllee 33..33 SSkkeeww

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Side 1 0.0 0.1 -1.0 to 1.0 mm Determined by test print output 

Side 2 0.0 0.1 -1.0 to 1.0 mm Determined by test print output 

344 Xerox® Versant® 4100 Press User Documentation

Troubleshooting



TTaabbllee 33..44 MMaaggnniiffiiccaattiioonn

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Side 1, Height 0.000 0.025 -0.200 to 0.200 
% 

Determined by test print output 

Side 1, Width 0.000 0.025 -0.200 to 0.200 
% 

Determined by test print output 

Side 2, Height 0.000 0.025 -0.200 to 0.200 
% 

Determined by test print output 

Side 2, Width 0.000 0.025 -0.200 to 0.200 
% 

Determined by test print output 

Fold Adjustment Profile

TTaabbllee 33..55 BBii--FFoolldd -- SSiinnggllee SShheeeett

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Left and Right 
Sides Equal 

N/A N/A N/A N/A 

Left Side of Fold 
is Longer 

0.0 0.1 0.0 – 20.0 mm Determined by test print output 

Right Side of Fold 
is Longer 

0.0 0.1 0.0 – 20.0 mm Determined by test print output 

Xerox® Versant® 4100 Press User Documentation 345

Troubleshooting



TTaabbllee 33..66 BBii--FFoolldd –– MMuullttiippllee SShheeeettss

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Left and Right 
Sides Equal 

N/A N/A N/A N/A 

Left Side of Fold 
is Longer 

0.0 0.1 0.0 – 20.0 mm Determined by test print output 

Right Side of Fold 
is Longer 

0.0 0.1 0.0 – 20.0 mm Determined by test print output 

TTaabbllee 33..77 BBii--FFoolldd –– MMuullttiippllee SShheeeettss SSttaapplleedd

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

SShheeeettss iinn SSeett 11 

Left and Right 
Sides Equal 

N/A N/A N/A N/A 

Left Side of Fold 
is Longer 

0.0 0.1 0.0 – 20.0 mm Determined by test print output 

Right Side of Fold 
is Longer 

0.0 0.1 0.0 – 20.0 mm Determined by test print output 

On the Fold N/A N/A N/A N/A 

Left of Fold 0.0 0.1 0.0 – 20.0 mm Determined by test print output 

Right of Fold 0.0 0.1 0.0 – 20.0 mm Determined by test print output 

SShheeeettss iinn SSeett 22 

Left and Right 
Sides Equal 

N/A N/A N/A N/A 

Left Side of Fold 
is Longer 

0.0 0.1 0.0 – 20.0 mm Determined by test print output 

Right Side of Fold 
is Longer 

0.0 0.1 0.0 – 20.0 mm Determined by test print output 

On the Fold N/A N/A N/A N/A 
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OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST-
MENT 
STEP 
INCRE-
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Left of Fold 0.0 0.1 0.0 – 20.0 mm Determined by test print output 

Right of Fold 0.0 0.1 0.0 – 20.0 mm Determined by test print output 

TTaabbllee 33..88 CC--FFoolldd

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

“A” Length 0.0 0.1 0.0 – 20.0 mm Determined by test print output 

“B” Length 0.0 0.1 0.0 – 20.0 mm Determined by test print output 

TTaabbllee 33..99 ZZ--FFoolldd

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

“A” Length 0.0 0.1 0.0 – 20.0 mm Determined by test print output 

“B” Length 0.0 0.1 0.0 – 20.0 mm Determined by test print output 

TTaabbllee 33..1100 ZZ--FFoolldd HHaallff SShheeeett

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

“A” Length 0.0 0.1 0.0 – 20.0 mm Determined by test print output 

“B” Length 0.0 0.1 0.0 – 20.0 mm Determined by test print output 
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Advanced Stock Setup for Stock Properties

TTaabbllee 33..1111 SSttoocckk BByy NNaammee aanndd MMuullttiiffeeeedd DDeetteeccttiioonn

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Stock By Name 
Only 

Checked Box — — — 

Multi Feed 
Detection 

Checked Box — — — 

TTaabbllee 33..1122 PPrriimmaarryy TTrraannssffeerr CCuurrrreenntt AAddjjuussttmmeenntt

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Yellow 100 1 10 to 200 % Determined by test print output 

Magenta 100 1 10 to 200 % Determined by test print output 

Cyan 100 1 10 to 200 % Determined by test print output 

Black 100 1 10 to 200 % Determined by test print output 

TTaabbllee 33..1133 SSeeccoonnddaarryy TTrraannssffeerr VVoollttaaggee AAddjjuussttmmeenntt

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Side 1 150 1 10 to 300 % Perform AAuuttoo Adjustment 

Side 2 150 1 10 to 300 % Perform AAuuttoo Adjustment 
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TTaabbllee 33..1144 MMoorree AAddvvaanncceedd SSttoocckk SSeettuupp FFeeaattuurreess

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Tray Air Assist System 
Default 

Distinct 
Selections 
Available 

System Default

Multi Feed 
Support Table

Mis-Feed 
Support Table

Forced Off

Custom 1 
through 8

Determined by test print output 

Enable Tray 
Heater 

Checked Box — — — 

Transfer Output 
Adjustment for 
Trail Edge 

100 1 0 to 100 % 10% 

Adjustment of 
Paper Speed at 
Transfer 

0.00 0.01 -0.50 to 0.50 % 0.05% 

Fuser 
Temperature 
Adjustment 

0 1 -10 to 10° C 1° or 2 ° 

Fuser Speed 
Adjustment 

0.0 0.1 -5.0 to 5.0 % 0.1% 

Aligner Roll 
Pressure 

0 1 -40 to 40 Pulse 5 or 10 

Regi-Loop 0.0 0.3 -3.0 to 3.0 mm 0.3 mm 

Alignment Profile Default Distinct 
Selections 
Available 

Available 
selections will 
be based on the 
Profiles created 
by the user 

Determined by test print output 
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OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST-
MENT 
STEP 
INCRE-
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Fold Adjustment 
Profile 

Default Distinct 
Selections 
Available 

Available 
selections will 
be based on the 
Profiles created 
by the user 

Determined by test print output 

Pre Gate Roll 
Adjustment 

System 
Default 

Distinct 
Selections 
Available 

System Default

On

Off

— 
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TTaabbllee 33..1155 PPaappeerr CCuurrll CCoorrrreeccttiioonn

OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST
MENT 
STEP 
INCRE
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

1 Sided- Face Up Default Distinct 
Selections 
Available 

Default

Type A

Type B

Type C

Custom

Severe Upward

Medium 
Upward

Moderate 
Upward

Slight Upward

No Curl

Slight 
Downward

Moderate 
Downward

Medium 
Downward

Severe 
Downward

Follow recommended sequential order:
• Default 
• Type A 
• Type B 
• Type C 
• Custom Curl Correction: Slight (Very 

Small) Upward or Slight (Very Small) 
Downward 

• Custom Curl Correction: Moderate 
(Small) Upward or Moderate (Small) 
Downward 

• Custom Curl Correction: Medium 
Upward or Medium Downward 

• Custom Curl Correction: Severe (Large) 
Upward or Severe (Large) Downward 

1 Sided- Face 
Down 

Default Distinct 
Selections 
Available 

Default

Type A

Type B

Type C

Custom

Severe Upward

Medium 
Upward

Moderate 
Upward

Follow recommended sequential order:
• Default 
• Type A 
• Type B 
• Type C 
• Custom Curl Correction: Slight (Very 

Small) Upward or Slight (Very Small) 
Downward 

• Custom Curl Correction: Moderate 
(Small) Upward or Moderate (Small) 
Downward 

• Custom Curl Correction: Medium 
Upward or Medium Downward 
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OPTION OR 
SETTING 

DEFAULT 
VALUE 

ADJUST-
MENT 
STEP 
INCRE-
MENTS 

AVAILABLE 
RANGE 

RECOMMENDED INCREMENTAL 
ADJUSTMENT 

Slight Upward

No Curl

Slight 
Downward

Moderate 
Downward

Medium 
Downward

Severe 
Downward

• Custom Curl Correction: Severe (Large) 
Upward or Severe (Large) Downward 

2 Sided Default Distinct 
Selections 
Available 

Default

Type A

Type B

Type C

Custom

Severe Upward

Medium 
Upward

Moderate 
Upward

Slight Upward

No Curl

Slight 
Downward

Moderate 
Downward

Medium 
Downward

Severe 
Downward

Follow recommended sequential order:
• Default 
• Type A 
• Type B 
• Type C 
• Custom Curl Correction: Slight (Very 

Small) Upward or Slight (Very Small) 
Downward 

• Custom Curl Correction: Moderate 
(Small) Upward or Moderate (Small) 
Downward 

• Custom Curl Correction: Medium 
Upward or Medium Downward 

• Custom Curl Correction: Severe (Large) 
Upward or Severe (Large) Downward 
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Paper Jams

If a paper jam occurs, a fault screen displays a message on the press control panel indicating in which area the jam 
is situated. Follow the instructions provided for clearing the jam and resuming press operation.

For more information, refer to Fault Messages. 

PAPER JAM INFORMATION

Before clearing paper jams, always refer to Fault Information. 

Warning: When you remove jammed paper, ensure that no pieces of jammed paper are left in the press. 
A piece of paper remaining in the press can cause fire. If a piece of paper is stuck in a hidden area or 
paper is wrapped around the fuser unit or rollers, do not remove it forcefully. You can get injured or burned. 
Switch off the press immediately and contact the Customer Support Center.

PPaappeerr JJaammss IInnssiiddee tthhee PPrreessss

There are three main module areas of the press where paper jams may occur:

• The Registration area behind the Left Front Door (Xerographic Drawer, Transfer Drawer, and Paper Handling 
Drawer)

• Fuser Assembly and Decurler area behind the Center Front Door

• Inverter and Entrance / Exit areas of the Output / Cooling Module behind the Right Front Door

Tip: AAllwwaayyss cchheecckk tthhee OOuuttppuutt MMoodduullee ffiirrsstt ffoorr aa ppaappeerr jjaamm aatt tthhee eennttrraannccee ooff tthhee mmoodduullee. Rotate the green 
knobs to pull paper through the entrance areas completely. Always ensure that all paper jams, including any small 
ripped pieces of paper, are cleared before proceeding with your print job.

Warning: Never touch a labeled area indicating High Temperature and Caution; this area is found on the 
fuser unit or nearby. Contact to this area can lead to burns.

CLEARING JAMS IN AREA 2

Important: Before opening any press doors, ensure that the press has stopped printing. 

The transfer drawer includes the following jam clearance areas: 

• Registration and alignment transport

• Registration roll

• Duplex transport

• Fuser entrance
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1. Open the left and center front doors. 

2. To unlock transfer drawer, locate the green handle 2 and rotate it clockwise (right) to the horizontal position. 

3. Slowly pull out the transfer drawer until it stops. 

Note: If paper is jammed in the drawer while pulling it out, stop pulling when the jammed paper is visible. 
Hold down the paper with one hand and continue pulling out the drawer.
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4. If paper is jammed at the top of the transfer drawer, remove paper from area 2a by pulling it straight out. 

5. Open lever 2b upward and remove any jammed paper. 

6. Return lever 2b to its original position. 
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7. Locate area 2c and pull any jammed paper out towards the left. 

8. Open lever 2d upward (1) and lever 2e to the right (2) and remove any jammed paper (3). 

9. Return levers 2d and 2e to their original positions. 
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10. Open lever 2f lever downward and remove any jammed paper. 

11. Return lever 2f to its original position. 

12. To close the transfer drawer, grasp handle 2 and gently push in the drawer completely (1), then turn the green 
handle to the left to lock the drawer in place (2). 

13. Close the left and center front doors completely. The press does not operate when doors or covers are open.

CLEARING JAMS IN AREAS 3 ,  4 ,  AND 5

Important: Before opening any press doors, ensure that the press has stopped printing. 
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1. Open the right front door. 

2. Open lever 3a upward (1) and remove any jammed paper (2). 

3. If there is difficulty in removing the jammed paper, rotate knob 3b clockwise (right) (1), and remove the 
jammed paper (2). 

Note: There may be extra sheets remaining in the press. To ensure all sheets are removed, rotate knob 3b 
clockwise (right) three times.
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4. Return lever 3a to its original position. 

5. Open lever 5a downward and remove any jammed paper . 

6. If there is difficulty in removing the jammed paper, rotate knob 5b clockwise (right) (1), and remove the 
jammed paper (2). 
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7. Return lever 5a to its original position. 

8. Open lever 5c downward (1) and remove any jammed paper (2). 

9. If there is difficulty in removing the jammed paper, rotate knob 5d clockwise (right) (1), and remove the 
jammed paper (2). 
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10. Return lever 5c to its original position. 

11. To open the exit module drawer, grasp handle 4 and rotate handle to the right to the horizontal position.  

12. Slowly pull out the exit module drawer until stops. 
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13. Remove any jammed paper from the top of the module (area 4a) by pulling it straight out. 

14. If there is difficulty in removing the jammed paper, rotate knob 4a clockwise (right) (1), and remove the 
jammed paper (2). 

15. Open lever 4b to the right (1) and remove any jammed paper (2). 
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16. If there is difficulty in removing the jammed paper, open lever 4d to the right (1), and remove the jammed 
paper (2). 

17. Return levers 4b and 4d to their original positions. 

18. Open lever 4c to the right (1) and remove any jammed paper (2). 
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19. Return lever 4c to its original position. 

20. To close the exit module, grasp handle 4, gently push in the exit module completely (1), and rotate handle to 
the left (2) to lock the module in place . 

21. Close the right front door completely. The press does not operate if a door is open even slightly.

PAPER JAMS IN TRAYS 1-3

Note: Paper is sometimes torn and remains inside the press if you open a tray without checking the paper 
jam position. This may cause a malfunction. Check where the paper jam occurred before clearing the 
problem.
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1. Open the tray where the paper jam occurred. 

2. Remove the jammed paper. 

3. Push the tray in gently until it comes to a stop. 
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PAPER JAMS IN THE BYPASS (TRAY 5)

Paper Jams When the Bypass is Installed on Trays 6 and 7

Tip: Always ensure that all paper jams, including any small, ripped pieces of paper, are cleared before proceeding 
with any print jobs.

1. Remove the paper currently loaded in the Bypass (Tray 5). 

2. Lift and open the Top Cover of the Bypass (Tray 5). 

3. Remove any jammed paper. 

Note: If paper is torn, check inside the press and remove it.

4. Close the Top Cover of the Bypass (Tray 5). 
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5. Reload paper into the tray and resume printing.

JAM CLEARANCE OF OHCF

Clearing OHCF Jams (Trays 6 and 7)

Nip Release levers inside of the Transport area of the Feeder hold back large size sheets (such as A3, 11 x 17 inches, 
12 x 18 inches) to reduce the chance of jamming as paper enters the print engine.

Note: Follow the jam clearance instructions displayed on the touch screen. Always ensure that all paper 
jams, including any small ripped pieces of paper, are cleared before proceeding with your print jobs. 

Paper Jams inside Trays 6 and 7

1. Pull out the tray where the paper jam occurred. 

2. Remove the jammed paper. 

Note: If paper is torn, check inside the machine and remove it.

3. Gently push in the tray until it comes to a stop.
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Trays 6 and 7 Paper Jams at Lever 1a and Knob 1c

1. Open the front cover of the feeder module. 

2. Move the lever 1a to the right and turn the knob 1c to the right. Remove the jammed paper. 

Note: If paper is torn, check for any torn pieces of paper inside the machine.

3. Return the lever 1a to the original position. 

4. Close the front cover of the feeder module. 

Note: If the front cover of the feeder module is not completely closed, a message will appear and the press 
will not operate.
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Trays 6 and 7 Paper Jams at Lever 1b and Knob 1c

1. Open the front cover of the feeder module. 

2. Move the lever 1b to the right and turn the knob 1c to the right. Remove the jammed paper. 

Note: If paper is torn, check for any torn pieces of paper inside the machine.

3. Return the lever 1b to the original position. 

4. Close the front cover of the feeder module. 

Note: If the front cover of the feeder module is not completely closed, a message will appear and the press 
will not operate.

Trays 6 and 7 Paper Jams at Lever 1d and Knob 1c

Note: If paper is torn, check for any torn pieces of paper inside the machine.
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1. Open the front cover of the feeder module. 

2. Move the lever 1d upward and remove the jammed paper. 

3. If the paper cannot be removed, turn the knob 1c clockwise, then remove the jammed paper. 
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4. Return the lever 1d to the original position. 

5. Close the front cover of the feeder module. 

Note: If the front cover of the feeder module is not completely closed, a message will appear and the press 
will not operate.
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Fault Information

The following occurs when there is a fault, such as paper jams, open doors or covers, or a press malfunction:

• The press stops running and a fault message displays on the press touch screen.

• The message includes a graphical illustration showing the location of the fault along with a brief explanation of 
corrective actions for clearing the fault.

• Paper jams may occur in multiple areas of the press and any optional devices connected to the press. When this 
happens, the graphical illustration changes to show the multiple locations and the required corrective actions. 

• Additionally, if a fault occurs with an optional device, an indicator lights on that device control panel and shows 
the corresponding area on the device where the fault occurred.

Always refer to the following information when clearing paper jams:

• Do not power off the press when removing paper jams.

• Paper jams can be removed with the press still powered on. When the power is turned off, all information stored 
to the system memory will be erased.

• Clear all paper jams before resuming print jobs.

• Do not touch components inside the press. This can cause print defects.

• Ensure that all paper jams, including any small ripped pieces of paper, are cleared before proceeding with print 
jobs.

• Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove all torn pieces.

• After removing paper jams, close all doors and covers. The press cannot print when doors or covers are open.

• After clearing a paper jam, printing automatically resumes from the state before the paper jam occurred.

• If all paper jams are not cleared, an error message continues to display on the press touch screen. To clear any 
remaining jams, refer to the press touch screen for instructions and information.

OBTAINING FAULT INFORMATION FROM THE PRESS TOUCH SCREEN

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. Use the following procedure to obtain information and instructions 
about the correcting the fault.
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1. From Home on the press touch screen, select the Faults button. 

• If there is only one fault, a Fault screen displays.  

• If there are multiple faults, a list displays underneath the graphical illustration on the Home screen; refer to 
the illustration in the next step.
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2. Select the first, top item from the displayed list. 

Note: Multiple faults are listed in descending order with the top fault being number one. Correct them in the 
order they listed starting with the top one and working down the list. 

A Fault screen displays.

3. To correct a fault, following the instructions provided on the Fault screen. 

When finished, select Close.

4. Repeat the previous steps until all faults are cleared. 
If a fault cannot be cleared, contact the system administrator.

FAULT MESSAGES

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. A graphical illustration shows the location of the fault with a brief 
explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration 
changes to indicate the multiple locations and the required corrective actions. 

Note: For more information, refer to Obtaining Fault Information from the Press Touch Screen. 
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Detailed information and instructions about the correcting a fault is available by selecting the Faults button on the 
Home screen. The Fault screen displays.

Find the code for the fault listed at the bottom of the Fault screen.
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Trays 8 and 9 Troubleshooting

TRAYS 8  AND 9 TROUBLESHOOTING

Paper Jams in Trays 8 and 9

Paper Jams When the Bypass is Installed on Trays 8 and 9

Tip: Always ensure that all paper jams, including any small, ripped pieces of paper, are cleared before proceeding 
with any print jobs.

1. Remove the paper currently loaded in the Bypass (Tray 5). 

2. Lift and open the Top Cover of the Bypass (Tray 5). 

3. Remove any jammed paper. 

Note: If paper is torn, check inside the press and remove it.
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4. Close the Top Cover of the Bypass (Tray 5). 

5. Pull open the Top Drawer (located at the top of Trays 6 and 7). 

6. Lift levers 2a and 2b, then remove any paper jams. 

7. Close levers 2a and 2b.

8. Close the Top Drawer.

Xerox® Versant® 4100 Press User Documentation 377

Troubleshooting



9. Reload paper into the tray and resume printing.

Paper Jams Inside Trays 8 and 9

1. Pull out the tray where the paper jam occurred. 

2. Remove the jammed paper. 

Note: If paper is torn, check inside the machine and remove it.

3. Gently push in the tray until it comes to a stop.

Trays 8 and 9 Paper Jams at Lever 1a and Knob 1c

1. Open the front cover of the feeder module. 
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2. Move the lever 1a to the right and turn the knob 1c to the right. Remove the jammed paper. 

Note: If paper is torn, check inside the machine and remove it.

3. Return the lever 1a to the original position.

4. Close the front cover of the feeder module. 

Note: If the front cover of the feeder module is not completely closed, a message will appear and the press 
will not operate.

Trays 8 and 9 Paper Jams at Lever 1b and Knob 1c

1. Open the front cover of the feeder module. 
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2. Move the lever 1b to the right and turn the knob 1c to the right. Remove the jammed paper. 

Note: If paper is torn, check inside the machine and remove it.

3. Return the lever 1b to the original position.

4. Close the front cover of the feeder module. 

Note: If the front cover of the feeder module is not completely closed, a message will appear and the press 
will not operate.

Trays 8 and 9 Paper Jams at Lever 1d and Knob 1c

1. Open the front cover of the feeder module. 
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2. Move the lever 1d upward and remove the jammed paper. 

Note: If paper is torn, check inside the machine and remove it.

3. If the paper cannot be removed, turn the knob 1c clockwise, then remove the jammed paper.

4. Return the lever 1d to the original position.

5. Close the front door of the feeder module. 

Note: If the front cover of the feeder module is not completely closed, a message will appear and the press 
will not operate.

Trays 8/9 Fault Messages

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. A graphical illustration shows the location of the fault with a brief 
explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration 
changes to indicate the multiple locations and the required corrective actions. 

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault. The (EE) code on the upper-left part of the Fault message displays which error indicator is lit 
on the Trays 8/9 indicator panel (E1–E7).

Trays 8/9 Fault Code Information

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. 

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault. 
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Tip: Trays 8 and 9 faults are identified by the codes which start with the three-digit number 117788.
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High Capacity XLS Vacuum Feeder (HCVF) Troubleshooting

For a printable flowchart of the HCVF Troubleshooting, that is described in the following section, refer to 
Troubleshooting Feed Errors in the Xerox® High Capacity XLS Vacuum Feeder in www.xerox.com. In the Customer 
Support > All Support and Drivers section of the web page, search for your Product. In the Documentation web 
page of your printer, you can find the HCVF Troubleshooting flowchart.

TROUBLESHOOTING MISFEEDS AND MULTIFEEDS IN THE HIGH CAPACITY XLS VACUUM 

FEEDER (HCVF)

When using the optional High Capacity XLS Vacuum Feeder (HCVF) and a misfeed or multifeed condition occurs, 
check the press user interface for one of the following fault codes.

MISFEED FAULT CODES MULTIFEED FAULT CODES 

• 078–101 
• 078–131 
• 078–132 
• 078–151 

• 178–101 
• 178–131 
• 178–132 
• 178–151 

• 077–131 
• 077–132 

• 078–125 
• 078–126 
• 078–127 

To resolve misfeed or multifeed conditions, adjust the air assist profile. For instructions on adjusting the air assist 
profile, refer to Adjusting the Air Assist Profile.

For information about the blower settings, refer to Information about the HCVF Air Assist Blowers.

To troubleshoot misfeeds, refer to Troubleshooting Misfeeds in the HCVF.

To troubleshoot multifeeds, refer to Troubleshooting Multifeeds in the HCVF.

Information about the HCVF Air Assist Blowers

Location of the air assist blowers in the High Capacity XLS Vacuum Feeder (HCVF):

HCVF BLOWER LOCATIONS DESCRIPTION 

AA: Vacuum Blower

BB: Air Knife Blower

CC: Rear Lead Blower

DD: Rear End Blower

EE: Front Blower

FF: Rear Option Blower

Before adjusting any HCVF air assist blower settings, refer to the following information.

Important: For all blowers, the settings do not require increasing or decreasing unless misfeed or multifeed 
faults are occurring.

Xerox® Versant® 4100 Press User Documentation 383

Troubleshooting

https://www.xerox.com


For the Air Knife Blower, refer to the following information:

• The available settings are: Off, Low, Mid, or High.

• Low is the slowest speed, and High is the fastest speed.

• If the preset value is Off, the blower is not operating. Do not change the setting.

For the Rear Lead Blower and Front Blower, refer to the following information: 

• The slowest speed is setting 2. Decrease the blower speed only if the current setting is greater than 2.

• The fastest speed is setting 13. Increase the blower speed only if the current setting is less than 13.

• If the preset value is 1, the blower is not operating. Do not change the setting.

Note: Before changing a blower setting, check the current value. For example, if the current value on a 
blower is set at 5, to increase the speed by two settings, change the setting to 7.

Adjusting the Air Assist Profile

The air assist profile controls blower settings in the HCVF. You can create a new profile or modify an existing profile. 
You can test changes to blower settings before you save a profile.

Note: Before you adjust the air assist profile, ensure that the media loaded in the HCVF adheres to the Paper 
and Media Guidelines for the HCVF.

For information about the blower settings, refer to Information about the HCVF Air Assist Blowers.

To adjust the air assist profile, do the following:

1. At the home screen, select Profiles.

2. In the Profiles window, select Air Assist.

3. In the Air Assist area, do one of the following. 

• To create a new profile, select New.

• To modify an existing air assist profile, select a named profile, then select Edit.

4. In the Air Assist Setup window, select VCF Settings.

5. In the VCF Settings window, you can adjust the settings for each blower in the HCVF. Make adjustments 
according to the recommended troubleshooting instructions only. 

a. To reset blower settings to system defaults, select Apply System Defaults.

b. To test an adjustment, select Test Print. Before you save your changes, you can run a test print.

6. To save the profile, select OK.

7. To return to the home screen, close the Profiles window.

Troubleshooting Misfeeds in the HCVF

When using the optional High Capacity XLS Vacuum Feeder (HCVF), the following fault codes indicate a misfeed 
condition: 
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• 078–101, 078–131, 078–132, 078–151.

• 178–101, 178–131, 178–132, 178–151.

For fault codes relating to multifeeds, refer to Troubleshooting Multifeeds in the HCVF.

To resolve a misfeed, follow the steps in the appropriate section. 

Note: Before you make any adjustments, note the current settings for the Air Knife Blower, the Rear Lead 
Blower, and the Front Blower. If you are instructed to change a blower setting to the preset value, use the 
setting that you noted.

Misfeeds when using paper weight 177 g/m² or heavier

When using paper of weights 177 g/m² or heavier, misfeeds can occur.

1. Make the following blower adjustments: 

• Air Knife Blower: No change.

• Rear Lead Blower: Increase the blower speed by two settings. For example, if the blower speed is set 
at 5, to increase the speed by two settings, change the setting to 7.

• Front Blower: Increase the blower speed by two settings.

2. Run a test print. If no misfeed or multifeed occurs, the problem is resolved.

3. If a misfeed or multifeed occurs, for the Rear Lead Blower and Front Blower, do the following: 

• If a misfeed occurs, increase the blower speed by two settings.

• If a multifeed occurs, decrease the blower speed by one setting.

4. Run another test print. If the problem is not resolved, contact your Xerox representative.

Misfeeds when using paper weight less than 177 g/m² and printing five or fewer sheets

When using paper of weights less than 177 g/m² and printing five or fewer sheets, misfeeds can occur.

1. Make the following blower adjustments: 

• Air Knife Blower: Decrease the blower speed by one setting. For example, if the current setting is 
High, change the setting to Mid. 

Note: For the Air Knife Blower, decrease the speed only if the current setting is High or Mid.

• Rear Lead Blower and Front Blower: Do not change any settings.

2. Run a test print. If no misfeed occurs, the problem is resolved.

3. If a misfeed occurs again, do the following: 

• Air Knife Blower: Decrease the blower speed by one setting. For example, if the current setting is 
Mid, change the setting to Low. 

Note: For the Air Knife Blower, decrease the speed only if the current setting is High or Mid.

• Rear Lead Blower and Front Blower: Do not change any settings.

4. Run another test print. If the problem is not resolved, contact your Xerox representative.

Misfeeds when using paper weight less than 177 g/m² and printing more than five sheets
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When using paper of weights less than 177 g/m² and printing more than five sheets, misfeeds can occur.

1. Make the following blower adjustments: 

• Air Knife Blower: No change.

• Rear Lead Blower: Increase the blower speed by two settings. For example, if the blower speed is set 
at 5, to increase the speed by two settings, change the setting to 7.

• Front Blower: Increase the blower speed by two settings.

2. Run a test print. If no misfeed or multifeed occurs, the problem is resolved.

3. If a misfeed or multifeed occurs, for the Rear Lead Blower and Front Blower, do the following: 

• If a misfeed occurs, increase the blower speed by two settings.

• If a multifeed occurs, decrease the blower speed by one setting.

4. Run a test print. If no misfeed or multifeed occurs, the problem is resolved.

5. If a misfeed occurs again, do the following: 

• Air Knife Blower: Decrease the blower speed by one setting. For example, if the current setting is 
High, change the setting to Mid. 

Note: For the Air Knife Blower, decrease the speed only if the current setting is High or Mid.

• Rear Lead Blower: Change the setting to the preset value.

• Front Blower: Change the setting to the preset value.

6. Run a test print. If no misfeed occurs, the problem is resolved.

7. If a misfeed occurs again, for the Air Knife Blower, decrease the blower speed by one setting. 

Note: For the Air Knife Blower, decrease the speed only if the current setting is High or Mid.

8. Run another test print. If the problem is not resolved, contact your Xerox representative.

Troubleshooting Multifeeds in the HCVF

When using the optional High Capacity XLS Vacuum Feeder (HCVF), the following fault codes indicate a multifeed 
condtion: 

• 077–131, 077–132.

• 078–125, 078–126, 078–127.

For fault codes relating to misfeeds, refer to Troubleshooting Misfeeds in the HCVF.

To resolve a multifeed, follow the steps in the appropriate section. 

Note: Before you make any adjustments, note the current settings for the Air Knife Blower, the Rear Lead 
Blower, and the Front Blower. If you are instructed to change a blower setting to the preset value, use the 
setting that you noted.

Multifeeds when using coated paper weight 177 g/m² or heavier
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Humidity levels of 50 percent or higher

When using coated paper of weight 177 g/m² or heavier in humidity levels of 50 percent or 
higher, multifeed problems can occur.

1. If the paper is coated on one side only, go to step 3.

2. If the paper is coated on both sides, do the following. 

a. Make the following blower adjustments: 

• Air Knife Blower: No change.

• Rear Lead Blower: Increase the blower speed by one setting. For example, if the blower 
speed is set at 5, to increase the speed by one setting, change the setting to 6.

• Front Blower: Increase the blower speed by one setting.

b. Run a test print. If no multifeed occurs, the problem is resolved.

c. If a multifeed occurs again, for the Rear Lead Blower and Front Blower, increase the blower 
speed by one setting.

d. Run a test print. If no multifeed occurs, the problem is resolved.

e. If multifeeds continue, repeat steps 2c and 2d twice.

3. If using paper that is coated on one side only, or if multifeeds continue, do the following. 

a. Make the following blower adjustments: 

• Air Knife Blower: No change.

• Rear Lead Blower: Change the setting to the preset value, then decrease the speed by 
one setting.

• Front Blower: Change the setting to the preset value, then decrease the speed by one 
setting.

b. Run a test print. If no multifeed occurs, the problem is resolved.

c. If a multifeed occurs again, for the Rear Lead Blower and Front Blower, decrease the blower 
speed by one setting.

d. Run a test print. If no multifeed occurs, the problem is resolved.

e. If multifeeds continue, repeat steps 3c and 3d twice.

4. If the problem is not resolved, contact your Xerox representative.
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Humidity levels below 50 percent

When using coated paper of weight 177 g/m² or heavier in humidity levels below 50 percent, 
multifeed problems can occur.

1. To resolve the multifeed, do the following. 

a. Make the following blower adjustments: 

• Air Knife Blower: No change.

• Rear Lead Blower: Decrease the blower speed by one setting. For example, if the 
blower speed is set at 7, to decrease the speed by one setting, change the setting to 6.

• Front Blower: Decrease the blower speed by one setting.

b. Run a test print. If no multifeed occurs, the problem is resolved.

c. For the Rear Lead Blower and Front Blower, decrease the blower speed by one setting.

d. Run a test print. If no multifeed occurs, the problem is resolved.

e. If multifeeds continue, repeat steps 1c and 1d twice.

2. If multifeeds continue, do the following. 

a. Make the following blower adjustments: 

• Air Knife Blower: Decrease the blower speed by one setting. 

Note: For the Air Knife Blower, decrease the speed only if the current setting is High or Mid.

• Rear Lead Blower: Change the blower speed to the preset value, then decrease the 
speed by one setting.

• Front Blower: Change the blower speed to the preset value, then decrease the speed 
by one setting.

b. Run a test print. If no multifeed occurs, the problem is resolved.

c. If a multifeed occurs again, do the following: 

• Air Knife Blower: Decrease the blower speed by one setting. 

Note: For the Air Knife Blower, decrease the speed only if the current setting is High or Mid.

• Rear Lead Blower: Decrease the blower speed by one setting.

• Front Blower: Decrease the blower speed by one setting.

d. Run a test print. If no multifeed occurs, the problem is resolved.

e. If multifeeds continue, for the Rear Lead Blower and Front Blower only, repeat steps 2c and 
2d twice.

3. If the problem is not resolved, contact your Xerox representative.
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Multifeeds when using uncoated paper of weight 177 g/m² or heavier

When using uncoated paper of weight 177 g/m² or heavier, multifeed problems can occur.

1. To resolve the multifeed, make the following blower adjustments: 

• Air Knife Blower: No change.

• Rear Lead Blower: Decrease the blower speed by three settings. For example, if the blower speed is 
set at 7, to decrease the speed by three settings, change the setting to 4.

• Front Blower: Decrease the blower speed by three settings.

2. Run a test print. If no misfeed or multifeed occurs, the problem is resolved.

3. If a misfeed or multifeed occurs, for the Rear Lead Blower and Front Blower, do the following: 

• If a misfeed occurs, increase the blower speed by one setting.

• If a multifeed occurs, decrease the blower speed by one setting.

4. Run another test print. If the problem is not resolved, contact your Xerox representative.
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Multifeeds when using paper weight less than 177 g/m²

Humidity levels of 50 percent or higher

When using paper of weight less than 177 g/m², in humidity levels of 50 percent or higher, 
multifeed problems can occur.

1. To resolve the multifeed, make the following blower adjustments: 

• Air Knife Blower: No change.

• Rear Lead Blower: Decrease the blower speed by two settings. For example, if the blower 
speed is set at 7, to decrease the speed by two settings, change the setting to 5.

• Front Blower: Decrease the blower speed by two settings.

2. Run a test print. If no misfeed or multifeed occurs, the problem is resolved.

3. If a misfeed or multifeed occurs, for the Rear Lead Blower and Front Blower, do the following: 

• If a misfeed occurs, increase the blower speed by one setting.

• If a multifeed occurs, decrease the blower speed by two settings.

4. Run a test print. If no misfeed or multifeed occurs, the problem is resolved.

5. If a multifeed occurs again, do the following. 

a. Make the following adjustments: 

• Air Knife Blower: No change.

• Rear Lead Blower: Change the blower speed to the preset value, then increase the 
speed by one setting.

• Front Blower: Change the blower speed to the preset value, then increase the speed by 
one setting.

b. Run a test print. If no multifeed occurs, the problem is resolved.

c. If a multifeed occurs again, for the Rear Lead Blower and Front Blower, increase the blower 
speed by one setting.

d. Run a test print. If no multifeed occurs, the problem is resolved.

e. If multifeeds continue, repeat steps 5c and 5d twice.

6. If multifeeds continue, do the following: 

• Air Knife Blower: Decrease the blower speed by one setting. 

Note: For the Air Knife Blower, decrease the speed only if the current setting is High or Mid.

• Rear Lead Blower: Change the blower speed to the preset value.
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• Front Blower: Change the blower speed to the preset value.

7. Run a test print. If no misfeed or multifeed occurs, the problem is resolved.

8. If a misfeed occurs, for the Air Knife Blower, decrease the blower speed by one setting. 

Note: For the Air Knife Blower, decrease the speed only if the current setting is High or Mid.

9. Run another test print. If the problem is not resolved, contact your Xerox representative.

Xerox® Versant® 4100 Press User Documentation 391

Troubleshooting



Humidity levels below 50 percent

When using paper of weight less than 177 g/m², in humidity levels below 50 percent, multifeed 
problems can occur.

1. To resolve the multifeed, make the following blower adjustments: 

• Air Knife Blower: No change.

• Rear Lead Blower: Increase the blower speed by two settings. For example, if the blower 
speed is set at 5, to increase the speed by two settings, change the setting to 7.

• Front Blower: Increase the blower speed by two settings.

2. Run a test print. If no misfeed or multifeed occurs, the problem is resolved.

3. If a misfeed or multifeed occurs, for the Rear Lead Blower and Front Blower, do the following: 

• If a misfeed occurs, increase the blower speed by two settings.

• If a multifeed occurs, decrease the blower speed by one setting.

4. Run a test print. If no misfeed or multifeed occurs, the problem is resolved.

5. If a multifeed occurs again, do the following: 

• Air Knife Blower: Decrease the blower speed by one setting. 

Note: For the Air Knife Blower, decrease the speed only if the current setting is High or Mid.

• Rear Lead Blower: Change the blower speed to the preset value.

• Front Blower: Change the blower speed to the preset value.

6. Run a test print. If no misfeed or multifeed occurs, the problem is resolved.

7. If a misfeed occurs, for the Air Knife Blower, decrease the blower speed by one setting. 

Note: For the Air Knife Blower, decrease the speed only if the current setting is High or Mid.

8. Run a test print. If no misfeed or multifeed occurs, the problem is resolved.

9. If a misfeed occurs, do the following. 

a. Make the following adjustments: 

• Air Knife Blower: Change the blower speed to the preset value.

• Rear Lead Blower: Decrease the blower speed by one setting.

• Front Blower: Decrease the blower speed by one setting.

b. Run a test print. If no misfeed or multifeed occurs, the problem is resolved.

c. If a multifeed occurs again, for the Rear Lead Blower and Front Blower, decrease the blower 
speed by one setting.

d. Run a test print. If no misfeed or multifeed occurs, the problem is resolved.

e. If misfeeds continue, repeat steps 5c and 5d twice.

10. If the problem is not resolved, contact your Xerox representative.
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Troubleshooting Finishing Devices

INTERFACE DECURLER MODULE TROUBLESHOOTING

Paper Jams on the Interface Decurler Module (IDM)

The following occurs when there is a fault, such as paper jams, open doors or covers, or a press malfunction:

• The press stops running and a fault message displays on the press touch screen.

• The message includes a graphical illustration showing the location of the fault along with a brief explanation of 
corrective actions for clearing the fault.

• Paper jams may occur in multiple areas of the press and any optional devices connected to the press. When this 
happens, the graphical illustration changes to show the multiple locations and the required corrective actions. 

• Additionally, if a fault occurs with an optional device, an indicator lights on that device control panel and shows 
the corresponding area on the device where the fault occurred.

Always refer to the following information when clearing paper jams:

• Do not power off the press when removing paper jams.

• Paper jams can be removed with the press still powered on. When the power is turned off, all information stored 
to the system memory will be erased.

• Clear all paper jams before resuming print jobs.

• Do not touch components inside the press. This can cause print defects.

• Ensure that all paper jams, including any small ripped pieces of paper, are cleared before proceeding with print 
jobs.

• Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove all torn pieces.

• After removing paper jams, close all doors and covers. The press cannot print when doors or covers are open.

• After clearing a paper jam, printing automatically resumes from the state before the paper jam occurred.

• If all paper jams are not cleared, an error message continues to display on the press touch screen. To clear any 
remaining jams, refer to the press touch screen for instructions and information.
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Clearing Paper Jams on the Interface Decurler Module

1. Open the front cover on the Interface Decurler Module (IDM). 

2. Remove jammed paper: 

a. Open lever 1a downward.

b. Turn knob 1b counterclockwise. 

Important: To ensure the jammed paper exits the area, turn the knob a minimum of ten (10) times 
or more.

c. Remove the jammed paper. 

Important: Remove the jammed paper by carefully pulling it out of the area.
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3. Return lever 1a to its original position. 

4. If you encounter difficulty when removing jammed paper, open lever 1c upward and carefully remove jammed 
paper. 

5. Return lever 1c to its original position. 

6. Close the IDM front cover.

7. If required, follow the instructions on the press touch screen to clear other areas of the system.
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Fault Messages on the Interface Decurler Module

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. A graphical illustration shows the location of the fault with a brief 
explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration 
changes to indicate the multiple locations and the required corrective actions.

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault.

Fault Code Information on the Interface Decurler Module

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. 

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault. 

Tip: Interface Decurler Module faults are identified by the codes which start with the three-digit number 004488.  

INSERTER MODULE TROUBLESHOOTING

Inserter Paper Jams

The following occurs when there is a fault, such as paper jams, open doors or covers, or a press malfunction:
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• The press stops running and a fault message displays on the press touch screen.

• The message includes a graphical illustration showing the location of the fault along with a brief explanation of 
corrective actions for clearing the fault.

• Paper jams may occur in multiple areas of the press and any optional devices connected to the press. When this 
happens, the graphical illustration changes to show the multiple locations and the required corrective actions. 

• Additionally, if a fault occurs with an optional device, an indicator lights on that device control panel and shows 
the corresponding area on the device where the fault occurred.

Always refer to the following information when clearing paper jams:

• Do not power off the press when removing paper jams.

• Paper jams can be removed with the press still powered on. When the power is turned off, all information stored 
to the system memory will be erased.

• Clear all paper jams before resuming print jobs.

• Do not touch components inside the press. This can cause print defects.

• Ensure that all paper jams, including any small ripped pieces of paper, are cleared before proceeding with print 
jobs.

• Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove all torn pieces.

• After removing paper jams, close all doors and covers. The press cannot print when doors or covers are open.

• After clearing a paper jam, printing automatically resumes from the state before the paper jam occurred.

• If all paper jams are not cleared, an error message continues to display on the press touch screen. To clear any 
remaining jams, refer to the press touch screen for instructions and information.

Clearing Paper Jams from Inserter E1 Area

1. Open the T1 cover (1), then remove the jammed papers (2) as well as all of the paper loaded in the tray (3). 

Note: When two or more sheets of paper are loaded, remove all sheets.

Fan the paper you removed and make sure all four corners are aligned correctly. 

2. Reload the paper into the tray.

3. Close the T1 cover.
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Clearing Paper Jams from Inserter E2 Area

1. Open the Inserter front cover. 

2. Open lever 1a upward (1) and turn knob 1b counterclockwise (2). Remove jammed paper (3). 

3. Return lever 1a to its original position. 
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4. If you have difficulty when removing jammed paper, open lever 1c to the right (1) and turn knob 1b 
counterclockwise (2). Remove jammed paper (3). 

5. Return lever 1c to its original position. 

6. Close the Inserter front cover.

Clearing Paper Jams from Inserter E3 Area

1. Open the Inserter front cover. 
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2. Open lever 1d downward (1) and turn knob 1e counterclockwise (2). Remove the jammed paper (3). 

Note: The jammed paper may be hidden behind the upper-left cover area.

3. Return lever 1d to its original position. 

4. If you have difficulty when removing jammed paper, open lever 1a upward (1) and turn knob 1e 
counterclockwise (2). Remove the jammed paper (3). 
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5. Return lever 1a to its original position. 

6. Close the Inserter front cover.

Inserter Fault Messages

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. A graphical illustration shows the location of the fault with a brief 
explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration 
changes to indicate the multiple locations and the required corrective actions. 

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault. The (EE) code on the upper-left part of the Fault message displays which error indicator is lit 
on the Inserter control panel (E1, E2, E3).

Inserter Fault Code Information

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen.

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault.

Tip: Inserter faults are identified by the codes which start with the three-digit numbers 001122, 001133, and 002244. 
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HIGH CAPACITY STACKER TROUBLESHOOTING

HCS Paper Jams

The following occurs when there is a fault, such as paper jams, open doors or covers, or a press malfunction:

• The press stops running and a fault message displays on the press touch screen.

• The message includes a graphical illustration showing the location of the fault along with a brief explanation of 
corrective actions for clearing the fault.

• Paper jams may occur in multiple areas of the press and any optional devices connected to the press. When this 
happens, the graphical illustration changes to show the multiple locations and the required corrective actions. 

• Additionally, if a fault occurs with an optional device, an indicator lights on that device control panel and shows 
the corresponding area on the device where the fault occurred.

Always refer to the following information when clearing paper jams:

• Do not power off the press when removing paper jams.

• Paper jams can be removed with the press still powered on. When the power is turned off, all information stored 
to the system memory will be erased.

• Clear all paper jams before resuming print jobs.

• Do not touch components inside the press. This can cause print defects.

• Ensure that all paper jams, including any small ripped pieces of paper, are cleared before proceeding with print 
jobs.

• Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove all torn pieces.

• After removing paper jams, close all doors and covers. The press cannot print when doors or covers are open.

• After clearing a paper jam, printing automatically resumes from the state before the paper jam occurred.

• If all paper jams are not cleared, an error message continues to display on the press touch screen. To clear any 
remaining jams, refer to the press touch screen for instructions and information.
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Clearing Paper Jams from HCS Area E1

1. Open the HCS top cover. 

2. Open lever 1b upward (1) and remove jammed papers (2). 

3. Return lever 1b to its original position. 

4. Close the HCS top cover.

5. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.
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Clearing Paper Jams from HCS Area E2

1. Open the HCS top cover. 

2. Open lever 1b upward (1) and rotate knob 1a counterclockwise (2) and remove jammed papers (3). 

3. Return lever 1b to its original position. 

4. Close the HCS top cover.

5. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.
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Clearing Paper Jams from HCS Area E3

1. Open the HCS top cover. 

2. Open lever 1b upward (1) and rotate knob 1a counterclockwise (2) and remove jammed papers (3). 

3. Return lever 1b to its original position. 

4. Open lever 2b upward (1) and turn knob 2c counterclockwise (2) and remove jammed papers (3). 
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5. Return lever 2b to its original position. 

6. Close the HCS top cover.

7. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

Clearing Paper Jams from HCS Area E4

1. Open the HCS top cover. 

2. Open lever 2a downward (1) and remove jammed papers(2). 

3. Return lever 2a to its original position. 

4. Close the HCS top cover.
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5. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

Clearing Paper Jams from HCS Area E5

1. Open the HCS top cover. 

2. Open lever 2b upward (1) and turn knob 2c counterclockwise (2) and remove jammed papers (3). 

3. Return lever 2b to its original position. 

4. Close the HCS top cover.

5. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.
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Clearing Paper Jams from HCS Area E6

1. Press the Unload button. 

2. Make sure the HCS front door is unlocked and then open it.  

3. Pull out the stacker cart slowly and remove any jammed paper. 

4. Push the stacker cart back into its original position. 

5. Close the HCS front door.

6. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

408 Xerox® Versant® 4100 Press User Documentation

Troubleshooting



Clearing Paper Jams from HCS Area E7

1. Remove any output delivered to the top tray. 

2. Open the HCS top cover. 

3. Open lever 1b upward (1) and remove jammed papers (2). 

4. Return lever 1b to its original position. 
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5. Open lever 2a downward (1) and remove jammed paper (2). 

6. Return lever 2a to its original position. 

7. Close the HCS top cover.

8. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

HCS Fault Messages

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. A graphical illustration shows the location of the fault with a brief 
explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration 
changes to indicate the multiple locations and the required corrective actions. 

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault. The (EE) code on the upper-left part of the Fault message displays which error indicator is lit 
on the HCS control panel (E1–E8).

HCS Fault Code Information

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. 

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault. 

Tip: HCS faults are identified by the codes which start with the three-digit numbers 004499. 
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Additional HCS Troubleshooting Information

Hints and Tips for Using the High Capacity Stacker (HCS)

Refer to the following hints and tips when using the HCS:

1. Check the paper in the applicable HCS tray for curl. 

a. If no curl is present and if the output is acceptable and meets customer satisfaction, you are finished.

b. If no curl is present and if the output is not acceptable, call for service.

c. If curl is present, continue to the next step.

2. To correct the paper curl, use the paper curl correction controls on the top of the Interface Decurler Module 
(IDM).

3. If the output has not improved, adjust the paper curl again.

4. If the output still has not improved, call the Customer Support Center.
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CREASE AND TWO-SIDED TRIMMER TROUBLESHOOTING

Crease and Two-Sided Trimmer Paper Jams

The following occurs when there is a fault, such as paper jams, open doors or covers, or a press malfunction:

• The press stops running and a fault message displays on the press touch screen.

• The message includes a graphical illustration showing the location of the fault along with a brief explanation of 
corrective actions for clearing the fault.

• Paper jams may occur in multiple areas of the press and any optional devices connected to the press. When this 
happens, the graphical illustration changes to show the multiple locations and the required corrective actions. 

• Additionally, if a fault occurs with an optional device, an indicator lights on that device control panel and shows 
the corresponding area on the device where the fault occurred.

Always refer to the following information when clearing paper jams:

• Do not power off the press when removing paper jams.

• Paper jams can be removed with the press still powered on. When the power is turned off, all information stored 
to the system memory will be erased.

• Clear all paper jams before resuming print jobs.

• Do not touch components inside the press. This can cause print defects.

• Ensure that all paper jams, including any small ripped pieces of paper, are cleared before proceeding with print 
jobs.

• Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove all torn pieces.

• After removing paper jams, close all doors and covers. The press cannot print when doors or covers are open.

• After clearing a paper jam, printing automatically resumes from the state before the paper jam occurred.

• If all paper jams are not cleared, an error message continues to display on the press touch screen. To clear any 
remaining jams, refer to the press touch screen for instructions and information.
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Clearing Paper Jams from Trimmer Area E1

1. Open the trimmer upper cover. 

2. Open lever 1a downward (1), lever 1b downward (2) and lever 1d upward (3). Remove jammed paper (4). 

Note: Check behind the upper cover for any hidden jammed paper.

3. If you have difficulty removing any paper jams, rotate knob 1c clockwise (1), then remove the jammed paper 
(2). 
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4. Return levers 1a, 1b and 1d to their original positions. 

5. Close the trimmer upper cover.

6. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

Clearing Paper Jams from Trimmer Area E2

1. Open the trimmer upper cover. 

2. Rotate knob 2 counterclockwise to align the mark on the knob with the unlock position (a mark resembling an 
open padlock). 
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3. Open lever 1a downward (1) and lever 1b downward (2). 

4. Turn knob 1c clockwise (1) and remove jammed papers (2). 

5. Return levers 1a and 1b to their original positions.  
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6. If you have difficulty removing any paper jams, open lever 1d upward (1) and lever 2a to the left (2). 

7. Rotate knob 2b counterclockwise (1) and remove jammed papers (2). 

8. Return levers 1d and 2a to their original positions. 

9. Close the trimmer upper cover.

10. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.
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Clearing Paper Jams from Trimmer Area E3

1. Open the trimmer upper cover. 

2. Rotate knob 2 counterclockwise to align the mark on the knob with the unlock position (a mark resembling an 
open padlock). 

3. Open lever 2c downward (1) and remove jammed paper (2). 

Note: Check behind the upper cover for any hidden jammed paper.
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4. Return lever 2c to its original position. 

5. Close the trimmer upper cover.

6. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

Clearing Paper Jams from Trimmer Area E4

1. Open the trimmer upper cover. 

2. Open lever 2c downward (1), lever 2d upward (2) and lever 2e to the right (3). 
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3. Rotate knob 2f clockwise (1) and remove jammed paper (2).  

Note: Grasp the lead edge of the jammed sheet and gently pull out the sheet to remove it.

4. If you have difficulty removing the jammed sheet, grasp the top edge at the inner-right side of the sheet and 
gently pull out the sheet to remove it. 

5. Return levers 2e (1), 2d (2) and 2c (3) to their original positions. 

6. Close the trimmer upper cover.

7. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.
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Clearing Paper Jams from Trimmer Area E5

1. Open the trimmer upper cover. 

2. Open lever 3a to the right (1), lever 3b to the left (2). 

3. Rotate knob 3c clockwise (1) and remove jammed paper (2). 

420 Xerox® Versant® 4100 Press User Documentation

Troubleshooting



4. Rotate knob 2f counterclockwise (1) and remove jammed paper (2). 

5. Return levers 3a and 3b to their original positions. 

6. Close the trimmer upper cover.

7. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

Clearing Paper Jams from Trimmer Area E6

1. Open the trimmer upper cover. 
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2. Open lever 3a to the right (1), lever 4b downward (2) and lever 4c to the right (3). Remove jammed paper (4). 

3. Rotate knob 4d counterclockwise (1) and remove jammed paper (2). 

4. Open lever 4a to the right (1) and rotate knob 2f counterclockwise (2). Remove jammed paper (3). 

Note: Hold lever 4a while rotating knob 2f.
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5. Rotate knob 3c clockwise (1) and remove jammed paper (2). 

6. Return levers 3a, 4b and 4c to their original positions. 

7. Close the trimmer upper cover.

8. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

Clearing Paper Jams from Trimmer Area E7

1. Open the trimmer upper cover. 
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2. Open lever 3a to the right (1) and rotate knob 2f counterclockwise (2). 

Note: Rotate the knob five times or more.

3. Pull out and push in the trimmer waste container continuously for three times or more.  

4. Return lever 3a to its original position. 

5. If indicator E7 remains lit, perform the following steps: 
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a. Open the lower cover. 

b. Remove the supplied cleaning rod from its location inside the lower cover. 

c. Open lever 3a to the right (1) and open lever 3d to the right (2). 
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d. Use the cleaning rod to sweep any remaining waste or debris from inside the trimmer into the trimmer 
waste container. 

e. If you have difficulty sweeping waste into the trimmer waste container, use the cleaning rod to gather 
waste, then remove the waste by hand. 

f. Return levers 3a and 3d to their original positions.

6. To ensure that all waste and debris is removed, especially beneath the frame that is located behind the 
container, use the cleaning rod to remove any remaining waste from inside the trimmer.  
For information, refer to Emptying the Crease and Two-Sided Trimmer Waste Container.

7. Close the trimmer upper and lower covers.

8. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

Crease and Two-Sided Trimmer Fault Messages

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. A graphical illustration shows the location of the fault with a brief 
explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration 
changes to indicate the multiple locations and the required corrective actions. 

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault. The (EE) code on the upper-left part of the Fault message displays which error indicator is lit 
on the Crease and Two-Sided Trimmer indicator panel (E1–E7).
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Crease and Two-Sided Trimmer Fault Code Information

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. 

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault. 

Tip: Crease and Two-Sided Trimmer faults are identified by the codes which start with the three-digit numbers 001122, 
001133, 001144, 002244, and 002288.

C/Z FOLDER TROUBLESHOOTING

C/Z Folder Paper Jams

• The press stops running and a fault message displays on the press touch screen.

• The message includes a graphical illustration showing the location of the fault along with a brief explanation of 
corrective actions for clearing the fault.

• Paper jams may occur in multiple areas of the press and any optional devices connected to the press. When this 
happens, the graphical illustration changes to show the multiple locations and the required corrective actions. 

• Additionally, if a fault occurs with the C/Z Folder, an indicator lights on the PR Finisher control panel and shows 
the corresponding area on the C/Z Folder where the fault occurred.
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Always refer to the following information when clearing paper jams: 

• Do not power off the press when removing paper jams.

• Paper jams can be removed with the press still powered on. When the power is turned off, all information stored 
to the system memory is erased.

• Clear all paper jams before resuming print jobs.

• Do not touch components inside the press. This can cause print defects.

• Ensure that all paper jams, including any small ripped pieces of paper, are cleared before proceeding with print 
jobs.

• Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove all torn pieces.

• After removing paper jams, close all doors and covers. The press cannot print when doors or covers are open.

• After clearing a paper jam, printing automatically resumes from the state before the paper jam occurred.

• If all paper jams are not cleared, an error message continues to display on the press touch screen. To clear any 
remaining jams, refer to the press touch screen for instructions and information.

Clearing Paper Jams from Folder Area E10

1. Open the folder front cover. 

2. Open lever 2a upward (1) and lever 2b to the left (2). Remove jammed paper (3). 
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3. Return levers 2a and 2b to their original positions.  

4. Close the folder front cover.

5. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

Clearing Paper Jams from Folder Area E11

1. Open the folder front cover. 

2. Open lever 2g to the right (1) and rotate knob 2c counterclockwise (2). Remove jammed paper (3).  
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3. Return lever 2g to its original position.  

4. Close the folder front cover.

5. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

Clearing Paper Jams from Folder Area E12

1. Open the folder front cover. 

2. Pull open the C/Z fold output tray 2d.  
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3. Open lever 2e to the right (1) and rotate knob 2c counterclockwise (2). Remove jammed paper (3). 

4. Return lever 2e to its original position.  

5. If you have difficulty removing any paper jams, open lever 2f to the right (1) and rotate knob 2c 
counterclockwise (2). Remove jammed paper (3). 
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6. Return lever 2f to its original position. 

7. Close the C/Z fold output tray 2d by pushing it in completely. 

8. Close the folder front cover.

9. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

C/Z Folder Fault Messages

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. A graphical illustration shows the location of the fault with a brief 
explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration 
changes to indicate the multiple locations and the required corrective actions. 

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault. The (EE) code on the upper-left part of the Fault message displays which error indicator is lit 
on the C/Z Folder indicator panel (E1–E7).

C/Z Folder Fault Code Information

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen.

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault.
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Tip: C/Z Folder faults are identified by the codes which start with the three-digit numbers 001122 and 001133.

PRODUCTION READY FINISHERS TROUBLESHOOTING

PR Finisher Paper Jams

PR FINISHER AND PR BOOKLET MAKER 
FINISHER PR FINISHER PLUS 

The following occurs when there is a fault, such as paper jams, open doors or covers, or a press malfunction:

• The press stops running and a fault message displays on the press touch screen.

• The message includes a graphical illustration showing the location of the fault along with a brief explanation of 
corrective actions for clearing the fault.

• Paper jams may occur in multiple areas of the press and any optional devices connected to the press. When this 
happens, the graphical illustration changes to show the multiple locations and the required corrective actions.

• Additionally, if a fault occurs with an optional device, an indicator lights on that device control panel and shows 
the corresponding area on the device where the fault occurred.

Always refer to the following information when clearing paper jams:

• Do not power off the press when removing paper jams.

• Paper jams can be removed with the press still powered on. When the power is turned off, all information stored 
to the system memory will be erased.

• Clear all paper jams before resuming print jobs.
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• Do not touch components inside the press. This can cause print defects.

• Ensure that all paper jams, including any small ripped pieces of paper, are cleared before proceeding with print 
jobs.

• Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove all torn pieces.

• After removing paper jams, close all doors and covers. The press cannot print when doors or covers are open.

• After clearing a paper jam, printing automatically resumes from the state before the paper jam occurred.

• If all paper jams are not cleared, an error message continues to display on the press touch screen. To clear any 
remaining jams, refer to the press touch screen for instructions and information.

Clearing Paper Jams from Finisher Area E1

1. Open the finisher front cover. 

2. Open lever 1a to the left (1) and remove the jammed paper (2). 

Note: Grasp the leading edge of the jammed sheet and pull out the sheet to remove it.
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3. If you have difficulty removing any paper jams, rotate knob 1b clockwise (1) and remove the jammed paper 
(2). 

4. Return lever 1a to its original position. 

5. Close the finisher front cover.

Clearing Paper Jams from Finisher Area E2

1. Open the finisher front cover. 
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2. Open lever 1c to the right (1) and rotate knob 1e clockwise (2). Remove the jammed paper (3). 

Note: The jammed paper may be hidden behind the upper cover.

3. Return lever 1c to its original position.  

4. Close the finisher front cover.

Clearing Paper Jams from Finisher Area E3

1. Pull out the jammed paper from the finisher top tray.  
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2. Open and close the finisher front cover.  

Clearing Paper Jams from Finisher Area E4

1. Open the finisher front cover. 

2. Open lever 1d to the right (1) and rotate knob 1e clockwise (2). Remove the jammed paper (3).  
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3. Return lever 1d to its original position.  

4. Close the finisher front cover.

Clearing Paper Jams from Finisher Area E5

1. Open the finisher front cover. 

2. Open lever 1d to the right (1) and rotate knob 1f counterclockwise (2). Remove the jammed paper (3). 
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3. Return lever 1d to its original position.  

4. Close the finisher front cover.

Clearing Paper Jams from Finisher Area E6

1. Pull out the jammed paper from the finisher stacker tray.  

2. Open and close the finisher front cover. 

Xerox® Versant® 4100 Press User Documentation 439

Troubleshooting



Clearing Paper Jams from Finisher Booklet Area E7

1. Open the finisher front cover. 

2. Open lever 3a to the left (1) and remove the jammed paper (2). 

3. If you have difficulty to remove the paper jam, pull out the Saddle Stitch Unit 3 (1) and remove the jammed 
paper (2). 
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4. Return lever 3a to its original position.  

5. Gently push in the Saddle Stitch Unit 3 until it stops.  

6. Close the finisher front cover.

Clearing Paper Jams from Finisher Booklet Area E8

1. Open the finisher front cover. 
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2. Pull out the Saddle Stitch Unit 3 toward you until it stops.  

Note: Check lever 3a for paper jam before pulling out the unit.

3. Rotate knob 3b counterclockwise (1) and remove the jammed paper (2). 

4. Gently push in the Saddle Stitch Unit 3 until it stops.  

5. Close the finisher front cover.
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Clearing Paper Jams from Finisher Booklet Area E9

1. Open the finisher front cover. 

2. Rotate knob 3b clockwise (1) and remove the jammed paper from the booklet tray area (2). 

3. Close the finisher front cover.

Clearing Paper Jams in the PR Finisher Plus, Finishing Transport

Refer to the following procedures for clearing paper jams the PR Finisher Plus, Finisher Module areas 1-4:

• Clearing Paper Jams in Finishing Transport Area 1

• Clearing Paper Jams in Finishing Transport Area 2

• Clearing Paper Jams in Finishing Transport Area 3

• Clearing Paper Jams in Finishing Transport Area 4
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Clearing Paper Jams in Finishing Transport Area 1

1. Open the Finishing Transport front cover. 

2. Open lever 1 downward and remove the jammed paper.  

3. Return lever 1 to its original position.  

4. Close the Finishing Transport front cover.

444 Xerox® Versant® 4100 Press User Documentation

Troubleshooting



Clearing Paper Jams in Finishing Transport Area 2

1. Open the Finishing Transport front cover. 

2. Open lever 2 to the right (1) and rotate the knob counterclockwise (2). Remove the jammed paper.  

3. Return lever 2 to its original position.  

4. Close the Finishing Transport front cover.

Xerox® Versant® 4100 Press User Documentation 445

Troubleshooting



Clearing Paper Jams in Finishing Transport Area 3

1. Open the Finishing Transport front cover. 

2. Open lever 3 to the left (1) and rotate the knob clockwise (2). Remove the jammed paper. 

3. Return lever 3 to its original position.  

4. Close the Finishing Transport front cover.
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Clearing Paper Jams in Finishing Transport Area 4

1. Open the Finishing Transport front cover. 

2. Open lever 4 downward (1) and rotate the knob clockwise (2). Remove jammed papers. 

3. Return lever 4 to its original position. 

4. Close the Finishing Transport front cover.
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Clearing Paper Jams in the PR Finisher Plus, Area E7

1. Open the finisher front cover. 

2. Remove any jammed paper.

3. To clear paper jams from Area E7, perform the following: 

a. Open lever 3a to the left (1) and lever 3b to the left (2). 

b. Rotate knob 1b clockwise (1) and remove the jammed paper (2). 
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c. Return levers 3a and lever 3b to their original positions.  

4. Close the finisher front cover.

Finisher Staple Faults

Use the following procedures when stapling issues occur with the printed output, such as when the sheets are not 
stapled or the staples are bent. Contact the service representative if the problems continue after you have tried the 
following solutions.

Not stapled Bent staple 

If printed sheets are stapled as shown in the following figures, contact your service representative. 

One side of staple raised up Staple bent in reverse direction Flattened staple 

Entire staple raised up Staple raised up with center pressed inward 
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Important: 

• Depending on the type of paper being stapled, the staple nails may be bent. If the bent nails are stuck inside 
the finisher, they may eventually cause paper jams.

• When you open the cover of the staple cartridge, remove any bent staples; otherwise staple jams may occur. 
Use the cover of the staple cartridge only when removing jammed staples.

Clearing Staple Jams in the Basic Stapler

If the staple cartridge accidentally detaches from its holder, refer to Reinserting the Basic Staple Cartridge.

Note: Ensure that the press is not running before performing this procedure.

1. Open the finisher front cover. 

2. Pull out R1. 

Note: After removing the staple cartridge, check the inside of the finisher for any remaining staples.
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3. Open the unit cover and remove the jammed staples. 

WARNING: To avoid personal injury, use care when removing jammed staples.

4. Reinsert the unit to its original position. 

5. Close the finisher front cover.

Reinserting the Basic Staple Cartridge

If a staple cartridge has been inserted incorrectly or accidentally removed, perform the following procedure to 
correctly reinsert the staple cartridge into the cartridge unit.

1. Open the finisher front cover. 
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2. Pull out R1.  

3. Open the unit cover and remove the jammed staples. 

WARNING: To avoid personal injury, use care when removing jammed staples.

4. Locate the lever on the back of the unit. 

WARNING: When moving the lever, be careful not to hurt your fingers and nails.
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5. Turn the unit up while holding the lever, then take out the staple cartridge from the unit. 

6. Remove the outside staples along the line. 

WARNING: When removing staples, be careful not to hurt your fingers.

7. Insert the staple cartridge into the unit. 
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8. Reinsert the unit to its original position. 

9. Close the finisher front cover.

Clearing Staple Jams in the Booklet Stapler

Note: Ensure that the press is not running before performing this procedure.

1. Open the finisher front cover. 

2. Pull out the Saddle Stitch Unit 3 toward you until it stops. 
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3. While holding the tabs on the staple cartridge, pull out the cartridge to remove it. 

4. Remove any jammed staples. 

WARNING: To avoid personal injury, use care when removing jammed staples.

5. While holding the tabs on the new staple cartridge, push in the cartridge until it seats. 

Note: Make sure that the marks are aligned.

6. Push the Saddle Stitch Unit 3 gently into the finisher until it stops. 
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7. Close the finisher front cover.

Stapler Faults in the PR Finisher Plus

Refer to the following procedures for clearing staple jams the PR Finisher Plus, Basic Staple Cartridge:

• Finisher Staple Faults

• Clearing Staple Jams in the Basic Stapler

• Reinserting the Basic Staple Cartridge

Finisher Fault Messages

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. A graphical illustration shows the location of the fault with a brief 
explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration 
changes to indicate the multiple locations and the required corrective actions. 

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault. The (EE) code on the upper-left part of the Fault message displays which error indicator is lit 
on the Finisher indicator panel (E1–E9).

Finisher Fault Code Information

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. 

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault. 

Tip: Finisher faults are identified by the codes which start with the three-digit numbers 001122, 001133, 002244, 004411, 111122, 
and 112244.

PR Finisher Plus Fault Code Information

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen.

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault.

Tip: PR Finisher Plus faults are identified by the codes which start with the three-digit numbers 001133 and 005511.
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SQUAREFOLD ®  TRIMMER TROUBLESHOOTING

SquareFold® Trimmer Paper Jams

The following occurs when there is a fault, such as paper jams, open doors or covers, or a press malfunction:

• The press stops running and a fault message displays on the press touch screen.

• The message includes a graphical illustration showing the location of the fault along with a brief explanation of 
corrective actions for clearing the fault.

• Paper jams may occur in multiple areas of the press and any optional devices connected to the press. When this 
happens, the graphical illustration changes to show the multiple locations and the required corrective actions. 

• Additionally, if a fault occurs with an optional device, an indicator lights on that device control panel and shows 
the corresponding area on the device where the fault occurred.

Always refer to the following information when clearing paper jams:

• Do not power off the press when removing paper jams.

• Paper jams can be removed with the press still powered on. When the power is turned off, all information stored 
to the system memory will be erased.

• Clear all paper jams before resuming print jobs.

• Do not touch components inside the press. This can cause print defects.

• Ensure that all paper jams, including any small ripped pieces of paper, are cleared before proceeding with print 
jobs.
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• Gently remove the paper taking care not to tear it. If paper is torn, be sure to remove all torn pieces.

• After removing paper jams, close all doors and covers. The press cannot print when doors or covers are open.

• After clearing a paper jam, printing automatically resumes from the state before the paper jam occurred.

• If all paper jams are not cleared, an error message continues to display on the press touch screen. To clear any 
remaining jams, refer to the press touch screen for instructions and information.

Clearing Paper Jams from SquareFold® Trimmer Areas E1 and E2

Note: Ensure that the press is not running before performing this procedure.

1. Open the left cover of trimmer device by pressing the button on the cover. 

2. Remove the jammed paper. 
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3. If you have difficulty removing the jammed paper, open the front cover of the finisher. 

4. Rotate the knob 3b to the right, then remove the jammed paper. 

5. If necessary, close the front cover of the finisher.

6. Close the left cover of the trimmer device.

7. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

Clearing Paper Jams from SquareFold® Trimmer Area E3

Note: Ensure that the press is not running before performing this procedure.
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1. Open the right cover of trimmer device by pressing the button on the cover. 

2. Remove the jammed paper. 

3. Close the right cover of the trimmer device.

4. If the press indicates there are additional paper jams, follow the instructions to clear the paper and to resume 
printing.

SquareFold® Trimmer Fault Messages

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. A graphical illustration shows the location of the fault with a brief 
explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration 
changes to indicate the multiple locations and the required corrective actions. 

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault. The (EE) code on the upper-left part of the Fault message displays which error indicator is lit 
on the SquareFold® Trimmer control panel (E1–E3).

SquareFold® Trimmer Fault Code Information

When a fault occurs, such as paper jams, open doors or covers, or a press malfunction, the press stops printing and 
a message appears on the press touch screen. 

The touch screen also displays a Faults button which provides information about the fault and detailed instructions 
for correcting the fault. 
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Tip: SquareFold® Trimmer faults are identified by the codes which start with the three-digit number 001133.

Guidelines for Using the SquareFold® Trimmer Device

Full-Page Images on Booklets

When using full-page images, ensure that the finished booklet size accommodates any full-page images and that 
when the booklet is trimmed, these images are not truncated.

The following are examples of a booklet with preprinted front/back covers with a full-page image but different sizes:

1. Booklet 1 is printed on 8.5 x 14 in./B4 paper: The front cover, which was trimmed, displays the entire image.

2. Booklet 2 is printed on 8.5 x 11 in./A4 paper: The image on the front cover is truncated after trimming it.

Booklet Considerations

Before you print any booklet, consider the following:

• Image location on the original as it will no longer be centered. Do you need to shift images in order to ensure 
they fit on the finished booklet?

• What is the desired size of the finished booklet?

• Does the booklet contain full-page images?
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• Are you using preprinted covers with full-page images?

• Are you trimming the booklet?

Considerations for Obtaining Desired Booklet Output

Follow these tips to ensure you get your desired output:

• Always run one or more test prints of your job before running a larger output quantity.

• Review your test prints for truncated images/text.

• If any images or text need shifting, use the various selections from the print driver for your application. Refer to 
the Help information for your print driver.

Note: It may take one or more test prints before you achieve your desired output.
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Troubleshooting Help

LOCATING THE PRESS SERIAL NUMBER

The press serial number can be accessed from the User Interface (UI) or by locating the serial number plate on the 
inside frame of the first feeder tray (Tray 1).

1. Press the Machine Status button on the UI.

2. From the Machine Status screen, ensure that the Machine Information tab is displayed. 

The press serial number is displayed under General Information.

3. If there is a loss of power and it is not possible to access the Machine Status screen, the press serial number 
can also be found on the inside frame of the press near paper Tray 1:  

a. At the press, fully open paper Tray 1.

b. At the left of the feeder tray, on the press frame, locate the plate with the serial number (SSEERR##). 

CALLING FOR SERVICE

1. Record any displayed fault codes. 
For more information, refer to Faults Tab and Fault Messages.

2. Record the press serial number. 

a. Select the Machine Status button at the press control panel. 

b. From the Machine Status screen, select the Machine Information tab. 

The serial number is listed with the Machine Information.

c. If the serial number is not displayed, open Tray 1 and locate the serial number plate on the left side of the 
frame (SSEERR ##). 
For more information, refer to Locating the Press Serial Number.

3. If output quality is a problem, take a sample as a reference to assist you in describing the problem over the 
telephone when answering the questions from the customer support operator about the defects.

4. If possible, use a phone near the press when calling for assistance. Follow the instructions provided by the 
operator.
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5. For system support, user help, and service support, call the appropriate number.  
For the specific number in your area, go to www.xerox.com/VERSANT_4100support.
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From the press, you can log into the Administrator mode. From the select Administrator mode, you can do the 
following:

• Customize the press screen

• Select the power saver mode settings

• Run the Clean the Fuser Assembly with Felt procedure

• Reset a High Frequency Service Item (HFSI) counter

• Use the Fuser NVM Read/Write Setting

• Select and edit other System Settings

• Connect to Xerox® CentreWare® Internet Services

• Setup and use the Accounting features and functions

• Setup and use the Authentication/Security Settings

For more information, refer to the System Administrator Guide.
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